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Capitolo 1: Novità

Prestazioni migliorate, stabilità

• Numerosi miglioramenti agli strumenti utilizzati più spesso in Fireworks che consentono di aumentare l'efficienza 

lavorativa

• Prestazioni complessive più veloci

• Maggiore controllo sul posizionamento dei pixel degli elementi di progettazione

• Strumento tracciati composti aggiornato

Precisione dei pixel

Una precisione dei pixel migliorata garantisce che i progetti vengano visualizzati in maniera nitida e pulita su qualsiasi 

dispositivo. Possibilità di correggere elementi del progetto che non appaiono su un intero pixel in maniera rapida e 

semplice.

Adobe Device Central: integrazione

Utilizzando Adobe Device Central, potete selezionare profili per dispositivi mobili e altri dispositivi, quindi avviare un 

flusso di lavoro automatizzato per creare un progetto Fireworks. Le dimensioni e la risoluzione schermo del progetto 

sono quelle del dispositivo di destinazione. Al termine della progettazione, potete visualizzare l'anteprima del progetto 

in varie condizioni utilizzando le funzionalità di emulazione di Device Central. Potete anche creare profili dispositivo 

personalizzati.

Flussi di progettazione per dispositivi mobili migliorati che includono l'emulazione di progetti interattivi con 

integrazione con Adobe Device Central.  

Flussi di lavoro supportati con Flash Catalyst e Flash 
Builder

Create interfacce utente avanzate e contenuto interattivo utilizzando nuovi flussi di lavoro tra Fireworks e Flash 

Catalyst.Design in Fireworks e selezionate oggetti, pagine e interi documenti da esportare mediante FXG, un nuovo 

formato grafico basato su XML per gli strumenti della piattaforma Adobe Flash. Esportate i progetti in maniera 

efficiente in Flash Professional, Flash Catalyst e Flash Builder mediante uno script estensibile personalizzabile.

Miglioramenti estensibilità

Sperimentate un maggiore controllo quando utilizzate altre applicazioni: API migliorate che supportano script di 

esportazione estensibili dall'utente, elaborazione batch e controllo avanzato sul formato file FXG.
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Condivisione campioni nella suite

Migliore controllo sulla precisione del colore utilizzando la capacità di Fireworks di condividere campioni tra le 

applicazioni Creative Suite. La capacità di condividere il formato file ASE favorisce lo scambio colore unificato tra i 

progettisti compresi quelli che utilizzano Adobe Kuler. 
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Capitolo 2: Nozioni di base di Fireworks

Le operazioni in Fireworks

Adobe® Fireworks® è un programma versatile per la creazione, la modifica e l’ottimizzazione degli elementi grafici per 

il Web. È possibile creare e modificare immagini bitmap e vettoriali, progettare effetti Web come rollover e menu a 

comparsa, ritagliare e ottimizzare gli elementi grafici per ridurre le dimensioni del file e abbreviare i tempi di lavoro 

automatizzando le operazioni ripetitive. È possibile esportare o salvare un documento come file JPEG, GIF o in altro 

formato. Tali file possono essere salvati con relativi file HTML contenenti tabelle HTML e codice JavaScript per 

l’utilizzo sul Web.

Per un’esercitazione video sulle nozioni di base di Fireworks, consultare www.adobe.com/go/lrvid4032_fw_it.

Disegnare e modificare oggetti vettoriali e bitmap

Il pannello Strumenti di Fireworks è composto da sezioni distinte contenenti gli strumenti di disegno e modifica di 

vettori e bitmap. Lo strumento che si seleziona determina se l’oggetto creato è di tipo vettoriale o bitmap. Dopo aver 

disegnato un oggetto o del testo, è possibile utilizzare una vasta gamma di strumenti, effetti, comandi e tecniche per 

ottimizzare gli elementi grafici o creare pulsanti di navigazione interattivi.

È possibile importare e modificare gli elementi grafici in molti formati, tra cui JPEG, GIF, PNG e PSD. 

Aggiungere interattività agli elementi grafici

Le porzioni e i punti attivi sono oggetti per il Web che specificano aree interattive in un elemento grafico per il Web. 

Le porzioni tagliano un’immagine in sezioni esportabili e consentono di applicare comportamenti rollover, 

animazioni e collegamenti URL. In una pagina Web, ciascuna porzione appare in una cella di tabella. 

Le maniglie rollover di trascinamento sulle porzioni e i punti attivi permettono di assegnare rapidamente agli elementi 

grafici comportamenti rollover e di scambio immagini. Con l’Editor dei pulsanti di Fireworks e l’Editor di menu a 

comparsa è possibile creare particolari elementi grafici interattivi per la navigazione nei siti Web. 

Ottimizzare ed esportare elementi grafici

Le potenti funzioni di ottimizzazione di Fireworks consentono di conferire agli elementi grafici esportati il giusto 

equilibrio tra le dimensioni del file e una qualità visiva accettabile. Il tipo di ottimizzazione dipende dalle necessità 

dell’utente e dal contenuto.

Dopo aver ottimizzato gli elementi grafici, il passaggio successivo consiste nell’esportarli per utilizzarli sul Web. Dal 

documento PNG sorgente di Fireworks, è possibile esportare i file in una serie di formati, tra cui JPEG, GIF, GIF 

animate e tabelle HTML, contenenti immagini porzione in vari tipi di file.

Elementi grafici vettoriali e bitmap

I computer visualizzano le immagini in formato vettoriale o bitmap. La comprensione della differenza tra i due formati 

consente di capire il funzionamento di Fireworks, il quale contiene sia strumenti vettoriali che bitmap ed è in grado di 

aprire o importare entrambi i formati.

http://www.adobe.com/go/lrvid4032_fw_it
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La grafica vettoriale

La grafica vettoriale definisce le immagini utilizzando linee e curve (vettori), che includono informazioni sul colore e 

la posizione. Ad esempio, l’immagine di una foglia può essere definita da una serie di punti che descrivono il contorno 

della foglia. Il colore della foglia è determinato dal colore del contorno (il tratto) e dal colore dell’area in esso racchiusa 

(il riempimento). 

Gli elementi grafici vettoriali sono indipendenti dalla risoluzione. Ciò significa che la qualità dell’aspetto degli elementi 

grafici vettoriali non cambia quando si modifica il colore, quando l’elemento grafico viene spostato, ridefinito o 

ridimensionato, o quando si modifica la risoluzione del dispositivo di output.

La grafica bitmap

La grafica bitmap è costituita da puntini (pixel) disposti su una griglia. Lo schermo stesso del computer è costituito da 

una grande griglia di pixel. Nella versione bitmap della foglia, l’immagine è determinata dalla posizione e dal valore 

del colore di ciascun pixel della griglia. A ogni pixel viene assegnato un colore. Se visualizzati con la risoluzione 

corretta, i puntini si uniscono come le tessere di un mosaico. 

Quando si modifica un elemento grafico bitmap, si interviene sui pixel anziché sulle linee e sulle curve. Tali elementi 

grafici bitmap sono dipendenti dalla risoluzione, in quanto i dati che descrivono l’immagine sono fissati in base a una 

griglia di dimensioni specifiche. Ingrandendo un elemento grafico bitmap, i pixel vengono ridistribuiti all’interno della 

griglia; per questa ragione i bordi dell’immagine appaiono spesso frastagliati. Visualizzando un elemento grafico 

bitmap su un dispositivo di output con una risoluzione inferiore a quella dell’immagine, anche la qualità 

dell’immagine risulta degradata.

Creazione di un nuovo documento Fireworks

I nuovi documenti di Fireworks vengono salvati come documenti PNG (Portable Network Graphic). PNG è il formato 

nativo di Fireworks. 
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Gli elementi grafici creati in Fireworks possono essere esportati o salvati in diversi formati grafici e per il Web. Il file 

PNG originale di Fireworks può essere sempre modificato in un secondo momento, indipendentemente dalle 

impostazioni di ottimizzazione ed esportazione selezionate. 

Creare un nuovo documento

1 Selezionare File > Nuovo. 

Viene visualizzata la finestra di dialogo Nuovo documento.

2 Immettere le impostazioni per il documento e fare clic su OK. 

Nota: utilizzare il menu a comparsa della casella colori Personalizzato per selezionare un colore personalizzato per 

l’area di lavoro.

Impostare dimensioni predefinite per nuovi documenti

Quando aprite Fireworks per la prima volta, i valori di dimensione seguenti appaiono nella finestra di dialogo Nuovo 

documento per impostazione predefinita:

• 660 x 440 (Windows)

• 500 x 500 (Mac)

Le impostazioni nella finestra di dialogo Nuovo documento non cambiano quando modificate la dimensione dell'area 

di lavoro in Fireworks. 

Le impostazioni predefinite vengono modificate quando copiate un oggetto. Le dimensioni dell'oggetto copiato (negli 

Appunti) vengono automaticamente utilizzate nella finestra di dialogo Nuovo documento.

Per cancellare le dimensioni oggetto dagli Appunti, effettuate le seguenti operazioni (Windows):

1 Create un documento con le dimensioni preferite.

2 Salvate il documento e chiudete Fireworks.

3 Riaprite Fireworks e create un documento.

Le dimensioni del documento salvato in precedenza appaiono nella finestra di dialogo Nuovo documento.

Per Mac OS, Fireworks conserva la dimensione di un oggetto copiato in precedenza durante la creazione di un nuovo 

documento. Questo perché il contenuto degli Appunti viene conservato finché altri elementi, come testo, non vengono 

tagliati e copiati. Se copiate elementi non correlati alle dimensioni e quindi selezionate "Nuovo", le dimensioni salvate 

in precedenza vengono visualizzate come predefinite.
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Creare un nuovo documento avente le stesse dimensioni di un oggetto 

esistente negli Appunti

1 Copiare un oggetto negli Appunti da un altro documento Fireworks, un browser Web o un’applicazione che 

consenta l’operazione Incolla.

2 Selezionare File > Nuovo. 

Viene visualizzata la finestra di dialogo Nuovo documento, con le dimensioni di altezza e larghezza dell’oggetto 

contenuto negli Appunti.

3 Impostare la risoluzione e il colore dell’area di lavoro, quindi fare clic su OK. 

4 Selezionare Modifica > Incolla per incollare nel nuovo documento l’oggetto contenuto negli Appunti.

Modelli

È possibile salvare un file di Fireworks come modello e creare nuovi file usando il modello. Il modello viene salvato nel 

formato PNG di Fireworks. Fireworks dispone di un elenco di modelli precostituiti da utilizzare per personalizzare i 

dispositivi mobili, i prototipi, i siti web e i frame web. 

Creare dei modelli

1 Create un nuovo file. Per standardizzare l’aspetto dei documenti creati con il modello, è possibile aggiungere dei 

segnaposto per la progettazione e i contenuti.

2 Selezionate File > Salva come modello per salvare il file come un modello di file Fireworks PNG.

Creare file da un modello

1 Selezionare File > Nuovo da modello

2 Selezionate il modello che desiderate utilizzare per creare il nuovo file e fate clic su Apri.

Nota: nel modello vengono memorizzati i dati specifici Fireworks come le pagine, i livelli e le informazioni vettoriali.

Apertura e importazione dei file

Nota: quando si importa un file da Adobe Dreamweaver®, Fireworks conserva la maggior parte dei comportamenti 

JavaScript. Se un comportamento è supportato, Fireworks lo riconosce e lo mantiene anche quando il file viene riportato 

in Dreamweaver.

Aprire un documento di Fireworks

❖ Selezionare File > Apri e selezionare il file. 

Per aprire un file senza sovrascrivere la versione precedente, selezionare Apri come “Senza nome”, quindi salvare il 

file con un nome diverso.

Aprire un file chiuso di recente

1 Selezionare File > Apri recente.
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2 Selezionare un file nel sottomenu visualizzato.

Aprire un file chiuso di recente quando non vi sono file aperti

❖ Fare clic sul nome del file sulla pagina iniziale.

Aprire elementi grafici creati in altre applicazioni

È possibile aprire file creati con altre applicazioni o di altri formati, tra cui file Photoshop®, Adobe Illustrator® e file 

WBMP, EPS, JPEG, GIF e GIF animate.

All’apertura di un file di formato diverso da PNG con File > Apri, viene creato un nuovo documento PNG di Fireworks 

basato sul file aperto. È possibile modificare l’immagine utilizzando tutte le funzionalità di Fireworks. È inoltre 

possibile selezionare Salva con nome per salvare il lavoro come nuovo file PNG di Fireworks o in un altro formato. 

In alcuni casi è possibile salvare il file nel suo formato originale. In tal caso, l’immagine viene ridotta a un singolo livello 

e non sarà possibile modificare le funzioni specifiche di Fireworks che le erano state aggiunte.

I seguenti formati file possono essere salvati direttamente da Fireworks: PNG di Fireworks, GIF, GIF animate, JPEG, 

BMP, WBMP, TIFF, SWF, AI, PSD e PICT (solo Mac OS).

Nota: Fireworks salva le immagini TIFF a 16 bit con una profondità colore a 24 bit.

GIF animate 

• Importare una GIF animata come simbolo di animazione, quindi modificare e spostare tutti gli elementi 

dell’animazione come una singola entità. Utilizzare il pannello Libreria documento per creare nuove istanze del 

simbolo.

Nota: quando si importa una GIF animata, l’impostazione di ritardo stato assume il valore predefinito di 7 centesimi 

di secondo. Se necessario, utilizzare il pannello Stati per ripristinare l’impostazione di tempo originale. 

• Aprire un file GIF animato come se si trattasse di un file GIF normale. Ogni elemento della GIF viene collocato 

come immagine separata su un proprio stato di Fireworks. Se lo si desidera, è possibile convertire l’elemento grafico 

in un simbolo di animazione.

File EPS

Fireworks consente di aprire la maggior parte dei file EPS, come immagini bitmap appiattite, ossia in cui tutti gli 

oggetti sono stati combinati su un unico livello. Alcuni file EPS esportati da Adobe Illustrator mantengono le proprie 

informazioni vettoriali.

File PSD

Fireworks consente di aprire file PSD creati in Photoshop e di mantenere la maggior parte delle caratteristiche dei PSD, 

inclusi i livelli gerarchici, gli effetti dei livelli e i metodi di fusione più comuni. Per personalizzare l’importazione di file 

PSD, utilizzare le diverse opzioni di importazione e apertura di file Photoshop nella finestra di dialogo Preferenze.

File WBMP 

Fireworks è in grado di aprire file WBMP, cioè file da 1 bit (monocromi) ottimizzati per dispositivi portatili. Questo 

formato deve essere utilizzato per le pagine WAP (Wireless Application Protocol). 
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È possibile utilizzare l’estensione Importa più file per importare diversi file selezionati nelle nuove pagine di un file 

PNG di Fireworks. Questa estensione consente di aggregare i file del proprio progetto creati con delle versioni 

precedenti di Fireworks. È inoltre possibile importare file bidimensionali nei formati PSD, AI, BMP, Freehand, GIF, GIF 

animate, JPEG, PICT e TIFF. Potete scaricare questa estensione da 

http://www.adobe.com/go/learn_fw_multiplepages_it.

Creare file PNG di Fireworks da file HTML

In Fireworks è possibile aprire e importare contenuti HTML creati in altre applicazioni con elementi tabella HTML di base.

Aprire solo la prima tabella di un file HTML

1 Selezionare File > Apri. 

2 Selezionare il file HTML contenente la tabella che si desidera aprire e fare clic su Apri.

La prima tabella del file HTML si apre in una nuova finestra del documento.

Importare la prima tabella di un file HTML in un documento di Fireworks 

aperto

1 Scegliere File > Importa. 

2 Selezionare il file HTML dal quale si desidera effettuare l’importazione e fare clic su Apri. 

3 Fare clic per posizionare il punto di inserimento nel punto in cui si desidera che appaia la tabella importata.

Nota: Fireworks è in grado di importare documenti che utilizzano la codifica UTF-8 e i documenti scritti in XHTML.

Inserire oggetti in un documento di Fireworks

Trascinare un’immagine o del testo in Fireworks

È possibile trascinare oggetti vettoriali, immagini bitmap o testi da qualsiasi applicazione che supporti il 

trascinamento.

❖ Dall’altra applicazione, trascinare l’oggetto o il testo e rilasciarlo in Fireworks. 

Incollare in Fireworks

Incollando in Fireworks un oggetto copiato proveniente da un’altra applicazione, l’oggetto viene collocato al centro 

del documento attivo. 

È possibile incollare negli Appunti il testo o gli oggetti creati in uno dei seguenti formati:

• Adobe FreeHand 7 o versioni successive

• Adobe Illustrator 

• PNG 

• PICT (Mac OS) 

• DIB (Windows) 

http://www.adobe.com/go/learn_fw_multiplepages_it
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• BMP (Windows) 

• Testo ASCII 

• EPS

• WBMP

• TXT

• RTF

1 Nell’altra applicazione, copiare l’oggetto o il testo che si desidera incollare.

2 In Fireworks, incollare l’oggetto o il testo nel documento.

Collocazione degli oggetti incollati

Il posizionamento dell’oggetto incollato dipende dall’elemento selezionato:

• Se è selezionato almeno un oggetto su un solo livello, l’oggetto incollato viene collocato davanti all’oggetto 

selezionato, direttamente sopra di esso nell’ordine di sovrapposizione del livello.

• Se è selezionato il livello e non è selezionato alcun oggetto o sono selezionati tutti gli oggetti, l’oggetto incollato 

viene collocato davanti all’oggetto superiore, direttamente sopra di esso nell’ordine di sovrapposizione del livello.

• Se sono selezionati due o più oggetti su più di un livello, l’oggetto incollato viene collocato nel livello superiore, 

davanti all’oggetto superiore, direttamente sopra di esso nell’ordine di sovrapposizione del livello.

• Se è selezionato il livello Web o un oggetto sul livello Web, l’oggetto incollato viene collocato sul livello inferiore 

davanti a tutti gli altri oggetti, direttamente sopra di essi nell’ordine di sovrapposizione del livello.

Nota: il livello Web è uno speciale livello che contiene tutti gli oggetti Web e rimane sempre nella parte superiore del 

pannello Livelli. 

Ridefinire gli oggetti incollati 

La ridefinizione (o il ricampionamento) aggiunge o sottrae pixel da un’immagine ridimensionata in modo da farla 

corrispondere il più possibile all’aspetto dell’immagine originale. La ridefinizione di una bitmap a una risoluzione 

superiore causa in genere una perdita ridotta di qualità. La ridefinizione verso una risoluzione inferiore comporta 

sempre una perdita rilevante di dati e una qualità inferiore.

Ridefinire un oggetto bitmap mediante un’operazione Incolla

1 Copiare la bitmap negli Appunti in Fireworks o in un altro programma.

2 Selezionare Modifica > Incolla in Fireworks.

3 Se l’immagine bitmap negli Appunti ha una risoluzione diversa rispetto a quella del documento corrente, scegliere 

un’opzione di ridefinizione.

Ridefinisci Mantiene la larghezza e l’altezza originali della bitmap incollata, aggiungendo o sottraendo pixel se 

necessario.

Non ridefinire Mantiene tutti i pixel originali, il che potrebbe rendere le dimensioni relative dell’immagine 

incollata maggiori o minori di quanto previsto.
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Importare un file PNG in un livello di un documento di Fireworks

Quando si importano file PNG di Fireworks nel livello corrente del documento Fireworks attivo, gli oggetti punto 

attivo e gli oggetti porzione vengono posizionati nel livello Web del documento. Le proporzioni dell’immagine 

importata rimangono invariate.

1 Nel pannello Livelli, selezionare il livello in cui si desidera importare il file.

2 Selezionare File > Importa per aprire la finestra di dialogo Importa.

3 Individuare il file da utilizzare e fare clic su Apri.

4 Nell’area di lavoro, posizionare il cursore di importazione nel punto in cui si desidera collocare l’angolo superiore 

sinistro dell’immagine.

5 Effettuare una delle seguenti operazioni:

• Fare clic per importare l’immagine completa.

• Trascinare il cursore di importazione per ridimensionare l’immagine mentre viene importata. 

Importare da fotocamera digitale o scanner

L’importazione di immagini da fotocamere digitali o scanner è possibile soltanto se si tratta di dispositivi compatibili 

TWAIN (Windows) o che supportano la funzionalità di acquisizione immagine incorporata (Mac OS). Le immagini 

importate in Fireworks da una fotocamera digitale o da uno scanner vengono aperte come nuovo documento.

Prima di provare a importare le immagini in Fireworks, installare tutti i driver software, moduli e plug-in necessari per 

la fotocamera o lo scanner.

La cartella dei plug-in si trova all’interno della cartella dell’applicazione Fireworks. In Mac OS, Fireworks effettua 

automaticamente la ricerca dei plug-in di acquisizione di Photoshop nell’apposita cartella.

Indirizzare Fireworks ai plug-in di acquisizione di Photoshop

1 In Fireworks, scegliere Modifica > Preferenze (Windows) o Fireworks > Preferenze (Mac OS).

2 Fare clic sulla categoria dei plug-in.

3 Selezionare Plug-in Photoshop e accedere alla cartella contenente i plug-in.

Se la finestra Seleziona la cartella di Plug-In Photoshop (Windows) o Scegli una cartella (Mac OS) non si apre 

automaticamente, selezionare la cartella. 

Importare un’immagine da una fotocamera digitale (Windows)

1 Collegare la fotocamera al computer.

2 In Fireworks, selezionare File > Scansione, quindi selezionare Acquisisci Twain o Seleziona Twain.

3 Selezionare la sorgente per le immagini da importare.

Viene visualizzata l’interfaccia utente del software della fotocamera. 

4 Seguire le istruzioni riportate per applicare le impostazioni desiderate. 

Importare un’immagine da una fotocamera digitale (Mac OS)

1 Collegare la fotocamera al computer.

2 In Fireworks, selezionare File > Acquisisci, quindi selezionare Acquisisci fotocamera o Seleziona fotocamera.

3 Selezionare la fotocamera e le immagini da importare.
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4 Seguire le istruzioni riportate per applicare le impostazioni desiderate. 

Importare un’immagine da uno scanner 

1 Collegare lo scanner al computer.

2 Installare il software che accompagna lo scanner, se tale operazione non è già stata eseguita.

3 Effettuare una delle seguenti operazioni:

• (Windows) In Fireworks, selezionare File > Scansione, quindi selezionare Acquisisci Twain o Seleziona Twain.

• (Mac OS) In Fireworks, selezionare File > Acquisisci, quindi selezionare Acquisisci Twain o Seleziona Twain.

Nota: per la maggior parte dei moduli TWAIN o dei plug-in di acquisizione di Photoshop, vengono visualizzate 

finestre di dialogo aggiuntive che richiedono di impostare altre opzioni.

4 Seguire le istruzioni riportate per applicare le impostazioni desiderate. 

Salvataggio dei file di Fireworks

Durante la creazione di un documento o l’apertura dei file in formati quali PSD o HTML, il comando File > Salva crea 

un file PNG di Fireworks. I file PNG di Fireworks offrono i seguenti vantaggi:

• Il file PNG sorgente è sempre modificabile. È possibile tornare indietro e apportare ulteriori modifiche anche dopo 

aver esportato il file per l’uso sul Web.

• Le grafica complessa può essere suddivisa in più parti nel file PNG e quindi esportata in più file con formati e 

impostazioni di ottimizzazione diverse.

Se il salvataggio di un documento complesso in Fireworks richiede del tempo, durante il processo di salvataggio è 

comunque possibile modificare altri documenti aperti.

Salvare un file PNG di Fireworks per una versione precedente

1 Selezionare File > Esporta.

2 Individuare la posizione in cui si desidera salvare il file.

3 Se il file di Fireworks include più pagine, nel menu a comparsa Esporta selezionare Pagine in file.

4 Selezionare Immagini o PNG Fireworks nel menu a comparsa Esporta come. Se si seleziona Immagini, ogni pagina 

viene salvata nel formato di file predefinito che può essere impostato con il pannello Ottimizza. Per ulteriori 

informazioni, consultare “Ottimizzazione ed esportazione” a pagina 234.

Durante l’esportazione vengono salvati tutti gli oggetti dei livelli superiori. Gli oggetti nascosti non vengono 

esportati.

Salvare tutti i documenti aperti

È possibile salvare tutti i documenti aperti anche se si continua a lavorare su di essi, specificando nomi di file per i 

documenti ancora senza un nome. I documenti che sono stati modificati dall’ultimo salvataggio sono contrassegnati 

da un asterisco (*) accanto al nome file, nella scheda del documento.

❖ Selezionare Comandi > Salva tutto.
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Nota: è possibile utilizzare l’utilità Fireworks Auto Backup per effettuare una copia di sicurezza di tutti i documenti 

Fireworks aperti. Scaricate l'utilità da Adobe AIR Marketplace all'indirizzo 

http://www.adobe.com/go/learn_fw_autobackuputility_it. 

Salvare i documenti in altri formati

Se si usa File > Apri per aprire un file in un formato diverso da PNG, è possibile selezionare successivamente File > 

Salva con nome per salvare il lavoro come nuovo file PNG di Fireworks o selezionare un altro formato.

Per i seguenti tipi di file, è possibile scegliere File > Salva per salvare il documento nel suo formato originale: PNG di 

Fireworks, GIF, GIF animate, JPEG, BMP, WBMP, TIFF, SWF, AI, PSD e PICT (solo Mac OS). Fireworks salva le 

immagini TIFF a 16 bit con una profondità di colore a 24 bit.

Nota: se si salva un file PNG come file bitmap, ad esempio GIF o JPEG, gli oggetti grafici manipolati nel file PNG non 

sono più disponibili in quello bitmap. Per modificare l’immagine, utilizzare il file PNG originale, quindi esportarlo di 

nuovo.

Aggiungere una cornice immagine

1 Selezionare Comandi > Creatività > Aggiungi cornice immagine.

2 Selezionare un motivo e impostare la dimensione della cornice.

3 Fare clic su OK.

Ripristinare i messaggi di avvertenza

Se i messaggi di avvertenza sono stati disattivati, è possibile riattivarli.

❖ Selezionare Comandi > Ripristino finestre avvertenza.

Acquisire una videata (solo Windows)

1 Selezionare Comandi > Acquisisci videata.

2 Passare alla finestra di cui si desidera acquisire la schermata. 

3 Fare clic su OK, quindi trascinare per selezionare l’area della finestra.

4 Incollare il contenuto degli Appunti nell’area di lavoro o in un’applicazione per l’elaborazione di immagini.

http://www.adobe.com/go/learn_fw_autobackuputility_it
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Capitolo 3: Area di lavoro

Nozioni di base sull’area di lavoro

Panoramica sull’area di lavoro di Fireworks

Quando si apre un documento in Adobe® Fireworks® per la prima volta, l’area di lavoro comprende il pannello 

Strumenti, la finestra di ispezione Proprietà, i menu e altri pannelli. Il pannello Strumenti, sul lato sinistro dello 

schermo, è suddiviso in varie categorie: i gruppi di strumenti bitmap, vettore e per il Web. La finestra di ispezione 

Proprietà è per impostazione predefinita nella parte inferiore del documento e contiene inizialmente le proprietà del 

documento. Successivamente, passa alla visualizzazione delle proprietà dello strumento selezionato o dell’oggetto 

corrente, a seconda della selezione effettuata nel documento. I pannelli sono inizialmente agganciati in gruppi sul lato 

sinistro dello schermo. La finestra del documento viene visualizzata al centro del programma.

Pagina iniziale

Quando Fireworks viene avviato senza aprire un documento, nello spazio di lavoro viene visualizzata la pagina iniziale. 

La pagina iniziale consente di accedere rapidamente alle esercitazioni di Fireworks, ai file recenti e a Fireworks 

Exchange, dove è possibile aggiungere nuove funzioni al programma. Per disattivare la pagina iniziale, quando si apre 

la pagina stessa fare clic su Non visualizzare di nuovo.
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I pannelli di Fireworks

I pannelli sono comandi flottanti che consentono di modificare vari aspetti di un oggetto selezionato o elementi del 

documento. I pannelli permettono di lavorare su stati, livelli, simboli, campioni colore e altro ancora. Ogni pannello 

può essere trascinato, in modo da consentire il raggruppamento dei pannelli in disposizioni personalizzate.

Pannello Ottimizza Permette di gestire le impostazioni di dimensione e tipo di un file e di lavorare con la tavolozza dei 

colori del file o della porzione.

Pannello Livelli Permette di gestire la struttura di un documento e contiene opzioni per creare, eliminare e manipolare 

i livelli. 

Pannello Libreria comune Consente di visualizzare i contenuti della cartella Libreria comune, che contiene simboli. È 

possibile trascinare con facilità istanze di questi simboli dal pannello Libreria documento al documento stesso. 

Pannello Pagine Visualizza le pagine nel file corrente e include opzioni per la gestione delle pagine.

Pannello Stati Visualizza gli stati nel file corrente e include opzioni per la creazione di animazioni.

Pannello Cronologia Elenca i comandi utilizzati più di recente, consentendo così di annullarli o ripristinarli con 

rapidità. È inoltre possibile selezionare più azioni, quindi salvarle e riutilizzarle come comandi. 

Pannello Forme automatiche Contiene Forme automatiche che non sono presenti nel pannello Strumenti.

Pannello Stili Consente di memorizzare e riutilizzare combinazioni di caratteristiche di oggetti oppure selezionare 

uno stile predefinito.

Pannello Libreria documento Contiene simboli grafici, simboli di pulsante e simboli di animazione già presenti nel 

documento Fireworks corrente. È possibile trascinare con facilità istanze di questi simboli dal pannello Libreria 

documento al documento stesso. È possibile effettuare modifiche globali a tutte le istanze semplicemente modificando 

il simbolo. 

Pannello URL Consente di creare librerie contenenti URL di uso frequente.

Pannello Mixer colori Permette di creare nuovi colori da aggiungere alla tavolozza dei colori del documento corrente 

o di applicarli agli oggetti selezionati.

Pannello Campioni colore Permette di gestire la tavolozza dei colori del documento corrente. 

Pannello Informazioni Fornisce le informazioni relative alle dimensioni degli oggetti selezionati e le coordinate esatte 

del puntatore man mano che viene spostato nell’area di lavoro.

Pannello Comportamenti Consente di gestire i comportamenti, che determinano cosa avviene quando i punti attivi o 

le porzioni rispondono al movimento del mouse.

Pannello Trova Consente di cercare e sostituire elementi come testo, URL, caratteri e colori in uno o più documenti.

Pannello Allinea Include comandi per l’allineamento e la distribuzione degli oggetti nell’area di lavoro.

Pannello Proprietà forma automatica Consente di modificare le proprietà di una forma automatica dopo averla 

inserita in un documento.

Pannello Tavolozza colori (Finestra > Altri) Consente di creare e scambiare le tavolozze di colori, di esportare 

campioni di colore ACT personalizzati, di esplorare diversi schemi di colore e di accedere ai comandi più comuni per 

la scelta dei colori.

Modifica immagine (Finestra > Altri) Organizza in un pannello gli strumenti e le opzioni utilizzati comunemente per 

la modifica dei file bitmap.

Pannello Tracciato (Finestra > Altri) Fornisce un accesso rapido a molti comandi relativi ai tracciati.

Caratteri Speciali (Finestra > Altri) Visualizza i caratteri speciali che possono essere utilizzati nei blocchi di testo.
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Proprietà simbolo Gestisce le proprietà personalizzabili dei simboli grafici.

Panoramica delle aree di lavoro

Potete creare e modificare documenti e file usando vari elementi come pannelli, barre e finestre. La disposizione di 

questi elementi è detta area di lavoro. Le aree di lavoro delle diverse applicazioni Adobe® Creative Suite® 5 condividono 

uno stesso aspetto, in modo da facilitare il passaggio da un’applicazione a un’altra. Potete adattare ogni applicazione 

al vostro modo di lavorare, selezionando un’area di lavoro tra quelle predefinite oppure creandone una personalizzata.

Anche se la disposizione dell’area di lavoro predefinita è diversa nei vari prodotti, i singoli elementi possono essere 

manipolati allo stesso modo.

Area di lavoro predefinita di Illustrator
A. Finestre documento a schede  B. Barra dell’applicazione  C. Commutatore area di lavoro  D. Barra del titolo del pannello  E. Pannello 
Controllo  F. Pannello Strumenti  G. Pulsante Riduci a icone  H. Quattro gruppi di pannelli ancorati verticalmente  

• La barra dell’applicazione lungo il lato superiore contiene un controllo per cambiare area di lavoro, i menu (solo in 

Windows) e altri controlli per l’applicazione. In alcuni prodotti per Mac OS, potete mostrare o nascondere la barra 

usando il menu Finestra.

• Il pannello Strumenti contiene gli strumenti per creare e modificare immagini, disegni, elementi di pagina e così 

via. Gli strumenti correlati sono raggruppati.

• Il pannello Controllo presenta le opzioni disponibili per lo strumento corrente. In Illustrator, il pannello Controllo 

presenta le opzioni disponibili per l’oggetto corrente. (In Adobe Photoshop® questo è conosciuto come barra delle 

opzioni. In Adobe Flash®, Adobe Dreamweaver® e Adobe Fireworks® è conosciuto come finestra di ispezione 

proprietà e include proprietà dell’elemento attualmente selezionato.) 

G

F

H

A B DC

E



16UTILIZZO DI FIREWORKS

Area di lavoro

Ultimo aggiornamento 4/5/2011

• Nella finestra del documento è visualizzato il file su cui state lavorando. Le finestre del documento possono essere 

sotto forma di schede e, in alcuni casi, raggruppate e ancorate.

• I pannelli permettono di controllare e modificare il lavoro. Alcuni esempi di pannelli sono la Timeline in Flash, il 

pannello Pennello in Illustrator, il pannello Livelli in Adobe Photoshop® e il pannello Stili CSS in Dreamweaver. I 

pannelli possono essere raggruppati, impilati o ancorati.

• Il riquadro applicazione raggruppa tutti gli elementi dell’area di lavoro in una singola finestra integrata che può 

essere utilizzata come una singola unità. Quando spostate o ridimensionate il riquadro applicazione o uno dei suoi 

elementi, tutti gli altri elementi al suo interno vengono regolati di conseguenza in modo da evitare sovrapposizioni. 

I pannelli non spariscono quando cambiate applicazione o se fate clic al di fuori dell’applicazione. Se usate più di 

un’applicazione, potete affiancarle sullo schermo o su più schermi. 

Se utilizzate Mac e preferite invece l’interfaccia libera classica, potete disattivare la funzione del riquadro 

applicazione. In Adobe Illustrator®, ad esempio, selezionate Finestra > Riquadro applicazione per attivarlo o 

disattivarlo. (In Flash, il riquadro applicazione è sempre attivo per Mac, mentre Dreamweaver per Mac non utilizza 

un riquadro applicazione.)

Nascondere o mostrare tutti i pannelli

• (Illustrator, Adobe InCopy®, Adobe InDesign®, Photoshop, Fireworks) Per nascondere o mostrare tutti i pannelli, 

compresi i pannelli Strumenti e Controllo, premete Tab.

• (Illustrator, InCopy, InDesign, Photoshop) Per nascondere o mostrare tutti i pannelli eccetto i pannelli Strumenti 

e Controllo, premete Maiusc+Tab.

Se nelle preferenze Interfaccia è selezionata l’opzione Mostra automaticamente pannelli nascosti, potete 

visualizzare temporaneamente i pannelli nascosti. In Illustrator questa opzione è sempre attiva. Portate il 

puntatore al bordo della finestra dell’applicazione (Windows®) o dello schermo (Mac OS®) e passate il mouse sulla 

fascetta che compare. 

• (Flash, Dreamweaver, Fireworks) Per nascondere o mostrare tutti i pannelli, premete F4.

Visualizzare le opzioni dei pannelli 

❖ Fate clic sull’icona del menu del pannello  nell’angolo superiore destro del pannello.

Potete aprire il menu di un pannello anche se questo è ridotto a icona.

In Photoshop, potete modificare la dimensione dei caratteri del testo dei pannelli e delle descrizioni dei comandi. 

Scegliete una dimensione dal menu Dimensione font interfaccia nelle preferenze di Interfaccia.

(Illustrator) Regolare la luminosità dei pannelli

❖  Spostate il cursore Luminosità nelle preferenze di Interfaccia utente. Questo comando agisce su tutti i pannelli, 

compreso il pannello Controllo.

Riconfigurare il pannello Strumenti

Potete visualizzare le voci nel pannello Strumenti disponendole in una singola colonna o l’una accanto all’altra, su due 

colonne. Questa funzione non è disponibile nel pannello Strumenti di Fireworks e Flash.

In InDesign e InCopy potete anche scegliere tra una visualizzazione a colonna singola, a due colonne o a riga singola, 

impostando un’opzione nelle preferenze Interfaccia.

❖  Fate clic sulla doppia freccia nella parte superiore del pannello Strumenti.
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Gestire le finestre e i pannelli

Per personalizzare l’area di lavoro, potete spostare e manipolare le finestre di documento e i pannelli. Potete inoltre 

salvare aree di lavoro personalizzate e passare dall’una all’altra. In Fireworks, rinominare le aree di lavoro 

personalizzate può portare a comportamenti inattesi. 

Nota: nei seguenti esempi viene utilizzato Photoshop solo a scopo esemplificativo. L’area di lavoro funziona allo stesso 

modo in tutti i prodotti.

Ridisporre, agganciare o rendere mobili le finestre dei documenti

Quando sono aperti più file, le finestre documento sono presentate sotto forma di schede. 

• Per modificare l’ordine delle schede, trascinate la scheda di un documento fino alla posizione desiderata nel gruppo 

di schede.

• Per disancorare (rendere mobile o sganciare le schede) una finestra documento dal gruppo di finestre, trascinatela 

fuori dal gruppo.

Nota: in Photoshop potete scegliere Finestra > Ordina > Finestra mobile per rendere mobile una sola finestra 

documento, oppure Finestra > Ordina > Tutte in finestre mobili per rendere mobili tutte le finestre dei documenti 

insieme. Per ulteriori informazioni, consultate la nota tecnica kb405298.

Nota:  Dreamweaver non supporta l’ancoraggio/disancoraggio di finestre documento. Utilizzate il pulsante Riduci a 

icona della finestra documento per creare finestre mobili (Windows) oppure scegliete Finestra > Affianca in verticale 

per creare finestre di documenti affiancate. Per ulteriori informazioni su questo argomento, consultate "Affianca in 

verticale" nella Guida in linea di Dreamweaver. Il flusso di lavoro per gli utenti Macintosh è leggermente diverso.

• Per ancorare una finestra documento in un altro gruppo di finestre, trascinatela fino al nuovo gruppo.

• Per creare gruppi di documenti a schede o affiancati, trascinate una finestra fino a una delle zone di rilascio lungo 

il bordo superiore, inferiore o laterale di un’altra finestra. Potete inoltre selezionare una disposizione per il gruppo 

di finestre mediante il pulsante per la disposizione dei documenti nella barra dell’applicazione.

Nota:  alcuni prodotti non supportano questa funzione. In questo caso, il menu Finestra del prodotto potrebbe 

presentare i comandi Sovrapponi o Affianca che facilitano la disposizione dei documenti.

• Per passare a un altro documento in un gruppo a schede mentre trascinate una selezione, trascinatela per un 

momento sulla scheda del documento desiderato.

Nota:  alcuni prodotti non supportano questa funzione.

Ancorare e disancorare i pannelli

Per ancoraggio si intende un set di pannelli o gruppi di pannelli visualizzati insieme, generalmente con un 

orientamento verticale. Potete ancorare o disancorare i pannelli spostandoli all’interno o all’esterno dell’ancoraggio.

• Per ancorare un pannello, trascinatelo dalla linguetta nell’ancoraggio, in alto, in basso o in mezzo ad altri pannelli. 

• Per ancorare un gruppo di pannelli, trascinatelo dalla barra del titolo (quella vuota sopra le linguette) 

nell’ancoraggio.

• Per rimuovere un pannello o un gruppo di pannelli, trascinatelo fuori dell’ancoraggio puntando il mouse sulla sua 

linguetta o barra del titolo. Potete trascinarlo in un altro ancoraggio o lasciarlo mobile.

http://kb2.adobe.com/cps/405/kb405298.html
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Pannello di navigazione trascinato in un nuovo ancoraggio, indicato da un’area blu verticale evidenziata

Pannello di navigazione nell’ancoraggio

Potete evitare che i pannelli occupino tutto lo spazio dedicato all’area di ancoraggio. Trascinate il bordo inferiore 

dell’area di ancoraggio verso l’alto, in modo che non tocchi più il bordo dell’area di lavoro.

Spostare i pannelli

Quando spostate i pannelli, vengono evidenziate le zone di rilascio blu in cui è possibile spostare il pannello. Ad 

esempio, potete spostare un pannello in alto o in basso in un ancoraggio trascinandolo nella zona di rilascio stretta e 

blu che si trova sopra o sotto un altro pannello. Se lo trascinate in un’area che non è una zona di rilascio, il pannello 

resta mobile nell’area di lavoro.

Nota: la posizione del mouse (anziché la posizione del pannello) attiva la zona di rilascio, pertanto se questa non è 

visibile, provate a trascinare il mouse nella posizione in cui questa dovrebbe trovarsi.

• Per spostare un pannello, trascinatelo dalla linguetta.

• Per spostare un gruppo di pannelli, trascinatene la barra del titolo.
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La zona di rilascio stretta e blu indica che il pannello Colore verrà ancorato sopra il gruppo di pannelli Livelli.
A. Barra del titolo  B. Tab  C. Zona di rilascio  

Tenete premuto Ctrl (Windows) o Comando (Mac OS) mentre spostate un pannello per evitare che venga ancorato. 

Premete Esc mentre spostate il pannello per annullare l’operazione.

Aggiungere e rimuovere i pannelli

Se rimuovete tutti i pannelli da un’area di ancoraggio, questa scompare. Per creare un’area di ancoraggio, portate i 

pannelli fino al bordo destro dell’area di lavoro, fino a visualizzare una zona di rilascio. 

• Per rimuovere un pannello, fate clic con il pulsante destro del mouse (Windows) o tenendo premuto il tasto Control 

(Mac OS) sulla sua linguetta e selezionate Chiudi; in alternativa, deselezionatelo nel menu Finestra.

• Per aggiungere un pannello, selezionatelo dal menu Finestra e ancoratelo dove desiderate.

Modificare i gruppi di pannelli

• Per spostare un pannello e inserirlo in un gruppo, trascinatene la linguetta fino alla zona di rilascio evidenziata nel 

gruppo. 

Aggiunta di un pannello a un gruppo di pannelli

• Per ridisporre i pannelli in un gruppo, trascinate la linguetta di un pannello fino alla nuova posizione desiderata 

all’interno del gruppo.

• Per rimuovere un pannello da un gruppo, così da renderlo mobile, trascinatelo dalla linguetta all’esterno del 

gruppo.

• Per spostare un gruppo, trascinatene la barra del titolo (l’area sopra le linguette).

Impilare i pannelli mobili

Se trascinate un pannello fino a un’area che non è una zona di rilascio, il pannello resta mobile nell’area di lavoro. Un 

pannello mobile può essere posizionato ovunque nell’area di lavoro. Potete impilare pannelli mobili o gruppi di 

pannelli in modo che si muovano come una singola unità se trascinate la barra del titolo superiore. 

A
B

C
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Pannelli mobili impilati

• Per impilare i pannelli mobili, trascinate un pannello dalla linguetta fino alla zona di rilascio nella parte inferiore di 

un altro pannello.

• Per cambiare l’ordine di disposizione a pila, trascinate un pannello in alto o in basso dalla linguetta.

Nota: rilasciate la linguetta sopra la zona di rilascio stretta che si trova tra i pannelli, invece che su quella più larga 

nella barra del titolo.

• Per rimuovere un pannello o un gruppo di pannelli dalla disposizione a pila, in modo che diventi mobile, 

trascinatelo fuori afferrandone la linguetta o la barra del titolo.

Ridimensionare i pannelli

• Per ridurre o espandere un pannello, gruppo di pannelli o una pila di pannelli mobili, fate doppio clic su una scheda. 

In alternativa, fate doppio clic sull’area delle linguette (nello spazio vuoto accanto alle linguette).

• Per ridimensionare un pannello, trascinatene un bordo. Alcuni pannelli, come il pannello Controllo di Photoshop, 

non possono essere ridimensionati mediante trascinamento.

Ridurre a icona ed espandere i pannelli

Per limitare il numero di elementi visualizzati nell’area di lavoro, conviene ridurre i pannelli a icona. In alcuni casi i 

pannelli sono ridotti a icona nell’area di lavoro predefinita. 

Pannelli ridotti a icona
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Pannelli espansi

• Per ridurre a icona o espandere tutti i pannelli di una colonna, fate clic sulla doppia freccia nella parte superiore 

dell’ancoraggio. 

• Fate clic sull’icona di un singolo pannello per espanderlo. 

• Per ridimensionare le icone dei pannelli in modo da visualizzare solo le icone (senza etichette di testo), regolate la 

larghezza dell’ancoraggio fino a far scomparire il testo. Per visualizzare nuovamente il testo delle icone, allargate 

l’ancoraggio.

• Per ridurre di nuovo a icona un pannello espanso, fate clic sulla linguetta, sull’icona o sulla doppia freccia nella 

barra del titolo del pannello.

In alcuni prodotti, se selezionate Riduzione automatica pannelli icone nelle preferenze Interfaccia o Opzioni 

interfaccia utente, l’icona di un pannello espanso si riduce automaticamente a icona quando fate clic lontano 

dall’icona.

• Per aggiungere un pannello o un gruppo di pannelli mobili a un ancoraggio di icone, trascinatene la linguetta o la 

barra del titolo. I pannelli aggiunti a un ancoraggio di icone vengono ridotti automaticamente a icona.

• Per spostare l’icona di un pannello (o un gruppo di icone di pannelli), trascinatela. Potete trascinare le icone dei 

pannelli in alto o in basso nell’ancoraggio, all’interno di altri ancoraggi (dove compaiono nello stile dei pannelli di 

quell’ancoraggio) o all’esterno dell’ancoraggio (dove compaiono come icone mobili).

Utilizzo di ConnectNow

Adobe® ConnectNow vi fornisce un luogo di incontro online sicuro e personalizzato che potete utilizzare per riunioni 

e collaborare con altri utenti via Web in tempo reale. Con ConnectNow, potete condividere e annotare lo schermo del 

computer, inviare messaggi tramite chat e comunicare grazie all’audio integrato. Inoltre potete trasmettere un video 

live, condividere file e acquisire note sulla riunione, nonché controllare il computer di un partecipante.

Potete accedere a ConnectNow direttamente dall’interfaccia dell’applicazione.

1 Scegliete File > Condividi schermo.

2 Nella finestra di dialogo Accedi ad Adobe CS Live, inserite l’indirizzo e-mail e la password, quindi fate clic su 

Accesso. Se non disponete di un ID Adobe, fate clic sul pulsante Crea ID Adobe.

3 Per condividere lo schermo, fate clic sul pulsante Condividi schermo al centro della finestra dell’applicazione 

ConnectNow.

Per istruzioni complete sull’uso di ConnectNow, visitate 

http://help.adobe.com/en_US/Acrobat.com/ConnectNow/index.html.

Per un’esercitazione video sull’utilizzo di ConnectNow, vedete Using ConnectNow to share your screen (7:12) 

(Utilizzo di ConnectNow per condividere lo schermo). (Questa dimostrazione è disponibile in Dreamweaver.)

http://help.adobe.com/en_US/Acrobat.com/ConnectNow/index.html
http://tv.adobe.com/#vi+f1590v1002
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Salvare e cambiare area di lavoro

Salvate le dimensioni attuali e la disposizione dei pannelli assegnando un nome all’area di lavoro, così da ripristinarla 

anche se spostate o chiudete un pannello. I nomi delle aree di lavoro salvate sono elencate nel controllo per 

l’impostazione dell’area di lavoro, nella barra dell’applicazione.

Salvare un’area di lavoro personalizzata

1 Quando l’area di lavoro è nella configurazione che desiderate salvare, effettuate una delle seguenti operazioni: 

• (Illustrator) Scegliete Finestra > Area di lavoro > Salva area di lavoro.

• (Photoshop, InDesign, InCopy) Scegliete Finestra > Area di lavoro > Nuova area di lavoro.

• (Dreamweaver) Scegliete Finestra > Layout area di lavoro > Nuova area di lavoro.

• (Flash) Scegliete Nuova area di lavoro dal controllo per l’impostazione dell’area di lavoro, nella barra 

dell’applicazione.

• (Fireworks) Scegliete Salva attuale dal controllo per l’impostazione dell’area di lavoro, nella barra 

dell’applicazione.

2 Immettete un nome per l’area di lavoro.

3 (Photoshop, InDesign) In Acquisisci, selezionate una o più opzioni:

Posizioni pannelli Salva le posizioni correnti dei pannelli (solo InDesign).

Scelte rapide da tastiera Salva il set corrente di scelte rapide da tastiera (solo Photoshop).

Menu o Personalizzazione menu Salva il set corrente di menu.

Visualizzare o cambiare area di lavoro

❖ Selezionate un’area di lavoro dal controllo per l’impostazione dell’area di lavoro, nella barra dell’applicazione.

In Photoshop, potete assegnare scelte rapide da tastiera a ciascuna area di lavoro per selezionarle più rapidamente. 

Eliminare un’area di lavoro personalizzata

• Selezionate Gestisci area di lavoro dal controllo per l’impostazione dell’area di lavoro, nella barra dell’applicazione, 

quindi fate clic su Elimina. Questa funzione non è disponibile in Fireworks.

• (Photoshop, InDesign, InCopy) Selezionate Elimina area di lavoro dal controllo per l’impostazione dell’area di 

lavoro, nella barra dell’applicazione. 

• (Illustrator) Scegliete Finestra > Area di lavoro > Gestisci aree di lavoro, selezionate l’area di lavoro e fate clic 

sull’icona Cestino.

• (Photoshop, InDesign) Scegliete Finestra > Area di lavoro > Elimina area di lavoro, selezionate l’area di lavoro e fate 

clic su Elimina.

Ripristinare le aree di lavoro predefinite

1 Selezionate l’area di lavoro Default o Essenziali dal commutatore area di lavoro nella barra dell’applicazione. Per 

Fireworks, consultate l´articolo 

http://www.adobe.com/devnet/fireworks/articles/workspace_manager_panel.html. 

Nota: in Dreamweaver, Designer è l’area di lavoro predefinita.

2 Per Fireworks (Windows), eliminate queste cartelle:

Windows Vista \\Utenti\<nome utente>\AppData\Roaming\Adobe\Fireworks CS4\ 

http://www.adobe.com/devnet/fireworks/articles/workspace_manager_panel.html
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Windows XP \\Documents and Settings\<nome utente>\Application Data\Adobe\Fireworks CS4 

3 (Photoshop, InDesign, InCopy) Scegliete Finestra > Area di lavoro > Ripristina [nome area di lavoro].

(Photoshop) Ripristinare una disposizione dell’area di lavoro salvata

In Photoshop, le aree di lavoro appaiono nelle stesse posizioni in cui le avete utilizzate l’ultima volta, ma potete 

ripristinare le posizioni predefinite originali dei pannelli.

• Per ripristinare una singola area di lavoro, scegliete Finestra > Area di lavoro > Ripristina nome dell'area di lavoro.

• Per ripristinare tutte le aree di lavoro installate con Photoshop, fate clic su Ripristina aree di lavoro predefinite nelle 

preferenze Interfaccia.

Per modificare l’ordine delle aree di lavoro nella barra dell’applicazione, trascinatele.

Pannello Strumenti

Il pannello Strumenti è organizzato in sei categorie: Seleziona, Bitmap, Vettore, Web, Colori e Visualizza. Quando si 

sceglie uno strumento, la finestra di ispezione Proprietà visualizza le opzioni corrispondenti. 
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Visualizzare le opzioni dello strumento nella finestra di ispezione Proprietà

❖ Con uno strumento selezionato, scegliere Seleziona > Deseleziona per deselezionare tutti gli oggetti sull’area di 

lavoro.

Selezionare uno strumento da un gruppo di strumenti

Un piccolo triangolo nell’angolo inferiore destro di uno strumento del pannello Strumenti indica che esso fa parte di 

un gruppo di strumenti.

1 Fare clic sull’icona dello strumento e tenere premuto il pulsante del mouse. 

2 Trascinare il puntatore per evidenziare lo strumento desiderato e rilasciare il pulsante del mouse. 

Per selezionare rapidamente uno strumento nascosto, premere più volte il tasto di scelta rapida del gruppo fino a 

visualizzare lo strumento desiderato. Le scelte rapide sono visualizzate tra parentesi accanto ai nomi degli strumenti.

finestra di ispezione Proprietà

La finestra di ispezione Proprietà è un pannello sensibile al contesto che visualizza le proprietà della selezione corrente, 

le opzioni dello strumento corrente o le proprietà del documento. Per impostazione predefinita, è agganciata nella 

parte inferiore dello spazio di lavoro.

La finestra di ispezione Proprietà può essere aperta a metà altezza, visualizzando solo due righe di proprietà, o ad 

altezza completa, visualizzando quattro righe. È possibile inoltre comprimere completamente la finestra di ispezione 

Proprietà pur lasciandola nello spazio di lavoro.

Nota: in ambiente Windows, il menu Opzioni è disponibile solo se la finestra di ispezione Proprietà è agganciata.

Sganciare la finestra di ispezione Proprietà

❖ Trascinare la scheda del pannello in un’altra parte dell’area di lavoro.

Agganciare la finestra di ispezione Proprietà nella parte inferiore dell’area di lavoro

❖ Trascinare la scheda del pannello fino alla parte inferiore della schermata.



25UTILIZZO DI FIREWORKS

Area di lavoro

Ultimo aggiornamento 4/5/2011

Espandere o comprimere la finestra di ispezione Proprietà

❖ Effettuare una delle seguenti operazioni:

• Fare doppio clic sulla scheda del pannello.

• Fare clic sulla freccia nell’angolo superiore sinistro del pannello.

Visualizzare e spostare le barre degli strumenti (solo Windows)

Visualizzare o nascondere una barra degli strumenti

❖ Scegliere Finestra > Barre degli strumenti e selezionare una delle seguenti opzioni:

Principale Visualizza una barra degli strumenti sopra la finestra del documento con pulsanti per i comandi di file 

comuni, quali Apri, Salva, Stampa e Copia.

Elabora Visualizza una barra degli strumenti sotto la finestra del documento con pulsanti per raggruppare, 

disporre, allineare e ruotare gli oggetti.

Sganciare una barra degli strumenti 

❖ Trascinare la barra degli strumenti allontanandola dalla sua posizione di aggancio.

Agganciare una barra degli strumenti (solo Windows)

❖ Trascinare la barra degli strumenti su un’area di aggancio nella parte superiore della finestra dell’applicazione 

finché non compare il rettangolo di anteprima del posizionamento.

Bloccare le modifiche durante l’operazione di salvataggio

Se si modifica un documento nel corso di un’operazione di salvataggio, Fireworks si blocca. Se impostate il parametro 

AsynchronousSave su true nel file preferences.txt, Fireworks impedisce di apportare modifiche al file fino al 

completamento dell’operazione di salvataggio. È possibile, tuttavia, continuare a lavorare su altri documenti Fireworks 

aperti.

Gli oggetti che vengono aggiornati durante l'operazione di salvataggio non lo sono in modalità AsynchronousSave. 

Impostate AsynchronousSave=false nel file preferences.txt quando utilizzate tali oggetti. Ad esempio, la forma 

automatica Save Time Stamp non viene aggiornata quando AsynchronousSave=True. 

Per impostazione predefinita, l’opzione asincrona è impostata su true per Windows, e su false per Mac.

1 Individuate il file preferences.txt. In Windows, il file si trova nel percorso \\<nome utente>\Application 

Data\Adobe\Fireworks CS5\English\Fireworks CS5 Preferences. In Mac OS, il file si trova nel percorso 

/<nome utente>/Library/Preferences/Adobe Fireworks CS5/en/Fireworks CS5 Preferences.

2 Impostare il parametro AsynchronousSave = true all’interno del file.

3 Salvare il file.
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Individuare e visualizzare i documenti

Usare le schede dei documenti per selezionare i documenti

Quando il documento è ingrandito, spostarsi tra più documenti aperti mediante le schede dei documenti visualizzate 

nella parte superiore della finestra del documento. Il nome file di ogni documento aperto è riportato nella relativa 

scheda, sopra i pulsanti di visualizzazione. Quando spostate il mouse sulla scheda, la posizione del file viene 

visualizzata come una descrizione comando.

Panoramica, ingrandimento e riduzione 

A. Strumento Mano  B. Strumento Zoom  C. Menu a comparsa Imposta ingrandimento  

Ingrandire la vista per incrementi predefiniti

❖ Effettuare una delle seguenti operazioni:

• Selezionare lo strumento Zoom e fare clic nella finestra del documento per definire il nuovo punto centrale. A 

ogni clic l’immagine viene ingrandita alla successiva percentuale preimpostata.

• Selezionare un’impostazione di zoom dal menu a comparsa Imposta ingrandimento, nella parte inferiore della 

finestra del documento.

A CB
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• Selezionare Ingrandisci o una percentuale di ingrandimento preimpostata dal menu Visualizza.

Ridurre la vista per incrementi predefiniti

❖ Effettuare una delle seguenti operazioni:

• Selezionare lo strumento Zoom e fare clic nella finestra del documento tenendo premuto il tasto Alt (Windows) 

o Opzione (Mac OS). A ogni clic la vista viene ridotta alla successiva percentuale preimpostata.

• Selezionare un’impostazione di zoom dal menu a comparsa Imposta ingrandimento, nella parte inferiore della 

finestra del documento. 

• Selezionare Riduci o una percentuale di ingrandimento preimpostata dal menu Visualizza.

Ingrandire un’area specifica 

1 Selezionare lo strumento Zoom.

2 Trascinare il mouse sulla parte dell’immagine da ingrandire.

Le dimensioni della casella di selezione dello zoom definiscono la percentuale di ingrandimento precisa, 

visualizzata nella casella Imposta ingrandimento.

Nota: non è possibile immettere una percentuale di ingrandimento nella casella Imposta ingrandimento.

Ridurre l’ingrandimento di un’area specifica

❖ Tenere premuto il tasto Alt (Windows) o Opzione (Mac OS) e trascinare un’area di selezione con lo strumento Zoom.

Tornare all’ingrandimento 100%

❖ Fare doppio clic sullo strumento Zoom nel pannello Strumenti.

Spostare l’area visibile di un documento 

1 Selezionare lo strumento Mano. 

2 Trascinare il cursore Mano.

Mentre si sposta l’area visibile oltre il bordo dell’area di lavoro, la vista si sposta ed è possibile continuare a lavorare 

sui pixel che si trovano lungo il bordo dell’area di lavoro.

Adattare il documento alla vista corrente

❖ Fate doppio clic sullo strumento Mano nel pannello Strumenti.

Gestire lo spazio di lavoro con le modalità di visualizzazione

Nel pannello Strumenti, selezionare un’opzione da una delle tre modalità di visualizzazione per controllare il layout 

dell’area di lavoro. 

 Modalità Schermo standard Vista predefinita della finestra del documento. 

 Modalità a tutto schermo con menu Finestra del documento ingrandita su sfondo grigio. I menu, le barre degli 

strumenti, le barre di scorrimento e i pannelli sono visibili. 

 Modalità a tutto schermo Finestra del documento ingrandita su sfondo nero. I menu, le barre degli strumenti o le 

barre dei titoli non sono visibili. 

Per ulteriori informazioni, vedere l’articolo sul sito web Fireworkszone.

http://www.fireworkszone.com/page-2-4-0-490.html
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Visualizzare più viste di un documento

Usare più viste per vedere un documento a più ingrandimenti differenti nello stesso tempo. Le modifiche apportate in 

una vista appariranno automaticamente in tutte le altre viste dello stesso documento. 

1 Selezionare Finestra > Duplica finestra.

2 Selezionare un’impostazione di zoom per la nuova finestra.

Visualizzare i documenti come appaiono su piattaforme diverse

Per importazione predefinita, Windows e Mac OSX Snow Leopard versione 10.6 utilizzano una gamma dello schermo 

di 2.2 per i propri monitor. Macintosh (precedente a Snow Leopard) utilizza un valore gamma di 1.8.

❖ Effettuate una delle seguenti operazioni:

• In Windows, selezionate Visualizza > Gamma 1.8 per visualizzare il documento come su un computer 

Macintosh (precedente a Snow Leopard).

• In Macintosh®, selezionate Visualizza > Gamma 1.8 per visualizzare il documento come su un Mac (precedente 

a Snow Leopard).

Modificare l’area di lavoro

È possibile regolare l’area di lavoro in qualsiasi momento.

Modificare le dimensioni dell’area di lavoro

1 Effettuare una delle seguenti operazioni:

• Selezionare Elabora > Area di lavoro > Dimensioni area di lavoro.

• Scegliere Seleziona > Deseleziona, fare clic sullo strumento Puntatore per visualizzare le proprietà del 

documento nella finestra di ispezione Proprietà, quindi fare clic sul pulsante Dimensioni area di lavoro. 

2 Immettere le nuove dimensioni nelle caselle di testo Larghezza e Altezza.

3 Fare clic su un pulsante Aggancio per specificare quali lati dell’area di lavoro di Fireworks aggiungere o eliminare, 

quindi fare clic su OK.

Nota: per impostazione predefinita, l’aggancio centrale è selezionato, le modifiche alle dimensioni dell’area di lavoro 

vengono perciò effettuate su tutti i lati.

Modificare il colore dell’area di lavoro 

❖ Effettuare una delle seguenti operazioni:

• Selezionare Elabora > Area di lavoro > Colore area di lavoro, quindi selezionare un’opzione di colore. Per un 

colore personalizzato, fare clic su un colore nella finestra a comparsa Campioni colore.

• Nella finestra di ispezione Proprietà, scegliere Seleziona > Deseleziona, fare clic sullo strumento Puntatore per 

visualizzare le proprietà del documento, quindi fare clic sulla casella Colore area di lavoro. Selezionare un colore 

nella finestra a comparsa Campioni colore o fare clic con il contagocce su uno dei colori. Per selezionare un’area 

di lavoro trasparente, fare clic sul pulsante Trasparente nella finestra a comparsa Campioni colore.

Per modificare il colore predefinito dell’area di lavoro, fare clic su Personalizza campione colore nella finestra 

di dialogo Nuovo documento. Consultare “Creazione di un nuovo documento Fireworks” a pagina 4.
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Ridimensionare un documento e il relativo contenuto

1 Effettuare una delle seguenti operazioni:

• Scegliere Seleziona > Deseleziona, fare clic sullo strumento Puntatore per visualizzare le proprietà del 

documento nella finestra di ispezione Proprietà, quindi fare clic sul pulsante Dimensioni immagine nella 

finestra di ispezione Proprietà. 

• Selezionare Elabora > Area di lavoro > Dimensioni immagine.

Si aprirà la finestra di dialogo Dimensioni immagine.

2 Nelle caselle di testo Dimensioni in pixel, immettere le nuove dimensioni orizzontale e verticale per l’immagine. 

(Facoltativo) Modificare le unità di misura. Se l’opzione Ridefinisci immagine non è selezionata, potranno essere 

modificate solo la risoluzione o le dimensioni di stampa, ma non le dimensioni in pixel.

3 Immettere i valori nelle caselle di testo Dimensioni di stampa per impostare le nuove dimensioni orizzontali e 

verticali dell’immagine stampata. 

4 Immettere i nuovi valori per la risoluzione dell’immagine nella casella Risoluzione. 

La modifica della risoluzione cambia le dimensioni dei pixel.

5 Effettuare una delle seguenti operazioni:

• Per mantenere lo stesso rapporto tra le dimensioni orizzontale e verticale del documento, selezionare Vincola 

proporzioni. 

• Per ridimensionare l’ampiezza e l’altezza separatamente, deselezionare Vincola proporzioni. 

6 Per aggiungere o rimuovere pixel durante il ridimensionamento in modo che l’immagine conservi 

approssimativamente lo stesso aspetto con dimensioni differenti, selezionare Ridefinisci immagine. 

7 Selezionare Solo pagina corrente per applicare la modifica delle dimensioni dell’area di lavoro solo alla pagina 

corrente. 

La ridefinizione delle immagini

Fireworks ridefinisce (ridimensiona o ricampiona) le immagini in modo differente dalla maggior parte delle 

applicazioni di modifica delle immagini. 

• Durante la ridefinizione di un oggetto bitmap, è necessario aggiungere o eliminare pixel per ingrandire o ridurre 

l’immagine.

• Durante la ridefinizione di un vettore, si verifica solo una ridotta perdita di qualità, in quanto il tracciato viene 

ridisegnato matematicamente nelle dimensioni maggiori o inferiori.

Poiché gli attributi di oggetti vettoriali in Fireworks sono visibili come pixel, alcuni tratti o riempimenti potrebbero 

apparire diversi dopo la ridefinizione. Ciò si verifica perché i pixel che compongono i tratti o il riempimento 

devono essere ridisegnati.

Nota: durante la modifica delle dimensioni dell’immagine, le guide, gli oggetti punto attivo e gli oggetti porzione 

vengono anch’essi ridimensionati.

È possibile modificare le dimensioni di un’immagine bitmap regolando la risoluzione o ridefinendo l’immagine. 

• Quando si regola la risoluzione, si modificano le dimensioni dei pixel nell’immagine in modo che in un dato spazio 

possa essere contenuto un numero maggiore o minore di pixel. Se si regola la risoluzione senza ridefinizione non 

si verifica alcuna perdita di dati.
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• Durante la ridefinizione, i pixel vengono aggiunti o rimossi:

Ridefinizione verso l’altro Aggiunge pixel per ingrandire l’immagine. Questo metodo può ridurre la qualità in 

quanto i pixel aggiunti non sempre corrispondono all’immagine originale.

Ridefinizione verso il basso Rimuove dei pixel per ridurre l’immagine e potrebbe comportare una perdita di dati. 

Questo metodo produce sempre una perdita della qualità in quanto i pixel vengono scartati per ridimensionare 

l’immagine. 

Ruotare l’area di lavoro

Quando l’immagine importata risulta capovolta o di lato, è possibile ruotare l’area di lavoro. L’ area di lavoro può 

essere ruotata di 180°, 90° in senso orario o 90° in senso antiorario. Durante la rotazione dell’area di lavoro, vengono 

ruotati anche tutti gli oggetti presenti nel documento.

❖ Selezionare Elabora > Area di lavoro > e scegliere un’opzione di rotazione. 

Ritagliare o adattare l’area di lavoro

L’area di lavoro può essere espansa o ritagliata in base agli oggetti che contiene.

Area di lavoro originale (a sinistra); area di lavoro ritagliata (a destra)

1 Per visualizzare le proprietà del documento nella finestra di ispezione Proprietà, scegliere Seleziona > Deseleziona.

2 Fare clic su Adatta area di lavoro nella finestra di ispezione Proprietà.

Ritagliare un documento

Il ritaglio consente di eliminare le porzioni non desiderate di un documento. L’area di lavoro si ridimensiona in base 

all’area definita dall’utente.

Per impostazione predefinita, il ritaglio consente di eliminare gli oggetti che si estendono oltre i margini dell’area di 

lavoro. Per conservare gli oggetti all’esterno dell’area di lavoro, occorre modificare una preferenza prima del ritaglio.

1 Selezionare lo strumento Ritaglio  nel pannello Strumenti o selezionare Modifica > Ritaglia documento.

2 Trascinare una casella di delimitazione nell’area di lavoro. Regolare le maniglie di ritaglio fino a quando la casella 

di delimitazione non circonda l’area da conservare.

3 Fare doppio clic all’interno della casella di delimitazione o premere Invio per ritagliare il documento.

L’area di lavoro si ridimensiona in base all’area definita e gli oggetti oltre i bordi dell’area di lavoro vengono 

eliminati.
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Per conservare gli oggetti esterni all’area di lavoro, deselezionare Elimina oggetti durante ritaglio nella scheda 

Modifica della finestra di dialogo Preferenze prima del ritaglio. 

Usare i righelli, le guide e la griglia 

Righelli, guide e griglia rappresentano un valido aiuto per posizionare e allineare oggetti quando si disegna. Le guide 

sono linee trascinate dai righelli all’area di lavoro del documento. È possibile utilizzare le guide per segnare parti 

importanti del documento, quali i margini e il punto centrale del documento. La griglia consente di visualizzare un 

reticolo di linee orizzontali e verticali sull’area di lavoro per un posizionamento preciso. Le guide e le griglie non 

risiedono su un livello e non vengono esportate con il documento.

Per lavorare facilmente con le guide, è possibile utilizzare le seguenti estensioni Fireworks: 

Estensione Pannello guida Se si installa questa estensione, nell’area di lavoro, viene visualizzato un pannello Guida, 

che consente di manipolare le guide all’interno del documento e di esportare o importare le guide da un set di guide 

precedentemente salvato. Questa estensione è disponibile all'indirizzo 

http://www.adobe.com/go/learn_fw_usingguidespanel_it.

Estensione Copia-incolla guida Questa estensione consente di copiare le guide da una pagina e incollarle su un’altra 

all’interno dello stesso documento. Questa estensione è pratica se il documento di Fireworks ha più pagine che 

necessitano di guide simili. Questa estensione è disponibile all'indirizzo 

http://www.adobe.com/go/learn_fw_copypasteguides_it.

Estensione Eredita guida Questa estensione consente di copiare le guide dalla pagina master o della pagina corrente e 

di applicarle a tutte le pagine del documento. Questa estensione è disponibile all'indirizzo 

http://www.adobe.com/go/learn_fw_inheritguides_it.

http://www.adobe.com/go/learn_fw_usingguidespanel_it
http://www.adobe.com/go/learn_fw_copypasteguides_it
http://www.adobe.com/go/learn_fw_inheritguides_it
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Per modificare le dimensioni della griglia o il colore delle guide e della griglia, consultare “Preferenze Guide e griglie” 

a pagina 306.

Mostrare e nascondere i righelli

❖ Selezionare Visualizza > Righelli.

Lungo i margini della finestra del documento appaiono i righelli verticali e orizzontali. I righelli usano i pixel come 

unità di misura.

Creare una guida orizzontale o verticale

1 Fare clic e trascinare dal righello corrispondente.

2 Posizionare la guida sull’area di lavoro e rilasciare il pulsante del mouse.

Nota: per riposizionare la guida è possibile trascinarla nuovamente.

Spostare una guida in una posizione specifica

1 Fare doppio clic sulla guida.

2 Immettere la nuova posizione nella finestra di dialogo Sposta guida e fare clic su OK.

Mostrare o nascondere le guide o la griglia

❖ Selezionare Visualizza > Guide > Mostra Guide o Visualizza > Griglia > Mostra griglia.

La selezione viene applicata a tutti i documenti aperti in Fireworks.
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Agganciare oggetti alle guide o alla griglia

❖ Selezionare Visualizza > Guide > Aggancia alle guide o Visualizza > Griglia > Aggancia alla griglia.

La selezione viene applicata a tutti i documenti aperti in Fireworks.

Bloccare o sbloccare tutte le guide

❖ Selezionare Visualizza > Guide > Blocca guide.

La selezione viene applicata a tutti i documenti aperti in Fireworks. 

Rimuovere una guida

❖ Trascinare la guida all’esterno dell’area di lavoro.

Visualizzare la distanza tra le guide

❖ Quando il puntatore si trova tra le guide, premere Maiusc.

Per visualizzare la distanza tra le guide, premere Maiusc mentre si trascinano le guide nell’area di lavoro.

Guide sensibili

Le Guide sensibili sono guide di aggancio temporanee che consentono di creare, allineare, modificare e trasformare 

oggetti relativi ad altri oggetti. Per attivare le Guide sensibili, scegliere Visualizza > Guide sensibili, quindi selezionare 

Mostra guide sensibili e Aggancia a guide sensibili.

È possibile utilizzare le guide sensibili nei modi seguenti:

• Quando si crea un oggetto, usare le guide sensibili per posizionarlo in relazione agli oggetti esistenti. Gli strumenti 

linea, rettangolo, ellisse, poligono e forma automatica visualizzano guide sensibili, così come gli strumenti porzione 

rettangolare e circolare.

• Quando si sposta un oggetto, usare le guide sensibili per allinearlo ad altri oggetti.

• Quando si trasforma un oggetto, le guide sensibili vengono visualizzate automaticamente. 

Per modificare i tempi e le modalità di visualizzazione delle guide sensibili, impostare le relative preferenze. 

Consultare “Preferenze Guide e griglie” a pagina 306.

Anteprima nel browser

Selezionate File > Anteprima nel browser e scegliete una delle opzioni.

Anteprima di tutte le pagine nel <browser principale> Ctrl+F12/Cmd+Maiusc+F12 Potete visualizzare l'anteprima 

dell'interazione tra tutte le pagine se queste sono collegate tra loro.

Anteprima nel <browser principale> F12 Consente di visualizzare l'anteprima del documento Fireworks attivo nel 

browser principale. Se nel computer è installato un solo browser, questo viene utilizzato come browser principale. Se 

sono installati più browser, potete selezionare un browser principale per la visualizzazione dei documenti Fireworks 

utilizzando File > Anteprima nel browser > Imposta browser primario.

Anteprima in Maiusc/Cmd+F12 Consente di visualizzare l'anteprima del documento Fireworks attivo nel browser 

secondario. Prima di utilizzare questa opzione, impostate il browser secondario utilizzando File > Anteprima in 

browser > Imposta browser secondario. Individuare e selezionare il file EXE/app del browser secondario.
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Annullare e ripetere più azioni 

Il pannello Cronologia elenca le operazioni più recenti eseguite durante la sessione di lavoro in Fireworks. È possibile 

specificare il numero di passaggi nel campo Livelli annullamento nella finestra di dialogo Preferenze di Fireworks. 

Annullare e ripetere le azioni

1 Selezionare Finestra > Cronologia per aprire il pannello Cronologia.

2 Trascinare il marcatore Annulla in alto o in basso.

Ripetere le azioni

1 Eseguire le azioni.

2 Nel pannello Cronologia, effettuare una delle seguenti operazioni per evidenziare le azioni da ripetere:

• Fare clic su un’azione per evidenziarla.

• Fare clic tenendo premuto il tasto Ctrl (Windows) o Comando (Mac OS) per evidenziare più azioni singole.

• Fare clic tenendo premuto Maiusc per evidenziare un intervallo continuo di azioni.

3 Fare clic sul pulsante Riproduci di nuovo nella parte inferiore del pannello Cronologia.

Salvare le azioni per riutilizzarle 

1 Nel pannello Cronologia, evidenziare le azioni che si desidera salvare.

2 Fare clic sul pulsante Salva nella parte inferiore del pannello.

3 Inserire un nome di comando. 

Usare il comando personalizzato salvato

❖ Selezionare il nome del comando desiderato dal menu Comandi.

Ripristino file non salvati (solo Mac)

quando una sessione di Fireworks termina in modo anomalo, i file non salvati vengono salvati sul desktop. Al 

successivo riavvio di Fireworks, viene visualizzato un messaggio che informa della presenza di una cartella sul desktop 

contenente i file salvati. Per impostazione predefinita, i file vengono salvati nel percorso Desktop\Fireworks 

Recuperati\<indicazione data e ora>.

I file non salvati ai quali non è stato assegnato un nome vengono salvati secondo la convenzione Senza nome, Senza 

nome (1), Senza nome (2) e così via. I nomi dei file corrispondono ai nomi predefiniti generati da Fireworks durante 

la creazione dei file. I file non salvati ai quali è stato assegnato un nome vengono salvati con lo stesso nome. 

I file di ripristino non vengono generati nei seguenti casi:

• L’operazione di salvataggio ha generato un errore.

• La memoria è insufficiente per recuperare i file salvati.

• DisableSaveOnCrash nel file Adobe Fireworks CS5 Preferences è impostato su True.

• Il file aperto non è stato modificato, quando si è verificato il problema.
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Disabilitare la generazione dei file recuperati

1 Aprire il file Fireworks CS5 Preferences.txt nel percorso \Utenti\<nomeutente>\Library\ Preferences\Adobe 

Fireworks CS5\<locale>\.

2 Impostare il parametro DisableSaveOnCrash su True.

Modificare il percorso predefinito dei file recuperati

1 Aprire il file Fireworks CS5 Preferences.txt. Il file si trova nel percorso \Utenti\<nomeutente>\Library\ 

Preferences\Adobe Fireworks CS5\<locale>\.

2 Impostare il percorso tramite il parametro SaveOnCrashRecoveredFolderPath. Per definire la posizione è 

possibile utilizzare il percorso assoluto o il percorso relativo.
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Capitolo 4: Selezione e trasformazione di 
oggetti

Selezionare gli oggetti

Prima di eseguire qualsiasi operazione su un oggetto nell’area di lavoro, è necessario selezionarlo. Questo vale per 

oggetti vettoriali, tracciati, punti, blocchi di testo, parole o lettere, porzioni o punti attivi, istanze e oggetti bitmap. Per 

selezionare un oggetto, utilizzare il pannello Livelli o uno strumento di selezione.

Pannello Livelli Visualizza ogni oggetto. Se il pannello Livelli è aperto e i livelli espansi, è possibile fare clic su un 

oggetto per selezionarlo. 

Strumenti di selezione Ogni strumento svolge funzioni specifiche:

Selezionare gli oggetti mediante clic

❖ Effettuare una delle seguenti operazioni:

• Spostare il puntatore sul tracciato dell’oggetto o sulla casella di delimitazione e fare clic.

• Fare clic sul tratto o sul riempimento dell’oggetto.

• Selezionare l’oggetto nel pannello Livelli.

Per visualizzare in anteprima l’elemento selezionato facendo clic su un oggetto nell’area di lavoro, selezionare 

l’opzione Mouse evidenziato nella categoria Modifica della finestra di dialogo Preferenze.

Selezionare gli oggetti mediante trascinamento

❖ Trascinare lo strumento Puntatore su uno o più oggetti nell’area di selezione.

Lo strumento Puntatore consente di selezionare gli oggetti facendo clic su di essi oppure trascinando 

un’area di selezione attorno agli oggetti.

Lo strumento Sottoselezione consente di selezionare un singolo oggetto all’interno di un gruppo o i 

punti di un oggetto vettoriale.

Lo strumento Seleziona dietro consente di selezionare ciò che è collocato dietro a un altro oggetto.

Lo strumento Area di esportazione consente di selezionare un’area da esportare come file separato.
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Spostare o modificare oggetti con lo strumento Sottoselezione

Lo strumento Sottoselezione consente di selezionare, spostare o modificare punti di un tracciato vettoriale o di un 

oggetto che fa parte di un gruppo.

1 Selezionare lo strumento Sottoselezione.

2 Effettuare una selezione. 

3 Effettuare una delle seguenti operazioni:

• Per modificare un oggetto, trascinare uno dei suoi punti o le maniglie di selezione.

• Per spostare l’intero oggetto, trascinare in un punto qualunque dell’oggetto diverso dal punto o dalla maniglia 

di selezione. 

Selezionare un oggetto che si trova dietro ad altri oggetti

❖ Fare clic ripetutamente con lo strumento Seleziona dietro sugli oggetti impilati fino a selezionare l’oggetto 

desiderato, partendo da quello superiore.

Nota: è inoltre possibile selezionare un oggetto difficile da raggiungere facendo clic sulla miniatura nel pannello Livelli, 

quando i livelli sono espansi.

Informazioni sulla selezione nella finestra di ispezione Proprietà

Quando si seleziona un oggetto, la finestra di ispezione Proprietà identifica l’oggetto selezionato. L’area superiore 

sinistra della finestra ispezione Proprietà contiene una descrizione dell’elemento ispezionato e, se sono selezionati più 

oggetti, il numero degli oggetti selezionati. Nella finestra ispezione Proprietà è inoltre disponibile un riquadro che 

consente di inserire il nome assegnato agli oggetti selezionati.

Nota: il nome compare nella barra del titolo del documento ogni volta che quell’elemento viene selezionato. Per le 

porzioni e i pulsanti, il nome visualizzato è il nome del file esportato.

(Solo Windows) Se la barra di stato è attiva, gli oggetti selezionati sono identificati anche nella barra di stato in fondo 

alla finestra del documento. 

finestra di ispezione Proprietà

Modificare una selezione

Una volta selezionato un singolo oggetto, è possibile aggiungere oggetti alla selezione e deselezionare gli oggetti 

selezionati. È possibile selezionare o deselezionare tutti gli elementi su ogni livello all’interno di un documento con un 

unico comando. È inoltre possibile nascondere il tracciato di selezione: in questo modo, mentre si modifica un oggetto 

selezionato è possibile vedere come sarà una volta stampato o pubblicato sul Web. 

Aggiungere a una selezione

❖ Tenere premuto il tasto Maiusc mentre si fa clic sugli oggetti addizionali con lo strumento Puntatore, 

Sottoselezione o Seleziona dietro. 
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Deselezionare un oggetto lasciando gli altri selezionati

❖ Tenere premuto il tasto Maiusc mentre si fa clic sull’oggetto selezionato. 

Selezionare tutti gli elementi su ogni livello del documento

❖ Scegliere Seleziona > Seleziona tutto. 

Nota: Seleziona tutto non permette di selezionare gli oggetti nascosti.

Deselezionare tutti gli oggetti selezionati

❖ Scegliere Seleziona > Deseleziona.

Nota: per selezionare tutti gli oggetti visibili su tutti i livelli del documento, occorre deselezionare la preferenza Modifica 

livello singolo. Quando si seleziona l’opzione Modifica livello singolo, vengono selezionati solo gli oggetti presenti sul 

livello corrente. Per ulteriori informazioni, consultare “Organizzare i livelli” a pagina 137.

Nascondere il riscontro visivo della selezione del tracciato di un oggetto 

selezionato

❖ Selezionare Visualizza > Bordi.

Nota: per identificare l’oggetto selezionato quando punti e contorno sono nascosti, usare il pannello Livelli o la finestra 

di ispezione Proprietà.

Nascondere gli oggetti selezionati

❖ Selezionare Visualizza > Nascondi selezione. 

Nota: gli oggetti nascosti non vengono esportati. (Questo non si applica agli oggetti porzione e punti attivi nel livello Web).

Mostrare tutti gli oggetti

❖ Selezionare Visualizza > Mostra tutto.

Nota: per nascondere gli oggetti indipendentemente dal fatto che siano selezionati o meno, fare clic o trascinare lungo la 

colonna dell’icona dell’occhio nel pannello Livelli.

Selezionare i pixel 

È possibile modificare i pixel nell’intera area di lavoro oppure scegliere uno degli strumenti di selezione per vincolare 

la modifica a un’area particolare di un’immagine: 

Lo strumento Perimetro di selezione consente di selezionare un’area rettangolare di pixel in un’immagine. Per ulteriori 

informazioni, vedete l'articolo di Thierry Lorey.

Lo strumento Perimetro di selezione ovale consente di selezionare un’area ellittica di pixel in un’immagine.

http://www.fireworkszone.com/index.php?root=2&extension=0&idTutorial=491&pageCourante=1
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Gli strumenti di selezione pixel disegnano perimetri di selezione che definiscono l’area dei pixel selezionati. Una volta 

disegnato il perimetro di selezione, è possibile spostarlo, farvi delle aggiunte oppure basare sullo stesso un’altra 

selezione. È possibile modificare i pixel all’interno della selezione, applicarvi dei filtri oppure cancellarli senza alterare 

quelli che si trovano dietro la selezione. È inoltre possibile creare una selezione mobile di pixel che può essere 

modificata, spostata, tagliata o copiata. 

Opzioni per gli strumenti di selezione bitmap 

Gli strumenti per la selezione bitmap offrono diverse opzioni.

Opzioni Bordo

Rigido Crea un perimetro di selezione con un bordo definito. 

Antialiasing Impedisce la scalettatura dei bordi del perimetro di selezione.

Morbido Consente di sfumare il bordo della selezione di pixel.

Opzioni Perimetro di selezione o Perimetro di selezione ovale

Normale Consente di creare un perimetro di selezione nel quale l’altezza e la larghezza sono autonome.

Rapporto fisso Vincola l’altezza e la larghezza a un rapporto definito. 

Dimensioni fisse Vincola l’altezza e la larghezza a un’impostazione fissa.

Nota: lo strumento Bacchetta magica dispone anche di un’impostazione Tolleranza. Per ulteriori informazioni, 

consultare “Selezionare i pixel in aree di colori simili” a pagina 40.

Creare perimetri di selezione pixel 

Gli strumenti della sezione Bitmap del pannello Strumenti consentono di disegnare un perimetro di selezione intorno 

a specifiche aree di pixel di un’immagine bitmap. 

Nota: per cambiare le impostazioni della selezione mentre si utilizzano questi strumenti, selezionare la casella di 

controllo Perimetro di selezione attivo prima di effettuare la selezione.

Selezionare un’area di pixel rettangolare o ellittica

1 Scegliere lo strumento Perimetro di selezione o Perimetro di selezione ovale. 

2 Impostare le opzioni Stile e Bordo nella finestra di ispezione Proprietà. 

3 Trascinare per disegnare il perimetro di selezione che definisce la selezione di pixel.

• Per disegnare altri perimetri di selezione quadrati o circolari, tenere premuto il tasto Maiusc mentre si trascina 

lo strumento Perimetro di selezione o Perimetro di selezione ovale. Se la casella di controllo Perimetro di 

selezione attivo viene selezionata mentre si esegue una serie di selezioni, la funzione ha effetto soltanto 

sull’ultima selezione della serie. 

Lo strumento Lazo consente di selezionare un’area di pixel di forma libera in un’immagine.

Lo strumento Lazo poligonale consente di selezionare un’area di pixel di forma libera a bordi diritti in un’immagine.

Lo strumento Bacchetta magica consente di selezionare un’area di pixel di colore simile in un’immagine.
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• Per disegnare un perimetro di selezione da un punto centrale, deselezionare gli altri perimetri di selezione attivi, 

quindi tenere premuto il tasto Alt (Windows) o Opzione (Mac OS) mentre si disegna. 

Selezionare un’area di pixel a forma libera

1 Selezionare lo strumento Lazo.

2 Selezionare un’opzione Bordo nella finestra di ispezione Proprietà. 

3 Trascinare il puntatore intorno ai pixel da selezionare.

Tracciare punti per creare un perimetro di selezione

Lo strumento Lazo poligonale consente di selezionare un’area poligonale di pixel specifici in un’immagine bitmap. 

1 Selezionare lo strumento Lazo poligonale. 

2 Selezionare un’opzione Bordo nella finestra di ispezione Proprietà.

3 Definire la selezione facendo clic per tracciare i punti intorno al perimetro dell’oggetto o dell’area. 

Tenere premuto il tasto Maiusc per vincolare i segmenti del perimetro del Lazo poligonale a incrementi di 45 gradi.

4 Per chiudere il poligono seguire una delle seguenti operazioni:

• Fare clic sul punto iniziale.

• Fare doppio clic nello spazio di lavoro.

Selezionare i pixel in aree di colori simili

1 Selezionare lo strumento Bacchetta magica.

2 Scegliere un’opzione per il bordo. 

3 Impostare il livello di tolleranza trascinando il dispositivo di scorrimento nella finestra di ispezione Proprietà.

La tolleranza rappresenta la gamma dei toni di colore selezionati quando si fa clic su un pixel con la Bacchetta 

magica. Se si immette 0 e si fa clic su un pixel, vengono selezionati solo i pixel adiacenti che hanno la stessa tonalità. 

Se si immette 65, viene selezionata una gamma di tonalità di colore più ampia.

4 Fare clic sull’area del colore da selezionare. 

Intorno all’intervallo di pixel selezionati viene visualizzato un perimetro di selezione.
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Pixel selezionati con tolleranza inferiore (sopra) e con tolleranza superiore (sotto)

Selezionare colori simili in un intero documento

1 Selezionare un’area di colore con lo strumento Perimetro di selezione, Lazo o Bacchetta magica.

2 Scegliere Seleziona > Seleziona simile. 

Uno o più perimetri di selezione mostrano tutte le aree contenenti l’intervallo di pixel selezionati. Ciò dipende 

dall’impostazione Tolleranza nella finestra di ispezione Proprietà per lo strumento Bacchetta magica.

Nota: per regolare la tolleranza per il comando Seleziona simili, selezionare lo strumento Bacchetta magica, quindi 

modificare l’impostazione Tolleranza della finestra di ispezione Proprietà prima di usarlo. In alternativa, selezionare 

la casella di controllo Perimetro di selezione attivo per modificare le impostazioni di Tolleranza durante l’utilizzo 

della Bacchetta magica.

Creare una selezione in base alle aree opache degli oggetti

Con un’immagine bitmap selezionata, è possibile creare una selezione di pixel in base all’opacità di un oggetto o una 

maschera del pannello Livelli. 

1 Selezionare un oggetto bitmap nell’area di lavoro.

2 Nel pannello Livelli, collocare il puntatore sulla miniatura dell’oggetto da usare per creare la selezione di pixel.

3 Tenere premuto il tasto Alt (Windows) o Opzione (Mac OS).

Il puntatore si trasforma per indicare che si sta per selezionare un canale alfa, vale a dire l’area opaca dell’oggetto.

4 Fare clic sulla miniatura.

Nella bitmap selezionata viene creata una nuova selezione di pixel.

5 (Facoltativo) Per aggiungere un elemento alla selezione, fare clic tenendo premuti i tasti Alt-Maiusc (Windows) o 

Opzione-Maiusc (Mac OS) su un altro oggetto del pannello Livelli.
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Per togliere un elemento dalla selezione, fare clic sull’oggetto desiderato tenendo premuti i tasti Ctrl-Maiusc.

Rimuovere un perimetro di selezione

È possibile rimuovere un perimetro di selezione senza modificare il documento.

❖ Effettuare una delle seguenti operazioni:

• Disegnare un altro perimetro.

• Fare clic all’esterno della selezione corrente con lo strumento Perimetro di selezione o Lazo.

• Premere Esc.

Regolare i perimetri di selezione

Riposizionare una selezione durante la creazione

1 Iniziare a trascinare la selezione.

2 Senza rilasciare il pulsante del mouse, tenere premuta la barra spaziatrice.

3 Trascinare il perimetro di selezione in un’altra posizione dell’area di lavoro.

4 Tenendo sempre premuto il pulsante del mouse, rilasciare la barra spaziatrice.

5 Continuare a trascinare la selezione.

Spostare un perimetro di selezione preesistente

❖ Effettuare una delle seguenti operazioni:

• Trascinare il perimetro di selezione mediante lo strumento Perimetro di selezione, Lazo o Bacchetta magica.

• Utilizzare i tasti freccia per spostare il perimetro di incrementi di 1 pixel. 

• Premere il tasto Maiusc e utilizzare i tasti freccia per effettuare spostamenti per incrementi di 10 pixel.

Aggiungere pixel a una selezione preesistente

1 Scegliere uno strumento di selezione bitmap.

2 Tenere premuto il tasto Maiusc e disegnare altri perimetri di selezione.

3 Ripetere i passaggi 1 e 2 con uno strumento qualsiasi di selezione bitmap per continuare ad ampliare la selezione.

I perimetri sovrapposti si uniscono a formare un perimetro contiguo.

Sottrarre pixel da una selezione

❖ Tenere premuto il tasto Alt (Windows) o Opzione (Mac OS) e utilizzare uno strumento di selezione bitmap per 

selezionare l’area da rimuovere.

Selezionare una parte di un perimetro di selezione preesistente

Per selezionare una parte di un perimetro di selezione preesistente, trascinare un nuovo perimetro che si sovrapponga 

all’originale.

1 Tenere premuti i tasti Alt-Maiusc (Windows) o Opzione-Maiusc (Mac OS) e creare un perimetro di selezione che 

si sovrapponga al perimetro originale. 

2 Rilasciare il pulsante del mouse. 



43UTILIZZO DI FIREWORKS

Selezione e trasformazione di oggetti

Ultimo aggiornamento 4/5/2011

Vengono selezionati solo i pixel che si trovano nell’area di sovrapposizione tra i due perimetri.

Invertire una selezione di pixel

Da una selezione di pixel, è possibile crearne un’altra che selezioni tutti i pixel deselezionati. 

1 Creare una selezione di pixel con uno strumento di selezione bitmap.

2 Selezionare Seleziona > Seleziona inverso per selezionare tutti i pixel non selezionati.

Applicare l’effetto Morbidezza a una selezione di pixel

L’effetto Morbidezza crea una trasparenza per i pixel selezionati. 

1 Scegliere Seleziona > Morbidezza.

2 Immettere un valore nella finestra di dialogo Morbidezza.

3 Se necessario, cambiare il valore nella finestra di dialogo Morbidezza per regolare l’effetto.

Per osservare l’aspetto della selezione senza i pixel circostanti, scegliere Seleziona > Seleziona inverso e premere 

Canc. 

Espandere o contrarre un perimetro di selezione

Dopo aver tracciato un perimetro di selezione pixel è possibile espandere o contrarre il bordo del perimetro stesso.

1 Dopo aver disegnato il perimetro, scegliere Seleziona > Espandi perimetro di selezione.

2 Immettere il numero dei pixel in base al quale espandere o contrarre il bordo del perimetro di selezione e fare clic 

su OK.

Selezionare un’area intorno a un perimetro di selezione preesistente

Per aggiungere effetti grafici speciali a un perimetro di selezione, creare un altro perimetro attorno a quello già 

esistente. 

1 Dopo aver disegnato il perimetro, scegliere Seleziona > Contorna perimetro di selezione.

2 Immettere la larghezza del perimetro da posizionare intorno al perimetro preesistente e fare clic su OK.

Attenuare il bordo di un perimetro di selezione

È possibile eliminare i pixel in eccesso presenti lungo il bordo di una selezione di pixel o un perimetro di selezione dopo 

aver usato lo strumento Bacchetta magica.

1 Scegliere Seleziona > Attenua perimetro di selezione.

2 Immettere un raggio campione per specificare il grado desiderato di attenuazione e fare clic su OK.

Selezione di pixel prima e dopo l’attenuazione
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Convertire, trasferire o salvare perimetri di selezione

Convertire un perimetro in tracciato

Per convertire una selezione bitmap in oggetto vettoriale, si disegna un perimetro intorno alla parte di immagine 

bitmap da convertire. Questa procedura è utile se si desidera iniziare a creare un’animazione, ad esempio tracciando 

una selezione da un’immagine bitmap.

❖ Dopo aver disegnato il perimetro, scegliere Seleziona > Converti perimetro in tracciato.

Trasferire un perimetro di selezione a un altro oggetto bitmap

È possibile trasferire un perimetro di selezione da un’immagine bitmap all’altra o a una maschera.

1 Creare una selezione disegnando un perimetro.

2 Nel pannello Livelli, selezionare un diverso oggetto bitmap su ciascun livello. 

Per ulteriori informazioni, consultare “Applicazione di maschere” a pagina 140.

Salvare o ripristinare un perimetro di selezione

1 Scegliere Seleziona > Salva selezione bitmap o Seleziona > Ripristina selezione bitmap. 

2 Nel menu Documento, scegliere il documento aperto contenente la selezione salvata.

3 Nel menu Selezione, scegliere Nuovo oppure scegliere una selezione precedentemente salvata che si desidera 

modificare.

4 Se si sceglie Nuovo, immettere un nome per la selezione.

5 (Solo per il ripristino) Per invertire la selezione ripristinata, selezionare la casella Inverti.

6 Selezionare un’opzione nella sezione Operazione:

Nota: se si sta salvando una nuova selezione, tutte le opzioni di modifica riportate di seguito vengono disattivate.

Nuova selezione  Sostituisce la selezione attiva nel documento attivo con quella specificata nella casella Selezione. 

Aggiungi alla selezione Aggiunge la selezione attiva a quella specificata nelle caselle Documento e Selezione. 

Sottrai dalla selezione Sottrae la selezione attiva da quella specificata nelle caselle Documento e Selezione.

Interseca con la selezione Interseca la selezione attiva con quella specificata nelle caselle Documento e Selezione.

7 Fare clic su OK, quindi ripetere questa procedura per ciascun perimetro di selezione da salvare o ripristinare.

Eliminare un perimetro di selezione salvato

Nota: questa funzione è abilitata solo se un documento aperto contiene almeno una selezione salvata.

1 Scegliere Seleziona > Elimina selezione bitmap.

2 Nel menu Documento, scegliere il documento aperto contenente la selezione salvata.

3 Nel menu Selezione, scegliere la selezione.

Copiare o spostare il contenuto di un perimetro di selezione

Quando con uno strumento di selezione si trascina un perimetro in una nuova posizione, viene spostato il perimetro 

ma non il contenuto. Per copiare o spostare i pixel selezionati, utilizzare lo strumento Puntatore  o tenere premuto 

un tasto di modifica durante l’utilizzo dello strumento Bitmap.
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 Se si tengono premuti i tasti di modifica riportati di seguito, è possibile spostare e copiare le selezioni mediante i tasti 

freccia. Per spostare in incrementi di 10 pixel, tenere premuto il tasto Maiusc.

Spostare il contenuto di un perimetro di selezione

1 Creare una selezione di pixel con uno degli strumenti di selezione bitmap.

2 Effettuare una delle seguenti operazioni:

• Con un qualsiasi strumento della sezione Bitmap del pannello Strumenti, tenere premuto il tasto Ctrl 

(Windows) o Comando (Mac OS) e trascinare la selezione.

• Con lo strumento Puntatore, trascinare la selezione.

Copiare il contenuto di un perimetro di selezione

❖ Effettuare una delle seguenti operazioni:

• Trascinare la selezione di con lo strumento Sottoselezione .

• Trascinare la selezione servendosi dello strumento Puntatore, tenendo premuto il tasto Alt (Windows) o 

Opzione (Mac OS).

• Trascinare la selezione con uno strumento Bitmap, tenendo premuti i tasti Ctrl+Alt (Windows) o 

Comando+Opzione (Mac OS).

Nota: quando si utilizza la procedura sopra descritta, la selezione spostata o copiata rimane parte dell’oggetto bitmap 

corrente. Per creare una nuova immagine bitmap da una selezione di pixel, completare la procedura descritta di 

seguito.

Inserire un nuovo oggetto bitmap copiando una selezione

1 Selezionare un’area di pixel con uno strumento di selezione pixel.

2 Effettuare una delle seguenti operazioni:

• Selezionare Modifica > Inserisci > Bitmap tramite Taglia.

Un nuovo oggetto bitmap formato dalla selezione di pixel viene creato nel livello corrente; i pixel selezionati 

vengono rimossi dall’oggetto bitmap originale.

• Selezionare Modifica > Inserisci > Bitmap tramite Copia.

Al livello corrente viene aggiunto un nuovo oggetto bitmap basato sulla selezione di pixel. Nel pannello Livelli, 

compare una miniatura del nuovo oggetto bitmap nel livello corrente, sopra l’oggetto dal quale è stato tagliato 

o copiato.

Modificare gli oggetti selezionati

Spostare, duplicare o eliminare oggetti

Spostare una selezione

❖ Effettuare una delle seguenti operazioni:

• Trascinare la selezione con lo strumento Puntatore, Sottoselezione o Seleziona dietro.

• Premere un tasto freccia per spostare la selezione in incrementi di 1 pixel. 
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• Tenere premuto il tasto Maiusc e uno dei tasti freccia per spostare la selezione in incrementi di 10 pixel.

• Nella finestra di ispezione Proprietà, immettere le coordinate x ey dell’angolo superiore sinistro della selezione.

• Immettere le coordinate x e y dell’oggetto nel pannello Informazioni. Se le caselle X e Y non sono visibili, 

trascinare il bordo inferiore del pannello.

Spostare o copiare gli oggetti selezionati mediante un’operazione Incolla

1 Selezionare uno o più oggetti.

2 Selezionare Modifica > Taglia o Modifica > Copia.

3 Selezionare Modifica > Incolla.

Duplicare uno o più oggetti selezionati

❖ Selezionare Modifica > Duplica. 

A mano a mano che si ripete il comando, i duplicati dell’oggetto selezionato vengono visualizzati sovrapposti rispetto 

alla disposizione originale. I duplicati appaiono sfalsati di 10 pixel verso il basso e 10 pixel verso destra rispetto al 

duplicato precedente. L’ultimo oggetto duplicato diventa l’oggetto selezionato.

Clonare una selezione

❖ Selezionare Modifica > Clona. 

Il clone della selezione viene posizionato esattamente sopra l’originale e diventa l’oggetto selezionato.

Nota: per allontanare un clone selezionato dall’originale per incrementi di un pixel alla volta, utilizzare i tasti freccia o 

Maiusc + i tasti freccia. Questo risulta utile per mantenere distanze specifiche tra cloni o garantire l’allineamento 

orizzontale e verticale dei cloni.

Eliminare gli oggetti selezionati

❖ Effettuare una delle seguenti operazioni:

• Premere Canc o Backspace.

• Selezionare Modifica > Cancella o Modifica > Taglia.

• Fare clic con il pulsante destro del mouse (Windows) o tenendo premuto il tasto Ctrl (Mac OS) sull’oggetto e 

selezionare Modifica > Taglia dal menu di scelta rapida.

Annullare o deselezionare una selezione

❖ Effettuare una delle seguenti operazioni:

• Scegliere Seleziona > Deseleziona. 

• Se si usa lo strumento Perimetro di selezione, Perimetro di selezione ovale o Lazo, fare clic in un punto 

dell’immagine all’esterno dell’area selezionata. 

• Premere Esc.

Trasformare e distorcere oggetti e selezioni 

È possibile trasformare un oggetto selezionato, un gruppo o una selezione di pixel utilizzando gli strumenti e i comandi 

menu Scala, Inclina e Distorci: 
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Quando si sceglie qualsiasi strumento o comando di menu di trasformazione, Adobe® Fireworks® visualizza le maniglie 

di trasformazione intorno agli oggetti selezionati. 

A. Punto centrale  B. Maniglie di trasformazione  

Oggetto ruotato, scalato, inclinato, distorto e riflesso in verticale o in orizzontale

Trasformare gli oggetti selezionati con le maniglie di trasformazione

1 Selezionare uno strumento di trasformazione.

Non appena lo si sposta, il puntatore cambia forma, indicando l’attività di trasformazione disponibile.

2 Effettuare una delle seguenti operazioni: 

• Posizionare il puntatore vicino a un punto d’angolo quindi trascinare per ruotare.

• Trascinare una maniglia di trasformazione per trasformare l’oggetto in base allo strumento di trasformazione 

attivo.

3 Fare doppio clic all’interno della finestra o premere Invio per applicare le modifiche.

Ridimensionare un oggetto selezionato

 La scala (o ridimensionamento) allarga o riduce l’oggetto in senso orizzontale, verticale o in entrambe le direzioni. Per 

ulteriori informazioni su Scala attributi, vedete l'articolo di Thierry Lorey.

1 Effettuare una delle seguenti operazioni: 

•  Selezionare lo strumento Scala .

• Selezionare Modifica > Trasforma > Scala.

2 Trascinare le maniglie di trasformazione:

• Per scalare l’oggetto sia in orizzontale che in verticale, trascinare una delle maniglie d’angolo. Durante la 

scalatura, le proporzioni sono vincolate se si preme il tasto Maiusc.

La funzione Scala allarga o riduce l’oggetto.

La funzione Inclina trasforma l’oggetto inclinandolo lungo un asse specificato.

La funzione Distorci sposta i lati o gli angoli di un oggetto nella direzione nella quale si trascina una maniglia di selezione mentre 

lo strumento è attivo. Questa funzione è utile per simulare un aspetto tridimensionale. 

A

B

http://www.fireworkszone.com/page-2-4-0-494.html


48UTILIZZO DI FIREWORKS

Selezione e trasformazione di oggetti

Ultimo aggiornamento 4/5/2011

• Per scalare l’oggetto orizzontalmente o verticalmente, trascinare una maniglia laterale.

• Per scalare l’oggetto dal centro, tenere premuto Alt (Windows) o Opzione (Mac) e trascinare una qualsiasi 

maniglia.

Ridimensionare/modificare in scala effetti e tratti quando l'oggetto associato viene 
ridimensionato

Potete scegliere di modificare in scala gli effetti e i tratti applicati agli oggetti in maniera proporzionale quando gli 

oggetti vengono ridimensionati.

Nota: per il ridimensionamento normale e quello a 9 sezioni, i tratti vengono ridimensionati utilizzando le impostazioni 

nella finestra di dialogo Preferenze, o il pannello Informazioni.

❖ Effettuate una delle seguenti operazioni:

• Selezionare Modifica > Preferenze (Windows) o Fireworks > Preferenze (Mac OS). Nella categoria Generale, 

selezionare Scala tratti ed effetti.

• Selezionate Finestra > Informazioni. Nel menu Opzioni del pannello Info, selezionate Scala attributi.

Ridimensionare tutti gli oggetti selezionati

È possibile selezionare gli oggetti presenti nell’area di lavoro e ridimensionarli in orizzontale, in verticale o in entrambe 

le direzioni. 

1 Con lo strumento Puntatore, selezionare gli oggetti sull’area di lavoro.

2 Selezionare Comandi > Ridimensiona oggetti selezionati.

3 Utilizzare i controlli di ridimensionamento disponibili nella finestra di dialogo per ridimensionare gli oggetti in 

orizzontale o verticale e fare clic su Applica.

Nota: selezionare i controlli più grande o più piccolo per regolare gli incrementi di ridimensionamento.

Inclinare degli oggetti

È possibile inclinare un oggetto per trasformarlo piegandolo lungo il proprio asse orizzontale, verticale o entrambi.

1 Effettuare una delle seguenti operazioni per visualizzare le maniglie di trasformazione:

•  Selezionare lo strumento Inclina .

• Selezionare Elabora > Trasformazione > Inclina.

2 Trascinare una maniglia per inclinare l’oggetto.

Per creare l’illusione di una prospettiva, trascinare un punto d’angolo.

3 Fare doppio clic sul documento o premere Invio. 

Distorcere gli oggetti

Per modificare la forma e le proporzioni di un oggetto, trascinarne una maniglia di selezione con lo strumento 

Distorci.

1 Effettuare una delle seguenti operazioni per visualizzare le maniglie di trasformazione:

•  Selezionare lo strumento Distorci .

• Selezionare Elabora > Trasforma > Distorci.

2 Trascinare una maniglia per distorcere l’oggetto.
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3 Fare doppio clic all’interno della finestra o premere Invio. 

Ruotare o riflettere gli oggetti

Un oggetto ruotato o riflesso ruota intorno al proprio punto centrale. 

Per creare l’illusione di una prospettiva, in modo da dare l’impressione che l’oggetto abbia ruotato in tre dimensioni, 

consultare “Inclinare degli oggetti” a pagina 48.

Ruotare un oggetto selezionato di 90° o 180° 

❖ Selezionare Elabora > Trasformazione, quindi selezionare un comando di rotazione dal sottomenu.

Ruotare l’oggetto selezionato mediante trascinamento

1  Selezionare uno strumento di trasformazione.

2 Spostare il puntatore fuori dall’oggetto fino a che non compare il cursore di rotazione.

3 Trascinare per ruotare l’oggetto.

Per vincolare la rotazione a incrementi di 15 gradi rispetto all’orizzonte, tenere premuto il tasto Maiusc e 

trascinare.

4 Fare doppio clic all’interno della finestra o premere Invio per applicare le modifiche.

Riposizionare l’asse di rotazione

❖ Trascinare il punto centrale allontanandolo dal centro. 

Ripristinare l’asse di rotazione al centro della selezione

❖ Effettuare una delle seguenti operazioni: 

• Fare doppio clic sul punto centrale.

• Premere Esc per deselezionare l’oggetto, quindi selezionarlo di nuovo.

Riflettere un oggetto mantenendone la posizione

❖ Selezionare Elabora > Trasformazione > Rifletti in orizzontale o Rifletti in verticale.

Trasformare gli oggetti mediante valori numerici

Anziché scalare, ridimensionare o ruotare un oggetto, è possibile intervenire specificando valori definiti. Questa 

operazione può essere effettuata mediante la finestra di ispezione Proprietà, il pannello Informazioni o il comando 

Trasformazione numerica.

❖ Nella finestra di ispezione Proprietà o nel pannello Informazioni, immettere i nuovi valori di larghezza (L) o altezza (A).
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Nota: se le caselle (L) e (A) non sono visibili nella finestra di ispezione Proprietà, fare clic sulla freccia di espansione per 

visualizzare tutte le proprietà.

Scalare o ruotare gli oggetti selezionati mediante il comando Trasformazione numerica

1 Selezionare Elabora > Trasformazione > Trasformazione numerica. 

2 Nel menu a comparsa, selezionare il tipo di trasformazione da eseguire. 

3 Selezionare Vincola proporzioni per mantenere lo stesso rapporto tra le dimensioni orizzontale e verticale del 

documento o ridimensionare una selezione.

4 Selezionare Scala attributi per trasformare riempimento, tratto ed effetto dell’oggetto assieme all’oggetto stesso. 

5 Deselezionare Scala attributi per trasformare il solo tracciato. 

6 Immettere i valori numerici per trasformare la selezione e fare clic su OK.

Visualizzare informazioni sulla trasformazione numerica 

Il pannello Informazioni consente di visualizzare le informazioni sulle trasformazioni numeriche per l’oggetto 

attualmente selezionato. L’informazione viene aggiornata mentre si modifica l’oggetto. 

❖ Selezionare Finestra > Informazioni.

Ridimensionamento a 9 sezioni

Il ridimensionamento a 9 sezioni consente di scalare gli oggetti vettoriali e bitmap senza distorcerli, mantenendo 

l’aspetto di elementi principali quali il testo o gli angoli arrotondati. 

Il ridimensionamento a 9 sezioni non può essere applicato ai seguenti elementi:

• Testo

• Simboli contenenti testo

• Gruppi contenenti testo ruotato, distorto o asimmetrico

Nota: se un gruppo o un simbolo contenenti testo vengono ridimensionati a 9 sezioni, il testo viene ridimensionato senza 

l’applicazione del ridimensionamento a 9 sezioni.

Fireworks offre due metodi per effettuare il ridimensionamento a 9 sezioni: modifica in scala del simbolo con guide di 

porzionamento permanenti e modificabili e modifica in scala standard con guide temporanee che si applicano una 

volta. La modifica in scala del simbolo è ideale per gli oggetti da riutilizzare più volte. La modifica in scala standard è 

ideale per apportare modifiche immediate a oggetti bitmap o forme base da incorporare ai modelli del progetto. 

Per un’esercitazione video sulla creazione di oggetti scalabili mediante la funzione di ridimensionamento a 9 sezioni, 

visitare www.adobe.com/go/lrvid4036_fw_it. Per degli esempi dimostrativi sull’uso del ridimensionamento a 9 

sezioni, vedete l'articolo di Sarthak Singhal all'indirizzo http://www.adobe.com/go/learn_fw_9slicescaling_it.

Per ottenere una scalatura estremamente flessibile, la porzione centrale deve essere quanto più grande possibile. 

Quando si riduce notevolmente un oggetto, Fireworks limita le porzioni circostanti alle loro dimensioni originali.

http://www.adobe.com/go/lrvid4036_fw_it
http://www.adobe.com/go/learn_fw_9slicescaling_it
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Altri argomenti presenti nell’Aiuto 

“Simboli” a pagina 161

“Aprire elementi grafici creati in altre applicazioni” a pagina 7

“Preferenze Guide e griglie” a pagina 306

Ridimensionamento a 9 sezioni dei simboli

Applicare guide a 9 sezioni a un simbolo

1 Fare doppio clic sul simbolo o sul pulsante per accedere alla modalità di modifica del simbolo.

2 Nel pannello Proprietà, selezionare Abilita guide scala 9.

3 Spostare le guide e collocarle correttamente sul pulsante o simbolo. Accertarsi che le parti del simbolo che non si 

desidera distorcere durante la modifica in scala (ad esempio, gli angoli) si trovino all’esterno delle guide.

Guide in scala a 9 sezioni posizionate in modo che gli angoli non vengano distorti quando si ridimensiona il pulsante.

4 (Facoltativo) Bloccare le guide: nel pannello Proprietà, selezionare Blocca guide scala 9.

5 Per tornare alla pagina contenente le guide, fare clic sull’icona della pagina nella parte superiore del pannello del 

documento .

6 Ridimensionare il simbolo secondo le necessità utilizzando lo strumento Scala .

Il pulsante viene modificato in scala senza alcuna distorsione della forma degli angoli.

Dopo l’applicazione delle guide ridimensionamento a 9 sezioni a un simbolo, è possibile nidificarlo nelle regioni 

protette di altri simboli ridimensionati a 9 sezioni, creando oggetti complessi che vengono scalati perfettamente. 

Altri argomenti presenti nell’Aiuto 

“Simboli” a pagina 161

Modificare in scala su un piano con tre porzioni

Se si ha intenzione di modificare in scala un oggetto lungo una singola dimensione, è possibile utilizzare tre porzioni 

anziché nove. 

❖ Completare la procedura per il ridimensionamento a 9 sezioni standard sopra descritta, ma al passaggio 3 effettuare 

una delle seguenti operazioni:

• Per la scala verticale, trascinare le guide di porzionamento orizzontali fino al bordo dell’oggetto. 
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• Per la scala orizzontale, trascinare le guide verticali fino al bordo. 

Identificare i simboli con ridimensionamento a 9 sezioni

❖ Nel pannello Libreria, fare doppio clic sull’icona di un simbolo per passare alla modalità di modifica e identificare 

le guide di porzionamento.

Altri argomenti presenti nell’Aiuto 

“Passare dalla modifica del simbolo alla modifica della pagina” a pagina 162

Ridimensionamento a 9 sezioni di oggetti standard

Lo strumento Ridimensionamento a 9 sezioni crea guide di porzionamento temporanee che consentono di scalare gli 

oggetti senza distorcerne la geometria. Questo strumento è particolarmente utile per modificare in scala rapidamente 

gli oggetti bitmap o le forme per la progettazione di prototipi e modelli. 

Le guide create con lo strumento Ridimensionamento a 9 sezioni scompaiono dopo l’uso. Per informazioni su altre 

guide di porzionamento permanenti da riutilizzare più volte, consultare “Ridimensionamento a 9 sezioni dei simboli” 

a pagina 51.

1 Nell’area di lavoro, selezionare l’oggetto bitmap o la forma vettoriale.

2 Nel pannello Strumenti, selezionare lo strumento Ridimensionamento a 9 sezioni .

Nota: se al passaggio 1 è stato selezionato Forma automatica, Fireworks chiede di separare gli oggetti. Effettuare 

questa operazione solo se è stata completata la regolazione dei punti di controllo delle forme automatiche.

3 Nell’area di lavoro, disporre le guide di porzionamento in modo da mantenere al meglio la geometria dell’oggetto. 

Per ulteriori dettagli, consultare “Ridimensionamento a 9 sezioni” a pagina 50.

4 Trasformare l’oggetto trascinando una maniglia d’angolo o laterale.

Altri argomenti presenti nell’Aiuto 

“Forme base” a pagina 74

“Forme automatiche” a pagina 78

“Preferenze Modifica” a pagina 306

Organizzare più oggetti

Opzioni per l’organizzazione degli oggetti
Raggruppare gli oggetti Gli oggetti raggruppati vengono considerati come unico elemento; la relazione di ciascun 

oggetto agli altri oggetti del gruppo viene protetta.

Definire l’ordine di sovrapposizione degli oggetti Gli oggetti sovrapposti sono disposti davanti o dietro altri oggetti. 

Allineare gli oggetti selezionati Gli oggetti possono essere allineati a una zona dell’area di lavoro oppure all’asse 

verticale o orizzontale.



53UTILIZZO DI FIREWORKS

Selezione e trasformazione di oggetti

Ultimo aggiornamento 4/5/2011

Raggruppare e separare gli oggetti 

È possibile raggruppare i singoli oggetti selezionati, quindi gestirli come se si trattasse di un unico oggetto. Ad esempio, 

dopo aver disegnato i petali di un fiore sotto forma di oggetti singoli, si potrà raggrupparli per selezionare e spostare 

l’intero fiore come se si trattasse di un unico oggetto.

È possibile modificare i gruppi senza separarli. È possibile selezionare e modificare un singolo oggetto di un gruppo 

senza separare gli oggetti. Inoltre, gli oggetti di un gruppo possono essere separati in qualsiasi momento.

❖ Selezionare Modifica > Raggruppa o Modifica > Separa. 

Selezionare gli oggetti all’interno dei gruppi 

Per intervenire sui singoli oggetti di un gruppo, è possibile separare gli oggetti oppure utilizzare lo strumento 

Sottoselezione  per selezionare solo gli oggetti da modificare, lasciando intatto il gruppo.

Quando si modificano gli attributi di un oggetto appartenente a una sottoselezione, viene modificato solo l’oggetto in 

questione. Se si sposta su un altro livello un oggetto sottoselezionato, questo viene rimosso dal gruppo originale. 

Sottoselezione di un oggetto all’interno del gruppo

Selezionare un oggetto all’interno di un gruppo

❖ Con lo strumento Sottoselezione, fare clic sull’oggetto oppure trascinare intorno allo stesso un’area di selezione. Per 

aggiungere oggetti alla selezione o per rimuoverli dalla selezione, tenere premuto il tasto Maiusc mentre si fa clic.

Selezionare il gruppo contenente l’oggetto di una sottoselezione

❖ Effettuare una delle seguenti operazioni:

• Fare clic con il pulsante destro del mouse (Windows) o tenendo premuto il tasto Controllo (Mac OS) in qualsiasi 

punto del gruppo e scegliere Seleziona > Superseleziona dal menu di scelta rapida.

• Scegliere Seleziona > Superseleziona.

Selezionare tutti gli oggetti di un gruppo selezionato

❖ Effettuare una delle seguenti operazioni:

• Fare clic con il pulsante destro del mouse (Windows) o tenendo premuto il tasto Controllo (Mac OS) in qualsiasi 

punto del gruppo e scegliere Seleziona > Sottoseleziona dal menu di scelta rapida.

• Scegliere Seleziona > Sottoseleziona.

Definire l’ordine di sovrapposizione degli oggetti 

All’interno del livello, Fireworks impila gli oggetti sulla base dell’ordine di creazione degli stessi, collocando in alto 

quello creato più di recente. L’ordine di sovrapposizione degli oggetti determina come compaiono quando sono l’uno 

sopra l’altro.
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Anche i livelli incidono sull’ordine di sovrapposizione. Ad esempio, nel caso di un documento contenente due livelli 

denominati Livello 1 e Livello 2, se il Livello 1 si trova sotto il Livello 2 nel pannello Livelli, tutti gli elementi del Livello 

2 vengono visualizzati davanti a tutti gli elementi del Livello 1. 

L’ordine dei livelli può essere modificato trascinando il livello del pannello Livelli in una nuova posizione. Per ulteriori 

informazioni, consultare “Organizzare i livelli” a pagina 137.

Modificare l’ordine di sovrapposizione di un oggetto o gruppo selezionato all’interno di un 
livello

• Per spostare l’oggetto o il gruppo nella parte superiore o inferiore dell’ordine di sovrapposizione, selezionare 

Modifica > Disponi > In primo piano o Porta sullo sfondo. 

• Per spostare l’oggetto o il gruppo in basso o in alto di una posizione nell’ordine di sovrapposizione, selezionare 

Modifica > Disponi > Porta avanti o Sposta dietro. 

Se è stato selezionato più di un oggetto o gruppo, gli oggetti verranno spostati davanti o dietro a tutti gli oggetti non 

selezionati, mantenendo però il loro ordine reciproco.

Disporre gli oggetti tra i livelli

Il pannello Livelli offre un’ulteriore possibilità di controllo a fini organizzativi. Per spostare gli oggetti selezionati da 

un livello all’altro, trascinare la miniatura dell’oggetto o l’indicatore di selezione blu su un altro livello. 

Allineare gli oggetti

Agli oggetti selezionati si possono applicare uno o più comandi di allineamento. 

Per un accesso rapido a questi comandi, usare il pannello Allinea (Finestra > Allinea).

Allineare gli oggetti selezionati

1 Selezionare Modifica > Allinea

2 Scegliere una delle seguenti opzioni:

A sinistra  Allinea gli oggetti all’oggetto selezionato che si trova più a sinistra.

Centrato verticale  Allinea i punti centrali degli oggetti lungo un asse verticale.

A destra  Allinea gli oggetti all’oggetto selezionato che si trova più a destra.

Margine superiore  Allinea gli oggetti all’oggetto selezionato che si trova più in alto.

Centrato orizzontale  Allinea i punti centrali degli oggetti lungo un asse orizzontale.

In basso  Allinea gli oggetti all’oggetto selezionato che si trova più in basso.

Per ulteriori informazioni sull'allineamento di oggetti, vedete il tutorial Allineamento e distribuzione di oggetti.

Allineare forme automatiche

Per impostare le opzioni di allineamento per le forme automatiche, utilizzare l’interfaccia API corrispondente. Ad 

esempio:

smartShape.elem.elements[0].pathAttributes.brushPlacement="center"; 
smartShape.elem.elements[0].pathAttributes.brushPlacement="inside"; 
smartShape.elem.elements[0].pathAttributes.brushPlacement="outside"; 
smartShape.elem.elements[0].pathAttributes.fillOnTop=false;

http://www.adobe.com/go/vid0035_it
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le impostazioni specificate vengono utilizzate solo per le corrispondenti forme automatiche. I tratti e i tracciati 

disegnati dopo l’applicazione di queste impostazioni a una forma automatica vengono utilizzati per forme 

automatiche future, ma non per gli oggetti.

Distribuire uniformemente le larghezze o le altezze di tre o più oggetti selezionati

❖ Selezionare Elabora > Allinea > Distribuisci in larghezza o Elabora > Allinea > Distribuisci in altezza. 
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Capitolo 5: Operazioni con le immagini 
bitmap

Creazione di immagini bitmap

Le immagini bitmap sono elementi grafici composti da piccoli quadrati colorati denominati pixel, che si combinano 

come le tessere di un mosaico per creare un’immagine. Alcuni esempi di elementi grafici bitmap sono fotografie, 

immagini acquisite da scanner e immagini create da programmi di grafica pittorica. Queste immagini sono anche dette 

immagini rasterizzate.

Adobe® Fireworks® offre diverse funzioni di applicazioni di fotoritocco, creazione di grafica vettoriale e grafica bitmap. 

È possibile creare immagini bitmap disegnando e pitturando con strumenti bitmap, convertendo oggetti vettoriali in 

immagini bitmap, oppure aprendo o importando immagini. Le immagini bitmap non possono essere convertite in 

oggetti vettoriali. 

Altri argomenti presenti nell’Aiuto 

“La grafica bitmap” a pagina 4

Creare oggetti bitmap mediante disegno

Quando si crea un oggetto bitmap, questo viene visualizzato sul livello corrente. Nel pannello Livelli con i livelli 

espansi, è possibile vedere una miniatura e un nome per ciascun oggetto bitmap sotto il livello su cui questo risiede. 

Sebbene alcune applicazioni bitmap considerino ciascun oggetto bitmap come un livello separato, Fireworks combina 

oggetti bitmap, oggetti vettoriali e testo sui livelli.

1 Selezionare lo strumento Pennello o Matita nella sezione Bitmap del pannello Strumenti. 

2 Per creare oggetti bitmap nell’area di lavoro, dipingere o disegnare con lo strumento Pennello o Matita.

Viene aggiunto un nuovo oggetto bitmap al livello corrente nel pannello Livelli. Per ulteriori informazioni sull’uso 

degli strumenti Pennello e Matita, consultare “Modifica di immagini bitmap” a pagina 57.

Creare oggetti bitmap vuoti

È possibile creare un oggetto bitmap vuoto e successivamente disegnarvi o dipingervi dei pixel.

❖ Effettuare una delle seguenti operazioni:

• Fare clic sul pulsante Nuova immagine bitmap  nel pannello Livelli.

• Selezionare Modifica > Inserisci > Bitmap vuota.

• Disegnare un perimetro di selezione, iniziando in un’area vuota dell’area di lavoro, quindi riempirlo. Per 

ulteriori informazioni, consultare “Creare perimetri di selezione pixel” a pagina 39.

Viene aggiunta una bitmap vuota al livello corrente nel pannello Livelli.

Tagliare o copiare pixel e incollarli come nuovo oggetto bitmap

1 Effettuare una selezione di pixel con gli strumenti Perimetro di selezione, Lazo o Bacchetta magica. 

2 Tagliare e incollare o copiare la selezione nella nuova bitmap.
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La selezione appare nel pannello Livelli come un oggetto sul livello corrente.

Nota: è inoltre possibile fare clic con il pulsante destro del mouse (Windows) o tenendo premuto il tasto Controllo 

(Mac OS) su un perimetro di selezione pixel e selezionare Taglia o Copia. 

Convertire l’oggetto vettore selezionato in un’immagine bitmap

Nota: la conversione degli oggetti vettoriali in un’immagine bitmap è un’operazione irreversibile, a meno che al termine 

non risultino disponibili l’opzione Modifica > Annulla o la funzione di annullamento dell’azione nel pannello 

Cronologia.

❖ Effettuare una delle seguenti operazioni:

• Selezionare Elabora > Appiattisci selezione.

• Selezionare Appiattisci selezione nel menu del pannello Livelli.

Modifica di immagini bitmap

Gli strumenti più comuni per la modifica delle foto si trovano nel pannello Modifica immagine (Finestra > Modifica 

immagine). Per ulteriori informazioni, vedete l'articolo di Ruth Kastenmayer, 

http://www.adobe.com/go/learn_fw_imageeditingpanel_it, in Adobe Dev Center.

Disegnare oggetti bitmap

1 Selezionare lo strumento Matita .

2 Impostare le opzioni dello strumento nella finestra di ispezione Proprietà:

Con antialiasing Attenua i bordi delle linee tracciate.

Cancellazione automatica Applica il colore di riempimento quando si fa clic con lo strumento Matita sul colore del 

tratto.

Conserva trasparenza Fa sì che lo strumento Matita disegni solo all’interno dei pixel esistenti e non sulle aree 

trasparenti dell’immagine.

3 Trascinare per disegnare. Per vincolare il tracciato a una linea orizzontale, verticale o diagonale, tenere premuto il 

tasto Maiusc durante il trascinamento.

Pitturare un oggetto con lo strumento Pennello

Per ulteriori informazioni, consultare “Applicare e modificare tratti” a pagina 120.

1 Selezionare lo strumento Pennello .

2 Impostare gli attributi di tratto nella finestra di ispezione Proprietà.

3 Trascinare per pitturare.

Applicare ai pixel il colore di riempimento

1 Selezionare lo strumento Secchio di vernice .

2 Scegliere un colore nella casella Colore di riempimento.

3 Impostare il valore di tolleranza nella finestra di ispezione Proprietà. 

http://www.adobe.com/go/learn_fw_imageeditingpanel_it
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Nota: la tolleranza determina di quanto i pixel possano scostarsi dal colore del pixel su cui si fa clic, per poter essere 

riempiti. Un basso valore di tolleranza consente di riempire i pixel con valori di colore molto simili a quelli del pixel 

su cui si fa clic. Un elevato valore di tolleranza consente di riempire i pixel con valori di colore che rientrano in un 

intervallo più ampio.

4 Fare clic sull’immagine. 

Tutti i pixel compresi nell’intervallo di tolleranza assumono il colore di riempimento.

Applicare un riempimento a gradiente a una selezione di pixel

1 Effettuare la selezione.

2 Fare clic sullo strumento Secchio di vernice nel pannello Strumenti e selezionare Strumento Gradiente  dal 

menu a comparsa.

3 Impostare gli attributi di riempimento nella finestra di ispezione Proprietà.

4 Fare clic sulla selezione di pixel per applicare il riempimento.

Campionare un colore da utilizzare come colore di tratto o riempimento

Nota: il puntatore del contagocce della casella colore è diverso dallo strumento Contagocce. Consultare “Campionare i 

colori da una finestra a comparsa colori” a pagina 115.

Utilizzare lo strumento Contagocce  per campionare un colore da un’immagine.

1 Se l’attributo corretto non è già attivo, effettuare una delle seguenti operazioni:

• Nel pannello Strumenti, fare clic sull’icona Tratto accanto alla casella Colore tratto per attivare questo attributo.

• Nel pannello Strumenti, fare clic sull’icona Riempimento accanto alla casella Colore di riempimento per attivare 

questo attributo.

Nota: non fare clic sulla casella colore, perché in tal caso viene visualizzato il puntatore Contagocce anziché lo 

strumento Contagocce. 

2 Aprire un documento di Fireworks o un file apribile con Fireworks. 

3 Selezionare lo strumento Contagocce nella sezione Colori del pannello Strumenti. Quindi, impostare il campione 

di Media colori nella finestra di ispezione Proprietà:

1 pixel Crea un colore di tratto o riempimento a partire da un solo pixel.

Media 3x3 Crea un colore di tratto o riempimento a partire dai valori colore medi di un’area di 3 x 3 pixel.

Media 5x5 Crea un colore di tratto o riempimento a partire dai valori colore medi di un’area di 5 x 5 pixel.

4 Fare clic sullo strumento Contagocce in un punto qualsiasi del documento.

Viene visualizzato il colore campionato in tutte le caselle Colore tratto o Colore di riempimento di Fireworks.

Cancellare pixel in un oggetto bitmap o una selezione

1 Selezionare lo strumento Gomma .

2 Nella finestra di ispezione Proprietà, selezionare la forma di gomma rotonda o quadrata.

3 Trascinare i dispositivi di scorrimento per impostare i bordi, le dimensioni e i livelli di opacità.

4 Trascinare lo strumento Gomma sui pixel da cancellare.
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Ritagliare un’immagine bitmap selezionata

In un documento di Fireworks è possibile isolare e ritagliare un solo oggetto bitmap, lasciando inalterati gli altri oggetti 

presenti nell’area di lavoro.

1 Selezionare un oggetto bitmap o disegnare un perimetro di selezione mediante uno strumento di selezione bitmap.

2 Selezionare Modifica > Ritaglia bitmap selezionata. 

3 Regolare le maniglie di ritaglio fino a quando la casella di delimitazione non circonda l’area dell’immagine bitmap 

da conservare.

Nota: per annullare una selezione di ritaglio, premere ESC.

Casella di delimitazione

4 Fare doppio clic all’interno della casella di delimitazione o premere Invio per ritagliare la selezione.

Ritocco delle bitmap

Lo strumento Timbro di gomma consente di copiare o clonare l’area di un’immagine in un’altra.

Lo strumento Sfocatura riduce la nitidezza delle aree selezionate di un’immagine.

Lo strumento Sfumatura consente di prelevare un colore e di sfumarlo nella direzione di trascinamento all’interno di 

un’immagine.

Lo strumento Precisione aumenta la nitidezza delle aree di un’immagine.

Lo strumento Schiarisci schiarisce parti di un’immagine.

Lo strumento Scurisci scurisce parti di un’immagine.

Lo strumento Rimuovi occhi rossi riduce l’effetto occhi rossi nelle fotografie.

Lo strumento Sostituisci colore sostituisce un colore ricoprendolo con un altro.
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Clonare pixel 

La clonazione dei pixel risulta utile se si desidera ripristinare una fotografia graffiata o togliere macchie di pulviscolo 

da un’immagine; è possibile copiare un’area di pixel di una foto e sostituire il punto graffiato o macchiato con l’area 

clonata.

1 Selezionare lo strumento Timbro di gomma.

2 Fare clic su un’area per designarla come sorgente (area da clonare).

Il puntatore di campionamento assume la forma di puntatore a croce. 

Nota: per designare una diversa area di pixel da clonare, fare clic tenendo premuto il tasto Alt (Windows) o Opzione 

(Mac OS) su un’altra area di pixel. 

3 Spostarsi su un’altra parte dell’immagine e trascinare il puntatore. 

Vengono visualizzati due puntatori. 

• Il primo rappresenta l’origine e ha la forma di un mirino a croce. 

• A seconda delle preferenze selezionate per il pennello, il secondo puntatore può essere un timbro di gomma, un 

mirino a croce o un cerchio blu. Mentre si trascina il secondo puntatore, i pixel sottostanti il primo puntatore 

vengono copiati e applicati all’area sottostante il secondo.

Impostare le opzioni per lo strumento Timbro di gomma

1 Selezionare lo strumento Timbro di gomma. 

2 Nella finestra di ispezione Proprietà, impostare le opzioni per Timbro di gomma: 

Dimensioni Determina le dimensioni del timbro.

Bordo Definisce la morbidezza del tratto (100% è duro, 0% è morbido).

Sorgente allineata Definisce l’operazione di campionamento. Se questa opzione è selezionata, il puntatore di 

campionamento si sposta in verticale e in orizzontale in allineamento con il secondo. In caso contrario, l’area 

campione è fissa, indipendentemente dal punto in cui si sposta e si fa clic con il secondo puntatore.

Usa documento intero Esegue il campionamento a partire da tutti gli oggetti su tutti i livelli. Se questa opzione è 

deselezionata, lo strumento Timbro di gomma esegue il campionamento solo dall’oggetto attivo.

Opacità Determina in che misura lo sfondo risulterà visibile attraverso il tratto.

Modalità fusione Determina in che modo l’immagine clonata si unisce allo sfondo.

Duplicare una selezione di pixel

• Trascinare la selezione di pixel con lo strumento Sottoselezione.

• Tenere premuto il tasto Alt (Windows) o Opzione (Mac OS) e trascinare la selezione di pixel con lo strumento 

Puntatore.

Rendere le immagini sfocate, nitide o sfumate

Gli strumenti Sfocatura e Precisione agiscono sul fuoco dei pixel. Lo strumento Sfocatura consente di dare risalto alle 

parti di un’immagine sfocando selettivamente gli altri elementi. Lo strumento Precisione è utile per rendere più nitide 

le immagini acquisite da scanner o le fotografie sfuocate. Lo strumento Sfumatura consente di fondere i colori in 

maniera uniforme.

1 Selezionare lo strumento Sfocatura, Precisione o Sfumatura.
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2 Impostare le opzioni del pennello nella finestra di ispezione Proprietà:

Dimensioni Consente di impostare le dimensioni della punta del pennello.

Bordo Definisce la morbidezza della punta del pennello.

Forma Conferisce forma rotonda o quadrata alla punta del pennello.

Intensità Determina in che misura l’immagine deve essere più sfuocata o nitida.

Opzioni di Sfumatura

Pressione Consente di impostare l’intensità del tratto. 

Colore sfumino Consente di applicare l’effetto sfumino utilizzando un colore specifico all’inizio di ogni tratto. Se 

questa opzione è deselezionata, lo strumento utilizza il colore sottostante il puntatore dello strumento.

Usa documento intero Applica l’effetto sfumino utilizzando i dati di colore ricavati da tutti gli oggetti su tutti i 

livelli. Se questa opzione è deselezionata, lo strumento Sfumatura utilizza solo i colori ricavati dall’oggetto attivo.

3 Trascinare lo strumento sui pixel che si desidera rendere più nitidi, più sfocati o da sfumare.

Tenere premuto Alt (Windows) o Opzione (Mac OS) per passare da uno strumento all’altro.

Schiarire o scurire parti delle immagini

Per schiarire o scurire i pixel di un’immagine, utilizzare lo strumento Schiarisci o Scurisci. L’uso di questi strumenti è 

analogo al processo con cui si aumenta o diminuisce l’esposizione alla luce quando si sviluppa una fotografia. 

1 Selezionare lo strumento Schiarisci o Scurisci rispettivamente per schiarire o scurire parti di un’immagine.

2 Impostare le opzioni del pennello e l’esposizione nella finestra di ispezione Proprietà.

L’esposizione è compresa tra 0% e 100%. Selezionando valori maggiori si ottengono effetti più marcati. 

3 Impostare l’intervallo nella finestra di ispezione Proprietà:

Ombre Consente di modificare principalmente le parti scure dell’immagine.

Luci Consente di modificare principalmente le parti chiare dell’immagine.

Mezzitoni Consente di modificare principalmente l’intervallo intermedio di ogni canale dell’immagine.

4 Trascinare il mouse sulla parte dell’immagine da schiarire o scurire.

Nota: per passare temporaneamente dallo strumento Schiarisci allo strumento Scurisci, tenere premuto il tasto Alt 

(Windows). 

Rimuovere gli occhi rossi dalle fotografie

Questo strumento ricopre rapidamente solo le aree degli occhi rossi di una fotografia, sostituendo i colori rossastri con 

grigi e neri.
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Fotografia originale e dopo l’uso dello strumento Rimuovi occhi rossi

1 Nella sezione Bitmap del pannello Strumenti, selezionare lo strumento Rimuovi occhi rossi . Se lo strumento 

non è visibile, tenere premuto lo strumento Timbro di gomma fino a visualizzare un menu a comparsa.

2 Nella finestra di ispezione Proprietà, impostare le seguenti opzioni:

Tolleranza Definisce la gamma di tonalità da sostituire (0 sostituisce solo i rossi, 100 sostituisce tutte le tonalità 

contenenti il rosso).

Forza Definisce il grado di oscurità dei grigi utilizzati per sostituire i colori rossastri.

3 Trascinare il puntatore a croce sulle pupille rosse del soggetto fotografico.

Se gli occhi rossi non vengono eliminati, scegliere Modifica > Annulla e ripetere i passaggi 2 e 3 selezionando 

impostazioni diverse per Tolleranza e Forza.

Sostituire i colori negli oggetti bitmap

Fotografia originale e dopo l’uso dello strumento Sostituisci colore

Sostituire un colore mediante un campione colore

1 Nella sezione Bitmap del pannello Strumenti, selezionare lo strumento Sostituisci colore . Se lo strumento non 

è visibile, tenere premuto lo strumento Timbro di gomma fino a visualizzare un menu a comparsa.

2 Nella casella Da della finestra di ispezione Proprietà, fare clic su Campione colori. 

3 Fare clic sulla casella colore Da per selezionare il misuratore colore, quindi selezionare un colore dal menu a 

comparsa per specificare il colore da sostituire.

4 Fare clic sulla casella colore Con della finestra di ispezione Proprietà e selezionare un colore dal menu a comparsa.

5 Impostare gli attributi di tratto nella finestra di ispezione Proprietà:

Tolleranza Definisce la gamma di colori da sostituire (0 sostituisce solo il colore della casella colore Da, 100 

sostituisce tutti i colori simili a quello della casella colore Da).
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Forza Determina in che misura viene sostituito il colore specificato nella casella Da.

Colorizza Sostituisce il colore della casella colore Da con quello della casella colore Con. Deselezionare Colorizza 

per inserire nella casella Da il colore della casella Con, lasciando invariato parte del colore Da.

6 Trascinare lo strumento sul colore che si desidera sostituire.

Sostituire un colore con il colore di un’immagine

1 Nella sezione Bitmap del pannello Strumenti, selezionare lo strumento Sostituisci colore . Se lo strumento non 

è visibile, tenere premuto lo strumento Timbro di gomma fino a visualizzare un menu a comparsa.

2 Nella casella Da della finestra di ispezione Proprietà, fare clic su Immagine. 

3 Fare clic sulla casella colore Con della finestra di ispezione Proprietà per selezionare il misuratore colore e quindi 

selezionare un colore dal menu a comparsa.

4 Impostare gli attributi di tratto nella finestra di ispezione Proprietà.

5 Utilizzando lo strumento, fare clic sulla sezione dell’immagine bitmap che contiene il colore da sostituire. Non 

sollevare lo strumento e continuare a trascinarlo sull’immagine.

Rendere sfocati i bordi mediante l’effetto morbidezza 

L’applicazione dell’effetto Morbidezza rende sfocati i bordi di una selezione di pixel e facilita la fusione di un’area 

selezionata con i pixel circostanti. Questa funzione è particolarmente utile quando si copia una selezione e la si incolla 

su un altro sfondo. 

1 Importare l’immagine che si desidera sfumare nell’area di lavoro utilizzando il menu File > Importa.

2 Selezionare la parte dell’immagine che si desidera sfumare utilizzando uno degli strumenti di selezione.

3 Scegliere Seleziona > Inverso. 

4 Scegliere Seleziona > Morbidezza. In alternativa, è possibile selezionare l’opzione dal menu Bordo nel pannello 

Proprietà.

5 Nella finestra di dialogo Selezione morbidezza, digitare un valore per il raggio di morbidezza. Il valore predefinito 

è 10 e si adatta agli scopi più comuni. È comunque possibile selezionare un valore per il raggio di morbidezza nel 

menu Bordo.

6 Premere Canc.
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Regolare il colore e la tonalità delle immagini bitmap

I filtri di regolazione del colore e della tonalità consentono di migliorare e potenziare i colori delle immagini bitmap.

• Per applicare filtri rimovibili, modificabili e che non alterano permanentemente i pixel, utilizzare i filtri attivi. 

Adobe consiglia l’utilizzo di filtri attivi, ove possibile. 

Nota: nonostante i filtri attivi siano più flessibili, un grande numero di questi in un documento può provocare il 

rallentamento del funzionamento di Fireworks. 

• Per applicare filtri in modo permanente e irreversibile, selezionarli dal menu Filtri. 

• Non è possibile applicare filtri attivi dal menu Filtri alle selezioni di pixel. È possibile definire un’area di una bitmap 

e creare da essa una bitmap separata, quindi applicarvi un filtro attivo.

• Se si applica un filtro a un oggetto vettoriale selezionato utilizzando il menu Filtri, la selezione viene convertita in 

un’immagine bitmap.

Applicare un filtro attivo a un’area definita da un perimetro di selezione 

bitmap

1 Scegliere uno strumento di selezione bitmap e disegnare un perimetro di selezione.

2 Selezionare Modifica > Taglia.

3 Selezionare Modifica > Incolla.

La selezione viene incollata esattamente nel punto in cui si trovavano i pixel di origine, ma costituisce ora un 

oggetto bitmap separato.

4 Fare clic sulla miniatura del nuovo oggetto bitmap nel pannello Livelli per selezionare l’oggetto bitmap.

5 Applicare un filtro attivo dalla finestra di ispezione Proprietà.

Il filtro attivo viene applicato solo al nuovo oggetto bitmap, simulando l’applicazione di un filtro a una selezione di 

pixel.

Regolare la gamma tonale delle immagini bitmap

Una bitmap con una gamma tonale completa deve avere un numero pari di pixel in tutte le aree. Per regolare la gamma 

tonale sono disponibili tre opzioni: Livelli; Curve, per controllo più preciso; Livelli auto, per la regolazione automatica.

La funzione Livelli corregge le bitmap con una concentrazione elevata di pixel nelle zone di luce, mezzitoni o ombre.

Luci Corregge l’eccessiva concentrazione di pixel nelle alte luci, che rendono l’immagine sbiadita.

Mezzitoni Corregge l’eccessiva concentrazione di pixel nelle tonalità intermedie, che rendono l’immagine blanda.

Ombre Corregge l’eccessiva concentrazione di pixel nelle ombre, che nascondono gran parte dei particolari.

La funzione Livelli imposta i pixel più scuri come neri e quelli più chiari come bianchi, quindi ridistribuisce i mezzitoni 

in modo proporzionale. In tal modo si ottiene un’immagine con la migliore definizione per ogni pixel.
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Originale con i pixel concentrati nelle zone di luce; immagine dopo la regolazione con Livelli

L’istogramma della finestra di dialogo Livelli consente di visualizzare la distribuzione dei pixel sull’immagine bitmap. 

L’istogramma è una rappresentazione grafica della distribuzione dei pixel nelle zone delle luci, dei mezzitoni e delle 

ombre.   

Mediante l’istogramma è possibile stabilire il migliore metodo di correzione della gamma tonale di un’immagine. 

Un’elevata concentrazione di pixel nelle zone di ombra o luce indica che è possibile migliorare l’immagine applicando 

le funzioni Livelli o Curve. 

L’asse orizzontale rappresenta i valori del colore dal più scuro (0) al più chiaro (255). L’asse orizzontale va letto da 

sinistra a destra: i pixel più scuri si trovano sulla sinistra, i pixel delle tonalità intermedie si trovano al centro e i pixel 

più chiari sulla destra.

L’asse verticale rappresenta il numero di pixel a ogni livello di luminosità. In genere, si regolano prima le luci e le 

ombre. Si interviene quindi sui mezzitoni per regolare il valore di luminosità delle tonalità intermedie senza incidere 

sulle luci e sulle ombre.

Regolare zone di luce, mezzitoni e ombre mediante Livelli

1 Selezionare un’immagine bitmap.

2 Effettuare una delle seguenti operazioni: 

• Nella finestra di ispezione Proprietà, fare clic sul pulsante più (+) accanto all’etichetta Filtri, quindi selezionare 

Regola colore > Livelli dal menu a comparsa Filtri.

• Selezionare Filtri > Regola colore > Livelli.
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Finestra di dialogo Livelli

Per visualizzare le modifiche nello spazio di lavoro, selezionare Anteprima nella finestra di dialogo. 

L’immagine viene aggiornata mentre si applicano le modifiche.

3 Dal menu a comparsa Canale, selezionare se si desidera apportare le modifiche a singoli canali di colore (Rosso, Blu 

o Verde) o a tutti i canali di colore (RGB). 

4 Trascinare i dispositivi di scorrimento di Livelli input situati sotto Istogramma: 

• Il dispositivo di scorrimento di destra regola le luci utilizzando valori da 255 a 0.

• Il dispositivo di scorrimento centrale regola i mezzitoni utilizzando valori da 10 a 0.

• Il dispositivo di scorrimento di sinistra regola le ombre utilizzando valori da 0 a 255. 

Nota: il valore delle ombre non può essere superiore a quello delle luci, il valore delle luci non può essere inferiore 

a quello delle ombre, mentre il valore dei mezzitoni deve rientrare tra le impostazioni delle ombre e delle luci.

5 Trascinare i dispositivi di scorrimento di Livelli output per regolare i valori di contrasto: 

• Il dispositivo di scorrimento di destra regola le luci utilizzando valori da 255 a 0.

• Il dispositivo di scorrimento di sinistra regola le ombre utilizzando valori da 0 a 255. 

Regolare automaticamente le luci, le tonalità intermedie e le ombre

1 Selezionare l’immagine.

2 Effettuare una delle seguenti operazioni:

• Nella finestra di ispezione Proprietà, fare clic sul pulsante più (+) accanto all’etichetta Filtri, quindi selezionare 

Regola colore > Livelli auto dal menu a comparsa Filtri.

• Selezionare Filtri > Regola colore > Livelli auto.

È inoltre possibile regolare automaticamente le luci, le tonalità intermedie e le ombre facendo clic sul pulsante 

Auto nella finestra di dialogo Livelli o Curve.

Regolare un colore specifico nella gamma tonale mediante Curve

La funzione Curve offre un controllo più preciso sulla gamma tonale rispetto alla funzione Livelli. La funzione Curve 

consente di regolare qualsiasi colore della gamma tonale, senza alterare gli altri colori.

La griglia della finestra di dialogo Curve riporta due valori di luminosità:

Asse orizzontale Rappresenta la luminosità originale dei pixel, visualizzata nella casella Input.
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Asse verticale Rappresenta i nuovi valori di luminosità, visualizzati nella casella Output.

Alla prima apertura della finestra di dialogo Curve, la linea diagonale indica che non sono state apportate modifiche, 

quindi i valori di input e output risultano gli stessi per tutti i pixel.

1 Selezionare l’immagine.

2 Effettuare una delle seguenti procedure per aprire la finestra di dialogo Curve:

• Nella finestra di ispezione Proprietà, fare clic sul pulsante più (+) accanto all’etichetta Filtri, quindi selezionare 

Regola colore > Curve dal menu a comparsa Filtri.

Nota: se la finestra di ispezione Proprietà è parzialmente ridotta, fare clic sul pulsante Aggiungi filtri invece che 

più (+).

• Selezionare Filtri > Regola colore > Curve.

Finestra di dialogo Curve

3 Dal menu a comparsa Canale, scegliere se applicare le modifiche a singoli canali di colore o a tutti.

4 Per regolare la curva, fare clic su un punto sulla linea diagonale della griglia e trascinarlo nella nuova posizione.

• A ogni punto della curva corrispondono valori di Input e Output. Quando si trascina un punto, i valori di Input 

e Output vengono aggiornati.

• La curva visualizza i valori di luminosità da 0 a 255, dove 0 rappresenta le ombre.

Curva dopo aver trascinato un punto per la regolazione

Per regolare automaticamente le luci, le tonalità intermedie e le ombre, fare clic sul pulsante Auto nella finestra 

di dialogo Curve.
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Eliminare un punto lungo la curva

❖ Trascinare il punto al di fuori della griglia.

Nota: non è possibile eliminare i punti finali della curva.

Regolare manualmente l’equilibrio tonale 

1 Aprire la finestra di dialogo Livelli o Curve e selezionare un canale di colore dal menu a comparsa Canale.

2 Scegliere il contagocce appropriato per ripristinare i valori di tonalità nell’immagine:

•  Fare clic sul pixel più luminoso dell’immagine con il contagocce delle luci  per ripristinarne il valore.

•  Fare clic su un pixel di colore neutro nell’immagine con il contagocce dei mezzitoni per ripristinarne il valore.

•  Fare clic sul pixel più scuro dell’immagine con il contagocce delle ombre per ripristinarne il valore.

3 Fare clic su OK. 

Regolare la luminosità e il contrasto

La funzione Luminosità/Contrasto modifica il contrasto o la luminosità dei pixel di un’immagine. Questa funzione 

incide sulle zone di luce, ombre e mezzitoni di un’immagine. 

Immagine originale (a sinistra) e dopo la regolazione della luminosità (a destra)

1 Selezionare l’immagine.

2 Effettuare una delle seguenti operazioni:

• Nella finestra di ispezione Proprietà, fare clic sul pulsante più (+) accanto all’etichetta Filtri, quindi selezionare 

Regola colore > Luminosità/Contrasto dal menu a comparsa Filtri.

• Selezionare Filtri > Regola colore > Luminosità/Contrasto.

3 Trascinare i dispositivi di scorrimento di luminosità e contrasto per regolare le impostazioni su un valore compreso 

tra –100 e 100.

Modificare i colori dell’oggetto mediante fusione

Per ulteriori informazioni, consultare “Le modalità fusione” a pagina 153.
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Se si applica la fusione, il colore viene aggiunto sopra l’oggetto. La fusione di un colore in un oggetto esistente è simile 

all’utilizzo di Tonalità/Saturazione. Tuttavia, la fusione consente di applicare in modo rapido un colore specifico da 

un pannello di campioni di colore. 

1 Nella finestra di ispezione Proprietà, fare clic sul pulsante più (+) accanto all’etichetta Filtri, quindi selezionare 

Regola colore > Riempimento colore dal menu a comparsa Filtri.

2 Scegliere una modalità fusione. Il valore predefinito è Normale. 

3 Scegliere un colore di riempimento dal menu a comparsa dei campioni colore.

4 Scegliere un valore percentuale di opacità per il colore di riempimento e premere Invio.

Regolare tonalità e saturazione

Regolare la nuance (tonalità), l’intensità (saturazione) o la luminosità del colore di un’immagine. 

Immagine originale (a sinistra) e dopo la regolazione della saturazione (a destra)

1 Selezionare l’immagine.

2 Effettuare una delle seguenti operazioni:

• Nella finestra di ispezione Proprietà, fate clic sul pulsante più (+) accanto all’etichetta Filtri, quindi selezionate 

Regola colore > Tonalità/Saturazione dal menu a comparsa Filtri.

• Selezionare Filtri > Regola colore > Tonalità/Saturazione.

3 Trascinare i dispositivi di scorrimento per regolare i colori dell’immagine. 

• I valori della tonalità sono compresi tra -180 e 180.

• I valori di saturazione e luminosità sono compresi tra –100 e 100.

Modificare un’immagine RGB in immagine bitonale o aggiungere un colore a un’immagine 
in scala di grigi

❖ Selezionare Colorizza nella finestra di dialogo Tonalità/Saturazione. 

Nota: quando si sceglie Colorizza, viene modificato l’intervallo valori dei dispositivi di scorrimento di Tonalità e 

Saturazione. I valori della tonalità sono compresi tra 0 e 360, mentre quelli della saturazione sono compresi tra 0 e 100. 

Invertire i valori del colore di un’immagine

È possibile modificare ogni colore di un’immagine nel suo opposto sulla ruota dei colori. Ad esempio, se si applica il 

filtro a un oggetto rosso (R=255, G=0, B=0), il colore viene modificato in azzurro (R=0, G=255, B=255).
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Immagine monocromatica prima (a sinistra) e dopo l’inversione (a destra)

Immagine a colori prima (a sinistra) e dopo l’inversione (a destra)

1 Selezionare l’immagine.

2 Effettuare una delle seguenti operazioni:

• Nella finestra di ispezione Proprietà, fate clic sul pulsante più (+) accanto all’etichetta Filtri, quindi selezionate 

Regola colore > Inverti dal menu a comparsa Filtri.

• Selezionare Filtri > Regola colore > Inverti.

Convertire un oggetto in scala di grigio

1 Selezionare l’oggetto.

2 Selezionare Comandi > Creatività > Converti in scala di grigio.

Convertire un oggetto in tonalità seppia

1 Selezionare l’oggetto.

2 Selezionare Comandi > Creatività > Converti in tonalità seppia.
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Sfocatura e definizione di precisione delle bitmap

Opzioni di Sfocatura
Sfocatura Riduce il fuoco dei pixel selezionati. 

Ulteriore sfocatura Applica una sfocatura tre volte maggiore rispetto all’opzione Sfocatura. 

Sfocatura Gaussian Applica a ogni pixel una media ponderata dei valori di sfocatura per ottenere un effetto foschia. I 

valori del raggio di sfocatura sono compresi tra 0,1 e 250. L’aumento del raggio genera un effetto di sfocatura più 

marcato.

Sfocatura movimento Crea l’illusione che l’immagine sia in movimento. L’intervallo dei valori di distanza è compreso 

tra 1 e 100. L’aumento della distanza genera un effetto di sfocatura più marcato.

Sfocatura radiale Crea l’illusione che l’immagine ruoti. Il valore Qualità può essere compreso tra 1 e 100. Un aumento 

del valore della qualità comporta un effetto sfocatura con un minor numero di ripetizioni dell’immagine originale.

Sfocatura zoom Crea l’illusione che l’immagine si avvicini o si allontani dall’osservatore. Richiede l’impostazione dei 

valori Quantità e Qualità. Un aumento del valore della qualità comporta un effetto sfocatura con un minor numero di 

ripetizioni dell’immagine originale. L’aumento della quantità genera un effetto di sfocatura più marcato.

1 Selezionare l’immagine.

2 Effettuare una delle seguenti operazioni:

• Nella finestra di ispezione Proprietà, fare clic sul pulsante più (+) accanto all’etichetta Filtri, quindi selezionare 

un’opzione Sfocatura dal menu a comparsa Filtri.

• Selezionare Filtri > Sfocatura > [opzione di sfocatura].

3 Impostare altri valori per l’opzione di sfocatura selezionata.

Convertire una bitmap in un disegno al tratto

È possibile modificare l’aspetto delle bitmap in modo da simulare disegni al tratto, identificando le transizioni di colore 

nelle immagini e convertendole in linee. Effettuare una delle seguenti operazioni:

• Nella finestra di ispezione Proprietà, fare clic sul pulsante più (+) accanto all’etichetta Filtri, quindi selezionare 

Altro > Trova bordi dal menu a comparsa Filtri.

• Selezionare Filtri > Altro > Trova bordi.

Immagine originale (a sinistra) e dopo l’applicazione di Trova bordi (a destra)
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Convertire un’immagine in trasparenza

Convertire un oggetto o testo in trasparenza in base alla trasparenza dell’immagine. Effettuare una delle seguenti 

operazioni:

• Nella finestra di ispezione Proprietà, fare clic sul pulsante più (+) accanto all’etichetta Filtri, quindi selezionare 

Altro > Converti in alfa dal menu a comparsa Filtri.

• Selezionare Filtri > Altro > Converti in alfa.

Miglioramento della nitidezza di un’immagine

Per correggere immagini sfuocate, utilizzare un’opzione di Precisione:

Precisione Regola la nitidezza di un’immagine sfuocata aumentando il contrasto dei pixel adiacenti. 

Ulteriore precisione Aumenta il contrasto dei pixel adiacenti in misura tre volte maggiore rispetto a Precisione. 

Maschera definizione dettagli Aumenta la nitidezza di un’immagine regolando il contrasto dei bordi dei pixel. Questa 

opzione offre il massimo controllo e rappresenta l’opzione migliore per definire la precisione di un’immagine.

Immagine originale (a sinistra) e dopo la definizione di precisione (a destra)

1 Selezionare l’immagine.

2 Effettuare una delle seguenti operazioni:

• Nella finestra di ispezione Proprietà, fare clic sul pulsante più (+) accanto all’etichetta Filtri, selezionare 

Precisione, quindi selezionare un’opzione Precisione dal menu a comparsa Filtri.

• Selezionare Filtri > Precisione > [opzione di precisione].

Le opzioni Precisione e Ulteriore precisione vengono applicate.

3 (Opzione Maschera definizione dettagli) Trascinare il dispositivo di scorrimento Valore precisione per selezionare 

un valore compreso tra l’1% e il 500%.

4 Trascinare il dispositivo di scorrimento di Raggio pixel per selezionare un raggio da 0,1 a 250.

Un aumento del raggio incrementa l’area di contrasto di definizione intorno al bordo dei pixel.

5 Trascinare il dispositivo di scorrimento di Soglia per selezionare una soglia da 0 a 255. 

I valori compresi tra 2 e 25 sono quelli di uso più frequente. Un aumento della soglia rende più precisi solo i pixel 

dell’immagine che presentano un contrasto più elevato. Una riduzione della soglia agisce anche sui pixel con 

contrasto inferiore. Una soglia pari a 0 migliora la precisione di tutti i pixel dell’immagine.
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Aggiungere disturbo a un’immagine

Se osservate a livelli di ingrandimento elevati, quasi tutte le immagini ottenute da scanner e fotocamere digitali non 

presentano colori perfettamente uniformi. I colori sono infatti costituiti da pixel di diversi colori. Nella manipolazione 

delle immagini, il termine disturbo fa riferimento a variazioni casuali di colore nei pixel che costituiscono 

un’immagine.

A volte, ad esempio quando si incolla parte di un’immagine in un’altra, la differenza nella quantità delle variazioni 

casuali di colore delle due immagini può essere percepita e le immagini non si fondono in modo omogeneo. In casi 

simili è possibile aggiungere disturbo a una o a entrambe le immagini, in modo da creare l’illusione che entrambe 

provengano dalla stessa fonte. È inoltre possibile aggiungere disturbo a un’immagine per ragioni estetiche, ad esempio 

per simulare una vecchia fotografia o disturbi di origine elettrostatica su uno schermo televisivo.

Fotografia originale (a sinistra) e dopo l’aggiunta del disturbo (a destra)

Aggiungere disturbo 

1 Selezionare l’immagine.

2 Effettuare una delle seguenti operazioni per aprire la finestra di dialogo Aggiungi disturbo:

• Nella finestra di ispezione Proprietà, fare clic sul pulsante più (+) accanto all’etichetta Filtri, quindi selezionare 

Disturbo > Aggiungi disturbo dal menu a comparsa Filtri.

• Selezionare Filtri > Disturbo > Aggiungi disturbo.

Nota: l’applicazione di un filtro a partire dal menu Filtri è un’operazione irreversibile: non può essere annullata, 

a meno che al termine non sia disponibile l’opzione Modifica > Annulla. Per poter continuare a regolare, 

disattivare o rimuovere questo filtro, occorre applicarlo come filtro attivo, secondo quanto descritto nella prima 

opzione dell’elenco puntato di questo passaggio. Per ulteriori informazioni, consultare “Uso dei filtri attivi” a 

pagina 129.

3 Trascinare il dispositivo di scorrimento Quantità per impostare la quantità di disturbo desiderata.

I valori consentiti sono compresi tra 1 e 400: un valore di quantità elevato genera un’immagine con un numero 

maggiore di pixel disposti casualmente.

4 Selezionare l’opzione Colore per applicare il disturbo cromatico. Deselezionare questa opzione per applicare solo 

disturbo monocromatico.

5 Fare clic su OK.
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Capitolo 6: Operazioni con gli oggetti 
vettoriali

Un oggetto vettoriale è un elemento grafico computerizzato la cui forma è definita da un tracciato. La forma di un 

tracciato vettoriale è determinata da punti lungo il tracciato. Il colore del tratto di un oggetto vettoriale segue il 

tracciato e il riempimento occupa l’area interna. Il tratto e il riempimento determinano l’aspetto dell’elemento grafico 

stampato o pubblicato sul Web.

Le forme degli oggetti vettoriali comprendono forme base, forme automatiche (gruppi di oggetti vettoriali con 

controlli speciali per la regolazione dei propri attributi) e forme a mano libera. Per disegnare e modificare oggetti 

vettoriali, sono disponibili diversi strumenti e tecniche. 

Forme base

Le forme base includono linee, rettangoli, ellissi, rettangoli con angoli arrotondati, poligoni e stelle.

Nota: per evitare pixel estranei, nonché incrementare la definizione degli oggetti vettoriali, utilizzate Comandi > 

Selezione > Usa rendering vettoriale precedente.

Disegnare e modificare forme base

Lo strumento Rettangolo e lo strumento Rettangolo arrotondato consentono di disegnare rettangoli come oggetti 

raggruppati. Per spostare un punto d’angolo di un rettangolo in modo indipendente, occorre separare il rettangolo o 

utilizzare lo strumento Sottoselezione .

Per ulteriori informazioni sul ridimensionamento e la modifica in scala degli oggetti, consultare “Trasformare e 

distorcere oggetti e selezioni” a pagina 46.

Disegnare linee, rettangoli o ellissi

1 Nel pannello Strumenti, selezionare lo strumento Linea, Rettangolo Ellisse.

2 (Facoltativo) Impostare gli attributi di tratto e riempimento nella finestra di ispezione Proprietà. 

3 Trascinare sull’area di lavoro per disegnare la forma.

• Per lo strumento Linea, tenere premuto il tasto Maiusc durante il trascinamento per vincolare le linee a 

incrementi di 45°. 

• Per lo strumento Rettangolo o Ellisse, tenere premuto il tasto Maiusc durante il trascinamento per vincolare le 

forme a quadrati o cerchi. 

Disegnare una forma dal punto centrale

❖ Posizionare il puntatore sul punto centrale e trascinare lo strumento di disegno tenendo premuto Alt (Windows) 

o Opzione (Mac OS). Per vincolare le proporzioni, tenere premuto il tasto Maiusc.

Aggiungere frecce a una linea

1 Disegnare o selezionare una linea.
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2 Selezionare Comandi > Creatività > Aggiungi frecce.

3 Impostare le seguenti opzioni:

• Selezionare Aggiungi all’inizio o Aggiungi alla fine e impostare lo stile di freccia desiderato.

• Se necessario, selezionare Applica tratto e Riempimento uniforme.

Regolare la posizione di una forma base mentre la si disegna 

❖ Tenendo premuto il pulsante del mouse, tenere premuta la barra spaziatrice (solo rettangolo o ellisse), quindi 

trascinare l’oggetto in un’altra posizione nell’area di lavoro. Rilasciare la barra spaziatrice e continuare a disegnare 

l’oggetto. 

Ridimensionare una linea, un rettangolo o un’ellisse

Quando si scala un oggetto vettoriale, lo spessore del tratto non viene modificato. Gli oggetti vengono ridimensionati 

in modo proporzionale.

❖ Effettuare una delle seguenti operazioni:

• Inserire nuovi valori di larghezza (L) o altezza (A) nella finestra di ispezione Proprietà o nel pannello Info.

• Selezionare lo strumento Scala nella sezione Seleziona del pannello Strumenti e trascinare una maniglia di 

trasformazione angolo. 

• Selezionare Modifica > Trasforma > Scala e trascinare una maniglia di trasformazione angolo, oppure 

selezionare Modifica > Trasforma > Trasformazione numerica e immettere nuovi valori per le dimensioni. 

• Trascinare un punto d’angolo di un rettangolo.

Aumentare la precisione delle linee

A volte, le linee tracciate in Fireworks diventano sfocate e non nitide quanto si vorrebbe. La sfocatura è causata da nodi 

del tracciato situati tramite il mouse a metà di un pixel.  Per aumentare la nitidezza degli oggetti, utilizzare il comando 

Aggancia a pixel. 

Il comando funziona per le linee dritte in cui la differenza nelle coordinate X o Y per i due nodi è inferiore o uguale a 

0,5 px. Se i nodi Fireworks sono situati a metà dei pixel, le coordinate X e Y di entrambi i nodi devono essere comprese 

nel limite dello stesso pixel.

Spostando i nodi di 0,5 px a volte può portare talvolta a un cambiamento di un pixel nelle coordinate X o Y nella 

finestra di ispezione Proprietà (PI). Il cambiamento è dovuto al fatto che, per i valori decimali, la finestra di ispezione 

Proprietà utilizza il valore intero più vicino.

Nota: per evitare pixel estranei, nonché incrementare la definizione degli oggetti vettoriali, utilizzate Comandi > 

Selezione > Usa rendering vettoriale precedente.

Numero Scenario Problema Soluzione

1 Un rettangolo viene ridimensionato senza 

l’attivazione dell’opzione “Scala tratti ed 

effetti” nella finestra di dialogo Preferenze.

Il rettangolo non viene agganciato al 

pixel più vicino e i bordi risultano 

sfocati.

Selezionare l’oggetto, fare clic con il tasto 

destro del mouse e selezionare Aggancia 

a pixel.*

2 Viene disegnata una linea con un tratto 

spesso utilizzando lo strumento Linea.

La linea appare sfocata. Selezionare l’oggetto, fare clic con il tasto 

destro del mouse e selezionare Aggancia 

a pixel.*

3 È stato realizzato un tracciato vettoriale 

rettilineo con lo strumento Penna.

Il tracciato appare sfocato. Selezionare l’oggetto, fare clic con il tasto 

destro del mouse e selezionare Aggancia 

a pixel.*
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*È possibile accedere alla funzione Aggancia a pixel anche dal menu Modifica o utilizzando il tasto di scelta rapida 

Ctrl+K (Windows) o Cmd+K (Mac OS).

Nota: il comando Aggancia a pixel non può essere annullato.

Scenario 1

Scenario 2
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Scenario 3

JSAPI: fw.getDocumentDOM().snapToPixel() - Aggancia a pixel viene applicato agli oggetti dell’area di lavoro 

selezionati.

Disegnare rettangoli base con angoli arrotondati

Viene specificata la smussatura dell’angolo in percentuale o in pixel. Quando la smussatura viene specificata in pixel, 

il valore massimo corrisponde a metà della lunghezza del lato minore del rettangolo; a valori maggiori non corrisponde 

un effetto più pronunciato.

Per informazioni sul mantenimento degli angoli arrotondati di un rettangolo durante il ridimensionamento di un 

oggetto, vedete l'articolo di Sarthak.

1 Nella sezione Vettore del pannello Strumenti, selezionare lo strumento Rettangolo. 

2 Trascinare sull’area di lavoro per disegnare il rettangolo.

3 Nella finestra di ispezione Proprietà, scegliere percentuale o pixel dal menu a comparsa a destra della casella di testo 

Smusso. Impostare la percentuale mediante il dispositivo di scorrimento oppure digitare nella casella un valore 

compreso tra 0 e 100. Per valori in pixel, è possibile impostare un valore massimo pari a metà della lunghezza del 

lato più corto del rettangolo.

Per ottenere angoli arrotondati, premere i tasti Freccia su o Freccia giù mentre si trascina. Per ridurre la curva, 

usare i tasti Freccia giù o Freccia sinistra.

Disegnare un poligono base

Lo strumento Poligono consente di disegnare poligoni equilateri (inclusi i triangoli), partendo da un punto centrale.

1 Selezionate Finestre > Proprietà forme automatiche.

2 Fate clic sullo strumento Poligono.

3 Effettuate una delle seguenti operazioni:

• Trascinate i controlli gialli sul numero di lati desiderato.

• Nella finestra di dialogo Proprietà forme automatiche, impostate i punti e i lati come richiesto.

Disegnare una stella

1 Fate clic in un punto qualsiasi del pannello Strumenti e premete U.

2 Fate clic sulla piccola icona freccia rivolta verso il basso e selezionate l'icona Stella dal menu.

http://www.adobe.com/go/learn_fw_preserverectangleround_it
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3 Effettuate una delle seguenti operazioni:

• Selezionate Finestra > Proprietà forme automatiche. Personalizzate la stessa utilizzando diverse opzioni nella 

finestra di dialogo Proprietà forma automatica.

• Trascinate i punti gialli sulla stella. Spostate il mouse sul punto giallo. Viene visualizzato un suggerimento che 

descrive la sua funzione.

Per vincolare l’orientamento della stella a incrementi di 45°, tenere premuto Maiusc mentre si trascina.

Modifica/salva rettangoli di base

Le opzioni di modifica e salvataggio dei rettangoli di base sono disponibili nella finestra di ispezione Proprietà solo se 

il rettangolo non è compreso in un gruppo. 

Non è possibile modificare la rotondità degli angoli di un rettangolo utilizzando la finestra di ispezione Proprietà se 

questo è stato separato dal gruppo. Tuttavia, è possibile utilizzare lo strumento vettoriale per cambiare la rotondità 

degli angoli del rettangolo.

Opzioni di tratto della finestra di ispezione Proprietà prima della separazione del rettangolo.

Opzioni di tratto della finestra di ispezione Proprietà dopo la separazione del rettangolo.

Forme automatiche

A differenza degli altri gruppi di oggetti, le forme automatiche hanno, oltre alle maniglie per i gruppi di oggetti, punti 

di controllo a forma di rombo. Il trascinamento di un punto di controllo altera solo la proprietà visiva associata. La 

maggior parte dei punti di controllo presenta descrizioni comandi che spiegano in che modo il punto modifica la 

forma automatica.

Gli strumenti Forme automatiche consentono di creare forme con orientamenti predefiniti. Ad esempio, lo strumento 

Freccia consente di disegnare frecce in orizzontale. Allo stesso modo, per la forma automatica Stella, fare clic e 

trascinare il punto di controllo sinistro verso l’alto o verso il basso in verticale per modificare il numero delle punte. È 

possibile utilizzare gli altri punti di controllo per modificare la “nitidezza” e la “profondità” delle punte.

Per informazioni sulla modifica dell’orientamento, vedete “Trasformare e distorcere oggetti e selezioni” a pagina 46.
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Gli strumenti di Forma automatica
Freccia Semplici frecce di qualsiasi proporzionee linee rette o curve.

Linea di freccia Linee di freccia rette e sottili con possibilità di scegliere tra diverse punte di freccia comuni (fare clic 

sulle estremità della linea).

Rettangolo smussato Rettangoli con angoli smussati.

Rettangolo bisellato Rettangoli con biselli (angoli arrotondati verso la parte interna del rettangolo). 

Linea connettore Linee connettore a tre segmenti, come quelle utilizzate per connettere gli elementi di un diagramma 

di flusso o un organigramma. 

Ciambella Anelli riempiti. 

Forma a L Forme con angoli retti. 

Strumento Misura Linee di freccia semplici che indicano le dimensioni degli elementi di progettazione principali in 

pixel o in pollici.

Torta Aerogrammi. 

Rettangolo arrotondato Rettangoli con angoli arrotondati.

Poligono intelligente Poligoni equilateri con un numero di lati compreso tra 3 e 25. 

Spirale Spirali aperte. 

Stella Stelle con un numero di punte compreso tra 3 e 25. 

Disegnare una forma automatica

1 Nella sezione Vettore del pannello Strumenti, selezionare uno strumento Forma automatica dal menu a comparsa.

2 Effettuare una delle seguenti operazioni:

• Trascinare il puntatore sull’area di lavoro per disegnare la forma.

• Fare clic sull’area di lavoro per assegnare alla forma le dimensioni predefinite.

Aggiungere un’ombra a una forma automatica

Il comando Aggiungi ombra consente di aggiungere un’ombra sotto l’oggetto selezionato, le cui dimensioni variano a 

seconda di quelle dell’oggetto. L’ombra è fondamentalmente una forma automatica con punti di controllo che 

consentono di modificarne l’aspetto. Ad esempio, è possibile tenere premuto il tasto Maiusc e trascinare il punto di 

controllo direzione per vincolarne lo spostamento a incrementi di 45 gradi. Se si fa clic sul punto di controllo direzione, 

viene ripristinata la forma originale dell’ombra. Il comando Aggiungi ombra posiziona automaticamente la nuova 

ombra indietro di un livello. Se non si applica questo comando a un solo oggetto all’inizio del livello corrente, l’ombra 

appare sopra l’oggetto selezionato.

1 Selezionare un oggetto sull’area di lavoro.

2 Selezionare Comandi > Creatività > Aggiungi ombra.

3 (Facoltativo) Per modificare l’ombra, effettuare una delle operazioni descritte di seguito:

• Trascinare il punto di controllo direzione per vincolarne lo spostamento a incrementi di 45 gradi.

• Fare clic sul punto di controllo direzione per ripristinare l’ombra (le dimensioni sono identiche a quelle della 

forma originale).

• Fare clic tenendo premuto il tasto Ctrl o Comando sul punto di controllo direzione per ripristinare solo l’asse x.
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• Fare doppio clic sul punto di controllo prospettiva per ripristinare solo la larghezza dell’ombra.

Modificare le proprietà di Forma automatica in modo esatto

Il pannello Proprietà forma automatica consente di controllare in modo preciso gli elementi numerici di una forma 

automatica selezionata o di inserire un’altra forma nel documento.

Nota: questo pannello supporta solo le forme automatiche che sono visualizzate nel pannello Strumenti. Non supporta 

forme automatiche di terze parti o quelle contenute nel pannello Forme (Finestra > Forme automatiche).

Le proprietà da modificare dipendono dal tipo di Forma automatica. 

1 Inserire una forma automatica nel documento.

2 Selezionare Finestra > Proprietà forma automatica.

3 Regolare le proprietà.

Per le forme rettangolari, è possibile bloccare gli angoli della forma, in modo che le modifiche apportate a un 

angolo vengano applicate a tutti i quattro angoli. Le proprietà possono anche essere modificate singolarmente per 

ogni angolo.

4 Per applicare le modifiche, premere il tasto Tab o Invio.

Per apportare ulteriori modifiche alla forma automatica nell’area di lavoro, utilizzare i punti di controllo. I valori 

corrispondenti nel pannello Proprietà forma automatica vengono aggiornati in modo dinamico.

Modificare le proprietà di Forma automatica mediante i punti di controllo

Selezionare una forma automatica, quindi utilizzare i punti di controllo gialli per regolarne le proprietà. 

I nomi dei punti di controllo ne rivelano la funzione. Per visualizzare un nome, posizionare il mouse su un punto di 

controllo fino a quando non appare la descrizione.

Regolare le forme automatiche freccia

• Per regolare la luminosità e la nitidezza della punta della freccia, trascinare i punti di controllo relativi alla punta e 

alle dimensioni della freccia.

• Per regolare la larghezza, l’altezza, lo spessore e la smussatura dell’angolo della coda, trascinare il punto di controllo 

con il nome corrispondente.

Per creare una freccia curva, trascinare il punto di controllo relativo a larghezza o altezza verso sinistra o destra.

Regolare le forme automatiche Linea di freccia

• Per passare da un’opzione punta di freccia all’altra, fare clic su un punto di controllo di una delle estremità della 

linea.

• Per estendere o ridurre la linea, trascinare un punto di controllo.

Regolare rettangoli smussati, bisellati e arrotondati

• Per regolare tutti gli angoli di un rettangolo contemporaneamente, trascinare un punto di controllo d’angolo.

• Per regolare un solo angolo di un rettangolo, trascinare un punto di controllo d’angolo tenendo premuto il tasto 

Alt (Windows) o Opzione (Mac OS).
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• Per ridimensionare un rettangolo senza che gli angoli vengano modificati, trascinare il punto di controllo che 

consente di trascinare per ridimensionare.

• Per convertire tutti gli angoli di un rettangolo, fare clic su un punto di controllo d’angolo.

• Per convertire un singolo angolo in un tipo diverso, fare clic tenendo premuto il tasto Alt (Windows) o Opzione 

(Mac OS) su un punto di controllo d’angolo.

Regolare le forme automatiche dello strumento Linea connettore

• Per spostare il punto iniziale o finale, trascinare il punto di controllo all’inizio o alla fine della linea connettore.

• Per riposizionare la barra a croce, trascinare il punto di controllo della posizione orizzontale.

• Per regolare tutti gli angoli, trascinare un punto di controllo d’angolo.

• Per regolare un solo angolo, trascinare un punto di controllo d’angolo tenendo premuto il tasto Alt (Windows) o 

Opzione (Mac OS).

Regolare le forme automatiche Ciambella

Ogni forma automatica a ciambella ha originariamente tre punti di controllo. Per ogni nuova sezione aggiunta, 

Fireworks aggiunge un punto di controllo per ridimensionarla o dividerla.

• Per aggiungere sezioni, trascinare il punto di controllo di aggiunta/divisione settore sul perimetro esterno della 

forma tenendo premuto Alt (Windows) o Opzione (Mac OS).

• Per rimuovere una sezione, trascinare il punto di controllo aggiunta/divisione settore sul perimetro esterno della 

forma per definire la parte di essa che si desidera mantenere sull’area di lavoro.

• Per ridimensionare il raggio interno, trascinare il relativo punto di controllo.

• Per impostare su zero il raggio interno, fare clic sul punto di controllo che consente di reimpostare il raggio.

Regolare le forme automatiche a forma di L

• Per modificare l’altezza o la larghezza di una sezione, trascinare uno dei due punti di controllo relativi ad 

altezza/larghezza.

• Per regolare la smussatura degli angoli, trascinare il punto di controllo relativo al raggio dell’angolo.

Regolare le forme automatiche dello strumento Misura

• Per modificare la lunghezza o l’angolo della sezione misurata, trascinare un punto di controllo di una delle 

estremità della linea. 

• Per far passare le unità da pixel a pollici, tenere premuto Ctrl (Windows) o Comando (Mac OS) mentre viene 

trascinato un punto di controllo di una delle estremità.

• Per estendere o ridurre le linee dei margini di un’area misurata, trascinare un punto di controllo su una delle 

estremità delle misura numerica.

Lo strumento Misura è utile quando si creano specifiche di interfaccia. Per nascondere le misure, fare clic sull’icona 

occhio nel pannello Livelli.

Regolare le forme automatiche Torta

Ogni torta ha originariamente tre punti di controllo, Per ogni nuova sezione aggiunta, Fireworks aggiunge un punto 

di controllo per ridimensionarla o dividerla.

• Per aggiungere sezioni, trascinare il punto di controllo di trascinamento sul segmento sul perimetro esterno della 

forma tenendo premuto Alt (Windows) o Opzione (Mac OS).
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• Per ridimensionare una sezione di torta, trascinare sul perimetro esterno della forma un punto di controllo di 

trascinamento sul segmento.

• Per ripristinare la torta su una sezione, fare clic sul punto di controllo per le reimpostazione.

Regolare forme automatiche Poligono intelligente

• Per ridimensionare o ruotare il poligono, trascinare il punto di controllo per la modifica in scala/rotazione. Per 

effettuare solo una rotazione, trascinare il punto di controllo per la modifica in scala/rotazione tenendo premuto il 

tasto Alt (Windows) o Opzione (Mac OS). 

• Per aggiungere o rimuovere sezioni, trascinare il punto di controllo relativo alle sezioni.

• Per modificare il numero di lati, trascinare il punto di controllo relativo ai lati.

• Per dividere il poligono in segmenti, trascinare il punto di controllo relativo ai lati tenendo premuto il tasto Alt 

(Windows) o Opzione (Mac OS).

• Per ridimensionare un poligono interno, trascinare il relativo punto di controllo.

• Per reimpostare un poligono interno, fare clic sul relativo punto di controllo.

Regolare le forme automatiche Spirale

• Per regolare il numero di spire, trascinare il punto di controllo relativo alla spirale.

• Per aprire o chiudere la spirale, fare clic sul punto di controllo per l’apertura/chiusura della spirale.

Regolare le forme automatiche Stella

• Per modificare il numero di lati, trascinare il punto di controllo delle punte.

• Per regolare le valli, trascinare il punto di controllo delle valli.

• Per regolare le punte, trascinare il punto di controllo dei vertici.

• Per regolare la smussatura di valli e vertici, trascinare un punto di controllo della smussatura.

Utilizzare forme automatiche aggiuntive

Il pannello Forme automatiche contiene forme automatiche aggiuntive più complesse rispetto a quelle disponibili nel 

pannello Strumenti. È possibile inserire nel disegno queste forme automatiche trascinandole dal pannello Forme 

automatiche all’area di lavoro.

1 Selezionare Finestra > Forme automatiche per visualizzare il pannello Forme automatiche.

2 Trascinare l’anteprima di una forma automatica dal pannello Forme automatiche all’area di lavoro.

3 (Facoltativo) Modificare la forma automatica trascinando uno qualsiasi dei suoi punti di controllo.

Aggiungere nuove forme automatiche a Fireworks

È possibile aggiungere nuove forme automatiche scaricandole dal sito Web di Adobe® Fireworks®. Le nuove forme 

automatiche vengono visualizzate nel pannello Forme automatiche o nel menu Strumenti.

È inoltre possibile aggiungere nuove forme automatiche scrivendo il codice JavaScript. Per ulteriori informazioni, 

consultare Estensione di Fireworks.

1 Selezionare Finestra > Forme automatiche per visualizzare il pannello Forme automatiche.

2 Nel menu Opzioni, selezionare Richiama altre forme automatiche.
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3 Nel sito Web di Exchange, seguire le istruzioni visualizzate per aggiungere nuove forme.

Forme libere

È possibile trascinare e modificare tracciati vettoriali per creare oggetti vettoriali di praticamente qualsiasi forma.

Disegnare tracciati a forma libera mediante lo strumento Tracciato vettoriale

Lo strumento Tracciato vettoriale, nel menu a comparsa dello strumento Penna, crea un effetto simile a quello 

prodotto da un pastello colorato o un pennarello a punta spessa. 

Lo strumento dispone di una vasta gamma di categorie di tratti pennello, fra cui Aerografo, Calligrafia, Carboncino, 

Pastello colorato e Innaturale. Ciascuna categoria dispone di dozzine di tratti, tra cui Pennarello chiaro e Pennarello 

scuro, Spruzzo di vernice, Bambù, Nastro, Coriandoli, 3D, Dentifricio e Vernice aliena viscosa.

Sebbene i tratti possano avere l’aspetto di vernice o inchiostro, sono dotati di punti e tracciati, come ogni altro oggetto 

vettoriale. Ciò significa che è possibile modificare la forma dei tratti con numerose tecniche di modifica vettoriale. 

Dopo aver rimodellato il tracciato, il tratto viene ridisegnato. È inoltre possibile modificare i tratti pennello esistenti e 

aggiungere riempimenti a oggetti selezionati disegnati con lo strumento Tracciato vettoriale. 

Consultare “Applicazione di colori, tratti e riempimenti” a pagina 111.

1 Dal menu a comparsa dello strumento Penna, selezionare lo strumento Tracciato vettoriale .

2 (Facoltativo) Impostare gli attributi di tratto e le opzioni dello strumento Tracciato vettoriale nella finestra di 

ispezione Proprietà. (Facoltativo) Per un’attenuazione più accurata del tracciato, selezionare un numero dal menu 

a comparsa Precisione nella finestra di ispezione Proprietà per lo strumento Tracciato vettoriale. A un valore 

maggiore corrisponde un maggior numero di punti sul tracciato disegnato.

3 Trascinare per disegnare. Per vincolare il tracciato a una linea orizzontale o verticale, tenere premuto il tasto Maiusc 

durante il trascinamento.

4 Rilasciare il pulsante del mouse alla fine del tracciato. Per chiudere il tracciato, rilasciare il pulsante del mouse dopo 

aver riportato il puntatore al punto iniziale del tracciato.

Disegnare tracciati a forma libera tracciando punti con lo strumento Penna

Tracciare dei punti è un’operazione simile a disegnare un’immagine collegando punti prestabiliti. Quando si fa clic su 

un punto con lo strumento Penna, viene disegnato automaticamente il tracciato dell’oggetto vettoriale a partire 

dall’ultimo punto su cui si è fatto clic. 

Oltre a collegare i punti con segmenti retti, con lo strumento Penna si possono disegnare curve uniformi, derivate da 

descrizioni matematiche, note come curve di Bézier. Ogni tipo di punto, punto d’angolo o punto curva, determina la 

natura rettilinea o curva del segmento adiacente. 
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Trascinandone i punti è possibile modificare segmenti rettilinei o curvi dei tracciati. I segmenti curvi di tracciati 

possono essere modificati anche trascinandone le maniglie punto. È possibile inoltre convertire un segmento rettilineo 

in uno curvo e viceversa, convertendone i punti.

Disegnare un tracciato con segmenti rettilinei

1 Nel pannello Strumenti, selezionare lo strumento Penna.

2 (Facoltativo) Selezionare Modifica > Preferenze (Windows) o Fireworks > Preferenze (Mac OS X) e selezionare una 

delle opzioni della scheda Modifica, quindi fare clic su OK:

Mostra Anteprima penna Consente di visualizzare un’anteprima del segmento risultante dall’operazione.

Mostra punti solidi Consente di visualizzare i punti solidi mentre si disegna.

3 Fare clic nell’area di lavoro per posizionare il primo punto d’angolo.

4 Spostare il puntatore e fare clic per posizionare il punto successivo.

5 Continuare il tracciamento dei punti. I segmenti rettilinei colmano gli spazi intercorrenti tra i punti.

6 Effettuare una delle seguenti operazioni:

• Fare doppio clic sull’ultimo punto per terminare il tracciato come aperto.

• Selezionare un altro strumento per terminare il tracciato come aperto. 

Nota: se si sceglie un altro strumento, eccetto lo strumento Testo, e si torna poi allo strumento Penna, l’operazione 

di disegno viene ripresa al clic successivo.

• Per chiudere il tracciato, fare clic sul primo punto disegnato. I punti iniziale e finale di un tracciato chiuso 

coincidono.

Nota: le forme definite da un tracciato che si sovrappone a sé stesso non sono tracciati chiusi. Solo i tracciati che 

iniziano e finiscono nello stesso punto costituiscono tracciati chiusi.

Disegnare un tracciato con segmenti curvi

1 Nel riquadro Strumenti, selezionare lo strumento Penna.

2 Fare clic per posizionare il primo punto d’angolo.

3 Passare alla posizione del punto seguente, quindi trascinare per produrre un punto curva. Ogni volta che si trascina, 

Fireworks estende il segmento di linea al nuovo punto.

4 Continuare il tracciamento dei punti. Se si trascina un nuovo punto, si produce un punto curva, mentre se si fa solo 

clic, si produce un punto d’angolo.

Per modificare la posizione dei punti e la forma delle curve man mano che si disegna, è possibile passare 

temporaneamente allo strumento Sottoselezione. Premere il tasto Ctrl (Windows) o Comando (Mac OS) mentre 

si trascina un punto o una maniglia punto con lo strumento Penna.
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5 Effettuare una delle seguenti operazioni: 

• Per terminare il tracciato come tracciato aperto, fare doppio clic sull’ultimo punto o selezionare un altro 

strumento. Quando si scelgono determinati strumenti e si torna poi allo strumento Penna, l’operazione di 

disegno dell’oggetto viene ripresa al clic successivo.

• Per chiudere il tracciato, fare clic sul primo punto disegnato. I punti iniziale e finale di un tracciato chiuso 

coincidono.

Convertire segmenti di un tracciato in segmenti curvi o rettilinei

I segmenti di tracciato rettilinei sono intersecati da punti d’angolo. I segmenti di tracciato curvi contengono punti 

curva. 

È possibile convertire un segmento rettilineo in uno curvo e viceversa, convertendone il punto. 

Convertire un punto d’angolo in un punto curva

1 Nel pannello Strumenti, selezionare lo strumento Penna.

2 Fare clic su un punto d’angolo di un tracciato selezionato e trascinarlo.

Le maniglie si estenderanno, curvando i segmenti adiacenti. 

Nota: per modificare le maniglie di un punto, scegliere lo strumento Sottoselezione oppure premere il tasto Ctrl 

(Windows) o Comando (Mac OS) mentre è attivo lo strumento Penna.

Convertire un punto curva in punto d’angolo

1 Nel pannello Strumenti, selezionare lo strumento Penna.

2 Fare clic su un punto curva di un tracciato selezionato. 



86UTILIZZO DI FIREWORKS

Operazioni con gli oggetti vettoriali

Ultimo aggiornamento 4/5/2011

Le maniglie si ritraggono e i segmenti adiacenti si raddrizzano. 

Modificare tracciati a forma libera mediante i punti e le maniglie punto

Lo strumento Sottoselezione  nel pannello Strumenti consente di selezionare più punti. Prima di selezionare un 

punto con lo strumento Sottoselezione, è necessario selezionare il tracciato con lo strumento Puntatore o lo strumento 

Sottoselezione oppure facendo clic sulla miniatura del tracciato nel pannello Livelli.

Selezionare punti specifici su un tracciato selezionato

❖ Con lo strumento Sottoselezione, effettuare una delle seguenti operazioni:

• Fare clic su un punto, oppure tenere premuto il tasto Maiusc e fare clic su più punti, uno per volta. 

• Trascinare attorno ai punti da selezionare.

Inserire un punto su un tracciato selezionato 

L’aggiunta di punti a un tracciato offre la possibilità di controllare un segmento specifico all’interno del tracciato. 

❖ Con lo strumento Penna fare clic ovunque sul tracciato, eccetto su un punto.

Eliminare un punto da un tracciato selezionato 

L’eliminazione di punti da un tracciato lo rimodella o ne semplifica la modifica.

❖ Effettuare una delle seguenti operazioni:

• Fare clic su un punto d’angolo di un oggetto selezionato con lo strumento Penna.

• Fare clic su un punto curva di un oggetto selezionato con lo strumento Penna.

• Selezionare un punto con lo strumento Sottoselezione e premere Canc o Backspace.

Spostare un punto

❖ Trascinarlo con lo strumento Sottoselezione.

Modificare un segmento rettilineo 

1 Selezionare il tracciato utilizzando lo strumento Puntatore o Sottoselezione.

2 Fare clic su un punto con lo strumento Sottoselezione.
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I punti d’angolo selezionati appaiono come quadratini di colore blu uniforme.

3 Per spostare il punto in una nuova posizione, trascinarlo con il puntatore del mouse o utilizzare i tasti freccia.

Modificare la forma di un segmento curvo 

1 Selezionare il tracciato utilizzando lo strumento Puntatore o Sottoselezione.

2 Fare clic su un punto curva con lo strumento Sottoselezione.

Un punto curva selezionato viene visualizzato come un cerchietto blu uniforme. Le maniglie punto si estendono 

dal punto. 

3 Trascinare le maniglie in una nuova posizione. Per vincolare la direzione di spostamento delle maniglie a 

incrementi di 45°, tenere premuto Maiusc mentre si trascina.

L’anteprima azzurra del tracciato mostra il punto nel quale il nuovo tracciato viene disegnato se si rilascia il 

pulsante del mouse. 

A. Maniglia punto  B. Punto selezionato  C. Puntatore di sottoselezione  D. Anteprima tracciato  E. Tracciato  

Ad esempio, se si trascina verso il basso la maniglia punto sinistra, la maniglia punto destra si sposta verso l’alto. 

Per spostare una maniglia indipendentemente dall’altra, premere il tasto Alt durante il trascinamento.

Regolare la maniglia di un punto d’angolo

1 Con lo strumento Sottoselezione, selezionare un punto d’angolo.

2 Trascinare il punto tenendo premuto Alt (Windows) o Opzione (Mac OS) per visualizzarne la maniglia e curvare 

il segmento adiacente.

CBA

E

D



88UTILIZZO DI FIREWORKS

Operazioni con gli oggetti vettoriali

Ultimo aggiornamento 4/5/2011

Trascinare la maniglia di un punto d’angolo con lo strumento Sottoselezione per modificare il segmento adiacente del tracciato

Estendere e unire tracciati a forma libera

Utilizzare lo strumento Penna per proseguire il disegno di un tracciato aperto preesistente per unire i tracciati.

Riprendere il disegno di tracciati aperti

1 Nel pannello Strumenti, selezionare lo strumento Penna.

2 Fare clic sull’estremità finale e continuare a disegnare il tracciato.

Unire due tracciati aperti 

Quando si collegano due tracciati, gli attributi di tratto, riempimento e filtro del tracciato superiore diventano gli 

attributi del nuovo tracciato.

1 Selezionare lo strumento Penna nel pannello Strumenti.

2 Fare clic sul punto finale di uno dei tracciati.

3 Spostare il puntatore del mouse sul punto finale dell’altro tracciato e fare clic.

Unione automatica di tracciati aperti simili

È possibile unire un tracciato aperto a un altro dotato di caratteristiche simili di tratto e riempimento.

1 Selezionare un tracciato aperto.

2 Scegliere lo strumento Sottoselezione e trascinare un punto finale del tracciato entro pochi pixel dal punto di 

estremità del tracciato simile. 

Forme composte

Creare forme composte

È possibile creare una forma composta utilizzando dei tracciati vettoriali semplici come il rettangolo, l’ellisse, e altri 

tracciati vettoriali. I singoli oggetti di una forma composta possono essere spostati e modificati utilizzando lo 

strumento Sottoselezione anche dopo la loro combinazione. Nella modalità Forma composta, tutti i nuovi oggetti 

vettoriali vengono aggiunti allo stesso oggetto nel pannello dei livelli. Per aggiungere oggetti a un oggetto diverso, 

uscite dalla modalità utilizzando il pulsante Normale.

È possibile creare delle forme composte tramite una delle seguenti operazioni:

• Creare un vettore, selezionare un’operazione di forma composta come Aggiungi o Sottrai e disegnare altri vettori.

• Creare diversi vettori e utilizzare l’operazione per la forma composta.
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Applicare la forma composta dopo aver creato diversi oggetti vettoriali.

1 Selezionare tutti gli oggetti che si desidera includere nella forma composta. Tutti i tracciati aperti selezionati 

vengono automaticamente chiusi.

2 Selezionare uno strumento vettoriale (rettangolo, ellisse, penna o tracciato vettoriale) nella tavolozza degli 

strumenti.

3 Nella finestra di ispezione Proprietà, selezionate una delle seguenti opzioni.

• Aggiungi/Unione 

• Sottrai/Ritaglio interno 

• Intersezione 

• Ritaglia

Per l’operazione di ritaglio interno, l’ultimo oggetto inserito viene ritagliato dal resto degli oggetti. Anche l’operazione 

di ritaglio interno effettuata tramite Elabora > Combina tracciati funziona in questo modo.

Applicare la forma composta prima di creare più oggetti vettoriali.

1 Creare un oggetto vettoriale.

2 Nella finestra di ispezione Proprietà, selezionate una delle seguenti opzioni.

• Aggiungi/Unione 

• Sottrai/Ritaglio interno 

• Intersezione 

• Ritaglia

3 Disegnare altri oggetti al di sopra del primo oggetto per ottenere l’effetto desiderato.

Convertire le forme composte in un tracciato composito

Non è possibile spostare e modificare i singoli oggetti dopo aver convertito una forma composta in un tracciato 

composito.

❖ Per convertire una forma composta in un tracciato composito, fare clic sul pulsante Combina.

Tecniche speciali di modifica vettoriale

Oltre al trascinamento dei punti e delle maniglie punto, è possibile utilizzare diversi strumenti Fireworks per 

modificare direttamente gli oggetti vettoriali. È possibile inoltre ricorrere alle operazioni sui tracciati per creare nuove 

forme unendo o alterando i tracciati esistenti. Inoltre, è possibile utilizzare il pannello Tracciato per accedere in modo 

rapido ai comandi per i tracciati.

Per informazioni sui nuovi strumenti di modifica dei vettori disponibili in Fireworks CS4, vedere 

http://www.adobe.com/devnet/fireworks/articles/vector_manipulation_tools_02.html.

Apportare modifiche con gli strumenti vettoriali

Gli strumenti vettoriali sono visualizzati nel pannello Strumenti.

http://www.adobe.com/devnet/fireworks/articles/vector_manipulation_tools_02.html
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Deformare e ridimensionare oggetti vettoriali con lo strumento Forma libera

Lo strumento Forma libera consente di deformare e rimodellare gli oggetti vettoriali direttamente senza manipolarne 

i punti. È possibile deformare verso l’esterno o l’interno qualsiasi parte di un tracciato, a prescindere dalla posizione 

dei punti. Fireworks consente di aggiungere, spostare o eliminare i punti lungo il tracciato mentre si modifica la forma 

dell’oggetto vettoriale.

Strumento Forma libera che effettua la deformazione di un segmento di tracciato; A indica la lunghezza specificata

Strumento Forma libera che deforma verso l’interno un tracciato

Portando il puntatore del mouse su un tracciato selezionato, si trasforma nel puntatore di deformazione verso l’interno 

o verso l’esterno, a seconda della sua posizione relativa rispetto al tracciato selezionato. È possibile modificare le 

dimensioni di entrambi i puntatori di deformazione.

Nota: lo strumento Forma libera risponde inoltre alla pressione delle tavolette Wacom o compatibili.

Deformare verso l’esterno un tracciato selezionato

Quando il puntatore si trova direttamente sul tracciato, è possibile deformarlo verso l’esterno. 

1 Nel pannello Strumenti, selezionare lo strumento Forma libera . 

2 Portare il puntatore direttamente sopra il tracciato selezionato.

3 Trascinare il tracciato.

Puntatore Significato

Lo strumento Forma libera è in uso.

Lo strumento Forma libera è in uso e il cursore di deformazione verso l’esterno è in posizione per modificare il tracciato 

selezionato.

Lo strumento Forma libera è in uso e il cursore di deformazione verso l’esterno sta intervenendo sul tracciato selezionato.

Lo strumento Forma libera è in uso e il cursore di deformazione verso l’interno è attivo.

Lo strumento Rimodellazione area è in uso e il cursore è attivo. L’area compresa tra il cerchio interno e quello esterno 

rappresenta l’intensità ridotta.

A
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Deformare verso l’interno un tracciato selezionato 

Quando il puntatore non si trova direttamente sul tracciato, è possibile deformarlo verso l’interno. 

1 Nel pannello Strumenti, selezionare lo strumento Forma libera.

2 Puntare su una posizione leggermente scostata dal tracciato.

3 Trascinare in direzione del tracciato per deformarlo verso l’interno. Per rimodellare il tracciato selezionato, 

procedere con movimenti minimi.

Modificare le dimensioni del puntatore di deformazione

❖ Effettuare una delle seguenti operazioni:

• Tenendo premuto il pulsante del mouse, premere il tasto Freccia destra o il tasto numerico 2 per aumentare le 

dimensioni del puntatore.

• Tenendo premuto il pulsante del mouse, premere il tasto Freccia sinistra o il tasto numerico 1 per diminuire la 

larghezza del puntatore.

• Per impostare le dimensioni del puntatore (in pixel) e la lunghezza del segmento del tracciato interessato, 

deselezionare tutti gli oggetti nel documento quindi immettere un valore compreso tra 1 e 500 nella casella 

Dimensioni della finestra di ispezione Proprietà. 

Distorcere tracciati selezionati con lo strumento Rimodellazione area

Lo strumento Rimodellazione consente di deformare verso l’esterno l’area di tutti i tracciati selezionati senza superare 

il perimetro del cerchio esterno del puntatore di rimodellazione. 

Il cerchio interno del puntatore rappresenta i limiti dello strumento a intensità piena. L’area compresa tra il cerchio 

interno e quello esterno consente di rimodellare i tracciati a intensità inferiore. Il cerchio esterno del puntatore 

determina l’intensità gravitazionale della spinta di distorsione del puntatore. Tale intensità può essere definita 

dall’utente.

Nota: anche lo strumento Rimodellazione area risponde alla pressione delle tavolette Wacom o compatibili.

1 Dal menu a comparsa dello strumento Forma libera, selezionare lo strumento Rimodellazione area.

2 Trascinare sui tracciati per ridisegnarli.
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Modificare le dimensioni del puntatore area di deformazione

❖ Effettuare una delle seguenti operazioni:

• Tenendo premuto il pulsante del mouse, premere il tasto Freccia destra o il tasto numerico 2 per aumentare le 

dimensioni del puntatore. 

• Tenendo premuto il pulsante del mouse, premere il tasto Freccia sinistra o il tasto numerico 1 per diminuire la 

larghezza del puntatore.

• Per impostare le dimensioni del puntatore (in pixel) e la lunghezza del segmento del tracciato interessato, 

deselezionare tutti gli oggetti nel documento quindi immettere un valore compreso tra 1 e 500 nella casella 

Dimensioni della finestra di ispezione Proprietà.

Impostare l’intensità del cerchio interno del puntatore di rimodellazione area

❖ Nella casella Forza della finestra di ispezione Proprietà, immettere un valore compreso tra 1 e 100 per specificare la 

percentuale di forza del puntatore. A valori percentuali più elevati corrisponde un’intensità maggiore.

Ridisegnare o estendere un segmento del tracciato selezionato con lo strumento Ridisegna 
tracciato

Quando si utilizza lo strumento Ridisegna tracciato, le caratteristiche relative a effetto, riempimento e tratto del 

tracciato vengono mantenute.

1 Dal menu a comparsa dello strumento Penna, selezionare lo strumento Ridisegna tracciato . 

2 (Facoltativo) Per modificare il livello di precisione dello strumento Ridisegna tracciato, selezionare un numero dal 

menu a comparsa nel riquadro Precisione della finestra di ispezione Proprietà. A un valore maggiore corrisponde 

un maggior numero di punti sul tracciato.

3 Spostare il puntatore direttamente sul tracciato.

4 Trascinare per ridisegnare o estendere un segmento del tracciato. 

5 Rilasciare il pulsante del mouse.

Modificare l’aspetto del tracciato variando la pressione e la velocità con gli strumenti 
Rettifica tracciato

Scegliendo pressioni e velocità diverse, si possono modificare le proprietà del tratto di un tracciato. La scheda 

Sensibilità della finestra di dialogo Modifica tratto consente di specificare quali di queste proprietà sono interessate 

dagli strumenti Rettifica tracciato. È inoltre possibile specificare in quale misura la pressione e la velocità possono 

modificare queste proprietà. 

Per informazioni dettagliate sull’impostazione delle opzioni nella finestra di dialogo Modifica tratto, consultare 

“Applicare e modificare tratti” a pagina 120.

Suddividere un tracciato in più oggetti con lo strumento Coltello

1 Nel pannello Strumenti, selezionare lo strumento Coltello .

Nota: con lo strumento Gomma sulla penna Wacom si seleziona automaticamente lo strumento Coltello.
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2 Effettuare una delle seguenti operazioni:

• Trascinare il puntatore sul tracciato.

• Fare clic sul tracciato.

3 Deselezionare il tracciato.

Effettuare modifiche con le operazioni sui tracciati

È possibile utilizzare le operazioni tracciato del menu Elabora per creare nuove forme unendo o alterando tracciati 

esistenti. Per alcune operazioni sui tracciati, l’ordine di sovrapposizione degli oggetti tracciato selezionati definisce le 

modalità di funzionamento delle operazioni stesse. 

Per informazioni sull’assegnazione dell’ordine di sovrapposizione degli oggetti selezionati, vedete “Definire l’ordine di 

sovrapposizione degli oggetti” a pagina 53.

Nota: le operazioni sui tracciati rimuovono dai tracciati tutte le informazioni su pressione e velocità.

Creare un tracciato continuo a partire da due tracciati aperti

1 Nel pannello Strumenti, scegliere lo strumento Sottoselezione.

2 Selezionare le due estremità finali dei due tracciati aperti.

3 Selezionare Elabora > Combina tracciati > Unisci.

Creare un tracciato composito

1 Selezionare due o più tracciati aperti o chiusi.

2 Selezionare Elabora > Combina tracciati > Unisci.

Separare un tracciato composito

1 Selezionare il tracciato composito.

2 Selezionare Elabora > Combina tracciati > Dividi.

Combinare tracciati chiusi selezionati in un unico tracciato che racchiude l’area dei tracciati 
originali

❖ Selezionare Elabora > Combina tracciati > Insieme. Il tracciato risultante assume gli attributi di tratto e 

riempimento dell’ultimo oggetto inferiore nell’ordine di sovrapposizione. 

Convertire un tracciato in perimetro di selezione

È possibile convertire una forma vettoriale in una selezione bitmap, quindi utilizzare gli strumenti bitmap per 

modificare la nuova bitmap.

1 Selezionare un tracciato.

2 Selezionare Modifica > Converti tracciato in perimetro.

3 Nella finestra di dialogo Converti tracciato in perimetro, selezionare un’impostazione Bordo per il perimetro di 

selezione.

4 Se si sceglie l’opzione Morbido per l’impostazione Bordo, specificare il valore da utilizzare per il grado di 

morbidezza.

5 Fare clic su OK.
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Nota: la conversione di un tracciato in perimetro comporta l’eliminazione del tracciato selezionato. Per modificare 

questa impostazione predefinita, selezionare Modifica > Preferenze > Modifica, quindi deselezionare l’impostazione 

Elimina tracciati durante la conversione in perimetro di selezione.

Creare un oggetto dall’intersezione di due o più oggetti

❖ Selezionare Elabora > Combina tracciati > Intersezione. Il tracciato risultante assume gli attributi di tratto e 

riempimento dell’ultimo oggetto inferiore nell’ordine di sovrapposizione. 

Rimuovere parti di un oggetto tracciato

È possibile rimuovere le parti di un oggetto tracciato selezionato che si sovrappongono a un secondo oggetto tracciato 

selezionato disposto di fronte al primo.

1 Selezionare l’oggetto tracciato che definisce l’area da rimuovere.

2 Selezionare Modifica > Disponi > In primo piano.

3 Tenere premuto Maiusc e aggiungere alla selezione il tracciato le cui parti si desidera rimuovere.

4 Selezionare Elabora > Combina tracciati > Ritaglio interno. 

Ritagliare un tracciato 

È possibile ritagliare un tracciato utilizzando la forma di un altro tracciato. Il tracciato superiore definisce la forma 

dell’area ritagliata. 

1 Selezionare l’oggetto tracciato che definisce l’area da ritagliare.

2 Selezionare Modifica > Disponi > In primo piano.

3 Tenere premuto il tasto Maiusc e aggiungere alla selezione l’oggetto tracciato da ritagliare.

4 Selezionare Elabora > Combina tracciati > Ritaglio. 
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Il tracciato risultante assume gli attributi di tratto e riempimento dell’ultimo oggetto inferiore nell’ordine di 

sovrapposizione.

Semplificare un tracciato 

Il comando Semplifica consente di eliminare il numero specificato di punti ridondanti di un tracciato. Un esempio di 

punti ridondanti è costituito da più punti su un segmento rettilineo o punti giacenti esattamente uno sopra l’altro.

1 Selezionare Elabora > Modifica tracciato > Semplifica. 

2 Immettere un valore di semplificazione e fare clic su OK.

Se si semplifica un tracciato, aumentano le probabilità che Fireworks possa modificare tale tracciato per ridurre il 

numero di punti sul tracciato stesso.

Espandere il tratto di un oggetto selezionato 

È possibile convertire il tratto di un tracciato selezionato in un tracciato chiuso. Il risultato crea l’illusione di un 

tracciato privo di riempimento e di un tratto con gli stessi attributi di riempimento dell’oggetto originale. 

Nota: espandendo il tratto di un tracciato che interseca se stesso si possono ottenere risultati interessanti. Se il tracciato 

originale contiene un riempimento, le porzioni del tracciato che si intersecano non conterranno un riempimento dopo 

l’espansione del tratto.

1 Selezionare Modifica > Modifica tracciato > Espandi tratto. 

2 Impostare la larghezza del tracciato chiuso risultante.

3 Scegliere un tipo di angolo.

4 Se si sceglie acuto, occorre impostarne il limite, vale a dire la soglia oltre al quale l’angolo acuto diventa un angolo 

con smusso. Tale limite corrisponde al rapporto tra la lunghezza dell’angolo acuto e la larghezza del tratto.

5 Selezionare un’opzione per l’estremità della linea e fare clic su OK.

Contrarre o espandere un tracciato

1 Selezionare Modifica > Modifica tracciato > Tracciato concentrico. 

2 Scegliere una direzione per la contrazione o l’espansione del tracciato:

Interno Contrae il tracciato.

Esterno Espande il tracciato.

3 Impostare la larghezza tra il tracciato originale e quello da contrarre o espandere.

4 Scegliere un tipo di angolo.

5 Se si sceglie un angolo acuto, impostarne il limite.

6 Fare clic su OK.



96UTILIZZO DI FIREWORKS

Operazioni con gli oggetti vettoriali

Ultimo aggiornamento 4/5/2011

Modificare i tracciati con il pannello Tracciato

Per accelerare le operazioni di modifica del tracciato, utilizzare gli strumenti riportati di seguito, presenti nel pannello 

Tracciato (Finestra > Altri > Tracciato).

Per ulteriori informazioni, vedete http://www.adobe.com/go/learn_fw_designguide_it

http://www.adobe.com/go/learn_fw_designguide_it
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Capitolo 7: Operazioni con il testo

Adobe® Fireworks® consente di utilizzare molte funzioni solitamente disponibili in applicazioni specifiche per DTP, 

tra cui l’uso di un’ampia gamma di caratteri, dimensioni, regolazione della crenatura, spaziatura, colore, interlinea e 

spostamento linea di base. È possibile modificare il testo in qualsiasi momento, anche dopo aver applicato i filtri attivi, 

ed importare testo modificabile da documenti Adobe Photoshop®.

Immettere testo

Usare lo strumento Testo  e le opzioni nella finestra di ispezione Proprietà per inserire, formattare e modificare il 

testo negli elementi grafici.

Nota: se la finestra di ispezione Proprietà è ridotta a icona, fate doppio clic sulla barra della finestra di ispezione per 

visualizzare tutte le proprietà di testo.

Gli oggetti di testo vengono automaticamente salvati con un nome che corrisponde al testo digitato. È possibile 

modificare il nome assegnato nella casella Testo della finestra di ispezione Proprietà o nella miniatura del pannello 

oggetto nel pannello Livelli.

Gli oggetti di testo nel pannello dei livelli, possono essere identificati utilizzando l’icona T.

Altri argomenti presenti nell’Aiuto 

“Preferenze Testo” a pagina 307

Creare e spostare blocchi di testo

In un documento Fireworks, il testo viene visualizzato all’interno di un blocco di testo (si tratta di un rettangolo con 

maniglie).  I blocchi di testo sono blocchi a ridimensionamento o larghezza fissa.

• Un blocco di testo a ridimensionamento automatico si espande orizzontalmente mentre si digita e si riduce quando 

viene rimosso del testo. I blocchi di testo a ridimensionamento automatico vengono creati per impostazione 

predefinita quando si fa clic sull’area di lavoro con lo strumento Testo e si inizia a digitare.

• I blocchi di testo a larghezza fissa permettono di controllare la larghezza del testo mandato a capo. I blocchi di testo 

a larghezza fissa vengono creati per impostazione predefinita trascinando il cursore e disegnando un blocco di testo 

con lo strumento Testo. 

• Quando è attivo il puntatore del testo all’interno di un blocco di testo, nell’angolo superiore destro di quest’ultimo 

appare un cerchio o un quadrato vuoto. Il cerchio indica un blocco a ridimensionamento automatico, mentre il 

quadrato rappresenta un blocco a larghezza fissa. Fare doppio clic sull’angolo per cambiare il tipo di blocco di testo.

1 Selezionare lo strumento Testo.

2 Selezionare le caratteristiche del testo.

3 Creare un blocco di testo:

• Per creare un blocco di testo a ridimensionamento automatico, fare clic sul documento nel punto in cui si desidera 

iniziare a crearlo.
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• Per creare un blocco di testo a larghezza fissa, trascinare il cursore per disegnare un blocco di testo. Per spostare il 

blocco di testo mentre si trascina per crearlo, tenere premuto il pulsante del mouse, tenere premuta la barra 

spaziatrice, quindi trascinare il blocco di testo in un’altra posizione. 

1 Digitare il testo. 

2 (Facoltativo) Evidenziare il testo all’interno del blocco di testo e riformattarlo.

3 (Facoltativo) Per spostare il blocco di testo, trascinarlo in una nuova posizione. 

4 Effettuare una delle seguenti operazioni:

• Fare clic all’esterno del blocco di testo.

• Selezionare un altro strumento nel pannello Strumenti.

• Premere Esc.

Modificare blocchi di testo a ridimensionamento automatico e a larghezza 

fissa

Un blocco di testo a larghezza fissa e un blocco di testo a ridimensionamento automatico
A. Indicatore di larghezza fissa  B. Indicatore di ridimensionamento automatico  

• Per cambiare un blocco di testo da larghezza fissa a ridimensionamento automatico e viceversa, fare doppio clic nel 

blocco di testo, quindi fare doppio clic sul cerchio o sul quadrato nell’angolo superiore destro del blocco stesso.

• Per modificare un blocco di testo selezionato nel tipo a larghezza fissa tramite ridimensionamento, trascinare una 

maniglia di ridimensionamento.

• Per cambiare in larghezza fissa più blocchi di testo, selezionarli e scegliere Comandi > Testo > Imposta larghezza.

• Per cambiare blocchi di testo a larghezza fissa in blocchi a ridimensionamento automatico, selezionarli e scegliere 

Comandi > Testo > Attiva e disattiva larghezza fissa.

Indicatore di overflow del testo

Quando il testo supera lo spazio che può essere contenuto in un blocco di testo o un percorso, viene visualizzato 

l'indicatore di overflow del testo. Per ulteriori informazioni, vedete http://www.fireworkszone.com/g-2-565.

Selezionare del testo

Selezionare parole e paragrafi

❖ Per selezionare una parola, fare doppio clic su di essa; per selezionare un intero paragrafo, fare triplo clic su di esso.

Selezionare parti di testo in un paragrafo

❖ Per selezionare delle porzioni o delle parti di testo all’interno di un paragrafo, premere il tasto Maiuscolo e 

selezionare tutte le porzioni di testo desiderate.

BA

http://www.fireworkszone.com/g-2-565
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Selezionare del testo con attributi simili

❖ Per selezionare del testo con attributi simili, premete Alt (Win)/Opzione (Mac) e fate doppio clic su una parola con 

gli attributi specificati. Tutte le parole di un blocco di testo corrispondenti agli attributi vengono selezionate 

automaticamente. 

Ad esempio, se desiderate selezionare tutte le parole con un carattere grassetto, premete Alt (Win)/Opzione (Mac) 

e fate doppio clic su una parola in grassetto. Tutte le parole in grassetto all’interno del blocco di testo vengono 

selezionate automaticamente.

Aggiungere del testo con attributi diversi alla selezione precedente

❖ È possibile aggiungere del testo precedentemente selezionato a del testo contenente un diverso set di attributi. Ad 

esempio, dopo aver selezionato del testo con il grassetto, usare la combinazione Alt+ Maiusc+doppio 

clic/Opzione+Maiusc+doppio clic su una parola in corsivo. In questo modo, vengono selezionate sia le parole in 

grassetto che le parole in corsivo. 

Aggiungere del testo a una selezione esistente

❖ Per aggiungere delle singole parole a una selezione esistente, fare clic all’interno del testo, e premete 

Alt+Maiusc+doppio clic/Opzione+Maiusc+doppio clic.

Deselezionare del testo da una selezione multipla

❖ Per deselezionare del testo da una selezione multipla, fare clic tenendo premuto il tasto Alt/Opzione sul testo da 

deselezionare.

Formattare e modificare il testo

Il metodo più rapido per modificare il testo con il comando di modifica dettagliata consiste nell’uso della finestra di 

ispezione Proprietà. In alternativa, è possibile usare i comandi del menu Testo. 

Per ulteriori informazioni sui comandi di testo, vedete http://www.fireworkszone.com/page-2-4-1-566.html.

Importante: le modifiche apportate durante una sessione di modifica del testo costituiscono un solo livello di 

annullamento. Se si sceglie Modifica > Annulla quando si modifica il testo, viene annullata ogni modifica apportata al 

testo dal momento in cui si è fatto doppio clic sul blocco di testo per modificarne il contenuto.

1 Per selezionare il testo da modificare, effettuare una delle seguenti operazioni:

• Per selezionare l’intero blocco, fare clic su un blocco di testo con lo strumento Puntatore o Sottoselezione. Per 

selezionare contemporaneamente più blocchi, tenere premuto il tasto Maiusc mentre si seleziona ciascun 

blocco.

• Fare doppio clic su un blocco di testo con lo strumento Puntatore o Sottoselezione, quindi evidenziare un 

intervallo di testo.

• Fare clic all’interno di un blocco di testo con lo strumento Testo, quindi evidenziare un intervallo di testo.

2 Modificare il testo o il carattere. I caratteri sono misurati in punti.

3 Effettuare una delle seguenti operazioni:

• Fare clic all’esterno del blocco di testo.

• Selezionare un altro strumento nel pannello Strumenti.

• Premere Esc.

http://www.fireworkszone.com/page-2-4-1-566.html
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I font

Un font è un insieme completo di caratteri, cioè di lettere, numeri e simboli che condividono spessore, larghezza e stile, 

come Adobe Garamond 10 punti. 

I tipi di carattere, detti anche famiglie di caratteri o famiglie di font, sono raccolte di font che condividono lo stesso 

aspetto e progettati per essere usati insieme, come Adobe Garamond.

Il formato di stile è una variante di un singolo font appartenente a una famiglia di font. In genere, lo stile Roman o Plain 

(il nome effettivo varia a seconda della famiglia) è il font di base, che può includere formati quali normale, grassetto, 

semigrassetto, corsivo e grassetto corsivo. 

Oltre ai font già installati nel sistema, potete creare le seguenti cartelle e usare i font installati in esse:

Windows Programmi/File comuni/Adobe/Fonts

Mac OS Libreria/Application Support/Adobe/Fonts

Un font Type 1, TrueType, OpenType o CID installato nella cartella locale Fonts apparirà solo nelle applicazioni 

Adobe.

Anteprima dei caratteri

È possibile visualizzare in anteprima un carattere nel menu Carattere della finestra di ispezione Proprietà. Potete 

disattivare la funzione di anteprima o modificare la dimensione dei punti dei nomi di carattere o dei campioni di 

carattere in Preferenze > Testo.

Specificare la dimensione del font

Per impostazione predefinita, la dimensione del font viene calcolata in punti (un punto equivale a 1/72 di pollice). È 

possibile specificare qualsiasi dimensione di font compresa tra 0,1 e 1.296 punti, in incrementi di 0,001 punti.

Nota: Per impostazione predefinita, in Fireworks la dimensione del font viene calcolata in pixel.

1 Selezionate i caratteri o gli oggetti di testo da modificare. Se non si seleziona del testo, la dimensione del font verrà 

applicata al nuovo testo creato.

2 Effettuate una delle seguenti operazioni:

• Nel pannello Carattere o nella barra di controllo, impostate l’opzione Dimensione font. 

• Scegliete la dimensione nel menu Testo > Dimensione. Scegliete Altro per digitare una nuova dimensione nel 

pannello Carattere.

Potete cambiare l’unità di misura del testo nella finestra di dialogo Preferenze. Questa opzione non è disponibile in 

Fireworks.

Rendere disponibili i font mancanti

❖ Effettuate una delle seguenti operazioni:

• Installate i font mancanti sul sistema. 

• Attivate i font mancanti usando un’applicazione di gestione dei font.

• Inserite i font mancanti nella cartella dei font all’interno della cartella dell’applicazione. I font contenuti in questa 

cartella sono disponibili solo per l’applicazione. Per Mac OS, potete installare i font nella cartella HD > Libreria > 

ApplicationSupport > Adobe > Fonts. I font installati in questa cartella possono essere usati solo dai prodotti 

Adobe.



101UTILIZZO DI FIREWORKS

Operazioni con il testo

Ultimo aggiornamento 4/5/2011

 Se non avete accesso ai font mancanti, cercateli e sostituiteli.

Scegliere una famiglia di caratteri e lo stile

È possibile scegliere una famiglia di caratteri e lo stile dalla finestra di ispezione Proprietà o dal menu Testo.

Altri argomenti presenti nell’Aiuto 

“Preferenze Testo” a pagina 307

Scegliere una famiglia di caratteri e lo stile con la finestra di ispezione Proprietà

1 Scegliere una famiglia dal menu Carattere. Se sul computer sono installate più copie di uno stesso tipo di caratteri, 

il nome del carattere è seguito da un’abbreviazione: (T1) per caratteri PostScript, (TT) per caratteri TrueType e 

(OT) per caratteri OpenType.

In Windows, è possibile scegliere una famiglia e uno stile di carattere digitandone il nome nella casella di testo.  

Mentre si digita, viene visualizzato il nome del primo carattere o stile che inizia con la lettera corrispondente. 

Continuare a digitare fino a che non appare il nome del carattere o dello stile desiderato.

2 Per scegliere uno stile di carattere, effettuare una delle seguenti operazioni:

• Scegliere uno stile installato dal menu Stile nella finestra di ispezione Proprietà.

• Se gli stili non sono inclusi nella famiglia di caratteri, fare clic sul pulsante Grassetto simulato, Corsivo simulato 

o Sottolineato per applicare uno stile simulato. 

Scegliere una famiglia di caratteri e lo stile con il menu Testo

❖ Selezionare Testo > Carattere > [famiglia] > [stile]. Se gli stili non sono inclusi nella famiglia di caratteri, scegliere 

Normale, Grassetto simulato, Corsivo simulato o Sottolineato dal menu Testo > Stile.

In Windows: digitare il nome del carattere nel menu per cercare il tipo di carattere.

Cambiare il testo in tutto maiuscolo

È possibile cambiare il testo selezionato in testo tutto maiuscolo. 

❖ Selezionare Comandi > Testo > Maiuscolo.

Cambiare il testo in tutto minuscolo

È possibile cambiare il testo selezionato in testo tutto minuscolo. 

❖ Selezionare Comandi > Testo > Minuscolo.

Applicare il maiuscolo alla prima parola del testo

È possibile cambiare il testo selezionato in testo minuscolo con la prima lettera della prima parola in maiuscolo. 

❖ Selezionare Comandi > Testo > Iniziale maiuscola.

Inserire un’interruzione di riga

Le interruzioni di riga possono essere inserite usando i tasti Shift + Invio.
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Annullare le modifiche al testo

Nella modalità di modifica del testo, è possibile annullare le modifiche (Ctrl + Z) fino a quando si è in modalità di 

modifica. Quando si esce dalla modalità di modifica, le modifiche vengono applicate e perciò l’annullamento delle 

modifiche non produce alcun effetto.

Inserire caratteri speciali

1 Dopo aver creato un blocco di testo, fare clic al suo interno nella posizione in cui si desidera inserire un carattere 

speciale.

2 Selezionare Finestra > Altri > Caratteri speciali, quindi selezionare il carattere da inserire.

Inserire testo segnaposto

È possibile inserire un blocco di testo segnaposto (testo senza alcun significato, lorem ipsum) nell’area di lavoro.

❖ Selezionare Comandi > Testo > Lorem ipsum.

Nota: se si desidera aggiungere del testo segnaposto per la bozza, è possibile utilizzare l’estensione di generazione di testo 

casuale LoremIpsum. L'estensione è disponibile all'indirizzo 

http://www.adobe.com/go/learn_fw_randomtextgenerator_it.

Applicare il colore al testo

• Per impostazione predefinita, il testo è di colore nero e non ha alcun attributo tratto. È possibile modificare il colore 

di tutto il testo o del testo evidenziato all’interno di un blocco di testo selezionato. Inoltre, è possibile aggiungere 

tratto e filtri attivi a tutto il testo in un blocco di testo selezionato, ma non al solo testo evidenziato.

• Lo strumento Testo mantiene il colore del testo corrente da un blocco di testo all’altro.

• Le caratteristiche del tratto e i filtri attivi applicati a un blocco di testo vengono aggiornati quando si modifica il 

testo nel blocco stesso, ma non vengono applicati ai nuovi blocchi di testo.

• Lo strumento Testo mantiene il colore del testo corrente a prescindere dal colore di riempimento di altri strumenti. 

Quando si usa un colore di riempimento e si torna allo strumento Testo, il colore di riempimento viene impostato 

sull’impostazione più recente del testo, mentre il tratto viene impostato su Nessuno. 

Consultare “Salvare gli attributi di tratto, riempimento e filtro del testo come stile” a pagina 106.

Impostare il colore del testo in un blocco di testo selezionato

❖ Effettuare una delle seguenti operazioni:

• Fare clic sulla casella Colore riempimento nella finestra di ispezione Proprietà e selezionare un colore 

dall’apposita finestra a comparsa. Oppure, con la finestra a comparsa aperta, usare il contagocce per campionare 

un colore da un punto qualsiasi dello schermo. 

http://www.adobe.com/go/learn_fw_randomtextgenerator_it
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Casella Colore riempimento

• Nel pannello Strumenti, fare clic sull’icona accanto alla casella Colore riempimento e selezionare un colore 

dall’apposita finestra a comparsa. Oppure, con la finestra a comparsa aperta, usare il contagocce per campionare 

un colore da un punto qualsiasi dello schermo. 

Nota: quando si applica un tratto al testo evidenziato all’interno di un blocco di testo, viene selezionato 

automaticamente tutto il testo.

Impostare la spaziatura tra righe e caratteri

La crenatura consente di aumentare o ridurre la spaziatura (in percentuale) tra determinate coppie di lettere per 

migliorarne l’aspetto. La crenatura automatica usa le informazioni relative alla crenatura dei caratteri quando viene 

visualizzato il testo. L’avvicinamento aumenta o riduce la spaziatura tra più caratteri selezionati.

In Fireworks CS5, crenatura e avvicinamento si comportano come in CS3. È possibile modificare la crenatura e 

l’avvicinamento posizionando il cursore all’interno di una parola, e cambiando i valori.

L’aspetto del testo importato da versioni precedenti (CS3 e precedenti) rimane lo stesso. I valori di crenatura e 

avvicinamento, tuttavia, risultano cambiati. Questo è dovuto al fatto che rispetto a Fireworks CS3 sono state apportate 

delle modifiche ad Adobe Text Engine.

Per disattivare la crenatura automatica, deselezionare Crenatura auto. nella finestra di ispezione Proprietà.

L’interlinea determina la distanza tra le righe adiacenti di un paragrafo. L’interlinea può essere misurata in pixel o 

come percentuale della distanza, espressa in punti, che separa la riga base dalla riga base successiva. Per una 

panoramica dettagliata del modo in cui Fireworks utilizza Adobe Text Engine (ATE) per il rendering degli elementi 

testuali, vedete l’articolo di Arun Kaza all'indirizzo http://www.adobe.com/go/learn_fw_textengine_it.

Altri argomenti presenti nell’Aiuto 

“Preferenze Testo” a pagina 307

Impostare la crenatura o l’avvicinamento

1 Per selezionare il testo a cui si desidera applicare la crenatura, effettuare una delle seguenti procedure:

• Con lo strumento Testo fare clic tra due caratteri o evidenziare i caratteri da modificare.

• Con lo strumento Puntatore selezionare un intero blocco di testo. Fare clic tenendo premuto il tasto Maiusc per 

selezionare più blocchi di testo.

http://www.adobe.com/go/learn_fw_textengine_it
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2 Selezionare i caratteri per i quali si desidera impostare la spaziatura ed effettuare una delle seguenti operazioni:

• Nella finestra di ispezione Proprietà, trascinare il dispositivo di scorrimento a comparsa Avvicinamento o 

immettere una percentuale nella casella.

Lo zero rappresenta l’avvicinamento normale. I valori positivi consentono di allontanare una lettera dall’altra. I 

valori negativi avvicinano invece le lettere tra loro.

• Tenere premuto il tasto Ctrl (Windows) o Comando (Mac OS) mentre si premono i tasti Freccia sinistra o 

Freccia destra sulla tastiera.

Il tasto Freccia sinistra riduce dell’1% lo spazio tra le lettere, mentre il tasto Freccia destra allontana le lettere 

dell’1%.

Tenere premuti Maiusc e Ctrl (Windows) o Maiusc e Comando (Mac OS) mentre si premono i tasti Freccia 

sinistra o Freccia destra per regolare l’avvicinamento in incrementi del 10%.

Impostare l’interlinea nel testo selezionato

Opzioni di interlinea nella finestra di ispezione Proprietà

1 Effettuare una delle seguenti operazioni:

• Nella finestra di ispezione Proprietà, trascinare il dispositivo di scorrimento a comparsa Interlinea o immettere 

un valore nella casella. L’impostazione predefinita è 100%.

• Usando la tastiera, tenere premuto Ctrl (Windows) o Comando (Mac OS) mentre si preme il tasto Freccia su 

(per aumentare lo spazio) o il tasto Freccia giù (per diminuire lo spazio).

Tenere premuti Maiusc e Ctrl (Windows) o Maiusc e Comando (Mac OS) mentre si premono i tasti Freccia su 

o Freccia giù per regolare l’interlinea in incrementi di 10.

2 Per modificare il tipo di unità dell’interlinea, selezionare % o PX (pixel) dal menu a comparsa Unità dell’interlinea.

Impostare l’orientamento e l’allineamento del testo

Impostare l’orientamento del testo

È possibile orientare gli interi blocchi di testo orizzontalmente o verticalmente. Righe multiple di testo verticale che 

scorrono da destra a sinistra, secondo il modello delle lingue asiatiche. 

1 Fare clic sul pulsante Orientamento testo  nella finestra di ispezione Proprietà.

2 Selezionare un’opzione di orientamento:

Orizzontale da sinistra a destra Valore predefinito.

Verticale da destra a sinistra Consente di orientare il testo verticalmente, dall’alto verso il basso. Righe multiple di 

testo separate da ritorni a capo vengono visualizzate come colonne che scorrono da destra a sinistra.

Per invertire il testo e ottenere un effetto speciale, usare lo strumento Distorci e trascinare una maniglia laterale.
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Impostare l’allineamento del testo

 L’allineamento determina la posizione di un paragrafo di testo rispetto ai margini del blocco di testo di cui fa parte. 

Per impostazione predefinita, il testo orizzontale è allineato a sinistra. 

Il testo verticale può essere allineato al margine superiore o inferiore di un blocco di testo, centrato all’interno del 

blocco di testo o completamente giustificato ai margini superiore e inferiore. 

1 Selezionare il testo.

2 Fare clic sul pulsante di allineamento nella finestra di ispezione Proprietà.

I comandi dell’allineamento ( ) appaiono nella finestra di ispezione Proprietà quando viene 

evidenziato del testo o viene selezionato un blocco di testo. 

Impostare il rientro e la spaziatura del paragrafo

❖ Per impostare il rientro del testo, nella finestra di ispezione Proprietà, trascinare il dispositivo di scorrimento a 

comparsa Rientro paragrafo o immettere un valore (in pixel) nella casella di testo.

Opzione di rientro del paragrafo nella finestra di ispezione Proprietà

❖ Per impostare la quantità di spazio prima e dopo i paragrafi, nella finestra di ispezione Proprietà, trascinare il 

dispositivo di scorrimento a comparsa Spazio prima del paragrafo o Spazio dopo paragrafo oppure immettere un 

valore nella casella di testo.

Opzioni di spaziatura tra i paragrafi nella finestra di ispezione Proprietà

Applicare effetti di testo

Attenuare i bordi del testo 

L’attenuazione di un bordo del testo selezionato viene denominata antialiasing. Grazie all’antialiasing, i bordi del testo 

sfumano nello sfondo e il testo risulta più pulito e leggibile in caso di testo di grandi dimensioni. L’antialiasing viene 

applicato a tutti i caratteri di un determinato blocco di testo.

Testo originale (a sinistra) e dopo l’attenuazione dei bordi (a destra)

❖ Nella finestra di ispezione Proprietà, selezionare una delle opzioni dal menu a comparsa Antialiasing:

Nessun antialiasing Disabilita l’attenuazione del testo.

Antialiasing netto Crea una transizione netta tra i bordi del testo e lo sfondo.

Antialiasing marcato Crea una transizione molto marcata tra i bordi del testo e lo sfondo, mantenendo invariata la 

forma dei caratteri e migliorando le aree di dettaglio di questi ultimi.
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Antialiasing attenuato Crea una transizione delicata tra i bordi del testo e lo sfondo.

Antialiasing personalizzato Offre i seguenti comandi sofisticati per l’antialiasing:

• Sovracampionatura Definisce la quantità di dettaglio necessaria per la transizione tra i bordi del testo e lo 

sfondo.

• Precisione Definisce l’omogeneità della transizione tra i bordi del testo e lo sfondo.

• Forza Determina in che misura i bordi del testo si uniscono allo sfondo.

Nota: quando viene aperto in Fireworks, al testo dei file vettoriali viene applicato l’antialiasing. 

Regolare la larghezza dei caratteri selezionati

❖ Nella finestra di ispezione Proprietà, trascinare il dispositivo di scorrimento a comparsa Scala orizzontale o 

immettere un valore nella casella di testo. Se si trascina il dispositivo di scorrimento su un valore superiore al 100%, 

si espande la larghezza o l’altezza dei caratteri, mentre se lo si trascina su un valore inferiore, la si contrae. 100% è 

l’impostazione predefinita.

Opzione Scala orizzontale nella finestra di ispezione Proprietà

Modificare la prossimità del testo alla linea di base

 L’opzione Spostamento linea di base consente di definire la distanza del testo sopra o sotto la linea di base naturale, ad 

esempio con i caratteri in posizione pedice o apice. Se non è impostato alcuno spostamento della linea di base, il testo 

si trova su di essa. Gli spostamenti della linea di base sono misurati in pixel.

Opzione Spostamento linea di base nella finestra di ispezione Proprietà

❖ Nella finestra di ispezione Proprietà, trascinare il dispositivo di scorrimento a comparsa Spostamento linea di base 

oppure immettere un valore nella casella di testo per specificare la distanza di apici e pedici. Immettere valori 

positivi per creare caratteri in posizione apice o negativi per creare caratteri in posizione pedice.

Salvare gli attributi di tratto, riempimento e filtro del testo come stile

È possibile applicare tratti, riempimenti e filtri al testo in un blocco di testo selezionato e salvare gli attributi del testo 

come stile. Dopo aver creato un testo, questo rimane modificabile in Fireworks. Tutti i tratti, riempimenti, filtri e stili 

vengono aggiornati automaticamente mentre si modifica il testo.

Testo con tratto, riempimento, filtro e stile applicati

1 Creare un oggetto di testo e applicarvi gli attributi desiderati. Applicare qualsiasi stile nel pannello Stili, anche se 

non si tratta di uno stile di testo.
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2 Selezionare l’oggetto di testo.

3 Selezionare Nuovo stile dal menu del pannello Stili.

4 Selezionare le proprietà dello stile e assegnare un nome al nuovo stile.

Altri argomenti presenti nell’Aiuto 

“Preferenze Testo” a pagina 307

Collegamento di testo a un tracciato

In alternativa ai blocchi di testo rettangolari, è possibile disegnare un tracciato a cui collegare un testo. Il testo scorre 

lungo la forma del tracciato. È possibile modificare sia il testo che il tracciato. 

I tracciati ai quali vengono collegati dei testi perdono temporaneamente gli attributi di tratto, riempimento e filtro. 

Eventuali attributi di tratto, riempimento e filtro applicati dopo il collegamento del tracciato al testo vengono applicati 

al testo e non al tracciato. Una volta separato dal testo, il tracciato recupera i propri attributi di tratto, riempimento e 

filtro.

Nota: se si collega a un tracciato del testo con ritorni a capo o fine riga, si potrebbero verificare effetti non previsti.

Quando la quantità di testo supera lo spazio all’interno o all’esterno di un tracciato, viene visualizzata un’icona per 

indicare la presenza di testo in eccesso. Eliminare il testo in eccesso oppure ridimensionare il tracciato in modo che 

riesca a comprendere tutto il testo. Quando tutto il testo è compreso nel tracciato, l’icona scompare.

Collegare il testo a un tracciato e modificarlo

• Per collegare il testo al perimetro di un tracciato, selezionare un oggetto di testo e un tracciato tenendo premuto il 

tasto Maiusc, quindi selezionare Testo > Collega al tracciato.

• Per inserire un blocco di testo all’interno di un tracciato, selezionare un oggetto di testo e un tracciato tenendo 

premuto il tasto Maiusc, quindi selezionare Testo > Allega in tracciato.

• Per separare il testo da un tracciato selezionato, selezionare Testo > Separa dal tracciato. 

• Per modificare un testo collegato a un tracciato, fare doppio clic sull’oggetto testo sul tracciato con lo strumento 

Puntatore o Sottoselezione oppure fare clic sul testo da modificare con lo strumento Testo.

• Per modificare la forma del tracciato, selezionare l’oggetto testo sul tracciato con lo strumento Sottoselezione, 

quindi trascinare i punti sottoselezionati per rimodellare il tracciato.

Nota: per modificare il tracciato, è inoltre possibile utilizzare lo strumento Penna di Bézier. Il testo scorre 

automaticamente intorno al tracciato man mano che i punti vengono modificati.

Modificare l’orientamento e la direzione del testo su un tracciato

L’ordine in cui viene disegnato un tracciato stabilisce la direzione del testo ad esso collegato. Ad esempio, se si disegna 

un tracciato da destra a sinistra, il testo collegato appare rivolto all’indietro e rovesciato.

Testo collegato a un tracciato disegnato da destra a sinistra

❖ Selezionare Testo > Orientamento, quindi selezionare un’opzione di orientamento.
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Testo ruotato intorno al tracciato 

Testo orientato in verticale su un tracciato 

Testo inclinato in verticale intorno al tracciato 

Testo inclinato in orizzontale intorno al tracciato 

• Per invertire la direzione del testo su un tracciato selezionato, selezionare Testo > Inverti direzione.

• Per spostare il punto iniziale del testo collegato a un tracciato, selezionare l’oggetto testo sul tracciato, quindi, nella 

finestra di ispezione Proprietà, immettere un valore nella casella di testo Scostamento testo. 

Allegare del testo in un tracciato

È possibile allegare del testo in un oggetto vettoriale. Il testo viene contenuto entro i bordi dell’oggetto vettoriale. Sia 

il testo che l’oggetto vettoriale restano modificabili. Quando si allega del testo in un tracciato, l’area all’interno del 

tracciato determina la quantità di testo visibile.

1 Selezionare il testo e un oggetto vettoriale sull’area di lavoro.

2 Selezionare Testo > Allega in tracciato.

Convertire il testo in tracciati

Convertire il testo in tracciati, quindi modificare la forma delle lettere come si fa per qualsiasi altro oggetto vettoriale. 

Per i testi convertiti in tracciati sono disponibili tutti gli strumenti di modifica vettoriale. 

Nota: i testi convertiti non possono essere modificati come testo.

• Per convertire un testo, selezionare Testo > Converti in tracciati.

• Per modificare singolarmente i tracciati di caratteri del testo convertito, selezionare il testo convertito con lo 

strumento Sottoselezione e selezionare Elabora > Separa.

• Per creare un tracciato composito da un gruppo di tracciati creato convertendo testo in tracciati, selezionare il 

gruppo di tracciati, selezionare Elabora > Separa, quindi selezionare Elabora > Combina tracciati > Unisci.

Trasformare blocchi di testo

I blocchi di testo possono essere trasformati così come si trasformano altri tipi di oggetti. È possibile scalare, ruotare, 

inclinare e riflettere il testo per creare effetti di testo particolari.
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Le trasformazioni eccessive possono rendere difficile la lettura del testo. Se la trasformazione di un blocco di testo 

comporta il ridimensionamento o la scalatura del testo, le nuove dimensioni dei caratteri vengono visualizzate nella 

finestra di ispezione Proprietà quando il testo è selezionato. 

Altri argomenti presenti nell’Aiuto 

“Preferenze Testo” a pagina 307

Solidificare il testo

È possibile convertire il testo in oggetti vettoriali compositi. Dopo tale conversione, il testo non è più modificabile a 

livello di testo. Poiché i caratteri vengono uniti come un oggetto composito, per modificare singolarmente i caratteri 

occorre prima dividere i tracciati composti.

• Per solidificare il testo, selezionare Comandi > Testo > Solidifica.

• Per dividere il tracciato composto in caratteri modificati singolarmente, utilizzare lo strumento Sottoselezione o 

selezionare Modifica > Combina tracciati > Dividi.

Importare testo

Fireworks supporta solo testo ASCII e il testo è visualizzato come caratteri garbage quando il file di testo Unicode viene 

aperto o importato in Fireworks. Convertite il testo Unicode in testo ASCII prima di importarlo in Fireworks. In 

alternativa, copiate il testo ASCII e incollatelo in Fireworks.

• Per importare il testo da Adobe Photoshop o Adobe Illustrator®, importare un file o copiare il testo in Fireworks.

È possibile copiare una quantità di testo massima pari a 8000 caratteri da Fireworks o da altre applicazioni.

Per impostazione predefinita, il testo proveniente da Photoshop e Illustrator mantiene tutti gli attributi in 

Fireworks. Tuttavia, è possibile importare il testo in Photoshop anche come immagini bitmap. Vedere “Preferenze 

di importazione e apertura da Photoshop” a pagina 307.

• Per importare del testo in formato RTF (Rich Text Format) e ASCII (solo testo), copiarlo in Fireworks. In 

alternativa, selezionare File > Apri o File > Importa e individuare il file da importare. Il testo ASCII importato viene 

impostato sul colore di riempimento e sul carattere predefinito correnti, con altezza pari a 12 pixel.

Sostituzioni di caratteri mancanti

Quando in Fireworks viene aperto un documento contenente caratteri non installati sul computer in uso, viene chiesto 

se si desidera sostituirli o mantenerne l’aspetto.

Per impostazione predefinita, per il testo contenente caratteri non disponibili sul proprio computer, viene utilizzato il 

carattere Myriad Pro. Utilizzare la finestra di dialogo Preferenze per modificare questa impostazione.

Mantieni aspetto Il testo viene sostituito con un’immagine bitmap che rappresenta l’aspetto del testo nel tipo di 

carattere originale. Il testo rimane comunque modificabile ma, in tal caso, Fireworks sostituisce l’immagine bitmap 

con un carattere installato sul sistema in uso. La modifica può quindi comportare una variazione nell’aspetto del testo.

Sostituisci caratteri mancanti I caratteri vengono sostituiti nel documento. È possibile modificare e salvare il testo. 

Riaprendo il documento su un computer che contiene i caratteri originali, Fireworks li ricorda e li utilizza.

Altri argomenti presenti nell’Aiuto 

“Preferenze Testo” a pagina 307
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Selezionare un carattere sostitutivo

1 Aprire un documento con i caratteri mancanti, quindi selezionare un carattere mancante dall’elenco Modifica 

carattere mancante.

2 Effettuare una delle seguenti operazioni: 

• Scegliere un carattere sostitutivo dall’elenco A.

• Fare clic su Nessuna modifica per lasciare il carattere mancante come tale.

All’apertura successiva di un documento con gli stessi caratteri mancanti, la finestra di dialogo Caratteri 

mancanti presenterà il carattere scelto.

Controllo ortografico del testo

Effettuare il controllo ortografico del testo

1 Selezionare uno o più blocchi di testo. Se non viene selezionato nessun blocco di testo, viene controllata l’ortografia 

dell’intero documento.

2 Selezionare Testo > Controllo ortografico.

Personalizzare il controllo ortografico

1 Selezionare Testo > Imposta controllo ortografico oppure fare clic sul pulsante Impostazione nella finestra di 

dialogo Controllo ortografico.

2 Scegliere le opzioni nella finestra di dialogo Imposta controllo ortografico:

• Scegliere uno o più dizionari.

• Cercare un dizionario personalizzato facendo clic sull’icona della cartella accanto alla casella di testo Percorso 

dizionario personale.

• Modificare il dizionario personalizzato facendo clic sul pulsante Modifica dizionario personale e aggiungendo, 

eliminando o modificando parole nell’elenco.

• Scegliere i tipi di parole che si desidera includere nel controllo ortografico.
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Capitolo 8: Applicazione di colori, tratti e 
riempimenti

Adobe® Fireworks® offre una vasta gamma di opzioni per l’organizzazione, la selezione e l’applicazione dei colori. 

Applicazione dei colori

Attivare, rimuovere o scambiare il tratto e il riempimento

Attivare il tratto o il riempimento per determinare a quale attributo applicare la regolazione del colore. Ripristinare le 

impostazioni predefinite relative ai colori di tratto e riempimento specificate nella finestra di dialogo Preferenze.

Attivare il colore di tratto o riempimento

❖ Nella sezione Colori del pannello Strumenti, fare clic sull’icona a sinistra della casella Colore tratto o Colore 

riempimento. 

Nota: lo strumento Secchio di vernice applica alle selezioni di pixel e agli oggetti vettoriali il colore mostrato nella casella 

Colore riempimento.

Caselle colore per tratto e riempimento del pannello Strumenti e finestra a comparsa dei colori

Ripristinare le impostazioni predefinite dei colori di tratto e riempimento

❖ Fare clic sul pulsante Imposta colori predefiniti tratto/riempimento nel pannello Strumenti o nel Mixer colori.

Rimuovere tratto e riempimento dagli oggetti selezionati 

❖ Fare clic sul pulsante Nessun tratto o riempimento nella sezione Colori del pannello Strumenti. Per impostare su 

Nessuno anche le caratteristiche inattive, fare clic di nuovo sul pulsante Nessun tratto o riempimento.

Nota: per impostare su Nessuno il tratto o il riempimento, è inoltre possibile fare clic sul pulsante Trasparente nella 

finestra a comparsa Colore riempimento o Colore tratto, oppure scegliere Nessuno dai menu Categoria riempimento o 

Categoria tratto della finestra di ispezione Proprietà.
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Scambiare i colori di tratto e riempimento

❖ Fare clic sul pulsante Scambia colori tratto/riempimento  nel pannello Strumenti o nel Mixer colori. 

Applicare e organizzare i campioni

Nel pannello Campioni colore è possibile visualizzare, cambiare, creare e modificare gruppi di campioni colore oltre 

ai colori dei tratti e dei riempimenti. 

Applicare un campione colore al tratto o riempimento di un oggetto selezionato 

1 Fare clic sull’icona di fianco alla casella Colore tratto o Colore riempimento nel pannello Strumenti o nella finestra 

di ispezione Proprietà per attivarla. 

2 Selezionare Finestra > Campioni colore.

3 Fare clic su un campione per applicare il colore al tratto o al riempimento di un oggetto selezionato. 

Selezionare, modificare o aggiungere gruppi di campioni

È possibile passare in modo semplice a un altro gruppo di campioni colore predefinito o crearne uno personalizzato. 

È inoltre possibile importare campioni colore personalizzati da tavolozze salvate in formato ACT o GIF. 

❖ Per selezionare un gruppo di campioni, scegliere il gruppo dal menu del pannello Campioni colore.

Nota: se si seleziona Campioni colore viene ripristinato il gruppo predefinito di campioni colore.

• Per selezionare un gruppo di campioni personalizzati, selezionare Sostituisci campioni dal menu Opzioni del 

pannello Campioni, individuare la cartella, quindi selezionare il file.

• Per aggiungere campioni a una tavolozza colori esterna, selezionare Aggiungi campioni colore dal menu Opzioni 

del pannello Campioni, individuare la cartella, quindi selezionare un file di tavolozza colori in formato ACT o GIF.

Aggiungere o sostituire un colore nel pannello Campioni colore

Nota: l’operazione Modifica > Annulla non annulla l’eliminazione o l’aggiunta di campioni colore.

1 Selezionare lo strumento Contagocce dal pannello Strumenti.

2 Selezionare il numero di pixel da campionare dal menu a comparsa Campione nella finestra di ispezione Proprietà: 

1 pixel, Media 3 x 3 o Media 5 x 5.

3 Fare clic in un punto qualsiasi nella finestra di un documento di Fireworks per campionare un colore. 

• Per aggiungere un colore, portare la punta del contagocce nel pannello Campioni colore, nello spazio vuoto 

dopo l’ultimo campione.

• Per sostituire un campione colore, tenere premuto Maiusc e posizionare il puntatore su un campione nel 

pannello Campioni colore.

4 Fare clic per aggiungere o sostituire il campione di colore.

Se si seleziona Adatta a WebSafe dal menu Opzioni della finestra a comparsa colori, qualsiasi colore prelevato con 

il Contagocce viene trasformato nel colore WebSafe che più gli si avvicina.

Eliminare un campione colore

❖ Per eliminare un campione di colore, tenere premuto il tasto Ctrl (Windows) o Comando (Mac OS), posizionare il 

puntatore su un campione e fare clic.
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Eliminare o ordinare campioni

• Per eliminare l’intero pannello di campioni, selezionare Cancella campioni colore dal menu del pannello Campioni 

colore. 

• Per ordinare i campioni in base al valore del colore, selezionare Ordina per colore dal menu del pannello Campioni 

colore.

Creare e modificare i colori in Mixer colori

Mixer colori (Finestra > Mixer colori) consente di visualizzare e modificare i colori di tratto e riempimento attivi.

Per impostazione predefinita, il Mixer colori identifica i colori RGB come esadecimali; pertanto visualizza valori 

esadecimali per i componenti rosso (R), verde (G) e blu (B). I valori RGB esadecimali sono calcolati sulla base di una 

gamma che va da 00 a FF.

Il menu Opzioni del Mixer colori consente comunque di selezionare modelli colore alternativi. I valori dei componenti 

del colore corrente cambiano a seconda del modello colore utilizzato. 

Nonostante CMY sia un’opzione di modello di colore, le immagini esportate direttamente da Fireworks non sono 

idonee per la stampa. Per elaborare per la stampa gli elementi grafici di Fireworks esportati, importarli in Adobe 

Illustrator, Adobe Photoshop o Adobe FreeHand. Per ulteriori informazioni, consultare la documentazione di tali 

applicazioni.

Applicare un colore a un oggetto vettoriale selezionato

1 Nel Mixer colori, fare clic sull’icona di fianco alla casella Colore tratto o Colore riempimento. 

2 Spostare il puntatore sulla barra colori e fare clic. 

Selezionare un colore

1 Deselezionare tutti gli oggetti per impedire modifiche indesiderate durante la miscelazione.

2 Fare clic sulla casella Colore tratto o Colore riempimento

3 Selezionare un modello di colore dal menu del Mixer colori.

4 Per specificare i valori del colore, immettere i valori nelle caselle di testo dei vari componenti del colore, utilizzare 

i dispositivi di scorrimento a comparsa o selezionare un colore dalla barra colori.

Modello colore Modalità di espressione cromatica

RGB Valori di rosso, verde e blu (RGB), nei quali ciascun componente ha un valore compreso tra 0 e 255; 

0-0-0 corrisponde al nero e 255-255-255 al bianco.

Esadecimale Valori RGB di rosso, verde e blu, nei quali ciascun componente ha un valore esadecimale compreso 

tra 00 e FF; 00-00-00 corrisponde al nero mentre FF-FF-FF rappresenta il bianco.

HSB Valori di tonalità (H), saturazione (S) e luminosità (B). La tonalità ha un valore compreso tra 0 e 360 

gradi, mentre la saturazione e la luminosità hanno un valore compreso tra 0% e 100%.

CMY Valori di ciano, magenta e giallo (CMY), nei quali ciascun componente ha un valore compreso tra 0 

e 255; 0-0-0 corrisponde al nero e 255-255-255 al bianco.

Scala di grigi Percentuale del nero. Il singolo componente nero (K) ha un valore compreso tra 0% e 100%, in cui 

0 corrisponde al bianco e 100 al nero, mentre i valori intermedi costituiscono le varie sfumature del 

grigio.
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Passare da un modello colore a un altro

❖ Fare clic tenendo premuto MAIUSC sulla barra colori posta in fondo al Mixer colori.

Nota: le opzioni contenute nel Mixer colori non sono soggette a variazioni.

Creare colori con il selettore dei colori di sistema

1 Fare clic su una casella colore.

2 Selezionare Windows OS o Mac OS dal menu Opzioni della finestra a comparsa colori.

3 Selezionare un colore dal selettore dei colori di sistema. 

Gestire i colori con il pannello Tavolozza colori

❖ Per aprire il pannello Tavolozza colori, selezionare Finestra > Altri > Tavolozza colori.

Individuare il colore WebSafe che si avvicina di più a ciascun valore del colore.

1 Fare clic sulla casella Colore riempimento nella scheda Selettore del pannello Tavolozza colori. 

2 Per campionare un colore, con il contagocce fare clic in un punto qualsiasi nella finestra del documento di 

Fireworks. 

Il colore WebSafe più simile viene visualizzato sotto il colore nella casella del colore di riempimento attiva.

Nota: è inoltre possibile utilizzare la scheda Selettore per convertire i colori tra i modelli di colore, ad esempio RGB e 

CMYK, nonché per selezionare la modalità di visualizzazione dei colori. 

Creare e scambiare le tavolozze di colori 

1 Selezionare la scheda Mixer nel pannello Tavolozza colori.

2 Per impostare i quattro colori di base del documento, utilizzare le cinque caselle Colore di riempimento situate nella 

parte inferiore del pannello. 

3 Se necessario, utilizzare la ruota dei colori HSB nell’angolo inferiore destro del pannello per modificare la tavolozza.

4 Per provare due tavolozze diverse nel documento, fare clic su Palette2 nella parte sinistra del pannello e scegliere i 

colori di base della seconda tavolozza.

5 Per passare da una tavolozza all’altra, fare clic su una delle due icone di Sostituisci colore. 

Nota: la funzione di scambio tavolozza consente di sostituire riempimenti, tratti e sfumature negli elementi vettoriali 

ma non in quelli bitmap o nei simboli grafici.

Esportare una tavolozza

1 Selezionare la tavolozza che si desidera esportare (ovvero la Palette 1 o 2).
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2 Fare clic sull’icona Esporta come bitmap per esportare la tavolozza come file bitmap oppure fare clic sull’icona 

Esporta come tavola colori per esportarla come file ACT.

Creare una serie di gradazioni di colore 

1 Selezionare la scheda Fusione nel pannello Tavolozza colori.

2 Utilizzare le caselle Colore riempimento nella parte inferiore del pannello per selezionare i colori iniziali e finali. 

3 Utilizzare il dispositivo di scorrimento a comparsa Passaggi per selezionare il numero di passaggi della serie.

Nota: per visualizzare il valore esadecimale del colore, posizionare il puntatore su un campione di colore. 

Creare una tavolozza condivisa

Se occorre modificare più immagini con una tavolozza colori limitata, è possibile esportare una tavolozza di colori 

condivisa contenente i colori di tali immagini. Per creare una tavolozza di colori condivisa, tutte le immagini devono 

risiedere nella stessa cartella.

1 Selezionare Comandi > Web > Crea tavolozza condivisa.

2 Specificare il numero massimo di colori da includere nella tavolozza di colori condivisa.

3 Fare clic su Sfoglia e specificare la cartella contenente le immagini, quindi fare clic su OK.

Selezionare colori da una finestra a comparsa colori

Fare clic su una casella colore per aprire una finestra a comparsa colori simile al pannello Campioni colore.

Selezionare un colore per una casella colore

1 Fare clic su una casella colore.

2 Effettuare una delle seguenti operazioni: 

• Per applicare un campione alla casella colore, fare clic su un campione.

• Per applicare il colore alla casella colore, fare clic con il contagocce su un colore, in un punto qualsiasi della 

schermata.

• Per applicare la trasparenza a un tratto o riempimento, fare clic sul pulsante Trasparente nella finestra a 

comparsa.

Visualizzare il gruppo di campioni del pannello Campioni colore

❖ Selezionare Pannello Campioni colore dal menu della finestra a comparsa colori. 

Visualizzare un diverso gruppo di campioni nella finestra a comparsa colori

❖ Selezionare un gruppo di campioni colore dal menu della finestra a comparsa colori. 

Nota: la scelta di un gruppo di campioni colore qui non influisce sul pannello Campioni colore.

Campionare i colori da una finestra a comparsa colori

Quando si apre una finestra a comparsa colori, il puntatore si trasforma in un contagocce in grado di campionare i 

colori da qualsiasi punto dello schermo. Questo processo è denominato campionamento.

1 Fare clic su una casella colore.
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2 Fare clic in un punto qualsiasi dello spazio di lavoro Fireworks per selezionare e applicare un colore per la casella 

colore. 

Fare clic tenendo premuto Maiusc per selezionare un colore WebSafe.

Identificare i valori colore

Per individuare valori di colore specifici, oltre al Mixer colori e alla finestra a comparsa del colore, è possibile utilizzare 

il pannello Informazioni. 

Visualizzare il valore del colore di ogni parte di un documento

❖ Effettuare una delle seguenti operazioni:

• Utilizzare il Mixer colori o la finestra a comparsa.

• Utilizzare il pannello Informazioni. Fare clic sullo strumento Contagocce, selezionare Finestra > Informazioni, 

quindi spostare il puntatore sull’oggetto contenente il colore da visualizzare (solo Windows).

Visualizzare il valore per il colore di tratto o riempimento attivo

❖ Effettuare una delle seguenti operazioni:

• Selezionare Finestra > Mixer colori per il modello RGB o altri modelli colore. 

• Fare clic su una casella colore per aprire la finestra a comparsa e visualizzare il valore esadecimale indicato nella 

parte superiore della finestra.

• Collocare il puntatore su una casella e leggere la descrizione (solo Windows).

Nota: per impostazione predefinita, i valori RGB del colore sono visualizzati nel pannello Informazioni e nel Mixer 

colore. Il relativo valore esadecimale viene visualizzato nella finestra a comparsa. 

Visualizzare le informazioni sul colore per un diverso modello di colore

❖ Selezionare un altro modello colore dal pannello Informazioni o dal menu Opzioni del Mixer colori.

Simulare trasparenze e colori WebSafe con il dithering

Se il colore utilizzato non è WebSafe, applicare un riempimenti Dithering Web. In tal modo è possibile approssimare 

un colore WebSafe che non subisce modifiche o dithering al momento dell’esportazione con una tavolozza WebSafe.

Per creare l’illusione di una trasparenza, applicare l’opzione di riempimento dithering Trasparente. Negli oggetti 

trasparenti, lo sfondo della pagina Web viene visualizzato attraverso gli altri pixel del riempimento dithering Web 

trasparente.

Nota: il Dithering Web può aumentare le dimensioni del file.

Due colori WebSafe creano un riempimento Dithering Web.
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Applicare un riempimento Dithering Web

1 Selezionare un oggetto contenente un colore non WebSafe.

2 Selezionare Dithering Web dal menu a comparsa Categoria riempimento nella finestra di ispezione Proprietà.

3 Fare clic sulla casella Colore riempimento nella finestra di ispezione Proprietà o nel pannello Strumenti per aprire 

la finestra a comparsa. 

Il colore non WebSafe dell’oggetto viene visualizzato nella casella colore Sorgente. I due colori di dithering WebSafe 

compaiono nelle caselle colori di destra. Il Dithering Web viene applicato all’oggetto e diventa il colore di 

riempimento attivo.

Nota: l’impostazione del bordo di un riempimento Dithering Web su Antialiasing o Morbidezza produce colori non 

WebSafe. 

4 Fare clic all’esterno della finestra a comparsa per chiuderla.

Applicare un riempimento Dithering Web

1 Selezionare l’oggetto al quale applicare il riempimento trasparente.

2 Selezionare Dithering Web dal menu a comparsa Categoria riempimento nella finestra di ispezione Proprietà.

3 Nella finestra di ispezione Proprietà, fare clic sulla casella Colore riempimento per visualizzare la finestra a 

comparsa Opzioni riempimento. 

4 Selezionare Trasparente.

L’oggetto nell’area di lavoro diventa semiopaco o traslucido.

5 Fare clic all’esterno della finestra a comparsa per chiuderla.

6 Esportare l’oggetto come file GIF o PNG e selezionare Trasparenza indice o Trasparenza canale alfa. Per ulteriori 

informazioni, consultare “Rendere trasparenti le aree” a pagina 245.

Nota: non tutti i browser supportano i file PNG.

Salva campioni colore

Salvare un gruppo di campioni colore

❖ Per salvare una selezione di colori campionati, aggiungere i colori, selezionare Salva campioni colore nel menu del 

pannello Campioni colore, quindi selezionare un nome file e una directory. 

Salvataggio di campioni colore come file ASE

I file ASE contengono dei colori che possono essere utilizzati da applicazioni come Photoshop, Illustrator e InDesign. 

È possibile utilizzare i colori creati in un’applicazione anche in altre applicazioni tramite la condivisione di un file ASE.

Fireworks supporta le aree di colori RGB e CMYK. I campioni di colore appartenenti ad altre aree di colore vengono 

ignorati. I campioni CMYK vengono convertiti in valori RGB e quindi importati in Fireworks. Tuttavia, non viene 

esplicitamente visualizzata alcuna informazione sui campioni convertiti da CMYK a RGB.

Salvataggio campioni come file ASE

1 Aprire il gruppo di campioni che si desidera salvare nel pannello Campioni colore.

2 Nelle opzioni del pannello Campioni colore, selezionare Salva campioni colore.
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3 Inserire un nome per il file contenente i campioni colore e salvarlo.

Importazione campioni colore da altre applicazioni CS

1 Aprire il gruppo di campioni nel pannello Campioni colore.

2 Nelle opzioni del pannello Campioni colore, selezionare Aggiungi campioni colore.

Pannello Kuler

Il pannello Kuler

Il pannello Kuler™ permette di accedere a gruppi di colori (o temi) creati da una comunità online di grafici. Potete usare 

questo pannello per trovare migliaia di temi in Kuler™, quindi ne potete scaricare alcuni per apportare modifiche o da 

includere nei vostri progetti. Con il pannello Kuler potete inoltre creare e salvare temi, quindi caricarli per condividerli 

con la comunità Kuler.

Il pannello Kuler è disponibile in Adobe Photoshop® CS5, Adobe Flash® Professional CS5, Adobe InDesign® CS5, 

Adobe Illustrator® CS5 e Adobe Fireworks® CS5. Il pannello non è disponibile nelle versioni francesi di questi prodotti.

Per un video sul pannello Kuler, visitate www.adobe.com/go/lrvid4088_xp_it.

Per un articolo su Kuler e fonti di ispirazione per l’uso dei colori, visitate il blog di Veerle Pieters all’indirizzo 

http://veerle.duoh.com/blog/comments/adobe_kuler_update_and_color_tips/.

Sfogliare i temi

Per sfogliare i temi online è necessaria una connessione Internet.

Effettuare ricerche nei temi

1 Scegliete Finestra > Estensioni > Kuler, quindi selezionate il pannello Sfoglia.

2 Effettuate una delle seguenti operazioni:

• Nella casella di ricerca, immettete il nome di un tema, di un tag o di un autore.

Nota: nelle ricerche potete usare solo caratteri alfanumerici (Aa-Zz, 0-9).

• Per filtrare i risultati della ricerca, selezionate un’opzione dai menu a comparsa sopra i risultati.

Visualizzare un tema online in Kuler

1 Nel pannello Sfoglia, selezionate un tema tra i risultati della ricerca.

2 Fate clic sul triangolino a destra del tema e selezionate Visualizza online in Kuler.

Salvataggio di ricerche frequenti

1 Selezionate l’opzione Personale nel primo menu a comparsa del pannello Sfoglia.

2 Nella finestra di dialogo risultante, immettete i termini da cercare e salvateli.

Per eseguire nuovamente la stessa ricerca, selezionatela dal primo menu a comparsa.

Per eliminare una ricerca salvata, selezionate l’opzione Personale nel menu a comparsa. Quindi cancellate le ricerche 

che desiderate eliminare e fate clic su Salva.

http://www.adobe.com/go/lrvid4088_xp_it
http://veerle.duoh.com/blog/comments/adobe_kuler_update_and_color_tips/
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Utilizzo dei temi

Con il pannello Kuler potete creare e modificare i temi, nonché includerli nei vostri progetti.

Nota: in Illustrator, potete creare e modificare i temi mediante la finestra di dialogo Modifica colore/Ricolora grafica, 

anziché nel pannello Crea. Per informazioni dettagliate, vedete l’Aiuto di Illustrator.

Aggiungere un tema al pannello Campioni dell’applicazione in uso

1 Nel pannello Sfoglia, selezionate il tema che desiderate usare.

2 Fate clic sul triangolino a destra del tema e selezionate Aggiungi al pannello Campioni.

Potete inoltre aggiungere un tema dal pannello Crea, facendo clic sul pulsante Aggiungere il tema selezionato ai 

campioni.

Modificare un tema

1 Nel pannello Sfoglia, individuate il tema da modificare e fate doppio clic su di esso tra i risultati della ricerca. Il tema 

si apre nel pannello Crea.

2 Nel pannello Crea, modificate il tema con gli strumenti disponibili. Per ulteriori informazioni, consultate la sezione 

Strumenti del pannello Crea, di seguito.

3 Effettuate una delle seguenti operazioni:

• Per salvare il tema, fate clic sul pulsante Salva tema.

• Per aggiungere il tema al pannello Campioni dell’applicazione, fate clic sul pulsante Aggiungi al pannello 

Campioni, sul fondo del pannello.

• Per caricare il tema nel servizio Kuler, fate clic sul pulsante Carica, nella parte inferiore del pannello.

Strumenti del pannello Crea

Nel pannello Crea sono disponibili diversi strumenti con cui creare e modificare i temi.

• Selezionate un criterio di armonia dal menu a comparsa Seleziona criterio. Il criterio generare i colori nel gruppo 

di colori a partire dal colore di base. Ad esempio, se scegliete un colore di base blu e il criterio Complementare, viene 

creato un gruppo di colori usando il colore di base, blu, e il suo colore complementare, rosso.

• Fate clic sul criterio Personale per creare un tema in base a regolazioni libere.

• Manipolate i colori nella ruota dei colori. Il criterio di armonia selezionato continua a determinare quali colori 

vengono generati per il gruppo di colori.

•  Per modificare la luminosità dei colori, regolate il cursore della luminosità accanto alla ruota.

• Per impostare il colore di base, trascinate l’indicatore corrispondente (indicatore più grande, con doppio cerchio) 

intorno alla ruota. Potete inoltre impostare il colore di base regolando i cursori colore nella parte inferiore della 

finestra di dialogo.

• Impostate uno degli altri quattro colori del gruppo come colore di base. Selezionate il campione di colore e fate clic 

sul pulsante a bersaglio che si trova sotto il gruppo di colori. 

• Impostate come colore di base il colore di sfondo o primo piano oppure il colore di riempimento o traccia 

dell’applicazione in uso. Fate clic sui primi due pulsanti sotto il gruppo di colori.

• Per rimuovere un colore dal gruppo di colori, selezionatene il campione e fate clic sul pulsante Rimuovi colore che 

si trova sotto il gruppo di colori. Per aggiungere un colore, selezionate un campione colore vuoto e fate clic sul 

pulsante Aggiungi colore. 

• Per provare diversi colori, selezionate un altro criterio di armonia e spostate gli indicatori nella ruota dei colori.
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• Per impostare il colore attivo (primo piano o sfondo, traccia o riempimento) per l’applicazione in uso, fate doppio 

clic su uno dei campioni nel gruppo di colori. Se l’applicazione non dispone di una funzione di colore attivo o 

selezionato, il pannello Kuler imposta il colore di sfondo o il colore di riempimento, come appropriato. 

Applicare tratti e riempimenti

Applicare e modificare tratti

L’utente ha pieno controllo di tutte le sfumature del pennello, tra cui la quantità di inchiostro, la grandezza e la forma 

della punta, la texture, l’effetto bordo e l’aspetto. È possibile applicare modifiche agli attributi del tratto prima o dopo 

aver creato gli oggetti. L’icona della matita indica la casella del Colore tratto nel pannello Strumenti, nella finestra di 

ispezione Proprietà e nel Mixer colori. 

Le impostazioni del tratto, le categorie del tratto e i nomi del tratto di un oggetto selezionato vengono conservati nei 

diversi documenti e nelle diverse sessioni delle applicazioni. Quando si crea un oggetto in un nuovo documento della 

sessione corrente o in un nuovo documento dopo la riapertura di Fireworks, vengono utilizzate le ultime impostazioni 

di tratto selezionate. Le impostazioni vengono mantenute anche tra diverse sessioni.

Per applicare un tratto a un oggetto bitmap, utilizzare Effetti dal vivo Photoshop e selezionare gli attributi del tratto. 

Consultare “Applicare i filtri attivi” a pagina 130.

Modificare gli attributi del tratto degli oggetti selezionati

Effettuare una delle seguenti operazioni:

• Selezionare gli attributi di tratto nel menu a comparsa Categoria tratto nella finestra di ispezione Proprietà. 

• Selezionare Opzioni tratto dal menu a comparsa Categoria tratto per visualizzare ulteriori opzioni, quindi 

effettuare una selezione dagli attributi del tratto. 

Modificare il colore del tratto di uno strumento di disegno

1 Per deselezionare tutti gli oggetti, premere Ctrl + D (Windows) o Comando + D (Mac OS).

2 Selezionare uno strumento di disegno nel pannello Strumenti.

3 Fare clic sulla casella Colore tratto nel pannello Strumenti o nella finestra di ispezione Proprietà. 

4 Selezionare un colore e trascinare per disegnare l’oggetto.

Nota: i tratti appena creati utilizzano il colore visualizzato nella casella Colore tratto.

Rimuovere gli attributi del tratto da un oggetto selezionato

Effettuare una delle seguenti operazioni:

• Selezionare Nessuno dal menu a comparsa Categoria tratto nella finestra di ispezione Proprietà o nella finestra a 

comparsa Opzioni tratto. 

•  Fare clic sulla casella Colore tratto nel pannello Strumenti o nella finestra di ispezione Proprietà, quindi fare clic 

sul pulsante Trasparente .
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Allineamento dei tratti

Nella finestra di ispezione Proprietà, utilizzare le opzioni di allineamento dei tratti (Allinea tratto su centro, Allinea 

tratto su interno e Allinea tratto su esterno). Le icone di allineamento presenti nella finestra di ispezione Proprietà 

consentono di accedere rapidamente a queste opzioni.

Creare e modificare tratti personalizzati

La finestra di dialogo Modifica tratto consente di cambiare determinate caratteristiche di tratto.

Aprire la finestra di dialogo Modifica tratto

Effettuare una delle seguenti operazioni:

1 Fare clic su Modifica tratto nella finestra di ispezione Proprietà.

2 Ciascuna scheda mostra il pennello con le impostazioni correnti. Le impostazioni di sensibilità relative alla 

pressione e alla velocità sono visualizzate nell’anteprima mediante un tratto che si riduce o si affievolisce (ovvero 

un tratto che si trasforma) da sinistra a destra. 

Impostare opzioni generiche dei tratti a pennello

1 Nella scheda Opzioni, impostare la quantità di inchiostro, la spaziatura e la velocità di flusso. Un valore di flusso 

più elevato genera tratti a pennello più lenti, come in un aerografo.

2 Selezionare le opzioni per il tratto a pennello:

• Per sovrapporre tratti a pennello e ottenere così tratti più spessi, selezionare Accumulo.

• Per impostare la texture di un tratto, modificare l’opzione Texture. Maggiore è il valore, più evidente è la texture.

• Per impostare la texture ai bordi, inserire un valore nella casella Texture bordo e selezionare un effetto bordo 

dal menu a comparsa Effetto bordo. 



122UTILIZZO DI FIREWORKS

Applicazione di colori, tratti e riempimenti

Ultimo aggiornamento 4/5/2011

• Impostare il numero di punte che si desidera dare al tratto a pennello. Per impostare più punte, immettere un 

valore Spaziatura punte e selezionare il metodo di variazione del colore. 

• Per scegliere una linea tratteggiata, selezionare un’opzione dal menu a comparsa Trattino.

• Per impostare la lunghezza dei trattini e degli spazi di una linea tratteggiata, utilizzare i tre gruppi di caselle di 

inserimento testo Pieno e Vuoto che consentono di definire rispettivamente il primo, il secondo e il terzo 

trattino.

3 Fare clic su OK.

Modificare la punta del pennello

1 Nella scheda Forma, selezionare l’opzione Quadrato se si desidera una punta quadrata; in caso contrario, 

deselezionarla.

2 Immettere i valori per la grandezza della punta del pennello, la morbidezza del bordo, l’aspetto e l’angolazione della 

punta.

3 Fare clic su OK.

Nota: se si utilizza una tavoletta Wacom con penna sensibile alla pressione, Fireworks offre impostazioni apposite per 

la regolazione precisa degli attributi di tratto per velocità e pressione. È possibile selezionare gli attributi di tratto 

controllabili con la penna.

Impostare la sensibilità del tratto

1 Nella scheda Sensibilità, selezionare una proprietà per il tratto dal menu a comparsa Proprietà tratto.

2 Dalle opzioni Influenzata da, scegliere in che misura la proprietà di tratto selezionata viene alterata dalla sensibilità.

Salvare o eliminare i tratti personalizzati

Per salvare o eliminare un tratto personalizzato, fare clic su Salva tratto personalizzato o su Elimina tratto 

personalizzato nella finestra di ispezione Proprietà.

Spostare un tratto a pennello all’interno o all’esterno di un tracciato

Tratto centrato, Tratto all’interno e Tratto all’esterno

Il menu a comparsa Tratto della finestra Opzioni tratto consente di spostare i tratti a pennello dalla posizione 

predefinita (al centro di un tracciato) in un’altra posizione.

1 Nel pannello Strumenti o nella finestra di ispezione Proprietà, fare clic sulla casella Tratto per aprire la finestra a 

comparsa dei campioni di colore.

2 Nella parte inferiore della finestra a comparsa, selezionare All’interno del tracciato o All’esterno del tracciato dal 

menu a comparsa.

3 (Facoltativo) Selezionare l’opzione Riempimento su tratto.
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Generalmente, il tratto si sovrappone al riempimento. Selezionare Riempimento su tratto per disegnare il 

riempimento sul tratto. Se si utilizza Riempimento su tratto con un oggetto che presenta una riempimento opaco, 

le parti del tratto all’interno del tracciato sono oscurate. Un riempimento con un grado di trasparenza può tingersi 

o fondersi con un tratto a pennello all’interno di un tracciato.

Creare stili di tratto

È possibile modificare le caratteristiche specifiche del tratto quali la quantità di inchiostro, la forma e la sensibilità della 

punta, nonché salvare il tratto personalizzato come stile da utilizzare anche in altri documenti.

1 Effettuare una delle seguenti operazioni:

• Fare clic sulla casella Colore tratto nel pannello Strumenti e fare clic su Opzioni tratto.

• Selezionare le opzioni tratto dal menu a comparsa Categoria tratto nella finestra di ispezione Proprietà.

2 Modificare gli attributi del tratto a pennello.

3 Fare clic sul pulsante Salva tratto personalizzato per salvare gli attributi di tratto personalizzati come stile da 

riutilizzare in futuro.

Creare e modificare riempimenti uniformi

È possibile creare e utilizzare riempimenti per il testo e gli oggetti vettoriali e utilizzare lo strumento Secchio di vernice 

o Gradiente per riempire le selezioni di pixel in base alle impostazioni correnti del riempimento. 

L’icona Secchio di vernice  rispecchia la casella Colore riempimento nel pannello Strumenti, nella finestra di 

ispezione Proprietà e nel Mixer colori.

Cambiare il colore di riempimento uniforme degli strumenti di disegno vettoriale e dello 
strumento Secchio di vernice

1 Selezionare uno strumento di disegno vettoriale o lo strumento Secchio di vernice.

2 Effettuare una delle seguenti operazioni:

• Premere Ctrl + D (Windows) o Comando + D (Mac OS) per deselezionare tutti gli oggetti, quindi fare clic sulla 

casella Colore riempimento nella finestra di ispezione Proprietà per aprire la finestra a comparsa dei colori.

• Fare clic sulla casella Colore riempimento nel pannello Strumenti o nel Mixer colori per aprire la finestra a 

comparsa colori.

3 Selezionare un colore per il riempimento dalla serie di campioni o utilizzare il contagocce per campionare un colore 

da un punto qualunque della schermata. 

Nota: quando si seleziona lo strumento Testo, la casella Colore riempimento ritorna all’ultimo colore utilizzato dallo 

strumento Testo.

Modificare il riempimento uniforme di un oggetto vettore selezionato

1 Fare clic sulla casella Colore riempimento nella finestra di ispezione Proprietà, nel pannello Strumenti o nel Mixer 

colori, per aprire la finestra a comparsa colori.

2 Selezionare un campione di colore. 

Creare e applicare riempimenti a gradiente o con motivo

• Utilizzare riempimenti a motivo per riempire un oggetto tracciato con un elemento grafico bitmap. 



124UTILIZZO DI FIREWORKS

Applicazione di colori, tratti e riempimenti

Ultimo aggiornamento 4/5/2011

• Utilizzare riempimenti a gradiente per miscelare i colori e creare diversi effetti. Tutte le categorie di riempimento 

diverse da Nessuno, Uniforme, Motivo e Dithering Web sono costituite da riempimenti a gradiente.

Nota: un riempimento appena creato assume il colore visualizzato nella casella Colore riempimento del pannello 

Strumenti. 

Applicare un riempimento a motivo a un oggetto selezionato

1 Effettuare una delle seguenti operazioni:

• Selezionare Motivo dal menu a comparsa Categoria riempimento nella finestra di ispezione Proprietà.

• Fare clic sulla casella Colore riempimento nel pannello Strumenti, quindi su Opzioni riempimento e selezionare 

Motivo dal menu a comparsa Colore di riempimento.

2 Scegliere il motivo dal menu a comparsa Nome motivo.

Creare un riempimento a motivo personalizzato da un file esterno

Impostare un file bitmap come nuovo riempimento a motivo, utilizzando come motivi i file che presentano il seguente 

formato: PNG, GIF, JPEG, BMP, TIFF e PICT (solo Mac OS). Quando un riempimento a motivo è un’immagine 

trasparente a 32 bit, la trasparenza incide sul riempimento utilizzato in Fireworks. Le immagini non a 32 bit diventano 

opache.

1 Nel menu a comparsa Categoria riempimento, selezionare Motivo, con l’oggetto vettoriale visualizzato nella 

finestra di ispezione Proprietà.

2 Fare clic sulla casella Colore riempimento e selezionare Altro dal menu a comparsa Nome motivo.

3 Portarsi nel file bitmap che si desidera utilizzare come nuovo motivo e fare clic su Apri.

Applicare un riempimento a gradiente a un oggetto selezionato

Oggetti con riempimenti a gradiente

❖ Scegliere un gradiente dal menu a comparsa Categoria riempimento nella finestra di ispezione Proprietà. 
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Modificare un riempimento a gradiente

Finestra a comparsa Modifica gradiente

1 Selezionare un oggetto contenente un riempimento a gradiente oppure scegliere un riempimento a gradiente dal 

menu Categoria riempimento nella finestra di ispezione Proprietà.

2 Fare clic sulla casella Colore riempimento nella finestra di ispezione Proprietà o nel pannello Strumenti per aprire 

la finestra a comparsa.

3 Effettuare una delle seguenti operazioni:

• Per aggiungere un nuovo campione colore, fare clic nell’area sotto la barra colore gradiente.

• Per aggiungere un campione opacità, fare clic sull’area posta sopra la barra colore gradiente.

• Per rimuovere un campione opacità o colore dal gradiente, trascinare il campione dalla finestra a comparsa 

Modifica gradiente.

• Per impostare o modificare il colore di un campione, fare clic sul campione e selezionare un colore.

• Per impostare o modificare la trasparenza di un campione opacità, fare clic sul campione e trascinare il 

dispositivo di scorrimento sulla percentuale di trasparenza (0 applica una trasparenza completa e 100 un’opacità 

completa) o immettere un valore di opacità numerico compreso tra 0 e 100. Quindi premere Invio o fare clic 

all’esterno della finestra a comparsa Modifica gradiente.

Nota: la scacchiera delle trasparenze è visibile attraverso il gradiente nelle aree trasparenti.

• Per regolare la transizione tra i colori del riempimento, trascinare i campioni di colore verso sinistra o destra.

Creare riempimenti con lo strumento Gradiente

Utilizzare lo strumento Gradiente per riempire un oggetto con un gradiente anziché un colore uniforme. Lo strumento 

Gradiente mantiene le proprietà dell’ultimo elemento utilizzato. 

1 Fare clic sullo strumento Secchio di vernice nel pannello Strumenti e selezionare Strumento Gradiente dal menu a 

comparsa.

2 Selezionare gli attributi nella finestra di ispezione Proprietà.

3 Fare clic e trascinare il puntatore per stabilire un punto di inizio del gradiente e la direzione e la lunghezza dell’area 

del gradiente.

Ridurre il banding nei gradienti

Tramite questa opzione, è possibile ridurre l’effetto banding nei gradienti. È possibile applicare il dithering solo agli 

oggetti vettoriali dotati di gradienti lineari o radiali. Quando il file viene importato in una precedente versione di 

Fireworks, il dithering viene perso.

1 Disegnare un oggetto vettoriale e riempirlo con un gradiente lineare o radiale.

2 Nella finestra di dialogo Opzioni riempimento, impostare il bordo con antialiasing.
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3 Impostare la texture su 0%.

4 Selezionare Dithering.

Trasformare e distorcere i riempimenti

È possibile spostare, ruotare, inclinare o modificare la larghezza di qualsiasi riempimento a gradiente o con motivo 

applicato a un oggetto. Quando si utilizzano gli strumenti Puntatore o Gradiente per selezionare un oggetto con un 

riempimento a motivo o a gradiente, sull’oggetto o vicino all’oggetto compare un set di maniglie. Trascinare le 

maniglie per regolare il riempimento dell’oggetto. 

Utilizzare le maniglie di riempimento per regolare in modo interattivo un riempimento a motivo o gradiente.

• Per spostare il riempimento all’interno di un oggetto, trascinare la maniglia rotonda o utilizzare lo strumento 

Gradiente per fare clic in una nuova posizione. 

• Per regolare la larghezza e l’inclinazione del riempimento, trascinare una maniglia quadrata.

• Per ruotare il riempimento, trascinare le linee che collegano le maniglie.

Per ruotare un riempimento in incrementi di 45 gradi, tenere premuto il tasto Maiusc durante il trascinamento.

Modificare i bordi dei riempimenti

I bordi di un riempimento possono essere costituiti da una linea rigida regolare o possono essere attenuati mediante 

le funzioni di morbidezza o antialiasing. 

Per impostazione predefinita, ai bordi è applicato l’antialiasing, che fonde il bordo sullo sfondo per attenuare i bordi 

scalettati visibili su oggetti arrotondati, quali ellissi e cerchi. 

La funzione Morbidezza crea una fusione visibile su entrambi i lati del bordo. In questo modo il bordo viene attenuato, 

con un effetto simile a un bagliore.

1 Effettuare una delle seguenti operazioni: 

• Fare clic sul menu a comparsa Bordo nella finestra di ispezione Proprietà.

• Fare clic sulla casella Colore riempimento, quindi su Opzioni riempimento e infine sul menu a comparsa Bordo.

2 Selezionare un’opzione per il bordo: Bordo rigido, Antialiasing o Morbidezza. 

3 Per ottenere un bordo ammorbidito, selezionare il numero di pixel (compreso tra 0 e 100) su ciascun lato del bordo 

da ammorbidire. Il valore predefinito è 10. Il valore è direttamente proporzionale al livello di morbidezza.
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Salvare un riempimento a gradiente personalizzato 

❖ Per salvare le impostazioni correnti dei riempimenti a gradiente per la condivisione tra diversi strumenti, creare 

uno stile. 

Rimuovere un riempimento da un oggetto selezionato

Effettuare una delle seguenti operazioni:

• Selezionare Nessuno dal menu a comparsa Categoria riempimento nella finestra di ispezione Proprietà oppure dal 

menu a comparsa della finestra Opzioni riempimento.

• Fare clic sulla casella Colore riempimento e sul pulsante Trasparente. Questa opzione elimina solo i riempimenti 

uniformi.

Aggiungere effetti tridimensionali a tratti e riempimenti

È possibile aggiungere effetti tridimensionali a tratti e riempimenti aggiungendo le texture. Le texture modificano la 

luminosità ma non la tonalità e conferiscono un aspetto più naturale a tratti e riempimenti. L’effetto delle texture 

risulta più efficace con i tratti ampi. 

Per aggiungere una texture a un tratto a pennello, utilizzare le opzioni Tratto nella finestra di ispezione Proprietà oppure la finestra a comparsa 
Opzioni tratto.

Aggiungere texture a un tratto o riempimento

1 Effettuare una delle seguenti operazioni: 

• Fare clic sul menu a comparsa Texture tratto o Texture riempimento nella finestra di ispezione Proprietà.

• Fare clic sulla casella Colore tratto o Colore riempimento nel pannello Strumenti, fare clic su Opzioni tratto o 

Opzioni riempimento e infine sul menu a comparsa Texture.

2 Effettuare una delle seguenti operazioni: 

• Scegliere una texture dal menu a comparsa.

• Selezionare Altro dal menu a comparsa e individuare un file di texture. 

Nota: le texture possono essere applicate ai file che presentano i seguenti formati: PNG, GIF, JPEG, BMP, TIFF e 

PICT (solo Mac OS). 

3 Immettere un valore in percentuale compreso tra 0 e 100 (dove 0 rappresenta il valore minimo e 100 il valore 

massimo) per controllare la profondità della texture. 

4 (Solo per i riempimenti) Selezionare Trasparente per conferire al riempimento un grado di trasparenza. 

Aggiungere una texture personalizzata

❖ È possibile utilizzare come texture file bitmap creati in Fireworks e altre applicazioni. Le texture possono essere 

applicate dai file nei seguenti formati: PNG, GIF, JPEG, BMP, TIFF e PICT (solo Mac OS). 
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Creare una nuova texture da un file esterno

1 Con le proprietà dell’oggetto vettoriale visualizzate nella finestra di ispezione Proprietà, selezionare Altro da un 

menu a comparsa Nome texture.

2 Individuare il file bitmap da utilizzare come nuova texture e fare clic su Apri. 
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Capitolo 9: Uso dei filtri attivi

Applicazione di filtri attivi

Adobe® Fireworks® consente di applicare filtri attivi (detti “effetti dal vivo” nelle versioni precedenti) a oggetti 

vettoriali, immagini bitmap e testo. I filtri attivi comprendono smussi e rilievi, ombre uniformi, luci e ombre esterne, 

correzione del colore, nonché sfocatura e precisione. È possibile applicare i filtri attivi agli oggetti selezionati 

direttamente dalla finestra di ispezione Proprietà.

I filtri attivi

I filtri attivi si aggiornano quando si modificano gli oggetti a cui sono applicati. Dopo l’applicazione di un filtro attivo, 

è possibile modificarne le opzioni in qualsiasi momento, oppure ridefinire l’ordine dei filtri in modo da sperimentare 

con filtri combinati. I filtri attivi possono essere attivati, disattivati o cancellati nella finestra di ispezione Proprietà. 

Quando si elimina un filtro, viene ripristinato l’aspetto precedente dell’oggetto o dell’immagine.

Menu a comparsa Filtri attivi nella finestra di ispezione Proprietà

• Alcuni filtri (ad esempio Livelli auto, Sfocatura Gaussian e Maschera definizione dettagli) originariamente 

disponibili come filtri o plug-in irreversibili, ora sono disponibili anche come filtri attivi di Fireworks.

• È possibile aggiungere plug-in di altri produttori come filtri attivi o utilizzare tali filtri nel modo consueto mediante 

il menu Filtri.

• se la finestra di ispezione Proprietà è ridotta a metà altezza, fare clic su Modifica filtri o Aggiungi filtri per 

visualizzare il menu a comparsa Filtri attivi.

Nota: un riempimento appena creato assume il colore visualizzato nella casella Colore di riempimento del pannello 

Strumenti.

• Quando si personalizzano i filtri attivi, provare le diverse impostazioni fino ad ottenere l’aspetto desiderato.
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Finestra del menu a comparsa Smusso interno
A. Larghezza dello smusso  B. Preimpostazione del pulsante di smusso  C. Contrasto  D. Morbidezza  E. Angolo dello smusso  

Applicare i filtri attivi

Applicare un filtro attivo a un oggetto selezionato

1 Nella finestra di ispezione Proprietà, fare clic sul pulsante più (+) accanto all’etichetta Filtri, quindi selezionare un 

filtro dal menu a comparsa Aggiungi filtri attivi.

Il filtro viene aggiunto all’elenco dei filtri attivi per l’oggetto selezionato.

Per applicare un filtro attivo in modo che incida apparentemente solo sulla selezione di pixel all’interno di 

un’immagine, è possibile tagliare e incollare la selezione anziché creare un’immagine bitmap, selezionarla e quindi 

applicare il filtro attivo.

2 Quando si apre una finestra o un menu a comparsa, specificare le impostazioni per il filtro ed effettuare una delle 

seguenti operazioni:

• Se il filtro attivo è associato a una finestra di dialogo, fare clic su OK.

• Se il filtro attivo è associato a un menu a comparsa, premere Invio o fare clic in un punto qualsiasi dello spazio 

di lavoro.

3 Ripetere i passaggi 1 e 2 per applicare più filtri attivi.

Nota: l’ordine in cui i filtri attivi vengono applicati incide sul filtro globale. È possibile trascinare i filtri attivi per 

ridefinirne l’ordine di sovrapposizione (e di applicazione).

Attivare o disattivare un filtro attivo applicato a un oggetto

❖ Fare clic sulla casella corrispondente al filtro nell’elenco Filtri della finestra di ispezione Proprietà.

Attivare o disattivare tutti i filtri attivi applicati a un oggetto

❖ Nella finestra di ispezione Proprietà, fare clic sul pulsante più (+) accanto all’etichetta Filtri, quindi selezionare 

Opzioni > Tutto attivato o Opzioni > Tutto disattivato dal menu a comparsa.

Salvare gli effetti applicati

❖ Dopo aver aggiunto e modificato un filtro attivo, fare clic all’esterno del menu a comparsa delle impostazioni o 

premere Invio.

Applicare bordi smussati

Un bordo smussato conferisce a un oggetto un aspetto in rilievo.

C

E

D

B

A
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Un rettangolo con smusso interno e smusso esterno

1 Nella finestra di ispezione Proprietà, fare clic sul pulsante più (+) accanto all’etichetta Filtri, quindi selezionare 

un’opzione per bordi smussati dal menu a comparsa.

2 Modificare le impostazioni del filtro nel menu a comparsa.

Applicare rilievi

Il filtro attivo Rilievo consente di conferire a un’immagine, un oggetto o un testo un aspetto rientrato o sollevato 

rispetto all’area di lavoro.

Un oggetto con rilievo rientrato e rilievo sollevato

1 Nella finestra di ispezione Proprietà, fare clic sul pulsante più (+) accanto all’etichetta Filtri, quindi selezionare 

un’opzione di rilievo dal menu a comparsa.

2 Modificare le impostazioni dei filtri.

Se si desidera che l’oggetto originale appaia nell’area in rilievo, selezionare Mostra oggetto.

Nota: per compatibilità retroattiva, nei documenti creati con versioni precedenti contenenti oggetti con il filtro attivo 

Rilievo, l’opzione Mostra oggetto è deselezionata.

Applicare ombre e luci 

Scegliere l’ombra desiderata, quindi specificare l’angolo da applicare per simulare la luce sull’oggetto.

Filtri Ombra esterna, Ombra interna e Luce

Impostazione dei filtri per le ombre

Le opzioni disponibili variano in base al tipo di ombra.

• Per impostare la direzione dell’ombra, trascinare il dispositivo di scorrimento Angolo.

• Per impostare la distanza dell’ombra dall’oggetto, trascinare il cursore Distanza.

• Per applicare un colore uniforme all’ombra, selezionare l’opzione Colore uniforme.

• Per impostare il colore dell’ombra, aprire il relativo menu a comparsa e impostare il colore dell’ombra.

• Per impostare la percentuale di trasparenza dell’ombra, trascinare il dispositivo di scorrimento Opacità.
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• Per impostare l’intensità dell’ombra, trascinare il dispositivo di scorrimento Morbidezza.

• Per visualizzare un’anteprima dell’ombra, fare clic sull’opzione Anteprima.

• Per nascondere l’oggetto e visualizzarne solo l’ombra, selezionare Scava.

Applicare un’ombra uniforme

1 Nella finestra di ispezione Proprietà, fare clic sul pulsante più (+) accanto all’etichetta Filtri, portare il puntatore su 

Ombra e luce e fare clic su Ombra uniforme.

2 Nella finestra di dialogo Ombra uniforme, regolare le impostazioni del filtro.

3 Al termine, fare clic su OK.

Applicare un’ombra esterna o interna

1 Nella finestra di ispezione Proprietà, fare clic sul pulsante più (+) accanto all’etichetta Filtri, quindi selezionare 

un’opzione per l’ombra dal menu a comparsa:

• Ombra e luce > Ombra esterna

• Ombra e luce > Ombra interna

2 Modificare le impostazioni del filtro nel menu a comparsa.

Applicare il filtro Bagliore

1 Fare clic sul pulsante Aggiungi filtri nella finestra di ispezione Proprietà, quindi selezionare Ombra e luce > Luce.

2 Modificare le impostazioni del filtro nel menu a comparsa:

• Per impostare il colore del bagliore, fare clic sulla casella di controllo relativa al colore.

• Per impostare la larghezza del bagliore, trascinare il dispositivo di scorrimento Larghezza.

• Per impostare la percentuale di trasparenza del bagliore, trascinare il dispositivo di scorrimento Opacità.

• Per impostare l’intensità del bagliore, trascinare il cursore Morbidezza.

• Per specificare la distanza dell’ombra dal bagliore, trascinare il dispositivo di scorrimento Scostamento.

Applicare filtri e plug-in di Photoshop come filtri attivi

Nota: il menu Xtra di alcune versioni precedenti di Fireworks è detto menu Filtri in Fireworks 8 e versioni successive. Le 

estensioni Xtra di Fireworks corrispondono quindi ai filtri attuali.

L’applicazione di plug-in e filtri incorporati nel menu a comparsa Aggiungi filtri come filtri attivi ne garantisce la 

modifica o la rimozione da un oggetto.

Utilizzare il menu Filtri per applicare i filtri e i plug-in di Adobe Photoshop® solo nel caso in cui si è sicuri di non voler 

modificare o rimuovere il filtro. Un filtro può essere rimosso solo se il comando Annulla è disponibile.

Installare e applicare i plug-in di Photoshop

1 Fare clic sul pulsante Aggiungi filtri nella finestra di ispezione Proprietà, quindi selezionare Opzioni > Individua 

plug-in.

2 Portarsi sulla cartella che contiene i plug-in di Photoshop, quindi fare clic su OK.

3 Riavviare Fireworks per caricare i plug-in.

Nota: se si spostano i plug-in in una cartella diversa, ripetere i passaggi precedenti, oppure selezionare File > 

Preferenze e fare clic sulla scheda Plug-in per modificare il percorso dei plug-in. Quindi riavviare Fireworks.
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4 Per applicare il plug-in di Photoshop a un oggetto selezionato, nella finestra di ispezione Proprietà, fare clic sul 

pulsante più (+) accanto all’etichetta Filtri, quindi selezionare un filtro dal sottomenu Opzioni.

Applicare effetti livello Photoshop

Nota: se si importa un file PSD, è anche possibile modificare gli effetti livello già esistenti nel file.

1 Fare clic sul pulsante Aggiungi filtri attivi nella finestra di ispezione Proprietà e scegliere Effetti dal vivo Photoshop.

2 Selezionare uno degli effetti nel riquadro a sinistra e quindi modificare le impostazioni nel riquadro a destra. È 

possibile selezionare più effetti contemporaneamente.

Applicare filtri a oggetti raggruppati

Quando si applica un filtro a un gruppo, il filtro viene applicato a tutti gli oggetti del gruppo. Se gli oggetti vengono 

separati, ciascuno riacquista le impostazioni dei filtri che gli erano state applicate individualmente.

Per applicare filtri a un solo oggetto di un gruppo, selezionare solo l’oggetto desiderato mediante lo strumento 

Sottoselezione.

Modificare e personalizzare i filtri attivi

Modificare le impostazioni dei filtri attivi

1 Nella finestra di ispezione Proprietà, fare clic sul pulsante Info accanto al filtro che si desidera modificare.

2 Regolare le impostazioni dei filtri.

I filtri non modificabili non sono attivi.

3 Fare clic all’esterno della finestra o premere Invio.

Riordinare o rimuovere i filtri attivi

Riordinare i filtri attivi

È possibile modificare l’ordine dei filtri applicati a un oggetto. Quando si riordinano i filtri, si modifica la sequenza in 

cui questi vengono applicati e ciò può determinare risultati diversi. I filtri vengono applicati in sequenza in base 

all’ordine dell’elenco, dall’alto al basso.

In genere, i filtri che modificano l’interno di un oggetto, quali il filtro Smusso interno, devono essere applicati prima 

di quelli che modificano l’esterno di un oggetto. Ad esempio, il filtro Smusso interno dovrebbe essere applicato prima 

dei filtri Smusso esterno, Luce o Ombra.

❖ Per riordinare i filtri, trascinare un filtro in una diversa posizione nell’elenco della finestra di ispezione Proprietà.

Rimuovere un filtro specifico applicato a un oggetto selezionato

❖ Selezionare il filtro da rimuovere nell’elenco Filtri della finestra di ispezione Proprietà, quindi fare clic sul pulsante 

di eliminazione filtri.

Rimuovere tutti i filtri da un oggetto selezionato

❖ Nella finestra di ispezione Proprietà, fare clic sul pulsante più (+) accanto all’etichetta Filtri, quindi selezionare 

Nessuno dal menu a comparsa.
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Creare filtri attivi personalizzati

I filtri attivi personalizzati sono stili le cui opzioni delle proprietà sono deselezionate, ad eccezione dell’opzione Filtro. 

Per salvare una particolare combinazione di impostazioni per i filtri attivi, creare un filtro attivo personalizzato.

Creare un filtro attivo personalizzato con il pannello Stili

1 Applicare le impostazioni dei filtri attivi agli oggetti selezionati. Per ulteriori informazioni, consultare 

“Applicazione di filtri attivi” a pagina 129.

2 Selezionare Nuovo stile dal menu del pannello Stili.

3 Deselezionare tutte le proprietà ad eccezione di Effetto, immettere un nome e fare clic su OK.

Al pannello stili viene aggiunta un’icona di stile che rappresenta il filtro attivo.

Nota: se si seleziona una proprietà aggiuntiva nella finestra di dialogo Nuovo stile, lo stile non comparirà più nel 

menu a comparsa Aggiungi filtri attivi della finestra di ispezione Proprietà, nonostante rimanga nel pannello Stili 

come stile tipico.

Applicare un filtro attivo personalizzato a un oggetto selezionato

❖ Fare clic sull’icona del filtro attivo personalizzato nel pannello Stili.

È possibile rinominare o eliminare un filtro attivo personalizzato come se si trattasse di qualsiasi altro stile del 

pannello Stili. Non è possibile rinominare o eliminare un filtro standard di Fireworks.

Salvare filtri attivi come comandi

È possibile salvare e riutilizzare un filtro creando un comando basato su di esso. Il comando può essere utilizzato 

nell’elaborazione batch.

1 Applicare i filtri all’oggetto.

2 Se il pannello Cronologia non è visibile, selezionare Finestra > Cronologia.

3 Tenere premuto il tasto Maiusc e fare clic sulle azioni da salvare come un comando.

4 Effettuare una delle seguenti operazioni:

• Selezionare Salva come comando dal menu Opzioni del pannello Cronologia.

• Fare clic sul pulsante Salva nella parte inferiore del pannello Cronologia.

5 Inserire il nome di un comando e fare clic su OK per aggiungere il comando al menu Comandi.
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Capitolo 10: Livelli, maschere e fusione

I livelli suddividono il documento di Adobe® Fireworks® in piani discreti, come se i componenti grafici fossero 

disegnati su fogli separati di carta da ricalco sovrapposti. Un documento può essere formato da diversi livelli, ognuno 

dei quali contenente a sua volta vari oggetti o livelli secondari. I livelli di Fireworks sono simili ai gruppi di livelli di 

Adobe Photoshop®. I livelli di Photoshop sono invece simili ai singoli oggetti di Fireworks.

L’applicazione di maschere consente di bloccare parte dell’immagine sottostante. Ad esempio, è possibile incollare una 

forma ellittica come maschera su una fotografia. Tutte le aree esterne all’ellisse scompariranno come se fossero state 

ritagliate, lasciando visibile solo la parte dell’immagine all’interno dell’ellisse.

Le tecniche di fusione e applicazione di maschere offrono un ulteriore livello di controllo creativo. È possibile creare 

effetti esclusivi effettuando una fusione di colori in oggetti sovrapposti. Fireworks offre diverse modalità di fusione per 

ottenere l’effetto desiderato.

Livelli

Ogni oggetto di un documento risiede su un livello. È possibile creare i livelli prima di iniziare le operazioni di disegno 

oppure aggiungerli in seguito, in base alle proprie esigenze. L’area di lavoro si trova sotto tutti gli altri livelli, ma non 

costituisce di per sé un livello.

Il pannello Livelli visualizza lo stato corrente di tutti i livelli nello stato o nella pagina corrente di un documento. Il 

nome del livello attivo è evidenziato. L’ordine di sovrapposizione è l’ordine con cui gli oggetti vengono visualizzati nel 

documento e determina il modo in cui gli oggetti situati su un livello si sovrappongono agli oggetti di un altro livello. 

I livelli più recenti si trovano in alto nell’ordine di sovrapposizione. L’ordine di impilamento dei livelli e degli oggetti 

all’interno dei livelli può essere modificato a piacere ed è possibile creare livelli secondari e spostare oggetti all’interno 

di essi.

Nel pannello Livelli sono visualizzati anche i comandi per le modalità di applicazione di maschere, opacità e fusione. 
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A. Espandi/riduci livello  B. Blocca/sblocca livello  C. Mostra/nascondi livello  D. Livello attivo  E. Elimina livello  F. Livello nuovo/duplicato  
G. Nuovo sottolivello  H. Aggiungi maschera  I. Nuova immagine bitmap  

Attivare un livello

Gli oggetti disegnati, incollati o importati risiedono inizialmente nel livello attivo, sopra agli altri oggetti di tale livello. 

❖ Effettuare una delle seguenti operazioni:

• Fare clic sul nome di un livello nel pannello Livelli.

• Selezionare un oggetto su quel livello.

Aggiungere e rimuovere livelli

Utilizzando il pannello Livelli, è possibile aggiungere nuovi livelli e livelli secondari, eliminare quelli superflui e 

duplicare i livelli e gli oggetti esistenti.

Aggiungere un livello

Un livello vuoto viene inserito sopra il livello correntemente selezionato e diventa il livello attivo.

❖ Effettuare una delle seguenti operazioni:

• Fare clic sul pulsante Livello nuovo/duplicato .

• Selezionare Modifica > Inserisci > Livello.

• Selezionare Nuovo livello o Nuovo Sottolivello dal menu o menu a comparsa Opzioni del pannello Livelli, 

quindi fare clic su OK.

Eliminare un livello

Il livello soprastante quello eliminato diventa il livello attivo. Se il livello eliminato è l’ultimo rimasto, viene creato un 

nuovo livello vuoto.

❖ Effettuare una delle seguenti operazioni:

• Trascinare il livello sull’icona del cestino  nel pannello Livelli.

• Selezionare il livello e fare clic sull’icona del cestino nel pannello Livelli.

• Selezionare il livello e scegliere Elimina livello dal menu o menu a comparsa Opzioni del pannello Livelli.

È possibile utilizzare l’estensione Elimina livelli vuoti per rimuovere tutti i livelli normali e i livelli web vuoti presenti 

in tutti gli stati e le pagine del documento corrente. Questa estensione è disponibile all'indirizzo 

http://www.adobe.com/go/learn_fw_deleteemptylayers_it.

A

C
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http://www.adobe.com/go/learn_fw_deleteemptylayers_it
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Duplicare un livello e gli oggetti

Un livello duplicato contiene gli stessi oggetti del livello selezionato. Gli oggetti duplicati mantengono la modalità di 

opacità e fusione degli oggetti originali. È possibile modificare gli oggetti duplicati senza incidere sugli originali.

❖ Effettuare una delle seguenti operazioni:

• Trascinare il livello sul pulsante Livello nuovo/duplicato.

• Selezionare un livello e scegliere Duplica livello dal menu o menu a comparsa Opzioni del pannello Livelli. 

Quindi impostare il numero di livelli duplicati da inserire e dove collocarli nell’ordine di sovrapposizione. Dal 

momento che il Livello Web è sempre il livello superiore, l’opzione In cima significa immediatamente sotto il 

Livello Web.

Duplicare un oggetto

❖ Trascinare l’istanza dell’oggetto tenendo premuto Alt (Windows) oppure Opzione (Mac OS).

Espandere o ridurre i livelli

Per rendere il pannello Livelli più ordinato e gestibile, ridurre la visualizzazione dei livelli. Per visualizzare o 

selezionare oggetti specifici di un livello, espandere il livello.

• Per espandere o ridurre un singolo livello, fare clic sul triangolino a sinistra del nome.

• Per espandere o ridurre tutti i livelli, tenere premuto il tasto Alt (Windows) o il tasto Opzione (Mac OS) e fare clic 

sul triangolino a sinistra del nome.

Organizzare i livelli

Per organizzare i livelli e gli oggetti di un documento è sufficiente denominarli e riorganizzarli all’interno del pannello 

Livelli. È possibile spostare gli oggetti all’interno di un livello o tra livelli diversi. 

Lo spostamento dei livelli e degli oggetti nel pannello Livelli modifica l’ordine di visualizzazione degli oggetti nell’area 

di lavoro. Gli oggetti in cima al livello compaiono sopra gli altri oggetti di tale livello sull’area di lavoro. Gli oggetti 

contenuti nel livello superiore compaiono davanti agli oggetti contenuti nei livelli inferiori. 

Nota: il pannello Livelli scorre automaticamente quando si trascina un livello o un oggetto verso l’alto o verso il basso 

oltre i limiti dell’area visualizzabile.

Assegnare un nome a un livello o un oggetto

1 Fare doppio clic su un livello o su un oggetto nel pannello Livelli.

2 Digitare un nuovo nome per il livello o per l’oggetto e premere Invio.

Nota: sebbene il Livello Web non possa essere rinominato, è possibile rinominare i relativi sottolivelli e oggetti Web, 

quali porzioni e punti attivi.

Spostare un singolo livello o oggetto

❖ Trascinare il livello o l’oggetto nella nuova posizione del pannello Livelli.

Spostare tutti gli oggetti selezionati su un livello

❖ Effettuare una delle seguenti operazioni:

• Trascinare in un altro livello il pulsante di scelta che si trova accanto al nome del livello. 

• Fare un clic nella colonna di destra del livello di destinazione.
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Nota: un livello principale non può essere trascinato nel proprio sottolivello.

Proteggere livelli e oggetti

Il blocco di un singolo oggetto lo protegge impedendone la selezione o modifica e il blocco di un livello protegge tutti 

gli oggetti di quel livello. L’icona di un lucchetto  indica un elemento bloccato. La funzione Modifica livello singolo 

protegge gli oggetti su tutti i livelli tranne quello attivo e i sottolivelli da operazioni di selezione o modifica indesiderate. 

È inoltre possibile proteggere oggetti e livelli nascondendoli. 

Nota: i livelli e gli oggetti nascosti non vengono inclusi all’esportazione del documento, Gli oggetti che si trovano sul 

Livello Web possono essere sempre esportati, indipendentemente dal fatto che siano bloccati o meno. Per ulteriori 

informazioni sull’esportazione, consultare “Esportare dallo spazio di lavoro” a pagina 249.

Bloccare oggetti e livelli

• Per bloccare un oggetto, fare clic sul quadratino nella colonna subito a sinistra del nome dell’oggetto.

• Per bloccare un livello, fare clic sul quadratino nella colonna subito a sinistra del nome del livello.

• Per bloccare più livelli, trascinare il puntatore lungo la colonna Blocca nel pannello Livelli.

• Per bloccare o sbloccare tutti i livelli, selezionare Blocca tutto o Sblocca tutto dal menu o menu a comparsa Opzioni 

del pannello Livelli.

Attivare o disattivare Modifica livello singolo

❖ Selezionare Modifica livello singolo dal menu o menu a comparsa Opzioni del pannello Livelli. 

A fianco del comando viene visualizzato un segno di spunta per indicare che l’opzione Modifica livello singolo è attiva.

Mostrare o nascondere oggetti e livelli

• Per mostrare o nascondere un livello o gli oggetti di un livello, fare clic sul quadratino nella prima colonna a sinistra 

relativa al nome del livello o oggetto. La presenza dell’icona occhio  indica che il livello o l’oggetto è visibile.

• Per mostrare o nascondere più oggetti o livelli, trascinare il puntatore lungo la colonna dell’icona occhio nel 

pannello Livelli.

• Per mostrare o nascondere tutti i livelli, selezionare Mostra tutto o Nascondi tutto dal menu o menu a comparsa 

Opzioni del pannello Livelli.

Nascondere o bloccare altri livelli

Per modificare con precisione un logo o un’icona, è possibile nascondere o bloccare tutti i livelli eccetto quello 

corrente. 

1 Nel pannello Livelli, selezionare il livello su cui si desidera lavorare.

2 Selezionare Comandi > Documento > Nascondi altri livelli oppure Comandi > Documento > Blocca altri livelli.

Unire oggetti nel pannello Livelli

Per rendere il pannello Livelli più ordinato e gestibile, è possibile unire gli oggetti del pannello Livelli. Gli oggetti e le 

immagini bitmap da unire non devono necessariamente essere adiacenti nel pannello Livelli, né risiedere sullo stesso 

livello. 
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L’unione fa sì che tutti gli oggetti vettoriali e bitmap selezionati vengano appiattiti nell’oggetto bitmap che si trova 

immediatamente sotto l’oggetto selezionato più in basso. Il risultato prodotto è un singolo oggetto bitmap. Una volta 

eseguita la fusione, gli oggetti vettoriali e gli oggetti bitmap non si possono modificare separatamente e la 

modificabilità degli oggetti vettoriali va perduta.

1 Nel pannello Livelli, selezionare l’oggetto da unire a un oggetto bitmap. Per selezionare più oggetti, fare clic tenendo 

premuto il tasto Maiusc o Ctrl.

È possibile unire il contenuto di un livello selezionato nell’oggetto bitmap più in alto che si trova sul livello 

immediatamente sotto il livello selezionato.

2 Effettuare una delle seguenti operazioni:

• Selezionare Unisci a sottostante dal menu del pannello Livelli.

• Selezionare Elabora > Unisci a sottostante.

• Fare clic con il pulsante destro del mouse (Windows) o tenendo premuto il tasto Controllo (Mac OS) sugli 

oggetti selezionati nell’area di lavoro e selezionare Unisci a sottostante.

Nota: il comando Unisci a sottostante non incide su porzioni, punti attivi e pulsanti.

Distribuire gli oggetti sui livelli

Se un livello contiene numerosi oggetti, è possibile semplificare il livello distribuendo gli oggetti in nuovi livelli. 

Vengono creati nuovi livelli allo stesso livello gerarchico del livello di origine. Inoltre, i livelli creati mantengono la 

stessa gerarchia di livelli. La distribuzione degli oggetti su nuovi livelli facilita la successiva manipolazione degli oggetti.

1 Selezionare il livello contenente gli oggetti da distribuire.

2 Selezionare Comandi > Documento > Distribuisci sui livelli.

Condividere livelli

Quando un livello è condiviso tra più pagine o stati e si aggiorna un oggetto di un livello, questo verrà aggiornato in 

tutte le pagine o gli stati. La condivisione dei livelli è utile per visualizzare oggetti quali gli elementi di sfondo in tutti 

gli stati dell’animazione o in tutte le pagine di un sito Web.

Per ulteriori informazioni, vedete http://www.adobe.com/go/learn_fw_usingpagesstates_it

Nota: non è possibile condividere i sottolivelli tra più pagine o stati; occorre condividere il relativo livello principale.

Condividere il livello selezionato tra più stati

❖ Effettuare una delle seguenti operazioni:

• Dal menu o menu a comparsa Opzioni del pannello Livelli, selezionare Condividi livello tra stati.

• Selezionare Nuovo livello dal menu o menu a comparsa Opzioni del pannello Livelli, quindi selezionare 

Condividi tra stati.

Il livello condiviso tra diversi stati è contrassegnato nel pannello Livelli da un’icona rappresentante una pellicola.

Condividere il livello selezionato su più pagine

❖ Dal menu o menu a comparsa Opzioni del pannello Livelli, selezionare Condividi livello tra pagine.

Il livello condiviso tra diverse pagine è contrassegnato nel pannello Livelli da un’icona rappresentante una pagina. 

http://www.adobe.com/go/learn_fw_usingpagesstates_it
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Disattivare la condivisione di un livello

1 Selezionare il livello condiviso e deselezionare Condividi tra stati dal menu o menu a comparsa Opzioni del 

pannello Livelli. 

2 Specificare in che modo si desidera che gli oggetti vengano copiati sugli stati: 

• Lasciare il contenuto del livello condiviso unicamente sullo stato corrente.

• Copiare il contenuto del livello condiviso su tutti gli stati.

Utilizzare il Livello Web

Il Livello Web viene visualizzato come livello superiore in ogni documento. Contiene oggetti Web, quali porzioni e 

punti attivi, utilizzati per assegnare funzioni di interattività ai documenti di Fireworks esportati. 

Non è consentito condividere, eliminare, duplicare, spostare o rinominare il Livello Web. Inoltre, non è possibile unire 

gli oggetti che risiedono sul Livello Web. Questo è infatti sempre condiviso tra tutti gli stati della pagina e gli oggetti 

Web sono visibili in ogni stato della pagina.

Rinominare una porzione o un punto attivo nel Livello Web

1 Fare doppio clic sulla porzione o sul punto attivo nel pannello Livelli.

2 Digitare il nuovo nome, poi fare clic fuori dalla finestra oppure premere Invio.

Nota: il nuovo nome viene utilizzato quando la porzione viene esportata.

Importazione dei livelli raggruppati di Photoshop

I file di Photoshop che contengono livelli vengono importati con ogni livello collocato come oggetto separato su un 

singolo livello Fireworks. I livelli raggruppati vengono invece importati sotto forma di livelli singoli, come se i livelli 

fossero stati separati in Photoshop prima di essere importati in Fireworks. L’effetto di ritaglio sui livelli raggruppati di 

Photoshop viene perduto con l’importazione.

Applicazione di maschere

Le maschere consentono di nascondere o mostrare parti di un oggetto o immagine. È possibile applicare agli oggetti 

diverse tecniche di mascheratura per ottenere vari tipi di effetti creativi.

Una maschera può fungere da stampo, ritagliando gli oggetti o le immagini sottostanti. È inoltre possibile conferire 

l’effetto di una finestra appannata, mostrando o nascondendo parti degli oggetti sottostanti. 

È possibile creare un oggetto maschera da un oggetto vettoriale (maschera vettoriale) o da un oggetto bitmap 

(maschera bitmap). È possibile utilizzare più oggetti o oggetti raggruppati per creare una maschera, nonché del testo 

(che crea una maschera vettoriale). Una volta creata una maschera, è possibile regolare la posizione sull’area di lavoro 

della selezione mascherata oppure modificare l’aspetto della maschera. Si possono anche applicare le trasformazioni 

alla maschera come insieme oppure ai suoi componenti singolarmente.

Maschere vettoriali

Le maschere vettoriali, anche dette tracciati di ritaglio o incolla dentro, vengono utilizzate nelle applicazioni per 

illustrazioni vettoriali.  L’oggetto maschera vettoriale ritaglia gli oggetti sottostanti in base alla forma del suo tracciato, 

creando un effetto “stampino”.
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Maschera vettoriale applicata utilizzando il contorno del proprio tracciato

Quando si crea una maschera vettoriale, nel pannello Livelli viene visualizzata la miniatura di una maschera con l’icona 

di una penna.

Miniatura di una maschera vettoriale nel pannello Livelli

Quando è selezionata una maschera vettoriale, la finestra di ispezione Proprietà visualizza informazioni sulle modalità 

di applicazione della maschera. La parte inferiore della finestra di ispezione Proprietà contiene ulteriori proprietà per 

la modifica del tratto e del riempimento dell’oggetto maschera.

Per impostazione predefinita, le maschere vettoriali vengono applicate utilizzando il contorno del proprio tracciato, 

ma si possono applicare anche in altri modi.

Maschere bitmap

Le maschere bitmap di Fireworks sono analoghe alle maschere di livello di Photoshop: i pixel di un oggetto maschera 

incidono sulla visibilità degli oggetti sottostanti. 

Oggetti originali (sopra) e maschera bitmap applicata utilizzando l’aspetto in scala di grigi (sotto)

Le maschere bitmap possono essere applicate in due modi:

• Utilizzando un oggetto preesistente per mascherare altri oggetti. Questa tecnica è simile all’applicazione di una 

maschera vettoriale.

• Creazione di una maschera vuota. Inizialmente, le maschere vuote sono trasparenti o opache. Una maschera 

trasparente (o bianca) mostra l’intero oggetto mascherato, mentre una maschera opaca (o nera) oscura 

completamente l’oggetto mascherato. È possibile utilizzare gli strumenti bitmap per disegnare o modificare 

l’oggetto maschera, visualizzando o occultando a piacere gli oggetti sottostanti.
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Quando si crea una maschera bitmap, la finestra di ispezione Proprietà visualizza informazioni sulle modalità di 

applicazione della maschera. Se si seleziona uno strumento bitmap quando è selezionata una maschera bitmap, la 

finestra di ispezione Proprietà visualizza sia le proprietà delle maschere che le opzioni dello strumento selezionato.

Per impostazione predefinita, la maggior parte delle maschere bitmap vengono applicate utilizzando l’aspetto della 

loro scala di grigi, ma è possibile applicarle anche utilizzando il canale alfa.

Creare una maschera da un oggetto preesistente

Quando un oggetto vettoriale viene utilizzato come maschera, il contorno del suo tracciato può essere utilizzato per 

ritagliare altri oggetti. Se a essere utilizzato come maschera è un oggetto bitmap, la luminosità dei suoi pixel o la loro 

trasparenza incidono sulla visibilità di altri oggetti.

Applicare maschere a oggetti con il comando Incolla come maschera

Il comando Incolla come maschera consente di creare maschere sovrapponendo un oggetto o un gruppo di oggetti a 

un altro oggetto. Incolla come maschera consente di creare una maschera vettoriale o bitmap.

1 Selezionare l’oggetto da utilizzare come maschera. Fare clic tenendo premuto il tasto Maiusc per selezionare più 

oggetti contemporaneamente.

Nota: se vengono utilizzati più oggetti come maschera, viene sempre creata una maschera vettoriale, anche se 

entrambi gli oggetti sono bitmap.

2 Posizionare la selezione in modo che si sovrapponga all’oggetto o al gruppo di oggetti ai quali applicare la maschera.

La selezione può essere effettuata davanti o dietro agli oggetti a cui applicare la maschera.

3 Selezionare Modifica > Taglia per tagliare gli oggetti da utilizzare come maschera.

4 Selezionare l’oggetto o il gruppo ai quali applicare la maschera.

Se si intende applicare la maschera a più oggetti, questi devono essere raggruppati.

5 Effettuare una delle seguenti operazioni:

• Selezionare Modifica > Incolla come maschera.

• Selezionare Modifica > Maschera > Incolla come maschera.
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Maschera applicata a un’immagine con un’area di lavoro nera

Mascherare oggetti mediante il comando Incolla dentro

Tale comando consente di creare una maschera vettoriale o bitmap, a seconda del tipo di oggetto maschera utilizzato. 

Il comando Incolla dentro crea una maschera riempiendo un tracciato chiuso o un oggetto bitmap con altri oggetti: 

grafica vettoriale, testo o immagini bitmap. Il tracciato stesso viene a volte denominato “tracciato di ritaglio”, mentre 

gli elementi al suo interno sono noti come contenuto o operazioni “incolla dentro”. Il contenuto che si estende oltre il 

tracciato di ritaglio viene nascosto.

1 Selezionare gli oggetti da utilizzare come contenuto dell’operazione.

2 Posizionare gli oggetti in modo che si sovrappongano all’oggetto nel quale si desidera incollare il contenuto.

Nota: l’ordine di sovrapposizione non è importante, purché gli oggetti da utilizzare come contenuto rimangano 

selezionati. Tali oggetti possono trovarsi sopra o sotto l’oggetto maschera nel pannello Livelli.

3 Selezionare Modifica > Taglia per spostare gli oggetti negli Appunti.

4 Selezionare l’oggetto in cui incollare il contenuto. Tale oggetto viene utilizzato come maschera (tracciato di 

ritaglio).

5 Selezionare Modifica > Incolla dentro.
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Gli oggetti incollati compaiono all’interno dell’oggetto maschera o ritagliati da esso.

Usare il testo come maschera

Le maschere di testo rappresentano un tipo di maschera vettoriale che è possibile applicare seguendo la stessa 

procedura utilizzata per l’applicazione di maschere che utilizzano oggetti esistenti. Il testo è l’oggetto maschera. La 

normale modalità di applicazione di una maschera di testo consiste nell’utilizzare il contorno del suo tracciato, sebbene 

sia possibile applicarla anche utilizzando l’aspetto della scala di grigi.

Maschera di testo applicata utilizzando il contorno del suo tracciato

Utilizzare le maschere vettoriali automatiche

Le maschere vettoriali automatiche applicano a oggetti bitmap e vettoriali motivi predefiniti come maschere vettoriali. 

Successivamente è possibile modificare l’aspetto e altre proprietà delle maschere vettoriali automatiche.

1 Selezionare gli oggetti bitmap o vettoriali.

2 Selezionare Comandi > Creatività > Maschera vettoriale automatica.

3 Selezionare il tipo di maschera e fare clic su Applica.

Mascherare oggetti con il pannello Livelli

Il pannello Livelli costituisce il modo più semplice per aggiungere una maschera bitmap vuota e trasparente. Il 

pannello Livelli aggiunge una maschera bianca a un oggetto, personalizzabile disegnando su di essa con gli strumenti 

bitmap.

1 Selezionare l’oggetto al quale applicare la maschera.

2 Nella parte inferiore del pannello Livelli, fare clic sul pulsante Aggiungi maschera.

Viene applicata una maschera vuota all’oggetto selezionato. Il pannello Livelli visualizza la miniatura di una 

maschera che rappresenta la maschera vuota.

3 (Facoltativo) Se l’oggetto mascherato è un’immagine bitmap, è possibile utilizzare uno degli strumenti lazo o 

perimetro di selezione per creare una selezione di pixel.

4 Dal pannello Strumenti, selezionare uno strumento di pittura bitmap.

5 Impostare le opzioni dello strumento nella finestra di ispezione Proprietà.
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6 Con la maschera ancora selezionata, disegnare sulla maschera vuota. Nelle aree di disegno, l’oggetto mascherato 

sottostante risulterà nascosto.

Immagine con maschera applicata

La maschera come appare nel pannello Livelli

Mascherare oggetti con i comandi Rivela e Nascondi

Il sottomenu Elabora > Maschera offre diverse opzioni per applicare le maschere bitmap agli oggetti.

Rivela tutto Applica una maschera vuota trasparente a un oggetto, rivelando così l’intero oggetto. Per ottenere lo 

stesso effetto, fare clic sul pulsante Aggiungi maschera del pannello Livelli.

Nascondi tutto Applica una maschera vuota opaca a un oggetto, nascondendo così l’intero oggetto.

Rivela selezione Può essere utilizzato solo con le selezioni di pixel. Rivela selezione applica una maschera di pixel 

trasparente utilizzando la selezione di pixel corrente. Gli altri pixel dell’oggetto bitmap sono nascosti. Per ottenere lo 

stesso effetto, eseguire una selezione di pixel e quindi fare clic sul pulsante Aggiungi maschera.

Nascondi selezione Può essere utilizzato solo con le selezioni di pixel. Nascondi selezione applica una maschera di 

pixel opaca utilizzando la selezione di pixel corrente. Gli altri pixel della bitmap vengono visualizzati. Per ottenere lo 

stesso effetto, effettuare una selezione di pixel, quindi fare clic tenendo premuto il tasto Alt (Windows) o Opzione 

(Mac OS) sul pulsante Aggiungi maschera.

Usare Rivela tutto e Nascondi tutto per creare una maschera

1 Selezionare l’oggetto al quale applicare la maschera.

2 Per mostrare l’oggetto, selezionare Modifica > Maschera > Rivela tutto. Per nasconderlo, selezionare Modifica > 

Maschera > Nascondi tutto.

3 Scegliere uno strumento di pittura bitmap nel pannello Strumenti.

4 Impostare le opzioni dello strumento nella finestra di ispezione Proprietà.

Se è stata applicata una maschera Nascondi tutto, è necessario selezionare un colore diverso dal nero.

5 Disegnare sulla maschera vuota. Nelle aree in cui si disegna, l’oggetto mascherato sottostante risulterà nascosto o 

visualizzato, a seconda del tipo di maschera applicato. 
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Utilizzare i comandi Rivela selezione e Nascondi selezione per creare una maschera

1 Selezionare lo strumento Bacchetta magica o qualsiasi strumento Perimetro di selezione o Lazo dal pannello 

Strumenti.

2 Selezionare i pixel nella bitmap.

Immagine originale; pixel selezionati con lo strumento Bacchetta magica.

3 Per mostrare l’area definita dalla selezione pixel, selezionare Modifica > Maschera > Rivela selezione. Per 

nasconderla, selezionare Modifica > Maschera > Nascondi selezione.

I risultati dei comandi Rivela selezione e Nascondi selezione

Una maschera bitmap viene applicata utilizzando la selezione di pixel. È possibile modificare ulteriormente la 

maschera per rivelare o nascondere i pixel rimanenti dell’oggetto mascherato utilizzando gli strumenti bitmap del 

pannello Strumenti.

Importazione ed esportazione delle maschere livelli di Photoshop

In Photoshop, è possibile applicare le maschere alle immagini utilizzando le maschere livelli o i livelli raggruppati. 

Fireworks consente di importare le immagini che utilizzano le maschere livelli mantenendo la capacità di modificarle. 

Le maschere livelli sono importate sotto forma di maschere bitmap.

Le maschere di Fireworks si possono esportare anche in Photoshop. Esse vengono convertite in maschere livelli di 

Photoshop. Se gli oggetti mascherati includono testo per il quale si desidera mantenere la modificabilità in Photoshop, 

al momento dell’esportazione selezionare l’opzione Privilegia modificabilità rispetto all’aspetto.

Nota: se invece il testo viene utilizzato come oggetto maschera, viene convertito in bitmap e non è più modificabile come 

testo una volta importato in Photoshop.
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Raggruppare oggetti per formare una maschera

Se si raggruppano due o più oggetti per creare una maschera, l’oggetto superiore diventa l’oggetto maschera. Il tipo di 

tale oggetto determina il tipo di maschera (vettoriale o bitmap).

1 Fare clic tenendo contemporaneamente premuto il tasto Maiusc su due o più oggetti che si sovrappongono.

Si possono rapidamente selezionare oggetti da livelli diversi.

2 Selezionare Elabora > Maschera > Raggruppa come maschera.

Selezionare e spostare le maschere

Selezionare maschere e oggetti mascherati con le miniature

Nel pannello Livelli, le miniature consentono di selezionare e modificare la maschera o gli oggetti mascherati senza 

incidere sugli altri oggetti. 

Quando si seleziona la miniatura di una maschera, l’icona della maschera viene visualizzata accanto a essa nel pannello 

Livelli. La finestra di ispezione Proprietà visualizza le proprietà della maschera e consente di modificarle.

• Per selezionare una maschera, fare clic sulla sua miniatura nel pannello Livelli.

• Per selezionare un oggetto mascherato, fare clic sulla sua miniatura nel pannello Livelli.
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Selezionare maschere e oggetti mascherati con lo strumento Sottoselezione

Lo strumento Sottoselezione consente di selezionare singole maschere e oggetti mascherati sull’area di lavoro senza 

selezionare gli altri componenti della maschera. La finestra di ispezione Proprietà mostra le proprietà dell’oggetto 

selezionato.

❖ Fare clic sull’oggetto nell’area di lavoro con lo strumento Sottoselezione.

Spostare maschere e oggetti mascherati

Le maschere e gli oggetti mascherati possono essere riposizionati a piacere, sia insieme che in modo indipendente.

Spostare una maschera e il relativo oggetto mascherato

1 Con lo strumento Puntatore, selezionare la maschera nell’area di lavoro.

2 Trascinare la maschera nella nuova posizione; attenzione a non trascinare la maniglia di spostamento, a meno che 

non si desideri spostare l’oggetto mascherato separatamente dalla maschera.

Spostare in modo indipendente maschere e oggetti mascherati con interruzione del collegamento

1 Nel pannello Livelli, fare clic sull’icona del collegamento sulla maschera.

In questo modo si interrompe il collegamento tra gli oggetti mascherati e la maschera, in modo da poterli spostare 

indipendentemente.

2 Selezionare la miniatura di una maschera o un oggetto mascherato.

3 Trascinare gli oggetti sull’area di lavoro con lo strumento Puntatore.

Nota: se sono presenti più oggetti mascherati, si spostano tutti contemporaneamente.

4 Per collegare nuovamente l’oggetto mascherato alla maschera, fare clic in un punto qualsiasi tra le miniature della 

maschera nel pannello Livelli.

Spostare una maschera in modo indipendente con la sua maniglia di spostamento

1 Con lo strumento Puntatore, selezionare la maschera nell’area di lavoro. 
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2 Selezionare lo strumento Sottoselezione e trascinare la maniglia di spostamento della maschera nella nuova 

posizione.

Spostare gli oggetti mascherati in modo indipendente dalla maschera utilizzando la maniglia di 

spostamento

1 Con lo strumento Puntatore, selezionare la maschera nell’area di lavoro.

2 Trascinare la maniglia di spostamento nella nuova posizione.

Gli oggetti si spostano senza incidere sulla posizione della maschera.

Nota: se sono presenti più oggetti mascherati, si spostano contemporaneamente.

Spostare gli oggetti mascherati in modo reciprocamente indipendente

❖ Fare clic sull’oggetto con lo strumento Sottoselezione per selezionarlo, quindi trascinare l’oggetto.

Questo è l’unico modo per selezionare e spostare un oggetto mascherato singolo senza spostare anche gli altri oggetti 

mascherati.

Modificare le maschere

Modificando la posizione, la forma e il colore della maschera si può intervenire sulla visibilità degli oggetti mascherati. 

Si possono modificare anche il tipo della maschera e le sue modalità di applicazione. Inoltre, le maschere possono 

essere modificate, eliminate e disattivate. Se si modifica una maschera, i risultati sono immediatamente visibili nella 

miniatura del pannello Livelli, anche se l’oggetto maschera non è visibile nell’area di lavoro.

Gli oggetti mascherati possono inoltre essere modificati e riorganizzati senza dover spostare la maschera. È possibile 

anche aggiungere ulteriori oggetti mascherati a un gruppo di maschere già esistente.

Modificare la forma di una maschera selezionata

❖ Effettuare una delle seguenti operazioni:

• Disegnare su una maschera bitmap con uno degli strumenti di disegno bitmap.
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• Con lo strumento Sottoselezione, spostare i punti di un oggetto maschera vettoriale.

Modificare il colore di una maschera selezionata

• Per le maschere bitmap in scala di grigi, utilizzare gli strumenti bitmap per disegnare sulla maschera utilizzando 

diversi valori della scala di grigi.

• Per le maschere vettoriali di scala di grigi, modificare il colore dell’oggetto maschera.

Nota: utilizzare colori più chiari per visualizzare gli oggetti mascherati e colori più scuri per nasconderli.

Aggiungere altri oggetti maschera a una maschera

1 Selezionare Modifica > Taglia per tagliare gli oggetti selezionati che si desidera aggiungere.

2 Selezionare la miniatura dell’oggetto mascherato nel pannello Livelli.

3 Selezionare Modifica > Incolla come maschera.

4 Selezionare Aggiungi quando il sistema richiede se sostituire la maschera esistente o procedere con l’aggiunta.

Modificare una maschera con gli strumenti di trasformazione

1 Con lo strumento Puntatore, selezionare la maschera nell’area di lavoro.

2 Utilizzare uno strumento di trasformazione o un comando del sottomenu Elabora > Trasformazione per applicare 

una trasformazione alla maschera. 

Per applicare una trasformazione al solo oggetto maschera è necessario prima interrompere il collegamento della 

maschera con gli oggetti mascherati nel pannello Livelli, quindi eseguire la trasformazione.

Aggiungere oggetti mascherati a una selezione mascherata

1 Selezionare Modifica > Taglia per tagliare gli oggetti selezionati che si desidera aggiungere.

2 Selezionare la miniatura dell’oggetto mascherato nel pannello Livelli.

3 Selezionare Modifica > Incolla dentro.

Nota: utilizzando il comando Incolla dentro su una maschera preesistente, il tratto e il riempimento della maschera 

non vengono visualizzati a meno che la maschera originale non sia stata applicata utilizzando i propri tratti e 

riempimenti.

Sostituire una maschera

1 Selezionare Modifica > Taglia per tagliare gli oggetti selezionati o gli oggetti da utilizzare come maschera.

2 Selezionare la miniatura dell’oggetto mascherato nel pannello Livelli e scegliere Modifica > Incolla come maschera.

3 Quando viene chiesto se sostituire la maschera esistente o procedere con l’aggiunta, fare clic su Sostituisci.

Disattivare o attivare una maschera selezionata

Disattivando una maschera la si nasconde temporaneamente.

❖ Effettuare una delle seguenti operazioni:

• Dal menu del pannello Livelli, selezionare Disattiva maschera o Attiva maschera.

• Selezionare Elabora > Maschera > Disattiva maschera o Elabora > Maschera > Attiva maschera.

Quando è disattivata, sulla miniatura della maschera compare una X rossa. Per attivare la maschera è sufficiente fare 

clic sulla X.
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Eliminare una maschera selezionata

Quando si elimina una maschera, questa viene rimossa in modo permanente.

1 Effettuare una delle seguenti operazioni:

• Dal menu del pannello Livelli, selezionare Elimina maschera.

• Selezionare Elabora > Maschera > Elimina maschera.

• Trascinare la miniatura della maschera sull’icona del cestino nel pannello Livelli.

2 Scegliere se applicare o scartare l’effetto della maschera sugli oggetti mascherati prima di eliminare la maschera:

Applica Mantiene le modifiche apportate alla maschera, ma la maschera non è più modificabile. Se l’oggetto 

mascherato è un oggetto vettoriale, sia la maschera che l’oggetto vettoriale vengono convertiti in un’unica 

immagine bitmap.

Scarta Elimina le modifiche apportate e ripristina la forma originale dell’oggetto.

Annulla Interrompe l’operazione di eliminazione e lascia la maschera invariata.

Modificare la modalità di applicazione delle maschere 

Quando è selezionata una maschera, la finestra di ispezione Proprietà permette di modificare le modalità di 

applicazione della maschera. Se le dimensioni della finestra di ispezione Proprietà sono ridotte, fare clic sulla freccia 

di espansione per visualizzare tutte le proprietà.

Per impostazione predefinita, le maschere vettoriali vengono applicate utilizzando il contorno del loro tracciato. 

Mostrare il riempimento e il tratto di una maschera produce lo stesso risultato ottenuto con l’uso del comando Incolla 

dentro per creare una maschera.

Maschera vettoriale applicata utilizzando il contorno del suo tracciato con l’opzione Mostra riempimento e tratto attivata

Applicando una maschera bitmap con il suo canale alfa è possibile creare una maschera simile a una maschera 

vettoriale applicata utilizzando il contorno del suo tracciato. La trasparenza dell’oggetto maschera incide sulla visibilità 

dell’oggetto mascherato.

Maschera bitmap applicata utilizzando il suo canale alfa
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Sia le maschere vettoriali che quelle bitmap possono essere applicate usando l’aspetto della rispettiva scala di grigi. La 

luminosità dei pixel della maschera determina la porzione visualizzata dell’oggetto mascherato. I pixel delle alte luci 

visualizzano l’oggetto mascherato, mentre quelli più scuri scavano l’immagine e mostrano lo sfondo. Questa tecnica 

crea oggetti interessanti se l’oggetto maschera contiene un riempimento a motivo o a gradiente.

Maschera vettoriale con riempimento a motivo applicata utilizzando l’aspetto in scala di grigi

È possibile convertire maschere vettoriali in maschere bitmap, ma non viceversa. 

Applicare una maschera vettoriale utilizzando il contorno del suo tracciato

❖ Selezionare Contorno tracciato nella finestra di ispezione Proprietà quando è selezionata una maschera vettoriale.

Mostrare tratto e riempimento di una maschera vettoriale

❖ Selezionare Mostra riempimento e tratto nella finestra di ispezione Proprietà quando è selezionata una maschera 

vettoriale applicata con il contorno del suo tracciato.

Applicare una maschera bitmap utilizzando il suo canale alfa

❖ Selezionare Canale Alfa nella finestra di ispezione Proprietà quando è selezionata una maschera bitmap.

Applicare una maschera vettoriale o bitmap utilizzando l’aspetto della sua scala di grigi

❖ Selezionare Aspetto scala dei grigi nella finestra di ispezione Proprietà quando è selezionata una maschera.

Convertire una maschera vettoriale in una maschera bitmap 

1 Nel pannello Livelli, selezionare la miniatura dell’oggetto maschera.

2 Selezionare Elabora > Appiattisci selezione.

Fusione e trasparenza

La composizione è il processo di variazione della trasparenza o dell’interazione tra i colori di due o più oggetti 

sovrapposti. In Fireworks, le modalità fusione consentono di creare immagini composite.
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Le modalità fusione 

Quando si sceglie una modalità fusione, essa viene applicata a tutti gli oggetti selezionati. Gli oggetti all’interno di un 

unico documento o livello possono avere modalità fusione diverse da quelle di altri oggetti presenti nello stesso 

documento o livello.

Quando vengono raggruppati oggetti con modalità fusione diverse, la modalità fusione del gruppo ha la priorità su 

quella dei singoli oggetti. Separando gli oggetti vengono ripristinate le singole modalità dei diversi oggetti.

Nota: Le modalità fusione all'interno di un simbolo vengono ignorate quando si esce dalla modalità di modifica simbolo.

Elementi in una modalità fusione 

Colore di fusione Il colore al quale viene applicata la modalità fusione.

Opacità Il grado di opacità con il quale viene applicata la modalità fusione.

Colore di base Il colore dei pixel sotto il colore di fusione.

Colore risultante Il risultato dell’effetto della modalità fusione sul colore di base. 

Modalità fusione 

La modifica di tonalità, saturazione e fusione colore funziona come in Photoshop. Per ulteriori informazioni sulle 

modalità di fusione, vedete l'articolo di Jim Babbage sulle modalità di fusione.

Normale Non applica alcuna modalità fusione.

Dissolvi Sceglie i colori in modo casuale tra il livello corrente e quello di sfondo per creare un effetto di fusione. 

Scurisci Seleziona il più scuro tra i colori di fusione e di base da utilizzare come colore risultante. Questa modalità 

sostituisce solo i pixel più chiari del colore di fusione.

Moltiplica Moltiplica il colore di base per il colore di fusione, creando un colore più scuro.

Scurisci colori Scurisce il colore di base in ogni canale per riflettere il colore di fusione aumentando il contrasto. La 

fusione con il bianco non dà luogo ad alcuna modifica.

Scurisci in modo lineare Ispeziona ogni canale del livello corrente e di quello di sfondo e scurisce il colore di sfondo 

per riflettere il colore di fusione diminuendo la luminosità. L’effetto complessivo è quello di scurire l’immagine. Il 

colore neutro è il bianco, quindi fondere Scurisci in modo lineare con il bianco non ha alcun effetto.

Schiarisci Seleziona il più chiaro tra i colori di fusione e di base da utilizzare come colore risultante. Questa modalità 

sostituisce solo i pixel più scuri del colore di fusione.

Scolora Moltiplica l’opposto del colore di fusione per il colore di base, con un effetto di decolorazione.

Schiarisci colori Schiarisce il colore di base in ogni canale per riflettere il colore di fusione riducendo il contrasto. La 

fusione con il nero non dà luogo ad alcuna modifica.

Schiarisci in modo lineare Ispeziona ogni canale del livello corrente e di quello di sfondo e schiarisce il colore di sfondo 

per riflettere il colore di fusione aumentando la luminosità. L’effetto complessivo è quello di schiarire l’immagine. Il 

colore neutro è il nero, quindi fondere Schiarisci in modo lineare con il nero non ha alcun effetto. 

Sovrapponi Moltiplica o scolora i colori, a seconda del colore di base. I motivi o colori si sovrappongono ai pixel 

esistenti mantenendo le aree di luce e ombra del colore di base. Il colore di base non viene sostituito, ma miscelato con 

il colore di fusione per riflettere il grado di chiarezza o oscurità del colore originale. 

Luce leggera Scurisce o schiarisce i colori, a seconda del colore di fusione. L’effetto è simile a quello ottenuto 

illuminando l’immagine con un faretto a luce diffusa. Se il colore di fusione (sorgente di luce) è più chiaro del grigio 

al 50%, l’immagine viene schiarita. Se il colore di fusione (sorgente di luce) è più scuro del grigio al 50%, l’immagine 

http://www.communitymx.com/content/article.cfm?page=4&cid=85300
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viene scurita. Colorando con nero o bianco puro, si genera un’area notevolmente più scura o più chiara, ma non di 

colore nero o bianco puro. 

Luce forte Moltiplica o scolora i colori, a seconda del colore di fusione. L’effetto è simile a quello ottenuto illuminando 

l’immagine con un faretto a luce intensa. Se il colore di fusione (sorgente di luce) è più chiaro del grigio al 50%, 

l’immagine viene schiarita come per la modalità di fusione Scolora. Questa modalità è utile per aggiungere a 

un’immagine delle aree di luce. Se il colore di fusione (sorgente di luce) è più scuro del grigio al 50%, l’immagine viene 

scurita, come per la modalità di fusione Moltiplica. Questa modalità è utile per aggiungere a un’immagine delle aree 

di ombra. Colorando con nero o bianco puro si ottiene rispettivamente il nero o bianco puro. 

Luce intensa Una modalità di fusione con aumento del contrasto che combina gli effetti delle modalità Scurisci colori 

e Schiarisci colori. Se il colore di fusione è più scuro del grigio medio, la Luce intensa scurisce l’immagine aumentando 

il contrasto. In caso contrario, l’immagine viene schiarita diminuendo il contrasto.

Luce lineare Una combinazione di Schiarisci in modo lineare e Scurisci in modo lineare per regolare la luminosità. Se 

il colore del livello di fusione è più scuro del grigio medio, Luce lineare diminuisce la luminosità dell’immagine. In caso 

contrario, Luce lineare ne aumenta la luminosità.

Luce puntiforme Sostituisce il colore in base al colore di fusione. Se il colore di fusione è più chiaro del grigio al 50%, 

i pixel più scuri del colore di fusione vengono sostituiti. Se il colore di fusione è più scuro del grigio al 50%, i pixel più 

chiari del colore di fusione vengono sostituiti.

Miscela dura Riduce i colori di un’immagine a soli otto colori puri.

Differenza Sottrae il colore di fusione dal colore base o viceversa. Il colore con caratteristiche di minore luminosità 

viene sottratto da quello con maggiore luminosità.

Esclusione Crea un effetto analogo a quello del metodo Differenza, ma con un contrasto minore. La fusione con il 

bianco inverte i valori del colore di base. La fusione con il nero non dà luogo ad alcuna modifica.

Tonalità Combina il valore della tonalità del colore di fusione con la brillanza e la saturazione del colore base per creare 

il colore risultante. 

Saturazione Combina la saturazione del colore di fusione con la tonalità e la brillanza del colore di base per creare il 

colore risultante. 

Colore Combina la tonalità e saturazione del colore di fusione con la brillanza del colore di base per creare il colore 

risultante. Questa modalità consente di mantenere i livelli di grigio dell’immagine, per la colorazione di immagini 

monocromatiche o la regolazione del colore delle immagini a colori.

Luminosità Combina la brillanza del colore di fusione con la tonalità e la saturazione del colore di base.

Inverti Inverte il colore di base.

Tinta Aggiunge il grigio al colore base.

Cancella Rimuove tutti i pixel dal colore di base, inclusi quelli dell’immagine di sfondo.

Per esempi e informazioni generali relativi alle modalità di fusione, in particolare quelle di Photoshop, visitare il 

seguente sito Web: www.pegtop.net/delphi/articles/blendmodes/.

http://www.pegtop.net/delphi/articles/blendmodes/
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Esempi di modalità di fusione 

Regolare l’opacità e applicare fusioni 

Utilizzare la finestra di ispezione Proprietà o il pannello Livelli per regolare l’opacità degli oggetti selezionati e 

applicare le modalità fusione. Un’impostazione dell’opacità pari a 100 rende l’oggetto completamente opaco. 

Un’impostazione pari a 0 (zero) lo rende invece completamente trasparente. 

Si può anche specificare una modalità fusione e opacità prima di disegnare un oggetto. 

Specificare una modalità fusione e opacità prima di disegnare un oggetto

❖ Con lo strumento selezionato nel pannello Strumenti, impostare le opzioni di fusione e opacità nella finestra di 

ispezione Proprietà prima di disegnare l’oggetto.

Nota: le opzioni di fusione e opacità non sono disponibili per tutti gli strumenti.

Immagine originale Normale Moltiplica

Scolora Scurisci Schiarisci

Differenza Tonalità Saturazione

Colore Luminosità Inverti

Tinta Cancella



156UTILIZZO DI FIREWORKS

Livelli, maschere e fusione

Ultimo aggiornamento 4/5/2011

Impostare una modalità di fusione e un livello di opacità per gli oggetti esistenti

1 Nel caso di due oggetti sovrapposti, selezionare quello superiore.

2 Selezionare un’opzione di fusione dal menu a comparsa Modalità fusione nella finestra di ispezione Proprietà o nel 

pannello Livelli.

3 Selezionare un’impostazione dal dispositivo di scorrimento a comparsa Opacità oppure digitare un valore nella 

casella di testo.

Impostare la modalità fusione e il livello di opacità predefiniti da applicare agli oggetti 
durante il disegno

1 Scegliere Seleziona > Deseleziona per evitare che la modalità fusione e l’opacità vengano accidentalmente applicate 

a eventuali oggetti selezionati.

2 Con uno strumento di disegno vettoriale o bitmap selezionato, scegliere una modalità fusione e un livello di opacità 

nella finestra di ispezione Proprietà.

La modalità fusione e il livello di opacità selezionati saranno utilizzati come impostazione predefinita per tutti gli 

oggetti disegnati successivamente con quello strumento.

Il filtro attivo Riempimento colore

Il filtro attivo Riempimento colore di Fireworks consente di regolare il colore di un oggetto modificandone l’opacità e 

la modalità di fusione. Il filtro Colore riempimento produce lo stesso effetto ottenuto con la sovrapposizione di un 

oggetto a un altro per il quale sono state impostate modalità di fusione e opacità diverse. 
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Capitolo 11: Stili, simboli e URL

Adobe® Fireworks® è dotato di tre pannelli che consentono di archiviare e riutilizzare simboli, stili e URL. Gli stili sono 

archiviati nel pannello Stili, i simboli del documento corrente nel pannello Libreria documento e gli URL nel pannello 

URL. Per impostazione predefinita, i tre pannelli sono organizzati nel gruppo Risorse.

Per un’esercitazione video sull’utilizzo di stili e simboli in Fireworks, visitare www.adobe.com/go/lrvid4033_fw_it.

Stili 

È possibile salvare e riapplicare un gruppo di attributi predefiniti di riempimenti, tratti, filtri e testo creando uno stile. 

Se si applica uno stile a un oggetto, l’oggetto ne assume le caratteristiche. 

Nota: gli oggetti bitmap ricevono solo gli attributi del filtro di uno stile.

Fireworks dispone di numerosi stili predefiniti. Gli stili possono essere aggiunti, modificati e rimossi a piacere. Sul 

DVD di Fireworks e nel sito Web di Adobe sono disponibili ulteriori stili predefiniti importabili in Fireworks. Gli stili 

possono anche essere esportati e condivisi con altri utenti di Fireworks oppure importati da altri documenti di 

Fireworks. 

Applicare uno stile

Usare il pannello Stili per creare, memorizzare e applicare l’intera gamma di stili agli oggetti, al testo, ai gruppi e alle 

forme automatiche. 

Per un accesso rapido al sottoinsieme di stili presente in un documento, usare il menu degli stili corrente nella finestra 

di ispezione Proprietà.

1 Nell’area di lavoro, selezionare gli oggetti a cui applicare uno stile.

2 Selezionare Finestra > Stili per visualizzare il pannello Stili.

3 Scegliere Documento corrente per accedere agli stili attualmente in uso oppure selezionare uno stile preimpostato 

dal menu a comparsa per accedere agli stili reimpostati di Fireworks. 

Nota: se un documento non contiene stili, il pannello degli stili rimane vuoto finché non si seleziona uno degli stili 

preimpostati.

4 Fare clic su uno stile nel pannello.

http://www.adobe.com/go/lrvid4033_fw_it
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Altri argomenti presenti nell’Aiuto 

“Salvare e importare gli stili” a pagina 159

“Modificare o ridefinire gli stili” a pagina 159

“Interrompere il collegamento a uno stile” a pagina 160

Creare ed eliminare gli stili

È possibile creare uno stile sulla base degli attributi di un oggetto, di un gruppo, di un testo o di una forma automatica 

selezionati.  I seguenti attributi possono essere salvati come stile:

• Tipo e colore del riempimento, compresi motivi, texture e attributi di gradienti vettoriali quali angolo, posizione e 

opacità

• Tipo e colore del tratto

• Filtri

• Gli attributi del testo, quali tipo di carattere, dimensioni, stile (grassetto, corsivo o sottolineato), allineamento, 

antialiasing, crenatura automatica, scalatura orizzontale, avvicinamento e interlinea

Una volta eliminato uno stile personalizzato, non sarà più possibile recuperarlo; tuttavia, tutti gli oggetti che usano lo 

stile in quel momento ne mantengono gli attributi. 

Creare uno stile

1 Creare o selezionare un oggetto vettoriale, un testo, un gruppo o una forma automatica con gli attributi desiderati 

per tratto, riempimento, filtro e testo.

2 Fare clic sul pulsante Nuovo stile  in fondo al pannello Stili o sulla finestra di ispezione Proprietà.

3 Selezionare gli attributi desiderati per lo stile. 

Nota: per salvare altri attributi di testo, usare l’opzione Testo altro.

4 Attribuire un nome allo stile e fare clic su OK.

Ridenominare uno stile

1 Selezionare uno stile dal pannello Stili.

2 Selezionare Rinomina stile dal menu delle opzioni del pannello Stili.

3 Digitare un nuovo nome per lo stile e fare clic su OK.

Basare un nuovo stile su uno preesistente

1 Applicare uno stile esistente a un oggetto selezionato.

2 Modificare gli attributi dell’oggetto.

3 Salvare gli attributi creando uno stile.

Eliminare uno stile

1 Selezionare uno stile dal pannello Stili.

Per selezionare più stili, fare clic tenendo premuto il tasto Maiusc; per selezionare più stili non contigui, fare clic 

tenendo premuto Ctrl (Windows) o Comando (Mac OS).

2 Fare clic sul pulsante Elimina stile .
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Per riportare l’oggetto allo stato precedente, effettuare una delle operazioni seguenti:

• Annullare lo stile che è stato applicato.

• Modificare manualmente gli attributi ripristinando le impostazioni precedenti all’applicazione dello stile.

Se necessario, è possibile creare uno stile predefinito che imposti le proprietà di un oggetto sui valori predefiniti di 

Fireworks. Creare un oggetto, selezionarlo e salvarlo come nuovo stile facendo attenzione a non selezionare alcuna 

opzione nella finestra delle proprietà Nuovo stile. Questo stile "predefinito" o "vuoto" ripristina tutti gli attributi di un 

altro stile, senza tuttavia riportare l’oggetto a un aspetto precedente. 

Modificare o ridefinire gli stili

È possibile modificare gli stili per attivare o disattivare proprietà specifiche quali riempimenti o tratti. Ridefinire gli 

stili per modificare i filtri in essi inclusi.

Quando si modifica o ridefinisce uno stile, tutti gli oggetti ad esso applicati vengono aggiornati automaticamente. 

Tuttavia, è possibile interrompere il collegamento tra gli stili e gli oggetti selezionati. Consultare “Interrompere il 

collegamento a uno stile” a pagina 160.

Altri argomenti presenti nell’Aiuto 

“Modificare e personalizzare i filtri attivi” a pagina 133

Modificare uno stile

1 Scegliere Seleziona > Deseleziona per deselezionare gli oggetti sull’area di lavoro. 

2 Fare doppio clic su uno stile nel pannello Stili.

3 Nella finestra di dialogo Modifica stile, selezionare o deselezionare gli attributi. 

4 Fare clic su OK per applicare le modifiche allo stile.

Ridefinire uno stile

1 Nell’area di lavoro, selezionare un oggetto che utilizza lo stile.

2 Nella finestra di ispezione Proprietà, modificare i filtri applicati, quindi fare clic sul pulsante Ridefinisci stile.

Nota: quando si ridefinisce uno stile da un gruppo, vengono ridefiniti solo gli effetti. Tutti gli attributi dei tracciati 

vengono ignorati.

Per sostituire in modo rapido uno stile con un altro tra gli stili del documento corrente, nel pannello Stili trascinare 

lo stile sopra un altro tenendo premuto il tasto Alt (Windows) o Opzione (Mac OS). 

Salvare e importare gli stili

Per risparmiare tempo e garantire coerenza, è possibile condividere gli stili esportandoli in modo che possano essere 

utilizzati da altri utenti.

Salvare la libreria di stili

È possibile salvare gli stili creati o modificati come una libreria di stili. I nomi degli stili sono disposti in ordine 

alfabetico. Gli stili possono essere applicati anche a gruppi, forme automatiche e simboli.

1 Selezionare Salva libreria stili dal menu delle opzioni del pannello Stili.

2 Immettere un nome e una destinazione per la libreria di stili.
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3 Fare clic su Salva.

Importare gli stili

1 Selezionare Importa libreria stili dal menu delle opzioni del pannello Stili.

2 Selezionare una libreria di stili (*.stl) da importare. La libreria di stili è disponibile per più documenti e per più 

sessioni di Fireworks.

Caricare gli stili nel documento corrente

1 Selezionare Carica stile dal menu delle opzioni del pannello Stili.

2 Selezionare una libreria di stili (*.stl) da caricare nel documento corrente. Gli stili caricati sono disponibili per il 

documento corrente.

Modificare le dimensioni delle icone degli stili

❖ Per modificare le dimensioni delle icone di anteprima dello stile e passare da icone grandi a icone piccole e 

viceversa, selezionare Icone grandi dal menu delle opzioni del pannello Stili.

Copiare gli attributi da un oggetto all’altro senza applicare uno stile

1 Selezionare l’oggetto di cui copiare gli attributi.

2 Scegliere Modifica > Copia.

3 Deselezionare l’oggetto originale, quindi selezionare gli oggetti ai quali applicare i nuovi attributi.

4 Selezionare Modifica > Incolla attributi.

Interrompere il collegamento a uno stile

È possibile interrompere il collegamento tra un oggetto e lo stile a esso applicato. L’oggetto mantiene gli stessi attributi, 

ma se lo stile viene modificato l’oggetto non viene più aggiornato di conseguenza.

1 Selezionare l’oggetto con lo stile a esso applicato.

2 Nell’area inferiore destra della finestra di ispezione Proprietà, fare clic sul pulsante Interrompi collegamento a stile.

Se la finestra di ispezione Proprietà è ridotta, scegliere Interrompi collegamento a stile dal menu del pannello Stili.

Rimuovere dagli oggetti impostazioni di stile locali

1 Selezionare gli oggetti modificati dopo l’applicazione di uno stile.

2 Selezionare Elimina impostazioni locali dal menu delle opzioni del pannello Stili.

Selezionare gli stili non utilizzati nel documento corrente

❖ Scegliere Seleziona stili non usati dal menu delle opzioni del pannello Stili.

Duplicare uno stile

1 Selezionare uno stile dal pannello Stili.

2 Selezionare Duplica stile dal menu delle opzioni del pannello Stili.
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Simboli

In Fireworks, gli elementi grafici riutilizzabili vengono detti simboli. Fireworks dispone di tre tipi di simboli: elementi 

grafici, animazioni e pulsanti. Quando si modifica l’oggetto simbolo originale, le istanze copiate cambiano 

automaticamente per riflettere il simbolo modificato (a meno che non si interrompa il collegamento tra i due 

elementi).

I simboli sono utili per la creazione di pulsanti e l’animazione di oggetti su più stati.

Per ulteriori informazioni sui simboli, vedete Stili e simboli in dev center.

Altri argomenti presenti nell’Aiuto 

“Creare simboli dei pulsanti” a pagina 193

“Creare simboli di animazione” a pagina 217

Creare un simbolo

È possibile creare un simbolo da qualsiasi oggetto, blocco di testo o gruppo e quindi memorizzare i simboli nella scheda 

Libreria comune del pannello Risorse, da cui è possibile modificare il simbolo e inserirlo nei documenti.

Creare un simbolo da un oggetto selezionato

1 Selezionare l’oggetto e scegliere Modifica > Simbolo > Converti in simbolo.

2 Digitare un nome per il simbolo nella casella Nome.

3 Scegliere un tipo di simbolo. 

4 Per scalare il simbolo senza distorcerne la geometria, selezionare Abilita guide scala 9. Consultare 

“Ridimensionamento a 9 sezioni” a pagina 50.

5 Per memorizzare il simbolo in modo che possa essere utilizzata in più documenti, selezionare l’opzione Salva in 

libreria comune.

6 Fare clic su OK per salvare il simbolo.

L’oggetto selezionato diventa un’istanza del simbolo e nella finestra di ispezione Proprietà sono visualizzate le 

opzioni dei simboli.

Creare un nuovo simbolo da zero

1 Effettuare una delle seguenti operazioni:

• Selezionare Modifica > Inserisci > Nuovo simbolo.

• Selezionare Nuovo simbolo nel menu Opzioni del pannello Libreria documento.

2 Scegliere un tipo di simbolo. 

3 Se si desidera utilizzare la guide in scala a 9 porzioni per scalare il simbolo, selezionare l’opzione Abilita guide scala 

9 e fare clic su OK.

4 Creare il simbolo mediante gli strumenti del pannello Strumenti.

Creare l’istanza di un simbolo

❖ Trascinare un simbolo dal pannello Libreria documento al documento corrente. 

http://www.adobe.com/go/learn_fw_understandstylesymbols_it
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Istanza del simbolo sull’area di lavoro

Modificare un simbolo e tutte le relative istanze

Quando si modifica un simbolo, tutte le istanze associate vengono aggiornate automaticamente per riflettere la 

maggior parte delle modifiche apportate. Tuttavia, alcune proprietà sono indipendenti. Per ulteriori informazioni, 

consultare “Modificare specifiche istanze dei simboli” a pagina 163.

Quando dividete il simbolo i grafici vengono raggruppati per impostazione predefinita. Separate i grafici (pulsanti, 

barre di scorrimento e altri elementi) per modificarli. Potete in seguito raggruppare nuovamente i grafici e convertirli 

in un simbolo. Se non raggruppate i grafici prima della conversione, i singoli grafici nel simbolo diventano 

modificabili.

Modificare un simbolo

1 Per accedere alla modalità di modifica del simbolo, effettuare una delle seguenti operazioni:

• Nell’area di lavoro, fare doppio clic sull’istanza di un simbolo.

• Selezionare un’istanza e scegliere Modifica > Simbolo > Modifica simbolo.

• Nel pannello Libreria documento, fare doppio clic sull’icona di un simbolo.

• (Solo per i simboli di animazione) Fare clic sul pulsante Modifica nella finestra di dialogo Anima.

2 Modificare i simboli in base alle necessità.

Nota: se il simbolo selezionato non è abilitato per il ridimensionamento in 9 sezioni, è possibile modificarlo nel suo 

contesto. Scegliere Modifica > Simbolo > Modifica in posizione.

Per evitare distorsioni durante il ridimensionamento di un simbolo, utilizzare le guide in scala a 9 porzioni. 

Consultare “Ridimensionamento a 9 sezioni” a pagina 50.

Passare dalla modifica del simbolo alla modifica della pagina

Quando si modifica un simbolo, il pannello del documento passa alla modalità di modifica del simbolo. Quando questa 

modalità è attiva, gli altri oggetti dell’area di lavoro vengono disattivati, consentendo di modificare in modo rapido i 

simboli dell’intera pagina. (Costituiscono un’eccezione i simboli che usano il ridimensionamento a 9 sezioni, che 

vengono visualizzati da soli).

Per passare dalla modifica del simbolo a quella della pagina, effettuare una delle operazioni descritte di seguito:

• Nell’area di lavoro, fare doppio clic su un’area vuota.

• Nella barra visualizzata nella parte superiore del pannello del documento, fare clic sull’icona della pagina o sulla 

freccia Indietro. (Se il simbolo è nidificato, la barra consente di accedere anche al simbolo che lo contiene.)

Rinominare un simbolo

1 Nel pannello Libreria documento, fare doppio clic sul nome di un simbolo.

2 Nella finestra di dialogo Converti in simbolo, cambiare il nome e fare clic su OK.
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Duplicare un simbolo

1 Nel pannello Libreria documento, selezionare il simbolo.

2 Selezionare Duplica dal menu delle opzioni del pannello Libreria documento. 

3 Se necessario cambiare il nome e tipo del duplicato, quindi fare clic su OK. 

Cambiare il tipo di simbolo

1 Fare doppio clic sul nome del simbolo nella Libreria.

2 Scegliere un’opzione diversa per il tipo.

Selezionare tutti i simboli inutilizzati nel pannello Libreria documento

❖ Scegliere Seleziona elementi inutilizzati dal menu Opzioni del pannello Libreria documento.

Eliminare un simbolo e tutte le relative istanze

❖ Nel pannello Libreria documento, trascinare il simbolo sull’icona del cestino.

Scambiare un simbolo

1 Nell’area di lavoro, fare clic con il pulsante destro del mouse su un simbolo e selezionare Scambia simbolo.

2 Nella finestra di dialogo Scambia simbolo, selezionare un altro simbolo tra quelli disponibili nella Libreria 

documento e fare clic su OK.

Modificare specifiche istanze dei simboli

Quando si fa doppio clic su un’istanza per modificarla, in realtà viene modificato il simbolo stesso. Per modificare solo 

l’istanza corrente, è necessario interrompere il collegamento tra l’istanza e il simbolo. In tal modo viene interrotta in 

modo permanente la relazione tra i due elementi. Eventuali modifiche apportate in un secondo momento al simbolo 

non verranno applicate alle istanze precedenti.

I pulsanti dei simboli dispongono di diverse funzioni che consentono di mantenere le relazioni simbolo-istanza e allo 

stesso tempo assegnare testo dei pulsanti e URL univoci a ciascuna istanza. 

Per regolare i comportamenti di JavaScript per i simboli dei componenti, modificare i valori nel pannello Proprietà 

simbolo. Per aggiungere proprietà personalizzabili al pannello, è necessario modificare il file JavaScript associato al 

simbolo. 

Nota: Gli attributi di altezza e larghezza non possono essere impostati per un componente che utilizza JavaScript.

Interrompere i collegamenti dei simboli

1 Selezionare l’istanza.

2 Selezionare Elabora > Simbolo > Dividi.

L’istanza selezionata diventa un gruppo. Nel pannello Libreria documento, il simbolo non è più associato a quel 

gruppo. Dopo la separazione dal simbolo, quella che era un’istanza del pulsante perde le sue caratteristiche di 

simbolo di pulsante, mentre quella che era un’istanza di animazione perde le sue caratteristiche di simbolo di 

animazione.

Modificare un’istanza senza interrompere il collegamento del simbolo

1 Selezionare l’istanza.

2 Modificare le proprietà dell’istanza intervenendo dalla finestra di ispezione Proprietà.
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Le seguenti proprietà dell’istanza possono essere modificate senza incidere sul simbolo e sulle altre istanze:

• Modalità fusione

• Opacità

• Filtri

• Larghezza e altezza

•  Coordinate x e y

Creare e utilizzare i simboli dei componenti

I simboli dei componenti sono simboli grafici che è possibile scalare in modo intelligente e cui è possibile assegnare 

attributi specifici mediante un file JavaScript (JSF). Vengono chiamati anche "simboli complessi". La modifica di 

un’istanza mediante il pannello Proprietà ha effetto sul simbolo e tutte le altre istanze. Tuttavia, la modifica dei 

parametri del pannello Proprietà simbolo (Finestra > Proprietà simbolo) ha effetto solo sull’istanza selezionata.

Fireworks include una libreria dei simboli dei componenti predefiniti, che possono essere personalizzati in base 

all’aspetto di un sito Web o un’interfaccia utente specifici.

Aggiungere un simbolo dei componenti a un documento

1 Selezionare Libreria comune dal menu Finestra. 

2 Per utilizzare un simbolo, trascinarlo dal pannello Libreria comune nell’area di lavoro di Fireworks.

Regolare le proprietà dei simboli dei componenti

1 Nell’area di lavoro, selezionare il simbolo desiderato.

2 Nel pannello Proprietà simbolo (Finestra > Proprietà simbolo), regolare i parametri quali lo stato, l’etichetta e il 

colore.

Per creare pulsanti interattivi per prototipi software e Web basati su HTML, consultare “Porzioni interattive” a 

pagina 177.

Creare un simbolo dei componenti

Per ulteriori informazioni, leggere l’articolo Using rich symbols in Fireworks (Uso di simboli complessi in Fireworks) 

o l’esercitazione video disponibile all'indirizzo www.wonderhowto.com.

1 Creare un oggetto con attributi da personalizzare.

Questo simbolo potrà avere il colore e il numero del punto elenco come opzioni personalizzabili.

2 Durante la creazione dell’oggetto, personalizzare i nomi delle funzionalità che si desiderano modificare digitando 

un nome nel pannello Livelli. Utilizzare il nome Label per il livello di testo, mantenendo la L maiuscola. Questo 

nome viene usato nel file JavaScript.

http://www.adobe.com/go/learn_fw_richsymbols_it
http://www.wonderhowto.com/how-to-create-property-scripts-for-rich-symbols-fireworks-3526/view/
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Nota: per evitare errori di JavaScript, non includere spazi nei nomi delle funzioni. Ad esempio, utilizzare 

“numero_etichetta” ma non “numero etichetta”.

3 Selezionare l’oggetto e scegliere Modifica > Simbolo > Converti in simbolo.

4 Digitare un nome per il simbolo nella casella Nome.

5 Selezionare Grafico come tipo di simbolo, quindi selezionare Salva in libreria comune e fare clic su OK.

6 Quando viene richiesto, salvare il nuovo simbolo nella cartella predefinita Simboli personalizzati o creare un’altra 

cartella sullo stesso livello di quella predefinita.

Nota: i simboli dei componenti devono essere salvati in una cartella all’interno della Libreria comune.

Dopo il salvataggio, il simbolo viene rimosso dall’area di lavoro e visualizzato nella Libreria comune.

7 Nel menu Comandi, selezionare Crea script simbolo.

8 Fare clic sul pulsante Sfoglia nell’angolo superiore destro del pannello e selezionare il file PNG del simbolo. La 

posizione predefinita è la seguente:

• Per Microsoft® Windows® XP: <impostazioni utente>\Dati applicazioni\Fireworks CS5\Common 

Library\Custom Symbols

• Per Windows Vista®: \Utenti\<nome utente>\AppData\Roaming\Adobe\Fireworks CS5\Common 

Library\Custom Symbols

• Per Mac® OS: <nome utente>/Application Support/Adobe/Fireworks CS5/Common Library/Custom Symbols

9 Fare clic sul pulsante Più per aggiungere un nome di elemento.

10 Nella casella Nome elemento, selezionare dal menu il nome dell’elemento che si desidera personalizzare. 

11 Nella casella Attributo, selezionare il nome dell’attributo che si desidera personalizzare. Ad esempio, per 

personalizzare il testo dell’etichetta, selezionare textChars.

Nota: per ulteriori informazioni su queste opzioni degli attributi, vedere Extending Fireworks.

12 Nel campo relativo al nome della proprietà, digitare il nome della proprietà personalizzabile, ad esempio “Etichetta” 

o “Numero”. Si tratta del nome della proprietà visualizzato nel pannello Proprietà simbolo.

13 Nel campo Valore, digitare un valore per la proprietà utilizzata quando si posiziona per la prima volta un’istanza 

del simbolo in un documento.

14 Aggiungere elementi aggiuntivi secondo le necessità.

15 Fare clic su Salva per salvare le opzioni selezionate e creare un file JavaScript.

16 Selezionare Ricarica dal menu del pannello Libreria comune per ricaricare il nuovo simbolo.

Dopo aver creato il file JavaScript, è possibile creare un’istanza trascinando il simbolo nell’area di lavoro. Quindi, è 

possibile modificarne gli attributi nel pannello Proprietà simbolo.

Nota:  se si rimuove o rinomina un oggetto a cui si fa riferimento nello script, il pannello Proprietà simbolo riporta 

degli errori.

Salvare un simbolo esistente come simbolo dei componenti

1 Selezionare un simbolo nel pannello Libreria documento.

2 Selezionare Salva in libreria comune dal menu Opzioni del pannello Libreria documento.

3 Creare un file JavaScript per controllare le proprietà del simbolo. 
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Creare parametri dei simboli modificabili utilizzando JavaScript

Quando si salva un simbolo dei componenti, Fireworks salva un file PNG nelle seguenti cartelle predefinite:

• Windows XP: <impostazioni utente>\Dati applicazioni\Adobe\Fireworks CS\Common Library\Custom Symbols

• Windows Vista: \Utenti\<nome utente>\AppData\Roaming\Adobe\Fireworks CS5\Common Library\Custom 

Symbols

• Mac OS: <nome utente>/Application Support/Adobe/Fireworks CS5/Common Library/Custom Symbols

Per creare un simbolo dei componenti, è necessario creare un file JavaScript e salvarlo nella stessa posizione, con 

l’estensione .JSF e lo stesso nome del simbolo. Ad esempio, pulsante.grafico.png deve essere associato a un file 

JavaScript denominato pulsante.jsf.

Il pannello Crea script simbolo consente a chi non ha familiarità con i linguaggi di programmazione di assegnare 

alcuni semplici attributi al simbolo e di creare il file JavaScript automaticamente. Per aprire questo pannello, 

selezionare Crea script simbolo dal menu Comandi.

Creare il file JavaScript 

Per aggiungere parametri modificabili al simbolo, è necessario definire due funzioni nel file JavaScript:

• function setDefaultValues() – definisce i parametri che possono essere modificati e i valori predefiniti di 

questi parametri.

• function applyCurrentValues() – applica i valori immessi nel pannello Proprietà simbolo al simbolo grafico.

Il file seguente è un file JSF di esempio per la creazione di un simbolo personalizzato:

function setDefaultValues() 
{ 

var currValues = new Array(); 
//to build symbol properties 

currValues.push({name:"Selected", value:"true", type:"Boolean"}); 
Widget.elem.customData["currentValues"] = currValues; 

} 
function applyCurrentValues() 
{ 

var currValues = Widget.elem.customData["currentValues"]; 
// Get symbol object name 

var Check = Widget.GetObjectByName("Check"); 
Check.visible = currValues[0].value; 

} 
switch (Widget.opCode) 
{ 

case 1: setDefaultValues(); break; 
case 2: applyCurrentValues(); break; 
default: break; 

} 
This sample JavaScript shows a component symbol that can change colors: 
function setDefaultValues() 
{ 

var currValues = new Array(); 
//Name is the Parameter name that will be displayed in the Symbol Properties Panel 
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//Value is the default Value that is displayed when Component symbol loads first time. In this 
case, Blue will be the default color when the Component symbol is used. 
//Color is the Type of Parameter that is displayed. Color will invoke the Color Popup box 
in the Symbol Properties Panel. 

currValues.push({name:"BG Color", value:"#003366", type:"Color"}); 
Widget.elem.customData["currentValues"] = currValues; 

} 
function applyCurrentValues() 
{ 

var currValues = Widget.elem.customData["currentValues"]; 
//color_bg is the Layer name in the PNG that will change colors 

var color_bg = Widget.GetObjectByName("color_bg"); 
color_bg.pathAttributes.fillColor = currValues[0].value; 

} 
switch (Widget.opCode) 
{ 

case 1: setDefaultValues(); break; 
case 2: applyCurrentValues(); break; 
default: break; 

}

Per una migliore comprensione delle modalità di utilizzo del file JSF per personalizzare le proprietà del simbolo, 

analizzare i componenti di esempio in dotazione con il software.

Importare ed esportare simboli

Il pannello Libreria documento memorizza i simboli creati o importati nel documento corrente. Il pannello Libreria 

documento è specifico per il documento corrente; per utilizzare i simboli di una libreria in un altro documento, 

importarli, esportarli, copiarli o trascinarli.

Importare uno o più simboli da una libreria di simboli di Fireworks

È possibile importare simboli di animazione preparati, simboli grafici e simboli dei pulsanti, nonché barre di 

navigazione e temi multi-simbolo.

1 Aprire un documento di Fireworks.

2 Selezionare una cartella nel pannello Libreria comune. 

È inoltre possibile importare simboli da file PNG di librerie precedentemente esportate ubicate sull’unità disco 

rigido, su un CD o in rete.

Importare nel documento corrente simboli provenienti da un altro file

1 Selezionare Importa simboli dal menu Opzioni del pannello Libreria documento.

2 Individuare la cartella contenente il file, selezionarlo, quindi fare clic su Apri.

3 Selezionare i simboli da importare e fare clic su Importa.

I simboli importati compaiono nel pannello Libreria documento.

Importare un simbolo mediante trascinamento o Copia e Incolla

❖ Effettuare una delle seguenti operazioni:

• Trascinare un’istanza di simbolo dal documento contenente il simbolo al documento di destinazione.

• Copiare un’istanza di simbolo nel documento contenente il simbolo, quindi incollarlo nel documento di 

destinazione.
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Il simbolo viene importato nel pannello Libreria documento del documento di destinazione e mantiene una 

relazione con il simbolo nel documento originale.

Esportare simboli

1 Selezionare Esporta simboli dal menu Opzioni del pannello Libreria documento.

2 Selezionare i simboli da esportare e fare clic su Esporta.

3 Portarsi su una cartella, digitare un nome per il file del simbolo, quindi fare clic su Salva.

Fireworks salva i simboli in un unico file PNG.

Aggiornare istanze e simboli esportati in più documenti

I simboli importati mantengono il proprio collegamento con il documento del simbolo originale. È possibile 

modificare il documento del simbolo originale e quindi aggiornare i documenti di destinazione affinché riflettano le 

modifiche apportate.

1 Nel documento originale, fare doppio clic su un’istanza o scegliere l’istanza e selezionare Modifica > Simbolo > 

Modifica simbolo.

2 Modificare il simbolo.

3 Salvare il file.

4 Selezionare il simbolo dal pannello Libreria documento del documento nel quale il simbolo è stato importato.

5 Selezionare Aggiorna dal menu Opzioni del pannello Libreria documento.

Nota: per aggiornare tutti i simboli importati, selezionare tutti i simboli nel pannello Libreria documento e 

selezionare Aggiorna.

Creare simboli nidificati

I simboli creati all’interno di simboli vengono detti simboli nidificati. 

1 Creare un oggetto in una pagina utilizzando lo strumento vettoriale. Ad esempio, creare un rettangolo utilizzando 

lo strumento vettoriale.

2 Fare clic con il tasto destro del mouse sul rettangolo e selezionare Converti in simbolo. 

3 Nella finestra di dialogo Converti in simbolo, effettuare le seguenti operazioni:

a Specificare un nome per il simbolo. Chiamarlo, ad esempio, Simbolo A.

b Se si prevede di utilizzare il ridimensionamento a 9 sezioni, selezionare Abilita guide scala 9.

4 Fare doppio clic sull’icona “+” situata al centro del simbolo.

5 Ripetere i passaggi da uno a quattro per creare un altro simbolo, ad esempio, il Simbolo B. Poiché il simbolo B è 

stato creato all’interno di del simbolo A, il simbolo B è un simbolo nidificato del simbolo A.

Nota: è possibile creare più di un simbolo nidificato.

Simboli nidificati con ridimensionamento a 9 sezioni

È possibile creare dei simboli all’interno di un simbolo. Questi simboli, detti simboli nidificati, possono essere 

ridimensionati singolarmente. 

Prima di provare il ridimensionamento a 9 sezioni, assicurarsi di aver compiuto le seguenti operazioni.

• Selezionare Abilita guide scala 9 durante la creazione del simbolo. 
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• Assicurarsi di essere nella modalità di modifica del simbolo che si desidera ridimensionare. Per passare alla 

modalità di modifica del simbolo interno, fare doppio clic sull’icona “+” presente su di esso.

Quando si trasformano dei simboli nidificati tramite l’impostazione di ridimensionamento a 9 sezioni, è possibile 

ridimensionare i simboli nidificati individualmente. Ad esempio, consideriamo un simbolo nidificato in tre livelli: 

un simbolo A all’interno di un simbolo B, che a sua volta è all’interno del simbolo C. È ridimensionare il simbolo 

A (il più interno) e il simbolo B (intermedio), secondo le rispettive guide a 9 sezioni. Per utilizzare il 

ridimensionamento a 9 sezioni, assicurarsi di essere in modalità di modifica nel simbolo più interno. Nella modalità 

Modifica in posizione, il ridimensionamento a 9 sezioni per i simboli nidificati può essere visualizzato solo tramite 

il pannello Libreria. Facendo doppio clic su un simbolo nell’area di lavoro le guide per il ridimensionamento a 9 

sezioni non vengono visualizzate.

Attivare il ridimensionamento a 9 sezioni su un simbolo esistente

1 Passare alla vista nella quale è stato creato il simbolo. 

2 Selezionare il simbolo nel pannello Libreria documento e fare clic su Proprietà simbolo.

Nota: se il pannello Libreria documento non è visibile, selezionare Finestra > Libreria documento.

3 Nella finestra di dialogo Converti in simbolo, selezionare Abilita guide scala 9.

URL

L’assegnazione di un URL a un oggetto Web crea un collegamento a un file, quale una pagina Web. È possibile 

assegnare URL a porzioni, punti attivi e pulsanti. Per memorizzare, modificare e organizzare URL da riutilizzare, 

creare una libreria URL nel pannello URL.

Ad esempio, se il sito Web contiene diversi pulsanti di navigazione per tornare alla Home Page, è possibile aggiungere 

l’URL della Home Page al pannello URL. Quindi, assegnare l’URL a ciascun pulsante di navigazione selezionandolo 

nella libreria URL. Utilizzare la funzione Trova e sostituisci per modificare un URL su più documenti (consultare 

“Ricerca e sostituzione di elementi” a pagina 292).

Le librerie di URL sono disponibili per tutti i documenti Fireworks e vengono salvate tra le sessioni.

URL assoluti e relativi 

È possibile immettere un URL assoluto o relativo nel pannello URL.

• Per creare un collegamento a una pagina Web al di fuori del proprio sito Web, utilizzare un URL assoluto.

• Per creare un collegamento a una pagina Web all’interno del proprio sito Web, utilizzare indifferentemente un URL 

assoluto o relativo.

Gli URL assoluti sono URL completi e comprendono il protocollo server, generalmente http:// per le pagine Web. 

Ad esempio, http://www.adobe.com/it/support/fireworks è l’URL assoluto della pagina Web relativa al supporto 

per Fireworks. Gli URL assoluti rimangono validi indipendentemente dalla posizione del documento sorgente, ma 

non consentono un collegamento corretto se il documento di destinazione viene spostato.

Gli URL relativi sono relativi alla cartella contenente il documento sorgente. Gli URL relativi sono solitamente gli 

URL di più facile utilizzo per i collegamenti ai file contenuti nella stessa cartella del documento corrente. Ecco 

alcuni esempi della sintassi di navigazione degli URL relativi:

• file.htm esegue il collegamento a un file che si trova nella stessa cartella del documento sorgente.
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• ../../file.htm esegue il collegamento a un file che si trova nella cartella superiore di due livelli rispetto alla cartella 

contenente il documento sorgente. Ogni elemento ../ rappresenta un livello.

• htmldocs/file.htm esegue il collegamento a un file che si trova in una cartella denominata htmldocs che si trova 

all’interno della cartella che contiene il documento sorgente.

Collegamento alle pagine di un documento di Fireworks

È possibile creare collegamenti tra più pagine in un documento di Fireworks utilizzando gli URL di ciascuna pagina. 

Nella finestra di ispezione Proprietà e nel pannello URL, il menu a comparsa Collegamento contiene un elenco degli 

URL per ciascuna pagina del documento. Selezionare una di queste pagine URL per creare il collegamento alla pagina.

Assegnare agli URL della pagina predefinita un’estensione diversa da .htm

1 Con il documento aperto, selezionare File > Esporta.

2 Selezionare HTML e immagini.

3 Fare clic sul pulsante Opzioni.

4 Nella scheda Generale, selezionare l’estensione del nome file desiderata dal menu a comparsa Estensione e fare clic 

su OK.

5 Fare clic su Annulla nella finestra di dialogo Esporta.

Assegnare un URL a un oggetto Web

1 Digitare l’URL nella casella URL corrente del pannello URL.

2 Fare clic sul pulsante Aggiunge l’URL corrente alla libreria (+) per aggiungere l’URL alla libreria di URL.

3 Selezionare un oggetto Web.

4 Selezionare l’URL dal pannello Anteprima URL.

Creare una libreria di URL

Le librerie raggruppano gli URL correlati, semplificandone l’accesso. È possibile salvare gli URL nella libreria URL 

predefinita, URLs.htm, oppure in nuove librerie URL create dall’utente. È inoltre possibile importare gli URL da un 

documento HTML esistente e creare una libreria che li contenga.

URLs.htm ed eventuali nuove librerie create sono memorizzati nella cartella Adobe/Fireworks CS5/URL Libraries 

all’interno della cartella dell’utente in Dati applicazioni (Windows) o nella cartella Application Support (Mac OS).

Per informazioni sull’individuazione di tali cartelle, consultare “Utilizzare i file di configurazione” a pagina 310.

Creare una libreria URL

1 Selezionare Nuova libreria URL dal menu del pannello URL.

2 Immettere il nome della libreria nella casella e fare clic su OK.

Aggiungere un nuovo URL a una libreria URL

1 Selezionare una libreria dal menu a comparsa Libreria.

2 Immettere l’URL nella casella Collegamento.

3 Fare clic sul pulsante Più (+).
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Aggiungere un URL alla libreria e assegnarlo a un oggetto Web

1 Selezionare l’oggetto.

2 Per inserire l’URL, effettuare una delle seguenti operazioni:

• Selezionare Aggiungi URL dal menu del pannello URL, inserire un URL assoluto o relativo, quindi fare clic su OK.

• Immettere un URL nella casella Collegamento, quindi fare clic sul pulsante Più (+).

L’URL compare nel pannello anteprima URL.

Aggiungere URL utilizzati a una libreria URL

1 Selezionare una libreria dal menu a comparsa Libreria.

2 Selezionare Aggiungi URL utilizzati a libreria dal menu del pannello URL.

Eliminare un URL selezionato dal pannello di anteprima URL

❖ Fare clic sul pulsante Elimina URL dalla libreria  nella parte inferiore del pannello URL.

Eliminare tutti gli URL inutilizzati dalla libreria

1 Selezionare Cancella URL inutilizzati dal menu del pannello URL.

2 Fare clic su OK.

Modificare gli URL

Modificare una singola ricorrenza di un URL o estendere la modifica a tutte le ricorrenze.

1 Selezionare l’URL dal pannello anteprima URL.

2 Selezionare Modifica URL dal menu del pannello URL.

3 Modificare l’URL.

4 Per aggiornare questo collegamento su tutto il documento, selezionare Modifica ogni ricorrenza nel documento.

Importare ed esportare gli URL

È possibile esportare gli URL e importarli in altri documenti di Fireworks. Si possono inoltre importare tutti gli URL 

presenti nel documento HTML esistente.

Esportare URL

1 Selezionare Esporta URL dal menu del pannello URL.

2 Inserire un nome file e fare clic su Salva.

Viene creato un file HTML contenente gli URL esportati.

Importare URL

1 Selezionare Importa URL dal menu del pannello URL.

2 Selezionare un file HTML, quindi fare clic su Apri.

Tutti gli URL del file vengono importati.
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Capitolo 12: Porzioni, rollover e punti 
attivi

Creazione e modifica di porzioni

Le porzioni rappresentano gli elementi di base per la creazione di elementi interattivi in Adobe® Fireworks®. Le 

porzioni sono oggetti Web sotto forma di codice HTML. È possibile visualizzarle, selezionarle e rinominarle 

intervenendo nel Livello Web del pannello Livelli.

La suddivisione in porzioni consente di suddividere un documento di Fireworks in parti più piccole ed esportare 

ciascuna di esse in un file separato. Al momento dell’esportazione, Fireworks crea un file HTML contenente il codice 

necessario per riassemblare la grafica nel browser.

La suddivisione in porzioni permette di suddividere un documento in più parti, esportate come file separati.

Suddividere un’immagine in porzioni offre tre vantaggi principali:

Ottimizza le immagini Per un download più rapido.

Aggiunge interattività Per fare in modo che le immagini rispondano agli eventi del mouse.

Semplifica gli aggiornamenti Per le parti delle pagine Web che vengono modificate frequentemente (ad esempio, foto 

e nomi sulla pagina del personaggio del mese).
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Creare porzioni rettangolari

È possibile creare porzioni rettangolari disegnandole con lo strumento Porzione o inserendo una porzione in base a 

un oggetto selezionato. Utilizzare le guide porzione (le linee che si estendono dall’oggetto porzione) per determinare i 

limiti dei diversi file di immagine in cui viene suddiviso il documento al momento dell’esportazione. 

Disegnare un oggetto porzione rettangolare

1  Selezionare lo strumento Porzione .

2 Trascinare per disegnare l’oggetto porzione.

Nota: per regolare la posizione di una porzione mentre si trascina per disegnarla, tenere premuta la barra spaziatrice 

e trascinare la porzione in un’altra posizione dell’area di lavoro. Rilasciare la barra spaziatrice per continuare a 

disegnare la porzione.

Creare una porzione rettangolare in base a un oggetto selezionato

1 Selezionare Modifica > Inserisci > Porzione rettangolare. La porzione è costituita da un rettangolo la cui area 

comprende i pixel più esterni dell’oggetto selezionato.

2 Se si selezionano più oggetti, selezionare Una per creare un singolo oggetto porzione che comprende tutti gli oggetti 

selezionati oppure Più di una per creare un oggetto porzione per ciascun oggetto selezionato.

Creare porzioni non rettangolari 

Lo strumento Porzione poligonale consente di creare porzioni non rettangolari, utili quando si desidera conferire 

interattività a un’immagine non rettangolare.

Disegnare oggetti porzione poligonali

1 Selezionare lo strumento Porzione poligonale .
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2 Fare clic per posizionare i punti vettoriali del poligono. Questa operazione è necessaria in quanto lo strumento 

Porzione poligonale disegna segmenti rettilinei.

3 Quando si disegna un oggetto porzione poligonale attorno a oggetti con bordi attenuati, includere l’intero oggetto 

per evitare di creare bordi rigidi indesiderati nell’immagine porzione.

4 Per uscire dallo strumento Porzione poligonale, selezionare un altro strumento dal pannello Strumenti. Per 

chiudere il poligono non è necessario fare clic sul primo punto.

Nota: le porzioni poligonali combinano tabelle HTML e mappe immagine, pertanto richiedono un codice più esteso 

rispetto alle porzioni rettangolari. L’utilizzo di molte porzioni poligonali può richiedere più tempo di elaborazione in 

un browser Web. 

Creare una porzione poligonale da un oggetto o tracciato vettoriale

1 Selezionare un tracciato vettoriale.

2 Selezionare Modifica > Inserisci > Porzione poligonale. 

Creare porzioni di testo HTML 

Una porzione HTML definisce un’area in cui, nel browser, comparirà normale testo HTML. Successivamente viene 

esportato il testo HTML che viene visualizzato nella cella di tabella definita dalla porzione.

Le porzioni HTML sono utili per aggiornare in modo rapido il testo dei siti Web senza creare nuovi elementi grafici.

Nota: dal momento che il tipo e le dimensioni del carattere possono essere impostati nel browser, l’aspetto delle porzioni 

di testo HTML può variare quando viene visualizzato in browser diversi e su diversi sistemi operativi.

1 Disegnare un oggetto porzione. 

2 Con l’oggetto porzione selezionato, selezionare HTML dal menu a comparsa Tipo nella finestra di ispezione 

Proprietà.

3 Fare clic su Modifica.

4 Digitare il testo nella finestra Modifica porzione HTML e formattare il testo aggiungendo i tag di formattazione HTML.

Nota: in alternativa, applicare i tag di formattazione del testo HTML dopo aver esportato l’HTML. 

5 Fare clic su OK per applicare le modifiche e chiudere la finestra Modifica porzione HTML.

Il testo e i tag HTML immessi vengono visualizzati nel file PNG di Fireworks come codice HTML raw sul corpo 

della porzione.
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Visualizzare porzioni e guide porzione

È possibile controllare la visibilità delle porzioni e di altri oggetti Web nel documento utilizzando i pannelli Livelli e 

Strumenti. Quando si disattiva la visibilità per l’intero documento, vengono nascoste anche le guide porzione.

Visualizzare e selezionare le porzioni 

Il Livello Web visualizza tutti gli oggetti Web del documento. 

1 Selezionare Finestra > Livelli. 

2 Espandere il Livello Web facendo clic sul triangolo.

3 Fare clic sul nome di una porzione per selezionarla.

Mostrare e nascondere porzioni

Quando si nasconde una porzione la si rende invisibile nel file PNG di Fireworks. Gli oggetti porzioni nascosti possono 

essere esportati nell’HTML.

• Per nascondere una singola porzione, fare clic sull’icona dell’occhio  accanto all’oggetto Web nel pannello Livelli.

• Per mostrare una porzione nascosta, fare clic sulla colonna del simbolo dell’occhio. 

• Per nascondere o mostrare tutti i punti attivi, porzioni e guide, fare clic sul relativo pulsante Nascondi/Mostra 

porzioni  nella sezione degli strumenti Web del pannello Strumenti o fare clic sull’icona dell’occhio accanto 

al Livello Web nel pannello Livelli. 

• Per nascondere o mostrare le guide porzione in una vista del documento, selezionare Visualizza > Guide porzioni.

Modificare il colore delle guide e gli oggetti porzione

Assegnare colori esclusivi a singole porzioni e guide porzioni ne semplifica la visualizzazione e l’organizzazione. 

• Per modificare il colore di un oggetto porzione selezionato, nella finestra di ispezione Proprietà, selezionare un 

nuovo colore dalla casella dei colori.

• Per modificare il colore delle guide porzione, scegliere Modifica > Preferenze (Windows) o Fireworks > Preferenze 

(Mac OS). Quindi selezionare un nuovo colore per le guide porzione nella categoria Guide e griglie della finestra di 

dialogo Preferenze. 

Nota: durante l’anteprima del documento, le porzioni deselezionate vengono visualizzate come una sovrapposizione 

bianca.

Altri argomenti presenti nell’Aiuto 

“Preferenze Guide e griglie” a pagina 306

Modificare le porzioni

L’utilizzo di un layout porzione è analogo a quello di una tabella in un’applicazione di elaborazione testi. Quando si 

trascina una guida porzione per ridimensionare una porzione, vengono ridimensionate anche tutte le porzioni 

rettangolari adiacenti. 

Per ridimensionare e trasformare le porzioni, è anche possibile utilizzare la finestra di ispezione Proprietà.
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Modificare le porzioni spostando le guide porzione 

Le guide porzione definiscono il perimetro e la posizione delle porzioni. Le guide porzione che si estendono oltre gli 

oggetti porzione definiscono in che modo il resto del documento verrà suddiviso in porzioni al momento 

dell’esportazione. Per modificare la forma di un oggetto porzione rettangolare, trascinare le guide porzione che lo 

circondano. 

Non è possibile ridimensionare oggetti porzione non rettangolari spostando le guide porzione.

Ridimensionamento di un oggetto porzione mediante il trascinamento delle guide

Nota: trascinando le guide porzione che circondano un pulsante di Fireworks nella finestra del documento si 

ridimensiona la porzione che definisce l’area attiva per il pulsante. Questa tecnica non consente di eliminare l’area attiva 

di un pulsante di Fireworks.

Se più oggetti porzione sono allineati lungo un’unica guida porzione, è possibile trascinare la guida per ridimensionare 

tutti gli oggetti porzione contemporaneamente. 

Ridimensionamento di più oggetti porzione mediante il trascinamento di una singola guida

Trascinando una singola guida lungo una determinata coordinata, si spostano anche tutte le altre guide situate sulla 

coordinata stessa.

Ridimensionare una o più porzioni

1 Posizionare lo strumento Puntatore o Sottoselezione su una guida porzione.

 Il puntatore si trasforma nel cursore di movimento delle guide .

2 Trascinare la guida porzione nella posizione desiderata. 

Le porzioni e tutte le porzioni adiacenti vengono ridimensionate.

Riposizionare una guida porzione al bordo dell’area di lavoro 

❖ Utilizzare lo strumento Puntatore o lo strumento Sottoselezione per trascinare la guida porzione oltre il bordo 

dell’area di lavoro.
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Spostare guide porzione adiacenti

1 Tenendo premuto il tasto Maiusc, trascinare una guida porzione sulle guide adiacenti.

2 Rilasciare la guida porzione nella posizione desiderata. 

Tutte le guide su cui si è eseguito il trascinamento vengono spostate in questa posizione.

Per annullare questa operazione e ripristinare la posizione originaria di tutte le guide porzione, rilasciare il tasto 

Maiusc prima di rilasciare il pulsante del mouse. 

Modificare le porzioni mediante gli strumenti 

Per ridefinire o ridimensionare una porzione è possibile utilizzare gli strumenti Puntatore, Sottoselezione e 

Trasformazione. 

Nota: è possibile inclinare o distorcere solo le porzioni poligonali.

Dal momento che le dimensioni degli oggetti porzione adiacenti non vengono regolate automaticamente, 

ridimensionare le porzioni può dare luogo a porzioni sovrapposte. Se le porzioni si sovrappongono, quella in cima ha 

la precedenza per quanto riguarda l’interattività. Per evitare la sovrapposizione delle porzioni, utilizzare le guide 

porzione per modificarle. 

❖ Per modificare la forma di una porzione selezionata, effettuare una delle seguenti operazioni:

• Con lo strumento Puntatore o lo strumento Sottoselezione trascinare i punti d’angolo della porzione per 

modificarne la forma.

• Utilizzare uno strumento di trasformazione per effettuare la trasformazione. La trasformazione di una porzione 

rettangolare può modificarne forma, posizione o dimensioni, ma la porzione stessa rimane di tipo rettangolare.

• Per modificare le dimensioni e la posizione di un oggetto porzione utilizzare la finestra di ispezione Proprietà.

Rimuovere una porzione

1 Nel pannello Livelli, selezionare la porzione nel Livello Web.

2 Nella parte inferiore del pannello, fare clic sull’icona del cestino.

Quando si trascina un simbolo di un pulsante dalla libreria comune alla pagina, viene creata automaticamente una 

porzione visibile nell’area di lavoro, ma non presente sul livello web.

Se si seleziona la porzione dell’area di lavoro con lo strumento puntatore e la si elimina, viene eliminato tutto il simbolo 

del pulsante. Per conservare l’elemento grafico sottostante, selezionare la porzione o l’oggetto nell’area di lavoro con 

lo strumento puntatore e selezionare Modifica > Simbolo > Dividi. La porzione scompare, ma la grafica del pulsante 

viene salvata sullo stato #1. Tuttavia, quando si divide un simbolo di pulsante, la grafica degli stati 2, 3 e 4 viene persa. 

Porzioni interattive

Fireworks offre due diversi modi per rendere interattive le porzioni:

• Per una interattività semplice, utilizzare il metodo di rollover trascina e rilascia. 

• Per una interattività più complessa, utilizzare il pannello Comportamenti. I comportamenti di Fireworks sono 

compatibili con i comportamenti di Adobe Dreamweaver®. Quando si esporta un rollover di Fireworks in 

Dreamweaver, è possibile modificare i comportamenti di Fireworks utilizzando il pannello Comportamenti di 

Dreamweaver.
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Aggiungere interattività semplice alle porzioni

Il metodo rollover con trascinamento è un sistema rapido ed efficiente per creare rollover ed effetti di scambio 

immagini. Questo metodo consente di determinare cosa accade a una porzione al passaggio del puntatore. Il risultato 

finale è un elemento grafico comunemente denominato immagine di rollover. 

Quando la porzione è selezionata, al centro della porzione compare un cerchio con un mirino, denominato maniglia 

del comportamento.

A. Nome della porzione  B. Maniglia del comportamento  C. Selezione della maniglia  

Trascinando la maniglia del comportamento da una porzione di innesco e rilasciandola su una porzione di obiettivo 

si possono facilmente creare effetti rollover e di scambio immagini. La porzione di innesco e quella obiettivo possono 

essere la stessa.

Nota: anche i punti attivi dispongono di maniglie del comportamento per incorporare gli effetti rollover. 

I rollover

I rollover funzionano tutti allo stesso modo: quando il puntatore del mouse scorre su un elemento grafico, viene 

attivata la visualizzazione di un altro elemento grafico. L’innesco è costituito sempre da un oggetto Web (una porzione, 

un punto attivo o un pulsante). 

A CB
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Il rollover più semplice esegue lo scambio di un’immagine nello Stato 1 con un’immagine direttamente sottostante 

nello Stato 2. È inoltre possibile creare rollover più complessi. I rollover di scambio immagini possono effettuare lo 

scambio di immagini da qualsiasi stato. I rollover disgiunti eseguono lo scambio di un’immagine da una porzione 

diversa rispetto alla porzione di innesco.

Quando si seleziona un oggetto Web di innesco creato utilizzando una maniglia di comportamento o il pannello 

Comportamenti, vengono visualizzate tutte le sue relazioni di comportamento. 

Per impostazione predefinita, una linea blu di comportamento rappresenta un’interazione rollover. 

Creare e allegare un rollover semplice

Un rollover semplice esegue lo scambio dello stato, direttamente sotto lo stato superiore, e riguarda una sola porzione.

1 Accertarsi che l’oggetto di innesco non si trovi su un livello condiviso. 

2 Selezionare Modifica > Inserisci > Porzione rettangolare o Porzione poligonale per creare un’immagine sopra 

l’oggetto di innesco.

3 Creare un nuovo stato con il pannello Stati facendo clic sul pulsante Stato nuovo/duplicato.

4 Creare, incollare o importare un’immagine da utilizzare come immagine di scambio nel nuovo stato. 

Posizionare l’immagine sotto la porzione creata nel passaggio 2. La porzione è visibile nonostante sia attivo lo stato 2. 

5 Selezionare lo stato 1 nel pannello Stati per tornare allo stato in cui si trova l’immagine originale.



180UTILIZZO DI FIREWORKS

Porzioni, rollover e punti attivi

Ultimo aggiornamento 4/5/2011

6 Selezionare la porzione e posizionare il puntatore sulla maniglia del comportamento.

Nota: è possibile selezionare la porzione in qualsiasi stato.

7 Fare clic sulla maniglia del comportamento e selezionare Aggiungi un comportamento rollover semplice dal menu.

8 Fare clic sulla scheda Anteprima per provare il rollover semplice, oppure premere F12 per eseguire l’anteprima in 

un browser.

Creare e allegare un rollover disgiunto

Un rollover disgiunto scambia un’immagine in un oggetto Web quando il puntatore attraversa un altro oggetto Web. 

Se con il puntatore si attraversa o si fa clic sull’immagine di innesco, comparirà un’immagine in una posizione diversa 

della pagina Web. L’immagine attraversata dal puntatore è considerata l’elemento di innesco, mentre quella che 

cambia è l’immagine obiettivo.

Per prima cosa è necessario impostare gli inneschi, le porzioni obiettivo e lo stato in cui si trova l’immagine di scambio. 

Quindi, è possibile collegare l’elemento di innesco alla porzione obiettivo con una linea di comportamento. L’innesco 

di un rollover disgiunto può essere costituito da una porzione, un punto attivo o un pulsante.

1 Selezionare Modifica > Inserisci > Porzione rettangolare, Porzione poligonale o Punto attivo per collegare una 

porzione o un punto attivo all’immagine di innesco (saltare questo passaggio se l’oggetto selezionato è un pulsante 

o se l’immagine è già coperta da una porzione o da un punto attivo).

2 Creare un nuovo stato con il pannello Stati facendo clic sul pulsante Stato nuovo/duplicato.

3 Collocare una seconda immagine (l’obiettivo) nel nuovo stato.

4 Collocare lo stato in un punto qualsiasi dell’area di lavoro ma non al di sotto della porzione creata nel passaggio 1.

5 Selezionare l’immagine, quindi scegliere Modifica > Inserisci > Porzione rettangolare o Porzione poligonale per 

collegare una porzione all’immagine.

6 Selezionare lo stato 1 nel pannello Stati per tornare allo stato in cui si trova l’immagine originale.

7 Selezionare la porzione, il punto attivo o il pulsante che copre l’area di attivazione (l’immagine originale) e 

posizionare il puntatore sulla maniglia del comportamento. 

8 Trascinare la maniglia del comportamento della porzione di innesco o del punto attivo verso la porzione obiettivo. 
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La linea del comportamento si estende dal centro dell’elemento di innesco verso la parte superiore sinistra della 

porzione obiettivo e si apre la finestra di dialogo Scambia immagine.

9 Dal menu a comparsa Scambia immagine, selezionare lo stato creato nel passaggio 2, quindi fare clic su OK.

10 Visualizzare in anteprima e provare il rollover disgiunto.

Applicare più rollover a una porzione

Una porzione che innesca un comportamento rollover e un comportamento rollover disgiunto

1 Trascinare una maniglia di comportamento dalla porzione selezionata verso il bordo della stessa porzione o su 

un’altra porzione.

• Per creare un’immagine di scambio, trascinare la maniglia fino all’angolo superiore sinistro della stessa 

porzione. 

• Per creare un rollover disgiunto, trascinarlo in un’altra porzione. 

2 Selezionare lo stato dell’immagine di scambio e fare clic su OK.

Rimuovere un rollover di trascinamento da porzioni, punti attivi o pulsanti

❖ Fare clic sulla linea blu di comportamento da rimuovere e fare clic su OK.

Aggiungere interattività complessa alle porzioni 

Le opzioni del pannello Comportamenti consentono di creare e modificare le interazioni personalizzate. Questo tipo 

di interazione si basa sui comportamenti esistenti. 
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Opzioni di comportamento

Nota: per rollover semplici, disgiunti e complessi si consiglia di utilizzare il metodo di rollover con trascinamento.

Rollover semplice Aggiunge un comportamento rollover alla pozione o all’oggetto Web selezionati utilizzando lo stato 

1 come stato Su e lo stato 2 come stato Sopra. Una volta selezionato questo comportamento, occorre creare 

un’immagine in un secondo stato, nella stessa porzione, per creare lo stato Sopra. L’opzione Rollover semplice in 

pratica è un gruppo contenente i comportamenti Scambia immagine e Ripristina immagine di scambio.

Imposta immagine barra di navigazione Consente di impostare una porzione in modo da inserirla in una barra di 

navigazione di Fireworks. A ciascuna porzione che fa parte della barra di navigazione deve corrispondere questo 

comportamento. L’opzione Imposta immagine barra navigazione in pratica è un gruppo contenente i comportamenti 

Sopra barra nav, Giù barra nav e Ripristina barra nav. Questo comportamento è impostato automaticamente per 

impostazione predefinita quando si utilizza l’Editor di pulsanti per creare un pulsante che comprenda Includi stato 

Sopra e premuto oppure lo stato Mostra immagine Giù al caricamento. Quando si crea un pulsante a due stati, alla 

porzione viene assegnato un comportamento di rollover semplice. Quando si crea un pulsante a tre o quattro stati, alla 

porzione viene assegnato un comportamento Imposta immagine barra di navigazione. 

Nota: non è possibile modificare l’evento per Rollover semplice e Imposta immagine barra navigazione.

Scambia immagine Sostituisce il contenuto della porzione specificata con il contenuto di un altro stato della porzione 

stessa o con il contenuto di un file esterno. 

Ripristino di immagini scambiate Ripristina l’aspetto predefinito dell’oggetto obiettivo sullo stato 1.

Sopra barra nav Specifica lo stato Sopra per la porzione correntemente selezionata quando questa fa parte di una barra 

di navigazione e, se lo si desidera, specifica lo stato Precarica immagini e Includi stato Sopra e premuto.

Giù barra nav Specifica lo stato Giù per la porzione correntemente selezionata quando questa fa parte di una barra di 

navigazione e, se lo si desidera, lo stato Precarica immagini.

Ripristina barra nav Riporta tutte le altre porzioni della barra di navigazione allo stato Su.

Mostra menu a comparsa Collega un menu a comparsa a una porzione o a un punto attivo. Quando si applica un 

comportamento menu a comparsa, è possibile utilizzare l’Editor di menu a comparsa. 

Impostazione del testo della barra di stato Consente di definire il testo visualizzato nella barra di stato situata nella 

parte inferiore delle schermate dei browser.

Allegare comportamenti a una porzione selezionata

1 Fare clic sul pulsante Aggiungi comportamento nel pannello Comportamenti. 

A. Pulsante Aggiungi comportamento  B. Pulsante Rimuovi comportamento  

2 Selezionare uno o più comportamenti. 

A B



183UTILIZZO DI FIREWORKS

Porzioni, rollover e punti attivi

Ultimo aggiornamento 4/5/2011

Modificare l’evento del mouse che attiva il comportamento

1 Selezionare la porzione o il punto attivo di innesco contenente il comportamento da modificare.

Tutti i comportamenti associati a tale porzione o punto attivo sono visualizzati nel pannello Comportamenti.

2 Selezionare il comportamento da modificare.

3 Fare clic sulla freccia a lato dell’evento e selezionare un nuovo evento dal menu a comparsa. Questa opzione non è 

disponibile per il comportamento rollover semplice.

onMouseOver Innesca il comportamento quando il puntatore attraversa l’area di innesco.

onMouseOut Innesca il comportamento quando il puntatore lascia l’area di innesco.

onClick Innesca il comportamento quando si fa clic sull’oggetto di innesco.

onLoad Innesca il comportamento quando viene caricata la pagina Web.

Utilizzare file esterni di immagini per le immagini di scambio

È possibile utilizzare un’immagine esterna al documento di Fireworks come immagine sorgente per un’immagine di 

scambio. Le immagini sorgente possono essere in formato GIF, GIF animato, JPEG o PNG. Il file esterno scelto come 

immagine sorgente viene scambiato con la porzione obiettivo quando l’immagine di scambio viene innescata in un 

browser Web.

Se l’altezza e la larghezza del file non corrispondono a quelle della porzione con cui si sta effettuando lo scambio, il 

browser ridimensiona il file in modo che si adatti all’oggetto porzione. Ridimensionare un file può ridurne la qualità, 

in particolare per quanto riguarda le GIF animate.

1 Selezionare File immagine nella finestra di dialogo Scambia immagine, Sopra e premuto barra nav o Giù barra nav, 

poi fare clic sull’icona della cartella.

2 Individuare il file da utilizzare e fare clic su Apri.

3 Se il file esterno è una GIF animata, deselezionare Precarica immagini. In tal modo è possibile evitare eventuali 

problemi durante la visualizzazione di GIF animate come stati rollover.

Nota: Fireworks crea percorsi relativi al documento per i file di immagine. Se si prevede di esportare il documento per 

utilizzarlo sul Web, accertarsi che il file di immagine esterno sia accessibile dall’HTML esportato di Fireworks. Inserire 

i file esterni nel sito locale utilizzandoli come immagini di scambio in Fireworks e accertarsi di caricare i file di 

immagine esterni quando si caricano sul Web i propri file. 

Preparazione delle porzioni per l’esportazione

Per preparare le porzioni da esportare, utilizzare la finestra di ispezione Proprietà.

Proprietà della porzione nella finestra di ispezione Proprietà

Per ottimizzare rapidamente una porzione, selezionare una preimpostazione dal menu a comparsa Impostazioni 

esportazione nella finestra di ispezione Proprietà o nel pannello Ottimizza. Per impostare le opzioni dettagliate, 

consultare “Ottimizzare lo spazio di lavoro” a pagina 237. 
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Assegnare URL alle porzioni

L’assegnazione di un URL a una porzione consente di accedere direttamente all’indirizzo indicato facendo clic sul 

punto attivo all’interno del proprio browser Web.

❖ Per assegnare un URL, immettere l’URL nella caselle di testo Collegamento della finestra di ispezione Proprietà.

Se il file include varie pagine che verranno esportate, utilizzare il menu a comparsa Collegamento per selezionare una 

delle pagine per l’URL. Dopo l’esportazione delle pagine, questo collegamento consentirà di passare automaticamente 

alla pagina specificata.

Se si ha intenzione di riutilizzare gli URL, creare una libreria URL nel pannello URL.

Immettere testo alternativo

L’immissione di testo alternativo conciso e significativo (testo alt) è importante per il numero sempre crescente di 

utenti ipovedenti che utilizzano applicazioni per la lettura dello schermo. Queste applicazioni consentono la lettura 

del testo alternativo tramite una voce generata dal computer quando l’utente passa il puntatore sugli elementi grafici 

di una pagina Web.

❖ Digitare il testo alternativo nella casella di testo Alt della finestra di ispezione Proprietà.

Selezionare le porzioni o i punti attivi senza testo alternativo

È possibile selezionare le porzioni e i punti attivi per i quali non è stato inserito il testo alternativo corrispondente. 

Successivamente sarà possibile impostare per tali oggetti un testo alternativo predefinito.

❖ Selezionare Comandi > Web > Selezione testo ALT vuoto.

Impostare il testo alternativo predefinito

Una volta selezionati i punti attivi e le porzioni per i quali non è stato inserito il testo alternativo corrispondente, è 

possibile impostare per tali oggetti un testo alternativo predefinito.

❖ Selezionare Comandi > Web > Imposta testo ALT e digitare il testo alternativo predefinito.

Assegnare un obiettivo per una porzione o punto attivo selezionati

Per obiettivo si intende uno stato di pagina Web alternativo o un browser Web nei quali viene aperto il documento 

collegato.

❖ Immettere il nome di uno stato HTML nella casella di testo Obiettivo o selezionare un obiettivo riservato dal menu 

a comparsa Obiettivo.

_blank Carica i documenti collegati in una nuova finestra di browser senza nome.

_parent Carica il documento collegato nel set di stato principale o nella finestra dello stato contenente il 

collegamento. Se lo stato in cui si trova il collegamento non è nidificato, il file collegato viene caricato nella finestra 

del browser a grandezza piena.

_self Carica il documento collegato nello stesso stato o nella stessa finestra del collegamento. Poiché questo 

collegamento è implicito, di solito non è necessario specificarlo.

_top Carica il documento collegato nella finestra del browser intera, eliminando così tutti gli stati.



185UTILIZZO DI FIREWORKS

Porzioni, rollover e punti attivi

Ultimo aggiornamento 4/5/2011

Assegnare un nome alle porzioni

La suddivisione in porzioni ritaglia l’immagine in varie parti. Dal momento che ciascuno stato viene esportato 

separatamente, ognuno di essi deve avere un nome univoco. Utilizzare le convenzioni di denominazione predefinite o 

assegnare nomi personalizzati.

Nota: non aggiungere un’estensione al nome base. Fireworks aggiunge infatti automaticamente le estensioni ai file delle 

porzioni al momento dell’esportazione.

Immettere un nome porzione personalizzato

❖ Effettuare una delle seguenti operazioni:

• Selezionare la porzione sull’area di lavoro, immettere un nome nella casella Modifica nome oggetto nella finestra 

di ispezione Proprietà e premere Invio.

• Fare doppio clic sul nome della porzione nel livello Web, digitare il nuovo nome e premere Invio.

Assegnare automaticamente il nome a un file porzione 

❖ Al momento dell’esportazione dell’immagine suddivisa in porzioni, immettere un nome nel campo Nome file 

(Windows) o Nome (Mac OS) della finestra di dialogo Esporta. Non aggiungere un’estensione al file. 

Modificare la convenzione predefinita di denominazione automatica

È possibile creare una convenzione di denominazione che comprenda fino a sei elementi. Un elemento può essere 

formato da qualsiasi delle opzioni di denominazione automatica elencate di seguito: 

Ad esempio, se il nome del documento è miodoc, la convenzione di denominazione doc.nome + “porzione” + 

Porzione n. (A,B,C...) darà come risultato una porzione denominata miodocporzioneA. 

Opzione Descrizione

Nessuna All’elemento non viene applicato alcun nome.

doc.nome L’elemento assume il nome del documento.

“porzione” È possibile inserire la parola “porzione” nella convenzione di denominazione.

Porzione n. (1,2,3...)

Porzione n. (01,02,03...)

Porzione n. (a,b,c...)

Porzione n. (a,b,c...)

L’elemento viene etichettato in ordine numerico o alfabetico in base allo stile prescelto.

riga/colonna (r3_c2, r4_c7...) Riga (r##) e Col (c##) designano le righe e le colonne della tabella che i browser Web utilizzano per 

ricostruire l’immagine suddivisa in porzioni. Queste informazioni possono essere utilizzate nella 

convenzione di denominazione.

Sottolineato

Punto

Spazio

Trattino

L’elemento utilizza questi caratteri, in genere come separatori tra gli altri elementi.
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Se la porzione è composta da più stati, per impostazione predefinita Fireworks aggiunge un numero a ognuno dei file. 

Ad esempio, se si inserisce il nome personalizzato home per un pulsante a tre stati, Fireworks assegna all’immagine 

dello stato Su il nome home.gif, all’immagine dello stato Sopra il nome home_s2.gif e all’immagine dello stato Giù il 

nome home_s3.gif. È possibile creare la propria convenzione di denominazione per le porzioni multistato utilizzando 

la finestra di dialogo Impostazioni HTML.

1 Selezionare File > Imposta HTML per aprire la finestra di dialogo Impostazioni HTML.

2 Fare clic sulla scheda Specifiche del documento.

3 Nella sezione Nomi file porzioni, creare la nuova convenzione di denominazione selezionando le opzioni dagli 

elenchi.

4 (Facoltativo) Fare clic su Imposta predefiniti per impostare queste informazioni come predefinite per tutti i nuovi 

documenti di Fireworks.

Nota: la selezione dell’opzione di menu Nessuno per la denominazione automatica delle porzioni richiede una certa 

cautela. Se si sceglie infatti questa opzione per i primi tre menu, Fireworks esporta i file delle porzioni che si 

sovrascrivono reciprocamente, producendo un singolo elemento grafico esportato e una tabella che visualizza tale 

elemento in ogni cella.

Definire le modalità di esportazione delle tabelle HTML

La suddivisione in porzioni definisce l’aspetto che avrà la struttura della tabella HTML al momento dell’esportazione 

del documento di Fireworks per l’uso sul Web.

Quando si esporta in HTML un documento di Fireworks suddiviso in porzioni, questo viene riassemblato utilizzando 

una tabella HTML. Ogni elemento suddiviso in porzioni dal documento di Fireworks risiede in una cella della tabella. 

Una volta esportata, la porzione di Fireworks si traduce in una cella di tabella HTML. È possibile specificare la modalità 

di ricostruzione di una tabella di Fireworks in un browser, incluso l’uso di spazi o tabelle nidificate.

• Gli spaziatori sono immagini utilizzate per spaziare le celle di una tabella in modo da ottenere un allineamento 

appropriato nella visualizzazione all’interno di un browser.
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• Una tabella nidificata è una tabella racchiusa in un’altra tabella. Le tabelle nidificate non utilizzano spaziatori. 

Potrebbero richiedere tempi maggiori di caricamento nei browser, ma vista l’assenza di spaziatori, è più semplice 

modificarne il codice HTML. 

1 Selezionare File > Imposta HTML, oppure fare clic sul pulsante Opzioni nella finestra di dialogo Esporta.

2 Fare clic sulla scheda Tabella.

3 Selezionare un’opzione di spaziatura dal menu a comparsa Spazio con:

Tabelle nidificate — nessuno spaziatore Crea una tabella nidificata senza spaziatori.

Tabella singola — nessuno spaziatore Crea una tabella singola senza spaziatori. Con questa opzione è possibile 

che le tabelle siano talvolta visualizzate in modo errato.

Spaziatore trasparente da 1 pixel Utilizza come spaziatore un’immagine GIF trasparente di 1 pixel per 1 pixel, 

ridimensionata come necessario nel file HTML. Ciò genera una riga di altezza pari a 1 pixel nella parte superiore 

della tabella e una colonna di larghezza pari a 1 pixel sul lato destro.

4 Selezionare un colore della cella per le porzioni HTML:

Nota: se si sceglie un colore dalla finestra a comparsa dei colori, questo viene applicato solo alle porzioni HTML; 

le porzioni di immagine continuano a utilizzare il colore dell’area di lavoro. 

5 Nel menu a comparsa dei contenuti, selezionare cosa si desidera inserire nelle celle vuote: 

Nessuna Fa sì che le celle vuote rimangano tali.

Immagine spaziatore Colloca una piccola immagine trasparente, spacer.gif, nelle celle vuote. 

Spazio unificatore Colloca un tag HTML spazio nelle celle vuote. La cella appare vuota.

Nota: le celle vuote sono presenti solo se l’opzione Includi aree senza porzioni è deselezionata nella finestra di 

dialogo Esporta.

6 Fare clic su OK.

Nota: è possibile selezionare impostazioni di esportazione delle tabelle specifiche per ciascun documento; oppure, 

per applicare le impostazioni predefinite per tutti i nuovi documenti, utilizzare il pulsante Imposta predefiniti nella 

scheda Specifiche del documento della finestra di dialogo Imposta HTML.

Punti attivi e mappe immagine

I Web designer possono utilizzare i punti attivi per creare parti più piccole da un elemento grafico interattivo di 

maggiori dimensioni, collegando aree della grafica Web a un URL. Per creare una mappa immagine in Fireworks, 

occorre esportare l’HTML da un documento che contiene punti attivi. 
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Mappa immagine con punti attivi

I punti attivi e le mappe immagine fanno spesso un uso meno intensivo delle risorse rispetto agli elementi grafici 

suddivisi in porzioni. La suddivisione in porzioni richiede maggiori tempi di elaborazione a causa del codice HTML 

aggiuntivo necessario per scaricare e riassemblare gli elementi grafici suddivisi in porzioni.

Nota: è possibile creare una mappa immagine suddivisa in porzioni. In genere l’esportazione di una mappa immagine 

suddivisa in porzioni genera diversi file grafici. Per ulteriori informazioni sulla suddivisione in porzioni, consultare 

“Creare porzioni rettangolari” a pagina 173.

Creare punti attivi

• I punti attivi rappresentano la soluzione ideale per collegare le aree di un immagine ad altre pagine Web, ma tali 

aree non sono necessarie per evidenziare o produrre effetti rollover in risposta al movimento o alle azioni del 

mouse. 

• I punti attivi e le mappe immagine sono ideali anche quando l’elemento grafico su cui si sono collocati i punti attivi 

è esportabile al meglio come file grafico singolo - in altre parole, l’esportazione ottimale dell’intero elemento grafico 

si ottiene utilizzando le stesse impostazioni di formato file e ottimizzazione.

• I punti attivi possono essere rettangoli, cerchi o poligoni. I poligoni sono utili quando si utilizzano immagini 

complesse.

• Selezionare un oggetto e inserirvi il punto attivo.

Creare un punto attivo di forma rettangolare o circolare

1 Selezionare lo strumento Punto attivo rettangolare o Punto attivo circolare dalla sezione Web del pannello 

Strumenti.

2 Trascinare lo strumento Punto attivo per tracciare un punto attivo su un’area dell’elemento grafico. Tenere 

premuto il tasto Alt (Windows) o Opzione (Mac OS) per disegnare da un punto centrale.

Nota: è possibile regolare la posizione di un punto attivo durante l’operazione di trascinamento. Tenendo premuto il 

pulsante del mouse, tenere premuta la barra spaziatrice e trascinare il punto attivo in un’altra posizione dell’area di 

lavoro. Rilasciare la barra spaziatrice per continuare a disegnare il punto attivo.
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Creare un punto attivo di forma irregolare

1  Selezionare lo strumento Punto attivo poligonale .

2 Fare clic per disegnare i punti vettoriali, come se si disegnassero segmenti diritti con lo strumento Penna. L’area del 

punto attivo viene definita dal riempimento, indipendentemente dal fatto che il tracciato sia aperto o chiuso.

Creare un punto attivo comprendente uno o più oggetti selezionati

1 Selezionare più oggetti, quindi scegliere Modifica > Inserisci > Punto attivo.

2 Fare clic su Singolo per creare un singolo punto attivo rettangolare comprendente tutti gli oggetti, oppure su 

Multipli per creare più punti attivi (uno per ogni oggetto).

Il livello Web visualizza i nuovi punti attivi.

Convertire un punto attivo selezionato in un punto attivo rettangolare, circolare o 
poligonale

❖ Scegliere Rettangolo, Cerchio o Poligono dal menu a comparsa Forma punto attivo della finestra di ispezione 

Proprietà.

Preparare i punti attivi per l’esportazione

Le proprietà dei punti attivi, ad esempio URL e testo alternativo, vengono assegnate tramite la finestra di ispezione 

Proprietà, con la stessa procedura con la quale si assegnano le proprietà delle porzioni. 

Creare mappe immagine 

Una volta inseriti i punti attivi in un’immagine, esportarla come mappa immagine in modo che possa essere usata in 

un browser Web. L’esportazione di una mappa immagine genera gli elementi grafici e il file HTML contenente le 

informazioni di mappa relative ai punti attivi e ai corrispondenti collegamenti URL. Al momento dell’esportazione, 

Fireworks produce solo mappe immagine client-side.

In alternativa, copiare la mappa immagine negli Appunti e incollarla in Dreamweaver o in un altro editor HTML.

Per informazioni sull’inserimento di contenuto di Fireworks esportato in Dreamweaver, consultare “Operazioni con 

Dreamweaver” a pagina 262

1 Ottimizzare l’elemento grafico da preparare per l’esportazione.

2 Selezionare File > Esporta.

3 Se si esporta un’immagine personale, individuare la cartella in cui si desidera posizionare il file HTML e assegnare 

un nome al file.

Se è già stata realizzata una struttura di file locale per il sito Web, è possibile salvare l’elemento grafico nella cartella 

appropriata del sito. 

4 Scegliere HTML e immagini dal menu a comparsa Esporta.

5 Scegliere un’opzione dal menu a comparsa HTML:

Esporta file HTML Genera il file HTML richiesto e i file grafici corrispondenti da importare in Dreamweaver o in 

un altro editor HTML.

Copia negli Appunti Copia negli Appunti tutti gli HTML richiesti, inclusa una tabella qualora il documento sia 

suddiviso in porzioni, da incollare in Dreamweaver o in un altro editor HTML.

Nota: per Porzioni, scegliere Nessuna solo se il documento non contiene porzioni.
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6 (Solo per l’esportazione) Se necessario, selezionare Inserisci immagine nella sottocartella e individuare la cartella 

appropriata. 

7 Fare clic su Salva.

8 Al momento dell’esportazione dei file, Fireworks può utilizzare i commenti HTML per identificare l’inizio e il 

termine del codice per le mappe immagine e altre caratteristiche Web. Per impostazione predefinita, i commenti 

HTML non sono inclusi nel codice. Per includerli, scegliere Includi commenti HTML nella scheda Generali della 

finestra di dialogo Impostazioni HTML.

Creare rollover con punti attivi 

Per allegare effetti rollover disgiunti a un punto attivo, utilizzare il metodo rollover con trascinamento. L’area obiettivo 

deve essere definita da una porzione. Gli effetti rollover sono applicati ai punti attivi nello stesso modo in cui avviene 

per le porzioni. 

Nota: un punto attivo può attivare solo un rollover disgiunto. Non può essere l’obiettivo di un rollover proveniente da un 

altro punto attivo o porzione.

Una volta creato un rollover disgiunto con un punto attivo, la linea di collegamento blu rimane visibile mentre il punto 

attivo è selezionato. 

Usare i punti attivi sulle porzioni 

In caso di elementi grafici di grandi dimensioni, di cui si desidera utilizzare solo una piccola porzione come elemento 

di innesco di un’azione, collocare un punto attivo sopra una porzione per innescare l’azione o il comportamento. 

È inoltre possibile collocare una porzione sull’elemento grafico, poi posizionare un punto attivo sul testo. L’effetto 

rollover viene attivato solo quando si passa il cursore sul testo; tuttavia l’intero elemento grafico sotto la porzione viene 

scambiato quando si verifica l’effetto rollover. 
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Nota: evitare di creare punti attivi sovrapposti a più porzioni.

1 Inserire una porzione sull’immagine da scambiare.

2 Nel pannello Stati, creare un nuovo stato e inserire l’immagine da utilizzare come immagine sostitutiva. Accertarsi 

di collocarla sotto la porzione inserita al passaggio 1.

3 Trascinare dal punto attivo alla porzione contenente l’immagine da scambiare.

4 Selezionare lo stato che contiene l’immagine del rollover dall’elenco Scambia immagine, quindi fare clic su OK.
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Capitolo 13: Creazione di pulsanti e menu 
a comparsa

Nozioni di base sulla navigazione

Le funzioni di navigazione

È possibile semplificare la navigazione all’interno dei documenti aggiungendo pulsanti, menu e barre di navigazione. 

Con Adobe® Fireworks® è possibile creare e implementare in modo semplice tali supporti di navigazione, anche se non 

si ha esperienza di codice CSS e JavaScript.

Quando i pulsanti o i menu a comparsa vengono esportati, Fireworks genera automaticamente il codice CSS o 

JavaScript necessario per visualizzarli in un browser Web. Con Adobe Dreamweaver è inoltre possibile inserire con 

facilità il codice CSS, JavaScript e HTML proveniente da Fireworks nelle proprie pagine Web, oppure in qualsiasi file 

HTML o CSS.

Creare una barra di navigazione di base

Una barra di navigazione consiste in un gruppo di pulsanti che permettono di accedere alle diverse aree di un sito Web. 

Una barra di navigazione rimane generalmente invariata in tutto il sito, in modo da offrire un metodo di navigazione 

coerente. Tuttavia, i collegamenti presenti nella barra di navigazione possono variare in base alle necessità delle singole 

pagine. 

Per garantire una navigazione coerente, è possibile duplicare i simboli dei pulsanti grazie alle istanze dei simboli. Se si 

modifica l’aspetto o la funzionalità del simbolo originale, vengono aggiornate automaticamente anche tutte le istanze 

associate. Consultare “Simboli” a pagina 161.

1 Creare un simbolo del pulsante.

2 Trascinare un’istanza (copia) del simbolo dal pannello Libreria allo spazio di lavoro.

3 Per creare una copia dell’istanza del pulsante, effettuare una delle seguenti operazioni:

• Selezionare l’istanza del pulsante, quindi selezionare Modifica > Clona. 

• Trascinare l’istanza del pulsante tenendo premuto Alt (Windows) o Opzione (Mac OS). 

4 Trascinare un pulsante tenendo premuto il tasto Maiusc per allinearlo orizzontalmente o verticalmente. Per un 

controllo più preciso, usare i tasti freccia per spostare l’istanza.

5 Ripetere i passaggi 3 e 4 per creare istanze aggiuntive del pulsante.

6 Selezionare ciascuna istanza e utilizzare la finestra di ispezione Proprietà per assegnare un testo univoco, un URL 

e altre proprietà. 
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Creare simboli dei pulsanti

I pulsanti costituiscono un tipo di simbolo speciale e vengono utilizzati come elemento di navigazione per una pagina 

Web. I pulsanti possono essere modificati con la finestra di ispezione Proprietà. Dal momento che è possibile 

trascinare istanze di un pulsante dalla libreria di simboli al documento attuale, se si modifica l’aspetto grafico di un 

singolo pulsante viene automaticamente aggiornato anche l’aspetto di tutte le istanze dei pulsanti in una barra di 

navigazione.

È possibile modificare il testo, l’URL e la destinazione di un’istanza del pulsante senza alterare le altre istanze dello 

stesso pulsante e senza interrompere la relazione simbolo-istanza.

Un’istanza di pulsante è incapsulata. Fireworks sposta tutti i componenti e gli stati associati ai pulsanti trascinati nel 

documento.

Analogamente agli altri simboli, i pulsanti dispongono di un punto di registro (un punto centrale che consente di 

allineare il testo e i diversi stati del pulsante mentre lo si modifica).

1 Selezionare l’oggetto da convertire in pulsante.

2 Selezionare Elabora > Simbolo > Converti in simbolo.

3 Nella finestra di dialogo Converti in simbolo, inserire un nome per il pulsante.

4 Nelle Opzioni testo, selezionare Pulsante.

5 (Opzionale) Per abilitare il ridimensionamento a 9 sezioni, selezionare Abilita guide scala 9.

6 (Opzionale) Per salvare l'immagine come pulsante nella libreria immagini di Fireworks, selezionare Salva  in 

libreria comune.

Applicare stati ai pulsanti

Un pulsante può avere quattro diversi stati che rappresentano l’aspetto del pulsante in risposta a un evento del mouse. 

I pulsanti a due stati hanno gli stati Su e Giù. I pulsanti a tre e quattro stati hanno inoltre gli stati Sopra e Sopra e 

premuto. Tali stati rappresentano l’aspetto del pulsante quando si passa il puntatore sopra di esso senza premere il 

pulsante del mouse (Sopra) oppure premendolo (Sopra e premuto).

È possibile creare una barra di navigazione utilizzando pulsanti a due o tre stati. Tuttavia, solo i pulsanti con quattro 

stati possono sfruttare i comportamenti della barra di navigazione integrati di Fireworks.

Creare un semplice pulsante a due stati

1 Per accedere alla modalità di modifica del simbolo, effettuare una delle seguenti operazioni: 

• Fare doppio clic su un pulsante esistente nell’area di lavoro.

• Scegliere Modifica > Inserisci > Nuovo pulsante.

2 Per importare o creare l’immagine dello stato Su, effettuare una delle seguenti operazioni:

• Trascinare o importare nell’area di lavoro l’immagine desiderata come stato Su del pulsante.

• Usare gli strumenti di disegno per creare un elemento grafico o utilizzare lo strumento Testo per creare un 

pulsante dal testo.

• Fare clic su Importa un pulsante nella finestra di ispezione Proprietà e selezionare un pulsante dalla libreria 

Importa simboli: Pulsante. Mediante questa opzione, ciascuno degli stati del pulsante viene automaticamente 

riempito con gli elementi grafici e il testo più appropriati.
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• (Facoltativo) Impostare le guide scala 9 per impedire che la forma del pulsante venga distorta al 

ridimensionamento. (Consultare “Applicare guide a 9 sezioni a un simbolo” a pagina 51.)

• (Facoltativo) Selezionare lo strumento Testo e creare testo per il pulsante.

3 Per creare lo stato Sopra, selezionare Sopra dal menu a comparsa ed effettuare una delle seguenti operazioni:

• Fare clic su Copia grafico Su per incollare una copia del pulsante dello stato Su nella finestra Sopra, quindi 

modificarlo.

• Trascinare e rilasciare, importare o disegnare un elemento grafico.

4 (Facoltativo) Per utilizzare i filtri attivi per la creazione di aspetti comuni per ciascuno stato, selezionare l’elemento 

grafico a cui si desidera aggiungere il filtro attivo e fare clic sul pulsante più (+) accanto all’etichetta Filtri nella 

finestra di ispezione Proprietà.

5 Selezionare Smusso e rilievo > Smusso interno, Rilievo incavato, Smusso esterno oppure Rilievo sollevato.

6 Selezionare un filtro di preimpostazione pulsante per ciascuno stato.

Creare un pulsante a tre o quattro stati

Sebbene i pulsanti a quattro stati non siano obbligatori, consentono di utilizzare i comportamenti della barra di 

navigazione integrati.

1 Con un pulsante a due stati aperto nell’area di lavoro, in modalità di modifica del simbolo, selezionare Giù dal menu 

a comparsa della finestra di ispezione Proprietà ed effettuare una delle seguenti operazioni:

• Fare clic su Copia grafico Sopra per incollare una copia del pulsante dello stato Su nella finestra Giù, quindi 

modificarla per variarne l’aspetto.

• Trascinare e rilasciare, importare o disegnare un elemento grafico.

2 Per aggiungere uno stato Sopra e premuto, verificare che il pulsante dello stato Giù sia aperto e ripetere il passaggio 1.

3 (Facoltativo) Applicare filtri di preimpostazione ai pulsanti.

Nota: quando si inserisce o crea un elemento grafico per gli stati Giù o Sopra e premuto, le opzioni che consentono di 

includere lo stato alla barra di navigazione vengono selezionate automaticamente.

Filtro Preimpostazione 

pulsante

Descrizione

Sollevato

Lo smusso appare più in alto rispetto agli oggetti sottostanti.

Evidenziato

Il colore del pulsante risulta schiarito.

Concentrico

Lo smusso appare più in basso rispetto agli oggetti sottostanti.

Inverso

Lo smusso sembra affondare negli oggetti sottostanti e il colore del pulsante risulta più chiaro.
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Convertire in pulsanti i rollover di Fireworks

È possibile convertire in pulsanti i rollover creati con le precedenti versioni di Fireworks e salvarli nella libreria. Per 

ulteriori informazioni sui rollover, consultare “Porzioni interattive” a pagina 177.

1 Eliminare la porzione o punto attivo che coprono le immagini del rollover.

2 Selezionare Mostra tutti gli stati dal menu Tecnica Onion skin del pannello Stati.

3 Selezionare tutti gli oggetti da includere nel pulsante. Utilizzare lo strumento Seleziona dietro per selezionare gli 

oggetti nascosti.

4 Selezionare Elabora > Simbolo > Converti in simbolo.

5 Immettere un nome per il simbolo nella casella Nome e selezionare un tipo di simbolo Pulsante.

Per convertire in pulsanti le animazioni a quattro stati, selezionare tutti i quattro oggetti da posizionare su 

ciascuno stato del pulsante.

Inserire e importare i simboli dei pulsanti 

È possibile inserire istanze di simboli del pulsante in un documento dal pannello Libreria comune. È possibile 

importare in un nuovo documento simboli di pulsante esistenti dal pannello Libreria documento. Per ulteriori 

informazioni, consultare “Importare ed esportare simboli” a pagina 167.

1 Per inserire istanze di un pulsante in un documento, aprire il pannello Libreria comune e trascinare il simbolo del 

pulsante nel documento.

2 Per collocare istanze aggiuntive di un simbolo del pulsante, effettuare una delle seguenti operazioni:

• Selezionare un’istanza, quindi selezionare Modifica > Clona per collocare un’altra istanza direttamente di fronte 

all’istanza selezionata. La nuova istanza diventa l’oggetto selezionato.

• Trascinare un’altra istanza del pulsante dal pannello Libreria documento al documento.

• Per creare un’altra istanza del pulsante, trascinare un’istanza sull’area di lavoro tenendo premuto Alt (Windows) 

o Opzione (Mac OS).

• Copiare un’istanza, quindi incollare istanze aggiuntive.

3 Per importare simboli di pulsanti nel pannello Libreria documento di un nuovo documento, effettuare una delle 

seguenti operazioni:

• Trascinare e rilasciare (o tagliare e incollare) l’istanza di un pulsante da un altro documento Fireworks.

• Importare simboli del pulsante da un file PNG di Fireworks.

• Esportare simboli del pulsante da un altro documento di Fireworks in un file di libreria PNG, e quindi importarli 

dal file libreria di PNG al documento.

• Selezionare Importa simboli dal menu Opzioni del pannello Libreria documento. Le librerie contengono 

un’ampia varietà di simboli predefiniti per pulsanti preparati da Adobe.

Modificare i simboli dei pulsanti

È possibile modificare più istanze di proprietà dei pulsanti a livello di simbolo, oppure singole istanze di proprietà dei 

pulsanti.
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Modificare le proprietà del pulsante a livello di simbolo

❖ Per modificare le caratteristiche di un pulsante, fare doppio clic su di esso. Per tornare all’area di lavoro, fare clic 

sull’icona pagina in alto o doppio clic all’esterno del pulsante.

Le proprietà modificabili del pulsante a livello di simbolo sono generalmente coerenti tra i vari pulsanti della barra di 

navigazione. Vedere gli esempi riportati di seguito:

• Aspetto grafico, ad esempio colore e tipo del tratto, colore e tipo del riempimento, forma del tracciato e immagini

• Filtri attivi o opacità applicati ai singoli oggetti del simbolo del pulsante

• Dimensioni e posizione dell’area attiva

• Comportamento del pulsante principale

• Impostazioni di ottimizzazione ed esportazione

• Collegamento URL (disponibile anche come proprietà a livello di istanza)

• Destinazione (disponibile anche come proprietà a livello di istanza)

Modificare le proprietà del pulsante a livello di istanza 

❖ Selezionare l’istanza del pulsante nell’area di lavoro, quindi impostare le proprietà nella finestra di ispezione 

Proprietà.

Generalmente le proprietà modificabili a livello di istanza variano da pulsante a pulsante in una serie di pulsanti. È 

possibile modificare tali proprietà per un’istanza senza incidere sul simbolo associato né sulle altre istanze del simbolo. 

Vedere gli esempi riportati di seguito:

• Il nome dell’oggetto di un’istanza, che compare nel pannello Livelli e viene usato per la definizione del nome 

all’esportazione delle porzioni per l’istanza del pulsante

• Filtri attivi o opacità applicati all’intera istanza

• Caratteri e formattazione del testo

• Collegamento URL (ha la priorità sugli URL esistenti in una proprietà a livello di simbolo)

• Descrizione dell’immagine alternativa (alt)

• Destinazione (ha la priorità sulle destinazioni esistenti in una proprietà a livello di simbolo)

• Comportamenti aggiuntivi assegnati a un’istanza mediante il pannello Comportamenti

• Opzione Mostra stato Giù durante il caricamento nella finestra di ispezione Proprietà per le istanze in una barra di 

navigazione

Nota: quando si seleziona l’opzione Esporta file multipli dalla sezione Specifiche del documento della finestra di 

dialogo Impostazioni HTML e si esporta una barra di navigazione, Fireworks esporta ciascuna pagina HTML con lo 

stato Giù del pulsante corrispondente. Consultare “Impostare le opzioni di esportazione HTML” a pagina 258.

Impostare le proprietà del pulsante interattivo

È possibile controllare i seguenti elementi interattivi di un pulsante:

Area attiva  L’area attiva consente di attivare l’interattività quando l’utente passa il puntatore del mouse su di essa o vi 

fa clic sopra in un browser Web. L’area attiva di un pulsante è una proprietà a livello di simbolo ed è esclusiva dei 

simboli del pulsante. Selezionare Area attiva dal menu a comparsa per modificare una porzione di pulsante o disegnare 

oggetti per punti attivi. Se si disegna una nuova porzione, questa sostituisce la precedente.
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URL per un simbolo del pulsante o un’istanza Gli URL possono essere proprietà del pulsante a livello di simbolo o 

istanza. L’URL collega il pulsante a un’altra pagina Web, sito Web o aggancio sulla stessa pagina Web e viene allegato 

a un’istanza del pulsante selezionato tramite la finestra di ispezione Proprietà o il pannello URL.

Obiettivo del pulsante L’obiettivo del pulsante è la finestra o il fotogramma nel quale compare la pagina Web di 

destinazione quando si fa clic su un’istanza del pulsante. Se non si immette un obiettivo nella finestra di ispezione 

Proprietà, la pagina Web viene visualizzata nello stesso fotogramma o finestra del collegamento che l’ha richiamata. 

L’obiettivo può essere una proprietà del pulsante a livello di simbolo o di proprietà. È possibile impostare l’obiettivo 

per un simbolo, in modo che tutte le sue istanze abbiano la stessa opzione Obiettivo.

Testo alternativo (alt) per un simbolo o istanza del pulsante Il testo alternativo (alt) compare su o accanto a un 

segnaposto dell’immagine mentre è in corso il download o al posto dell’immagine se il download non riesce. Inoltre, 

sostituisce gli elementi grafici qualora l’utente abbia impostato il browser per evitare la visualizzazione delle immagini. 

Il testo alternativo può essere una proprietà del pulsante a livello di simbolo o di istanza.

Modificare le proprietà del pulsante interattivo 

Nota: se si modifica la destinazione, l’URL o l’intero testo per il simbolo di un pulsante, le istanze del pulsante esistenti 

per quel simbolo non vengono modificate. 

1 Aprire il simbolo del pulsante in modalità di modifica del simbolo.

2 Effettuare una delle seguenti operazioni:

• Per modificare una porzione o punto attivo nell’area attiva del simbolo del pulsante, selezionare Area attiva dal 

menu a comparsa della finestra di ispezione Proprietà. Utilizzare lo strumento Puntatore per spostare o 

rimodellare la porzione o la guida porzione. In alternativa, usare qualsiasi strumento porzione o punto attivo 

per disegnare una nuova area attiva.

• Per impostare l’URL per un simbolo di pulsante, selezionare Area attiva dal menu a comparsa. Immettere l’URL 

nella casella Collega della finestra di ispezione Proprietà, selezionare una pagina dall’elenco oppure selezionare 

un URL dal pannello URL. 

Nota: quando si immettono URL assoluti in un sito, è possibile allegare un URL a un simbolo, in modo che lo stesso 

URL appaia nella casella Collegamento della finestra di ispezione Proprietà per ogni istanza. 

• Per impostare la destinazione per un simbolo di pulsante, selezionare il pulsante nell’area di lavoro. Quindi, 

immettere un obiettivo nella casella Obiettivo oppure selezionare uno dei seguenti obiettivi preimpostati dal 

menu Obiettivo nella finestra di ispezione Proprietà:

Nessuno o _self Carica la pagina Web nello stesso frame o finestra del collegamento.

_blank Carica la pagina Web in una nuova finestra del browser senza nome.

_parent Carica la pagina Web nella finestra o nel set di frame principale del frame contenente il collegamento.

_top Carica la pagina Web nella finestra del browser, eliminando tutti i frame.

• Per impostare il testo alternativo per un simbolo di pulsante, selezionare l’istanza del pulsante nell’area di lavoro. 

Quindi, nella finestra di ispezione Proprietà, immettere il testo o la descrizione che si desidera applicare.
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Menu a comparsa

I menu a comparsa vengono visualizzati nel browser quando l’utente fa clic o passa con il puntatore su un oggetto Web 

di innesco, ad esempio una porzione o un punto attivo. 

• Ogni elemento del menu a comparsa viene visualizzato come cella dell’immagine o HTML. La cella dispone di uno 

stato Su, uno stato Sopra e di testo in entrambi gli stati. 

• È possibile allegare collegamenti URL alle voci dei menu a comparsa per la navigazione, quindi creare il numero di 

livelli di sottomenu desiderato nei menu a comparsa.

• È possibile utilizzare alcune o tutte le schede e modificare le impostazioni delle schede in qualsiasi momento. 

• È necessario aggiungere almeno una voce di menu nella scheda Contenuto per creare un’opzione di menu 

visualizzabile in anteprima in un browser.

• Per visualizzare in anteprima un menu a comparsa, premere F12. I menu a comparsa non vengono visualizzati nello 

spazio di lavoro di Fireworks.

Creare un menu a comparsa semplice

1 Selezionare un punto attivo o una porzione che funga da area di attivazione per il menu a comparsa.

2 Effettuare una delle seguenti operazioni:

• Selezionare Elabora > Menu a comparsa > Aggiungi menu a comparsa.

• Fare clic sulla maniglia di comportamento posta al centro della porzione e selezionare Aggiungi menu a 

comparsa.

3 Fare clic sulla scheda Contenuto, quindi sul menu Aggiungi. 

4 Fare doppio clic su ciascuna cella ed immettere o selezionare le informazioni appropriate per Testo, Collegamento 

e Obiettivo. Per i campi Collegamento e Obiettivo, immettere le informazioni personalizzate o effettuare una 

selezione dai menu visualizzati. L’immissione del contenuto nell’ultima riga della finestra aggiunge una riga sotto 

di essa.

Premere il tasto di tabulazione per spostarsi tra le celle e i tasti Freccia su o Freccia giù per scorrere l’elenco in 

verticale.

5 Ripetere i passaggi 3 e 4 sino ad aggiungere tutti gli elementi del menu. Per eliminare una voce di menu, fare clic 

sul pulsante Elimina menu.

6 Fare clic su Avanti o fine o selezionare un’altra scheda. 

Nello spazio di lavoro, il punto attivo o la porzione in cui viene creato il menu a comparsa visualizza una linea di 

comportamento blu collegata a un contorno sul livello più alto del menu a comparsa.

Creare sottomenu all’interno di un menu a comparsa

I sottomenu sono menu a comparsa che vengono visualizzati quando l’utente sposta il puntatore o fa clic su un alto 

elemento voce del menu a comparsa. Non c’è limite al numero di livelli di sottomenu.

1 Aprire la scheda Contenuto dell’Editor menu a comparsa e creare elementi di menu. Collocare gli elementi di menu 

da utilizzare per il sottomenu direttamente sotto l’elemento di menu del quale saranno un sottomenu. 

2 Evidenziare l’elemento del menu a comparsa che si desidera diventi elemento del sottomenu, quindi fare clic sul 

pulsante Menu rientrato. 
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3 Per aggiungere l’elemento successivo al sottomenu, evidenziarlo e fare clic su Menu rientrato. In alternativa, per 

inserire un nuovo elemento subito dopo quello evidenziato, evidenziare un elemento di menu o sottomenu e fare 

clic su Aggiungi menu. 

Tutti gli elementi rientrati in modo contiguo allo stesso livello costituiscono un singolo sottomenu a comparsa.

4 Per creare un sottomenu all’interno di un sottomenu a comparsa, evidenziare un elemento di sottomenu nella 

scheda Contenuto dell’Editor di menu a comparsa, quindi fare clic nuovamente sul pulsante Menu rientrato.

5 Fare clic su Avanti per proseguire con la creazione del menu a comparsa o fare clic su Fine.

Modificare l’aspetto di un menu a comparsa

Una volta creato un menu di base e i sottomenu opzionali, è possibile formattare il testo, applicare stili grafici agli stati 

Sopra e Su e scegliere l’orientamento orizzontale o verticale nella scheda Aspetto dell’Editor di menu a comparsa.

1 Mediante il menu a comparsa aperto nell’Editor di menu a comparsa, fare clic sulla scheda Aspetto.

2 Selezionare Verticale o Orizzontale da Sceglie l’allineamento del menu a comparsa.

3 Selezionare un’opzione per le celle.

HTML Imposta l’aspetto del menu utilizzando solo il codice HTML. Con questa impostazione si ottengono pagine 

con dimensioni di file più contenute.

Immagine Offre una selezione di stili di immagini grafiche da usare come sfondo della cella. Con questa 

impostazione si ottengono dimensioni del file maggiori.

4 Scegliere una dimensione predefinita dal menu a comparsa Dimensioni o immettere un valore nella casella di testo 

Dimensioni.

Nota: quando la larghezza e l’altezza della cella sono impostate su Automatico nella scheda Avanzate dell’Editor di menu 

a comparsa, le dimensioni del testo determinano le dimensioni degli elementi grafici associati con l’elemento di menu.

5 Scegliere un gruppo di tipi di carattere di sistema dal menu a comparsa Carattere o immettere un nome di un 

carattere personalizzato.

Nota: se nel sistema non è installato il carattere scelto, nel browser Web viene visualizzato un carattere di sostituzione.

6 (Facoltativo) Applicare al testo lo stile, la giustificazione e il colore desiderati.

7 Selezionare i colori del testo e della cella per ogni stato.

8 Se si seleziona Immagine come tipo di cella, scegliere uno stile grafico per ogni stato.

9 Proseguire con la creazione del menu a comparsa o fare clic su Fine. 

Aggiungere stili di menu personalizzati all’Editor di menu a comparsa

Selezionare uno stile per celle da utilizzare quando si seleziona Immagine come stile della cella. Per ulteriori 

informazioni sugli stili, consultare “Creare ed eliminare gli stili” a pagina 158.

Nota: la posizione esatta della cartella Menu Bars varia a seconda del sistema operativo. Per ulteriori informazioni, 

consultare “Utilizzare i file di configurazione” a pagina 310.

1 Applicare qualsiasi combinazione di tratto, riempimento, texture e filtri attivi a un oggetto, quindi salvarlo come 

stile utilizzando il pannello Stili. 

2 Selezionare il nuovo stile nel pannello Stili, quindi selezionare Salva libreria stili dal menu Opzioni del pannello 

Stili.

3 Passare alla cartella Menu Bars sul disco rigido, rinominare il file, se lo si desidera, quindi fare clic su Salva.



200UTILIZZO DI FIREWORKS

Creazione di pulsanti e menu a comparsa

Ultimo aggiornamento 4/5/2011

Impostare le proprietà avanzate per le celle 

1 Aprire l’Editor di menu a comparsa e fare clic sulla scheda Avanzate.

2 Selezionare un vincolo di larghezza o altezza dal menu a comparsa Automatica/Pixel.

Automatica Forza l’altezza delle celle a conformarsi alle dimensioni del testo impostate nella scheda Aspetto 

dell’Editor di menu a comparsa e la larghezza della cella a conformarsi all’elemento di menu che contiene il testo 

più lungo

Pixel Consente di immettere misure specifiche in pixel nelle caselle di testo Larghezza cella e Altezza cella.

3 Immettere un valore nella casella di testo Margine celle per determinare la distanza tra il testo del menu a comparsa 

e il margine della cella.

4 Immettere un valore nella casella di testo Spaziatura celle per impostare la quantità di spazio tra le celle del menu.

5 Immettere un valore nella casella di testo Rientro testo per definire la quantità del rientro per il testo del menu a 

comparsa.

6 Immettere un valore nella casella di testo Ritardo menu per impostare la quantità di tempo in millisecondi durante 

la quale il menu resta visibile dopo l’allontanamento del puntatore.

7 Selezionare se mostrare o nascondere i margini dei menu a comparsa. Se si sceglie di mostrare i bordi, impostarne 

gli attributi.

8 Proseguire con la creazione del menu a comparsa o fare clic su Fine.

Modificare la posizione dei menu e sottomenu a comparsa

Utilizzare la scheda Posizione dell’Editor di menu a comparsa per specificare la posizione di un menu a comparsa. È 

inoltre possibile posizionare il livello superiore di un menu a comparsa trascinando il suo contorno nello spazio di 

lavoro quando è visibile il livello Web.
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Impostare una posizione specifica per un menu o sottomenu a comparsa

1 Con il menu a comparsa desiderato visualizzato nell’Editor di menu a comparsa, fare clic sulla scheda Posizione.

2 Effettuare una delle seguenti procedure per definire la posizione del menu:

• Fare clic su un pulsante Posizione menu per definire la collocazione del menu a comparsa in relazione alla 

porzione che lo attiva.

• Immettere le coordinate x e y. Il valore 0,0 allinea l’angolo superiore sinistro del menu a comparsa con l’angolo 

superiore sinistro della porzione o del punto attivo che lo attiva.

3 Definire la posizione di un sottomenu:

• Fare clic su un pulsante Posizione sottomenu per definire la collocazione del sottomenu a comparsa in relazione 

alla porzione che lo attiva.

• Immettere le coordinate x e y. Con il valore 0,0 l’angolo superiore sinistro del menu a comparsa viene allineato 

all’angolo superiore destro del menu o dell’elemento di menu che lo attiva.

4 Impostare una posizione relativa:

• Per rendere la posizione di ogni sottomenu relativa al menu principale, deselezionare Colloca nella stessa 

posizione. 

• Per rendere la posizione di ogni sottomenu relativa al menu a comparsa principale, selezionare Colloca nella 

stessa posizione.

5 Fare clic su Fine per chiudere l’Editor di menu a comparsa o su Indietro per modificare le proprietà delle altre 

schede.

Impostare la posizione di un menu a comparsa trascinandolo

1 Per visualizzare il Livello Web, effettuare una delle seguenti operazioni:

• Fare clic sul pulsante Mostra porzioni e punti attivi nel pannello Strumenti.

• Fare clic sulla colonna dell’icona occhio nel pannello Livelli.

2 Selezionare l’oggetto Web che permette di attivare il menu a comparsa.

3 Nello spazio di lavoro, trascinare il contorno del menu a comparsa in un’altra posizione.

Modificare o spostare gli elementi dei menu a comparsa

Nell’Editor di menu a comparsa, è possibile modificare o aggiornare il contenuto di un menu a comparsa, ridisporre 

gli elementi del menu o modificare altre proprietà in una qualsiasi delle quattro schede.

1 Per visualizzare il Livello Web, effettuare una delle seguenti operazioni:

• Fare clic sul pulsante Mostra porzioni e punti attivi nel pannello Strumenti.

• Fare clic sulla colonna dell’icona occhio nel pannello Livelli.

2 Selezionare la porzione a cui allegare il menu a comparsa.

3 Nello spazio di lavoro, fare doppio clic sul contorno blu del menu a comparsa. 

4 Nell’Editor di menu a comparsa, apportare alle schede le modifiche desiderate. 

Modificare il testo del menu

1 Aprire il menu a comparsa nell’Editor di menu a comparsa e fare clic sulla scheda Contenuto.
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2 Fare doppio clic sulle caselle di testo Testo, Collegamento oppure Obiettivo e modificare il testo del menu. Fare clic 

all’esterno dell’elenco delle voci per applicare la modifica.

Spostare una voce di menu 

1 Evidenziare l’elemento di menu nella scheda Contenuto dell’Editor di menu a comparsa.

2 Effettuare una delle seguenti operazioni:

• Per spostare l’elemento in un sottomenu di livello superiore o nel menu a comparsa principale, fare clic sul 

pulsante Menu sporgente.

• Per spostare l’elemento in una diversa posizione dello stesso menu, trascinarlo nella posizione desiderata 

dell’elenco.

Esportazione dei menu a comparsa

Fireworks genera tutto il codice CSS o JavaScript (a seconda dell’opzione scelta) necessario per visualizzare i menu a 

comparsa nei browser Web. 

Se per i menu a comparsa si utilizza il codice CSS, un documento Fireworks contenente tali menu viene esportato in 

HTML utilizzando il codice CSS. È anche possibile fare sì che il codice CSS venga scritto in un file .css esterno da 

esportare insieme a un file mm_css_menu.js nella stessa posizione del file HTML.

Oltre al codice CSS, è possibile utilizzare JavaScript. In questo caso, un documento di Fireworks con menu a comparsa viene 

esportato in HTML e un file JavaScript denominato mm_menu.js viene esportato nella stessa posizione del file HTML.

Al caricamento dei file, mm_css_menu.js (o mm_menu.js per JavaScript) deve essere caricato nella stessa directory 

della pagina Web contenente il menu a comparsa. Se si intende collocare il file in una posizione diversa, occorre 

aggiornare il collegamento ipertestuale che fa riferimento a mm_css_menu.js e al file .css (o mm_menu.js) nel codice 

HTML di Fireworks per riflettere la nuova posizione. Un file .css univoco viene esportato per ciascun documento 

contenente menu a comparsa CSS esportati come HTML e immagini di Fireworks. 

Quando si includono sottomenu, Fireworks genera un file immagine (arrows.gif), rappresentato da una piccola freccia 

visualizzata accanto agli elementi di menu che presentano un sottomenu. Indipendentemente dal numero di 

sottomenu contenuti in un documento, Fireworks utilizza sempre lo stesso file arrows.gif.

Per ulteriori informazioni sull’esportazione HTML, consultare “Esportazione del codice HTML” a pagina 253.
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Capitolo 14: Creazione di prototipi di siti 
Web e interfacce di applicazioni

Adobe® Fireworks® offre un ambiente ideale per la realizzazione di prototipi e consente di convertire le bozze in siti 

Web e applicazioni funzionanti.

Flusso di lavoro per la creazione di prototipi

Utilizzando il pannello Pagine in combinazione con altre potenti funzioni di Fireworks, è possibile creare in modo 

rapido prototipi software e Web interattivi. Per convertire un prototipo completato in un sito funzionante, è sufficiente 

esportarlo in Adobe Flash®, Adobe Flex®, Adobe AIR™ o Adobe Dreamweaver®.

Per suggerimenti generali sui flussi di lavoro legati ai prototipi, leggere i seguenti articoli del Developer Center 

Fireworks:

• Articolo di Nick Myers sulla progettazione di prodotti interattivi con Fireworks: 

http://www.adobe.com/go/learn_fw_interactiveproducts_it

• Articolo di Dave Cronin sulle tendenze nell'industria sulla creazione di prototipi: 

http://www.adobe.com/go/learn_fw_prototypingtrends_it

• Articolo di Matt Stow sull’utilizzo di modelli CSS precostituiti in Fireworks: Modelli CSS precostituiti in Fireworks CS4.

• Articolo di Jim Babbage, Esempi di Fireworks CS4: importazione, esportazione, simboli, prototipi e 

ridimensionamento.

• Video tutorial di Dave Hogue sull’uso di Fireworks per la progettazione dell’interazione e la creazione rapida di 

prototipi:

• Uso di Fireworks per la progettazione dell’informazione e dell’interazione: 

http://www.adobe.com/go/learn_fw_infointeract_it

• Creazione di prototipi interattivi con Fireworks: http://www.adobe.com/go/learn_fw_creatinginteractivepro_it

• Creazione di prototipi rapidi con Fireworks: http://www.adobe.com/go/learn_fw_rapidpro_it

• Fireworks nel contesto di un processo di progettazione completo: 

http://www.adobe.com/go/learn_fw_completedesignpro_it

• Articolo sulla progettazione di un’applicazione per sito web con Fireworks: 

http://www.adobe.com/go/learn_fw_designwebsiteapp_it

• Articolo di Kumar Vivek sulla progettazione per i dispositivi mobili con Fireworks: 

http://www.adobe.com/go/learn_fw_designmobiledevices_it

Per un’esercitazione video sulla creazione di prototipi per interfacce di applicazioni, visitare 

www.adobe.com/go/lrvid4034_fw_it.

1.  Creare le pagine

Nel pannello Pagine, creare il numero di pagine o di schermate desiderato per la progettazione iniziale. A mano a mano 

che si procede con la progettazione, è possibile aggiungere o sottrarre pagine in base alle necessità.

http://www.adobe.com/go/learn_fw_interactiveproducts_it
http://www.adobe.com/go/learn_fw_prototypingtrends_it
http://www.adobe.com/go/learn_fw_prebuiltcsstemplates_it
http://www.adobe.com/go/learn_fw_howtosympro_it
http://www.adobe.com/go/learn_fw_howtosympro_it
http://www.adobe.com/go/learn_fw_infointeract_it
http://www.adobe.com/go/learn_fw_creatinginteractivepro_it
http://www.adobe.com/go/learn_fw_rapidpro_it
http://www.adobe.com/go/learn_fw_completedesignpro_it
http://www.adobe.com/go/learn_fw_designwebsiteapp_it
http://www.adobe.com/go/learn_fw_designmobiledevices_it
http://www.adobe.com/go/lrvid4034_fw_it
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2.  Disporre elementi di progettazione comuni

Nell’area di lavoro, disporre gli elementi di progettazione che si desidera condividere tra più pagine, ad esempio barre 

di navigazione e immagini di sfondo. Per allineare gli elementi, utilizzare le Guide sensibili. Per ottenere la massima 

flessibilità, strutturare il layout mediante CSS. (Consultare “Guide sensibili” a pagina 33 e “Creazione di layout basati 

su CSS” a pagina 209.). 

3.  Condividere elementi comuni tra più pagine

Quando si condividono elementi comuni, una singola modifica aggiorna automaticamente tutte le pagine interessate. 

Utilizzare una pagina master per condividere tutti gli elementi in essa contenuti o condividere i livelli per copiare 

sottoinsiemi di elementi. Consultare “Utilizzare una pagina master” a pagina 206 e “Condividere livelli” a pagina 139.

4.  Aggiungere elementi univoci alle singole pagine

Su ciascuna pagina, aggiungere elementi univoci di grafica, navigazione e progettazione. Il pannello Libreria comune 

offre numerosi pulsanti, caselle di testo e menu a comparsa che ottimizzano il processo di progettazione. I simboli dei 

componenti contenuti nelle cartelle HTML, Mac, Win, Web e applicazione e Componenti Flex includono proprietà 

che è possibile personalizzare per singole istanze dei simboli. (Consultare “Creare e utilizzare i simboli dei 

componenti” a pagina 164.)

5.  Simulare la navigazione dell’utente mediante collegamenti

Partendo da oggetti Web quali porzioni, punti attivi o pulsanti di navigazione, creare collegamenti tra le diverse pagine 

del prototipo. Consultare “Collegamento alle pagine di un documento di Fireworks” a pagina 170.

6.  Esportare il prototipo interattivo completato

Fireworks offre diversi formati di output per i prototipi in cui vengono mantenuti i collegamenti ipertestuali per la 

navigazione delle pagine. Leggere i seguenti articoli: 

• Per condividere un prototipo flessibile basato su CSS con i propri clienti o per apportarvi ulteriori modifiche in 

Adobe Dreamweaver, consultare “Esportare un layout CSS” a pagina 210.

• Per creare un prototipo più convenzionale basato su tabelle, consultare “Esportare HTML di Fireworks” a 

pagina 254.

• Per distribuire una versione PDF per i commenti o la stampa, consultare “Esportare file Adobe PDF” a pagina 259.

• Per creare un prototipo per applicazioni Flex, consultare “Creazione di prototipi per applicazioni Flex” a 

pagina 211. Per creare un’applicazione Adobe AIR, consultare “Creare un’applicazione Adobe AIR” a pagina 214.

Operazioni con pagine di Fireworks

Un singolo file PNG di Fireworks può contenere più pagine, offrendo il modo ottimale per la creazione di prototipi 

Web e interfacce applicative. Ogni pagina contiene impostazioni proprie per l’area di lavoro, le dimensioni, il colore, 

la risoluzione dell’immagine e le guide. Le opzioni possono essere impostate sia pagina per pagina, sia globalmente per 

tutte le pagine del documento. Oltre al Livello Web, ciascuna pagina contiene un gruppo esclusivo di livelli. Per gli 

elementi comuni, tuttavia, è possibile utilizzare una pagina master o condividere livelli su più pagine. Consultare 

“Condividere livelli” a pagina 139.

Se non si creano nuove pagine, tutti gli elementi del documento si troveranno in una pagina singola.
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Le pagine sono visualizzate nel pannello Pagine, che mostra gli oggetti di ciascuna pagina sotto forma di miniatura 

accanto al nome della pagina. La pagina attiva è evidenziata nel pannello e mostrata nel menu a comparsa delle pagine 

sopra il documento attivo. 

Per informazioni sull’esportazione, consultare “Esportare dallo spazio di lavoro” a pagina 249.

Aggiungere, eliminare e accedere alle pagine

Utilizzando il pannello Pagine, è possibile aggiungere nuove pagine, eliminare quelle superflue e duplicare le pagine 

esistenti. Quando vengono aggiunte, eliminate o rimosse delle pagine, Fireworks aggiorna automaticamente il numero 

a sinistra dei titoli della pagina. Questo aggiornamento automatico del numero consente di accedere rapidamente alle 

pagine specifiche nelle progettazioni composte da più pagine.

Aggiungere una pagina

Una pagina vuota viene inserita alla fine dell’elenco di pagine e diventa la pagina attiva. 

❖ Effettuare una delle seguenti operazioni:

• Nel pannello Pagine, fare clic sul pulsante Pagina nuova/duplicata .

• Fare clic con il pulsante destro del mouse sul pannello e scegliere Pagina nuova dal menu a comparsa.

• Selezionare Modifica > Inserisci > Pagina.

Accedere a una pagina

❖ Effettuare una delle seguenti operazioni:

• Nel pannello Pagine, selezionare una pagina.

• Utilizzare i tasti Pagina su e Pagina giù.

• Scegliere la pagina dal menu a comparsa delle pagine, nella parte superiore della finestra del documento o nella 

parte inferiore sinistra del pannello Pagine.

Nel menu a comparsa delle pagine, le pagine master sono contrassegnate da un asterisco.

Duplicare una pagina

La duplicazione consente di aggiungere una nuova pagina contenente gli stessi oggetti e la stessa gerarchia di livelli di 

quella attualmente selezionata. Gli oggetti duplicati mantengono la modalità di opacità e fusione degli oggetti originali. 

È possibile modificare gli oggetti duplicati senza incidere sugli originali.

❖ Effettuare una delle seguenti operazioni:

• Trascinare un pagina sul pulsante Pagina nuova/duplicata.

• Fare clic con il pulsante destro del mouse sulla pagina e scegliere Duplica pagina dal menu a comparsa. 

Spostare una o più pagine

Nel pannello Pagine, spostare le pagine per avvicinare le progettazioni correlate e accelerare il processo di disposizione.

1 (Facoltativo) Se si spostano più pagine, effettuare una delle seguenti operazioni:

• Fare clic tenendo premuto Maiusc sulle pagine per selezionare un gruppo contiguo.

• Fare clic tenendo premuto il tasto Ctrl (Windows) o Comando (Mac OS) per selezionare un gruppo non 

contiguo.
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2 Trascinare le pagine selezionate verso la parte superiore o inferiore del pannello. Sopra o sotto le altre pagine, 

vengono visualizzati dei bordi più scuri nei punti in cui è possibile rilasciare il mouse per spostare le pagine 

selezionate.

Eliminare una pagina

La pagina soprastante quella eliminata diventa la pagina attiva.

❖ Effettuare una delle seguenti operazioni:

• Nel pannello Pagina, trascinare la pagina sull’icona del cestino .

• Fare clic con il pulsante destro del mouse sulla pagina e scegliere Elimina pagina dal menu a comparsa.

Modificare l’area di lavoro di una pagina

Ciascuna pagina presenta una propria area di lavoro, con dimensioni, colore e risoluzione immagine indipendenti.

1 Selezionare una pagina dal pannello Pagine o dal menu a comparsa pagine nella parte superiore della finestra del 

documento.

2 Selezionare Elabora > Area di lavoro > Dimensioni immagine, Elabora > Area di lavoro > Colore Area di lavoro o 

Elabora > Area di lavoro > Dimensioni area di lavoro.

3 Effettuare le modifiche. Le modifiche possono essere eseguite anche utilizzando il pannello Proprietà quando si 

seleziona l’area di lavoro di una pagina.

4 Per applicare le modifiche solo alla pagina selezionata, lasciare selezionata l’opzione Solo pagina corrente. Per 

applicare le modifiche a tutte le pagine, deselezionarla.

Utilizzare una pagina master

Per utilizzare una serie di elementi per tutte le pagine, utilizzare una pagina master. Quando si converte una pagina 

normale in pagina master, questa si sposta nella parte superiore dell’elenco del pannello Pagine. Quando si crea una 

pagina master, in fondo alla gerarchia dei livelli di ogni pagina si aggiunge un Livello Pagina master.

Creare una pagina master

❖ Nel pannello Pagine, fare clic con il pulsante destro del mouse su una pagina esistente e scegliere Imposta come 

Pagina master dal menu a comparsa.

Eventuali livelli condivisi con altre pagine diventano livelli normali (non condivisi). Vengono invece mantenuti i livelli 

condivisi tra fotogrammi. Per visualizzare i fotogrammi di una pagina master in una pagina collegata, consultare 

“Visualizzare gli oggetti in uno stato” a pagina 223.

Altri argomenti presenti nell’Aiuto 

“Condividere livelli” a pagina 139

Collegare le pagine alla pagina master

Dopo aver creato una pagina master, le pagine che vengono successivamente create ne ereditano automaticamente le 

impostazioni. Le pagine esistenti non ereditano tali impostazioni a meno che non vengano collegate alla pagina master. 

Se successivamente si modifica la pagina master, tutte le pagine collegate vengono aggiornate automaticamente.
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L’applicazione di oggetti e comportamenti dalle pagine master alle altre pagine presenta i seguenti limiti:

• Le pagine ereditano solo lo stato corrente di tutti gli oggetti di una pagina master. Per ereditare tutti gli stati di tutti 

gli oggetti, in ogni pagina, aggiungere almeno lo stesso numero di stati all’oggetto con il numero di stati più elevato. 

Tutti gli oggetti in tale pagina ereditano tutti gli stati della pagina master.

• Le modifiche apportate alla dimensione dell’area di lavoro o dell’immagine incidono su tutte le pagine, comprese 

le pagine che non sono collegate alla pagina master. Per limitare le modifiche solo alla pagina corrente, selezionare 

Solo pagina corrente.

• Solo le pagine collegate ereditano le modifiche apportate al colore dell’area di lavoro della pagina master.

❖ Effettuare una delle seguenti operazioni:

• Nel pannello Pagine, fare clic con il pulsante destro del mouse su una pagina e scegliere Collega a Pagina master 

dal menu a comparsa.

• Fare clic sulla colonna a sinistra della miniatura della pagina nel pannello Pagine. Viene visualizzata un’icona di 

collegamento che indica che la pagina è collegata alla pagina master.

Nota: se si modifica un’impostazione su una pagina collegata alla pagina master, prevale la nuova impostazione 

ma il collegamento con la pagina master viene interrotto.

Mostrare o nascondere il livello della pagina master

Una modifica di visibilità si riflette su tutte le pagine.

❖ Nel pannello Livelli, fare clic sull’icona dell’occhio a sinistra del livello della pagina master.

Rimuovere i livelli della pagina master

❖ Fare clic con il pulsante destro del mouse sul pannello Livelli e selezionare Rimuovi livello Pagina master dal menu 

a comparsa. 

Per aggiungere nuovamente un livello della pagina master, fare clic con il pulsante destro del mouse sul pannello Livelli 

e selezionare Aggiungi livello Pagina master dal menu a comparsa.

Riconvertire una pagina master in pagina normale

❖ Fare clic con il pulsante destro del mouse sul pannello Pagine e scegliere Ripristina Pagina master dal menu a 

comparsa.

Esportare delle pagine selezionate

È possibile esportare diverse pagine in un unico passaggio. Vengono esportate solo le pagine selezionate. Quando si 

esportano delle pagine, le impostazioni di ottimizzazione specificate per le singole pagine vengono utilizzate per 

l’esportazione dei file. 

1 Nel pannello Pagine, selezionare le pagine che si desidera esportare.

2 Fare clic con il tasto destro del mouse e selezionare Esporta pagina/e selezionata/e.

3 Nella finestra di dialogo Esporta, selezionate una delle opzioni dal menu Esporta:

Livelli su file Esporta i livelli delle pagine selezionate come singoli file.

Stati su file Esporta gli stati delle pagine selezionate come singoli file.

Pagine in file Esporta le pagine selezionate come singoli file.
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Personalizzare i nomi file durante l'esportazione delle pagine

1 Nel pannello Pagine, selezionare le pagine che si desidera esportare.

2 Fare clic con il tasto destro del mouse e selezionare Esporta pagina/e selezionata/e.

3 Nella finestra di dialogo Esporta, fate clic su Opzioni. Il pulsante Opzioni è abilitato in base all'opzione selezionata 

nel menu Esporta.

4 Nella finestra di dialogo Opzioni di esportazione, selezionare Aggiungi Prefisso o Aggiungi suffisso e selezionare 

un’opzione dal menu. È possibile nominare i file utilizzando una delle seguenti opzioni:

doc.name Il nome del file di origine viene aggiunto come prefisso o suffisso. Ad esempio, se si esporta una pagina 

nominata Index dal file di origine sites.png utilizzando l’opzione Aggiungi Prefisso, viene generato un file 

nominato Sites_Index.gif.

Numerico (1, 2, 3... oppure 01, 02, 03...) I file vengono generati in sequenza numerica e al nome del file vengono 

aggiunti dei numeri come prefissi o come suffissi. Tutti i file di pagina esportati vengono numerati secondo l’ordine 

di apparizione nel pannello pagine. Quando si esportano molte pagine, utilizzare la sequenza a doppia cifra.

5 Utilizzare le opzioni nel menu Tipo di file per ottimizzare le impostazioni del file esportato.

Esportare porzioni di pagine selezionate

Durante l’esportazione di un file, le porzioni vengono ignorate. Per esportare delle porzioni, utilizzare le seguenti 

impostazioni nella finestra di dialogo Esporta.

1 Nel menu Esporta, selezionare HTML e immagini oppure Solo immagini.

2 Nel menu HTML, selezionare Esporta file HTML.

3 Nel menu Porzioni, selezionare Esporta porzioni.

4 Selezionare una delle seguenti opzioni:

Solo porzioni selezionate Le aree contrassegnate come porzione vengono esportate.

Includi aree senza porzioni Vengono esportate anche le aree non contrassegnate come porzioni.

Anteprima multipagina

Visualizza l’anteprima di tutte le pagine, tranne la pagina master, nella fase di importazione o apertura dei file. La 

pagina selezionata durante l’anteprima viene visualizzata all’apertura del file.

Quando si inserisce una pagina contenente oggetti dal livello master, la pagina master viene convertita in un normale 

livello e importata.

Abilita anteprima multipagina

Visualizza l’anteprima di tutte le pagine di un file durante la sua importazione o la sua apertura. Nella finestra di 

dialogo Preferenze, l’opzione di anteprima multipagina è abilitata per impostazione predefinita.

Per abilitare l’anteprima multipagina per i file creati con versioni precedenti, è necessario aprire i file nella versione 

attuale e salvarli.

1 Nella finestra di dialogo Preferenze, selezionare Generale.

2 Per abilitare l’anteprima multipagina, selezionare Salva una miniatura per ciascuna pagina. Se questa opzione è 

disabilitata, i nomi delle pagine vengono memorizzati, ma le miniature dei file non vengono generate.
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Pagine di anteprima prima dell’apertura o dell’importazione

• In Windows, l’anteprima viene visualizzata nelle finestre di dialogo Importa o Apri durante l’importazione o 

l’apertura di un file. 

• In Mac, fare clic su Anteprima nelle finestra di dialogo Importa o Apri. In alternativa, fare doppio clic sul file nella 

finestra di dialogo Importa ed entrare nella modalità Anteprima.

Durante l'importazione di file, selezionate Inserisci dopo pagina corrente per aggiungere le pagine importate dopo 

la pagina attualmente selezionata nel documento. 

Creazione di layout basati su CSS

È possibile progettare layout basati su CSS in un file documento Fireworks, quindi convertirli in pagine HTML con 

regole CSS che replicano i layout. I layout basati su CSS forniscono un approccio basato su standard e un codice 

supportato da più browser.

Per un’esercitazione video sulla creazione di layout di pagine basati su CSS, visitare 

www.adobe.com/go/lrvid4035_fw_it. Consultare anche le seguenti risorse:

• Tutorial sull'esportazione di CSS e immagini in Fireworks all'indirizzo 

http://www.adobe.com/go/learn_fw_exportcssimages_it.

• Tutorial sulla creazione di progetti Web conformi con gli standard con Fireworks all'indirizzo 

http://www.adobe.com/go/learn_fw_standardscompliantdesign_it.

Informazioni sul layout di pagina CSS

Con Fireworks è possibile progettare pagine ed esportare immediatamente il codice CSS e HTML mediante un motore 

di esportazione che analizza il posizionamento degli oggetti. Inoltre, è possibile impostare l’allineamento della pagina 

e specificare un’immagine di sfondo ricorrente.

È possibile usare gli elementi HTML disponibili nella cartella HTML, nella Libreria comune. La cartella HTML 

contiene elementi HTML quali pulsanti, elenchi a discesa e campi di testo. È possibile modificare le proprietà di tali 

elementi mediante il pannello Proprietà simbolo. Quando si trascina un elemento di progettazione nella pagina, il 

motore di esportazione inserisce tag <form> durante l’esportazione del layout basato su CSS.

Nel file HTML esportato, il testo su cui è stata inserita una porzione appare sotto forma di immagine. Se si desidera 

che il testo appaia come testo, usare i componenti HTML contenuti nella Libreria comune. I componenti HTML 

includono elementi di collegamento e titoli da 1 a 6. 

Regole per i layout basati su CSS

Durante la creazione di layout basati su CSS, è opportuno seguire alcune regole per ottenere i risultati desiderati.

Regola 1: usare i rettangoli per esportare il testo e le porzioni per esportare le immagini Il motore di esportazione 

esporta il testo inserito nei rettangoli. Dal momento che vengono esportate solo le immagini coperte da porzioni 

rettangolari, per esportare un’immagine posizionare sopra di essa delle porzioni. Tali porzioni “informano” il motore 

di esportazione sul punto in cui si trovano le immagini.

Regola 2: evitare di sovrapporre gli oggetti Il motore di esportazione tratta testo, immagini e rettangoli come blocchi 

rettangolari. Esamina le dimensioni e la posizione di tali oggetti per stabilire in quali righe e colonne del layout inserirli. 

Posizionare gli oggetti con attenzione per evitare che i bordi si sovrappongano. 

http://www.adobe.com/go/lrvid4035_fw_it
http://www.adobe.com/go/learn_fw_exportcssimages_it
http://www.adobe.com/go/learn_fw_standardscompliantdesign_it
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Regola 3: progettare il layout di righe e colonne Il motore di esportazione cerca partizioni logiche in cui inserire una 

linea visiva distinta tra oggetti o gruppi di oggetti. Racchiudere i layout a colonne in un rettangolo per evitare che il 

motore di esportazione inserisca una riga logica che causa l’interruzione del layout a colonne.

Regola 4: considerare il documento come se avesse due dimensioni Quando si progetta una pagina, usare i rettangoli 

per racchiudere gli oggetti che si desidera trattare come oggetti secondari del rettangolo. Il motore di esportazione 

rileva le relazioni principale-secondario. Il motore di esportazione effettua la ricerca di righe e colonne negli elementi 

secondari, come descritto nella Regola 3.

Oltre alle regole sopra descritte, osservare quanto segue: 

• Il motore di esportazione esporta solo i rettangoli originari. Per esportare gli angoli arrotondati dei rettangoli, 

posizionare sopra di essi porzioni rettangolari.

• Per esportare i tratti dei rettangoli, posizionare sopra tali rettangoli delle porzioni rettangolari.

• Per esportare i simboli, posizionare sopra di essi una porzione rettangolare. 

• Per esportare i filtri applicati al testo o ai rettangoli, posizionare sopra di essi delle porzioni rettangolari.

Esportare un layout CSS

Fireworks consente di esportare i layout creati come file basati su CSS. Tali file possono quindi essere aperti in 

Dreamweaver e altri editor compatibili con CSS. 

1 Scegliere File > Esporta.

2 Nel menu a comparsa Esporta, selezionare CSS e immagini.

3 Fare clic su Opzioni per impostare le proprietà di pagina HTML.

4 Fare clic su Sfoglia per specificare un’immagine di sfondo e impostarne le opzioni di ripetizione:

• Selezionare Non ripetere per visualizzare l’immagine una sola volta.

• Selezionare Ripeti per ripetere (affiancare) l’immagine in orizzontale e in verticale.

• Selezionare Ripeti-x per affiancare l’immagine in orizzontale.

• Selezionare Ripeti-y per affiancare l’immagine in verticale.

5 Selezionare l’allineamento della pagina nel browser (a sinistra, al centro, a destra).

6 Selezionare lo scorrimento dell’allegato desiderato, fisso o con scorrimento.

7 Fare clic su OK, quindi su Salva.

Creare un documento demo 

È possibile creare una dimostrazione del documento Fireworks su cui si sta lavorando. Il documento demo si apre in 

un browser e può essere utilizzato per dimostrare le caratteristiche del documento e navigare tra le varie pagine.

1 Selezionare Comandi > Demo documento corrente.

2 Selezionare le pagine che interessano e fare clic su Crea demo.

3 Selezionare la cartella e fare clic su Apri.
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Creazione di prototipi per applicazioni Flex

Il processo di creazione di prototipi per Flex è simile al flusso di lavoro usato per la creazione di prototipi per siti Web 

e interfacce software. Consultare “Flusso di lavoro per la creazione di prototipi” a pagina 203. In Fireworks, è possibile 

trascinare componenti Flex nell’area di lavoro, specificarne le proprietà ed esportare l’interfaccia utente risultante in 

MXML. L’interfaccia può quindi essere rifinita in Flex Builder.

1.  Creare un’interfaccia utente Flex

Nel pannello Pagine, creare il numero di schermate di interfaccia desiderato per la progettazione iniziale.

2.  Inserire nel layout i componenti di progettazione Flex

Nell’area di lavoro, inserire i componenti Flex dalla cartella Flex del pannello Libreria comune. Questi simboli di 

componenti sono progettati appositamente per l’esportazione MXML, per garantire i risultati desiderati. Quando si 

esporta il documento in formato MXML, ognuno di questi simboli viene convertito nei rispettivi tag MXML. Gli 

oggetti che non sono riconosciuti come componenti Flex vengono invece esportati come bitmap, collegati al 

documento MXML mediante il tag <mx:Image>. (Consultare “Creare e utilizzare i simboli dei componenti” a 

pagina 164.)

Quando si modifica in Fireworks un componente di progettazione Flex, è possibile copiare il codice XML modificato 

nel progetto Flex. In questo modo l’eventuale replica nel progetto del comportamento del componente modificato 

risulterà più agevole.

I simboli Cursore, BarraScorrimento, Scheda e DescrizioneComando vengono ignorati durante l’output in formato 

MXML, poiché tali componenti non possono essere tradotti direttamente da Fireworks a MXML. Ad esempio, il 

simbolo BarraScorrimento compare automaticamente nelle istanze di contenitori Flex qualora sia possibile scorrerne 

il contenuto. In Fireworks, tali simboli agiscono solo come indicatori del funzionamento di parti dell’interfaccia 

utente.

Nota: anche le porzioni di immagini, i rollover e i punti attivi vengono usati solo per prototipi basati su HTML. Per la 

creazione di prototipi Flex, evitare quindi di usare questi oggetti Web.

3.  Condividere componenti Flex comuni tra più pagine

Quando si condivide un singolo componente Flex su più pagine, una singola modifica aggiorna automaticamente tutte 

le pagine (o schermate) interessate. È possibile utilizzare una pagina master per condividere tutti i componenti Flex in 

essa contenuti; per copiare invece sottoinsiemi di componenti, condividere i livelli. Consultare “Utilizzare una pagina 

master” a pagina 206 e “Condividere livelli” a pagina 139.

4.  Specificare le proprietà dei componenti Flex

Nel pannello Proprietà simbolo (Finestra > Proprietà simbolo), specificare le proprietà e gli eventi per ognuno dei 

componenti Flex inseriti nell’area di lavoro. 

5.  Esportare il layout Flex in MXML

Esportare il layout dell’interfaccia utente Flex e aprire in Flex il file MXML risultante. Fireworks esporta il codice 

MXML necessario mantenendo lo stile e il posizionamento assoluto. Gli sviluppatori Flex possono quindi usare tale 

interfaccia senza dover creare nuovamente il layout in Flex.
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Modificare le proprietà dei componenti Flex

Nel pannello Proprietà simbolo è possibile modificare le proprietà e gli eventi dei componenti Flex. 

1 Selezionare il componente Flex nell’area di lavoro.

2 Aprire il pannello Proprietà simbolo (Finestra > Proprietà simbolo).

3 Nel pannello Proprietà simbolo, impostare le proprietà e gli eventi del componente.

Esportare un documento Fireworks in MXML

Fireworks consente di impostare il layout di applicazioni RIA (Rich Internet Applications) grazie all’esportazione di 

risorse della libreria comune come componenti conosciuti da utilizzare in Adobe Flex Builder. Fireworks esporta il 

codice Flex necessario (MXML) mantenendo lo stile e il posizionamento assoluto. 

Una volta finalizzato il prototipo di un’applicazione Flex, questo può essere esportato in formato MXML ed elaborato 

ulteriormente in Flex Builder. Nella vista Progettazione, il prototipo ha lo stesso aspetto della sua controparte 

Fireworks, a eccezione di componenti quali cursori e barre di scorrimento, che non vengono esportati. 

1 Scegliere File > Esporta.

2 Nel menu a comparsa Esporta, selezionare MXML e immagini.

3 Se si desidera salvare le immagini in una cartella separata dal codice MXML, selezionare Inserisci immagini nella 

sottocartella.

4 Per esportare solo la pagina corrente, selezionare Solo pagina corrente.

5 Fare clic su Salva per completare l’esportazione.

Le immagini associate al prototipo vengono esportate nella cartella delle immagini. Con i file delle immagini 

vengono inoltre create le immagini delle pagine MXML complete. Le pagine MXML non richiedono tali immagini 

di anteprima ed è quindi possibile rimuoverle.

Creare ed esportare interfacce Flex

In Fireworks è possibile creare le interfacce di componenti Flex, da esportare per la realizzazione di interfacce di 

applicazioni e siti Web basati su Flex. 

Componenti per interfacce Flex

In Fireworks è possibile creare e modificare interfacce per molti diversi componenti Flex basate sui modelli Flex. 

1 Selezionare Comandi > Interfaccia Flex > Nuova interfaccia Flex. 

2 Effettuare una delle seguenti operazioni:

• Per creare interfacce Flex per tutti i componenti disponibili, selezionare Più componenti. 

Viene creato un singolo documento con tutti i componenti Flex disponibili.

• Per specificare i componenti per i quali si desidera realizzare un’interfaccia, selezionare Componenti specifici.

Selezionare solo i componenti con un particolare stile o tutte le istanze di un componente.

3 Fare clic su OK.

Esportare le interfacce Flex

1 Selezionare Comandi > Interfaccia Flex > Esporta interfaccia Flex.

2 Selezionare la cartella in cui esportare il documento Fireworks e fare clic su Apri.
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Limitazioni nell’esportazione di MXML

Prima di usare le funzioni di esportazione Flex MXML, è importante conoscerne le possibilità e i limiti:

L’esportazione MXML non crea interfacce dai componenti L’esportazione in MXML non crea interfacce per i 

componenti in Flex, anche se sono stati modificati in Fireworks. L’esportazione in MXML genera semplicemente 

documenti MXML da utilizzare in Flex. Tali documenti possono includere immagini collegate per oggetti Fireworks 

che non possono essere convertite in tag MXML. Queste immagini vengono aggiunte al documento MXML mediante 

tag <mx:Image>.

L’esportazione MXML ignora le porzioni Poiché l’esportazione in MXML genera un documento basato su tag da 

utilizzare in Flex, le porzioni non vengono considerate nella creazione di immagini o celle di tabelle. Per la creazione 

di immagini durante l’esportazione MXML, vengono utilizzate le impostazioni di ottimizzazione del documento per 

determinare il formato dell’immagine e il metodo di compressione.

Le proprietà MXML sono limitate alle proprietà di simboli complessi Nell’esportazione in MXML, le proprietà di un 

tag MXML vengono basate sul componente Flex in Fireworks. In Fireworks è disponibile un sottoinsieme di 

componenti Flex, con un numero di proprietà limitato.

Gli stili vengono incorporati Le proprietà riconosciute come stili sono separate dai tag MXML creati, ma mantenute 

all’interno dello stesso documento MXML, in un tag <mx:Style>. Fireworks non è in grado di definire gli stili in un file 

CSS esterno.

I riquadri (o frame) non sono supportati Nella creazione di progetti grafici e layout per output MXML, non utilizzare 

riquadri (o frame). Per ottenere diversi design in un unico documento, utilizzare le pagine.

Altri argomenti presenti nell’Aiuto 

“Creare e utilizzare i simboli dei componenti” a pagina 164

Creazione di prototipi per applicazioni Adobe AIR

Adobe® AIR™ per Fireworks permette di trasformare un prototipo Fireworks in un’applicazione desktop.  Ad esempio, 

se alcune pagine prototipo interagiscono tra di esse per presentare diversi dati, con Adobe AIR è possibile assemblare 

questo set di pagine in una piccola applicazione che può essere installata nel computer di un utente. Quando l’utente 

esegue l’applicazione dal proprio desktop, il prototipo viene caricato e visualizzato in una propria finestra 

applicazione, indipendente dal browser. Gli utenti possono quindi visualizzare il prototipo a livello locale sul proprio 

computer senza connessione Internet.

Vedete l’articolo di Ethan Eismann su Adobe AIR e sull’esperienza del marchio alla pagina: 

http://www.adobe.com/go/learn_fw_airexperiencebrand_it.

Aggiungere eventi del mouse Adobe AIR

È possibile aggiungere agli oggetti del documento eventi del mouse Adobe AIR predefiniti. Fireworks fornisce quattro 

eventi del mouse predefiniti: chiudere la finestra, trascinare la finestra, ingrandire la finestra e ridurre la finestra.

1 Selezionare gli oggetti nell’area di lavoro a cui si desidera applicare il comportamento evento del mouse.

2 Selezionare Comandi > Eventi mouse AIR e scegliere l’evento desiderato.

http://www.adobe.com/go/learn_fw_airexperiencebrand_it
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Visualizzare in anteprima un’applicazione Adobe AIR

È possibile visualizzare in anteprima un’applicazione Adobe AIR senza impostare alcun parametro relativo a tale 

applicazione.

❖ Selezionare Comandi > Crea pacchetto AIR e fare clic su Anteprima.

Creare un’applicazione Adobe AIR

❖ Selezionare Comandi > Crea pacchetto AIR e impostare le seguenti opzioni: 

Nome applicazione Consente di specificare il nome da visualizzare nelle schermate di installazione, al momento 

dell’installazione dell’applicazione. Per impostazione predefinita, l’estensione specifica il nome del sito Fireworks.

ID applicazione Consente di inserire un ID univoco per l’applicazione. Non utilizzare spazi né caratteri speciali. 

Utilizzare solo i caratteri 0-9, a-z, A-Z, . (punto), - (trattino). Questa impostazione è obbligatoria.

Versione Consente di specificare il numero di versione dell’applicazione. Questa impostazione è obbligatoria.

Cartella menu dei programmi Consente di specificare una cartella nel menu Start di Windows in cui inserire il 

collegamento dell’applicazione (non applicabile a Mac OS).

Descrizione Consente di aggiungere una descrizione dell’applicazione, da visualizzare al momento 

dell’installazione.

Copyright Consente di specificare le informazioni di copyright da visualizzare nella finestra Informazioni su per le 

applicazioni Adobe AIR installate in Mac OS.  Queste informazioni non vengono utilizzate dalle applicazioni 

installate in Windows.

Contenuto pacchetto Selezionare Documento corrente per selezionare automaticamente la cartella contenente i file.

Contenuto principale Fare clic su Sfoglia per selezionare la pagina che deve comparire come contenuto principale. 

Se in precedenza è stato selezionato Documento corrente, il contenuto principale viene impostato 

automaticamente. 

File inclusi Consente di specificare quali file o cartelle includere nell’applicazione. È possibile aggiungere file 

HTML e CSS, file di immagini e file di libreria JavaScript. Fare clic sul pulsante più (+) per aggiungere file e 

sull’icona della cartella per aggiungere cartelle.  Per eliminare un file o una cartella dall’elenco, selezionare il file o 

la cartella e fare clic sul pulsante meno (-). I file o le cartelle selezionati da includere nel pacchetto Adobe AIR 

devono essere contenuti nella cartella del contenuto principale.

Stile del sistema e Trasparente Consente di specificare lo stile di finestra da utilizzare quando gli utenti eseguono 

l’applicazione sul proprio computer. Lo stile del sistema applica i comandi della finestra standard del sistema 

operativo all’applicazione. Lo stile trasparente elimina lo stile standard del sistema e permette di creare un proprio 

stile per l’applicazione.  Con questa funzione è possibile creare finestre dell’applicazione non rettangolari.

Larghezza e Altezza Consentono di specificare le dimensioni in pixel della finestra dell’applicazione all’apertura.

Seleziona immagini icone Fare clic per selezionare immagini personalizzate per le icone dell’applicazione.  

Selezionare la cartella per le dimensioni di ciascuna icona e selezionare il file immagine da utilizzare. Per le 

immagini dell’icona dell’applicazione è possibile usare solo file PNG.

Nota: le immagini personalizzate selezionate devono risiedere nel sito dell’applicazione e i percorsi devono essere 

relativi alla cartella principale del sito.

Firma digitale Fare clic su Imposta per firmare l’applicazione con una firma digitale. Questa impostazione è 

obbligatoria. Per ulteriori informazioni, consultare la sezione successiva.

Crea pacchetto file Consente di specificare la cartella in cui salvare il programma di installazione dell’applicazione 

(file .air). La posizione predefinita è la posizione principale del sito. Per selezionare un’altra posizione, fare clic sul 
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pulsante Sfoglia. Il nome file predefinito si basa sul nome del sito, con estensione .air. Questa impostazione è 

obbligatoria.

Firmare un’applicazione Adobe AIR con un certificato digitale

Una firma digitale offre garanzia che il codice dell’applicazione non sia stato alterato né danneggiato da quando è stato 

creato dall’autore del software. Tutte le applicazioni Adobe AIR richiedono una firma digitale e non possono essere 

installate se questa manca. 

1 Nella finestra di dialogo Crea pacchetto AIR, fare clic sul pulsante Imposta accanto all’opzione Firma digitale. 

2 Nella finestra di dialogo Firma digitale, eseguire una delle operazioni seguenti: 

• Per firmare un’applicazione con un certificato digitale acquistato, fare clic sul pulsante Sfoglia, selezionare il 

certificato, immettere la password e fare clic su OK.

• Per creare un proprio certificato digitale, fare clic sul pulsante Crea e compilare la finestra di dialogo. L’opzione 

Tipo di chiave del certificato fa riferimento al livello di protezione del certificato: 1024-RSA usa una chiave da 

1024 bit (meno sicura), mentre 2048-RSA utilizza una chiave da 2048 bit (più sicura). Al termine, fare clic su 

Crea. Immettere la password nella finestra di dialogo Firma digitale e fare clic su OK.

Nota: sul computer deve essere installato Java® Runtime Environment (JRE).
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Capitolo 15: Creazione di animazioni

Nozioni di base delle animazioni

Adobe® Fireworks® permette di creare elementi grafici animati con banner pubblicitari, logotipi e cartoni animati. È 

possibile creare le animazioni assegnando proprietà agli oggetti chiamati simboli di animazione. L’animazione di un 

simbolo viene suddivisa in stati, che contengono le immagini e gli oggetti dell’animazione. È possibile disporre di più 

simboli in un filmato e ogni simbolo può avere un’azione diversa. Simboli differenti possono inoltre contenere un 

numero diverso di stati. L’animazione termina quando sono state completate tutte le azioni di tutti i simboli.

È possibile applicare impostazioni al simbolo per modificare gradualmente il contenuto di stati successivi. Inoltre, si 

può creare l’illusione che il simbolo si muova all’interno dell’area di lavoro, appaia, scompaia, diventi più grande o più 

piccolo oppure ruoti. Dato che un singolo file può contenere più simboli, è possibile realizzare animazioni complesse 

nelle quali diversi tipi di azione si verificano contemporaneamente.

È possibile modificare le impostazioni di ottimizzazione ed esportazione nel pannello Ottimizza per controllare la 

creazione del file. Fireworks può esportare animazioni in formato GIF animato o Adobe Flash® SWF. Inoltre, è 

possibile importare animazioni Fireworks direttamente in Flash per ulteriori modifiche.

L'articolo di Zsolt Szekely in Adobe Dev Center fornisce informazioni utili su 

www.adobe.com/go/learn_fw_creatinganimlogos_it.

Flusso di lavoro per le animazioni

1 Create un simbolo di animazione, da zero o convertendo un oggetto esistente in un simbolo (vedete “Creare simboli 

di animazione” a pagina 217).

2 Modificate il simbolo di animazione nella finestra di ispezione Proprietà o nella finestra di dialogo Anima. Potete 

impostare grado e direzione di spostamento, scalatura, opacità (dissolvenza), nonché angolo e direzione di 

rotazione (vedete “Modificare i simboli di animazione” a pagina 217.)

Nota: le opzioni relative a grado e direzione di spostamento sono presenti solo nella finestra di dialogo Anima.

3 Utilizzare i comandi Ritardo stati nel pannello Stati per impostare la velocità di animazione. (Vedete “Impostare la 

durata dello stato” a pagina 220.)

4 Ottimizzare il documento come GIF animata. (Vedete “Ottimizzare un’animazione” a pagina 225.)

5 Esportare il documento come GIF animata o file SWF, oppure salvarlo come Fireworks PNG e importarlo in Flash 

per ulteriori modifiche. (Vedete “Esportare un’animazione” a pagina 252.)

I simboli di animazione

I simboli di animazione sono i protagonisti di un’animazione. Un simbolo animazione può essere qualsiasi oggetto 

creato o importato dall’utente; un file può contenere numerosi simboli. Ogni simbolo ha proprietà specifiche e opera 

in modo autonomo; è quindi possibile creare simboli che si spostano attraverso lo schermo mentre altri si dissolvono 

o si riducono.

Non è necessario utilizzare simboli per ogni aspetto dell’animazione. Tuttavia, l’utilizzo di simboli o istanze per 

elementi grafici presenti in più stati riduce la dimensione del file.

http://www.adobe.com/go/learn_fw_creatinganimlogos_it
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Le proprietà del simbolo dell’animazione possono essere modificate in qualsiasi momento usando la finestra di dialogo 

Anima o la finestra di ispezione Proprietà. Inoltre, è possibile modificare il disegno del simbolo senza influire sul resto 

del documento. Per modificare il movimento di un simbolo è sufficiente spostare il relativo tracciato di movimento.

Dato che i simboli dell’animazione vengono posizionati automaticamente nella libreria, è possibile riutilizzarli per 

creare altre animazioni.

Creare simboli di animazione

È possibile creare un simbolo di animazione da zero o convertendo un oggetto in un simbolo. Quindi, si possono 

impostare le proprietà che determinano il numero di stati nell’animazione e il tipo di azione dell’animazione, quali la 

scalatura e la rotazione. Per impostazione predefinita, il nuovo simbolo di animazione ha cinque stati, ciascuno con 

un ritardo di 0,07 secondi. 

Per informazioni sull'utilizzo dei livelli per animazione, vedete l'articolo di David Hogue 

http://www.adobe.com/go/learn_fw_pagestatelay_it.

Creare un simbolo di animazione

1 Selezionare Modifica > Inserisci > Nuovo simbolo. 

2 Nella finestra di dialogo Converti in simbolo, inserire un nome per il nuovo simbolo. 

3 Selezionare Animazione e fare clic su OK. 

4 Nel pannello del documento, utilizzate gli strumenti di disegno o di testo per creare un oggetto. È possibile 

disegnare oggetti vettoriali o bitmap.

5 Al termine della modifica del simbolo, passare alla pagina generale. (Vedete “Passare dalla modifica del simbolo alla 

modifica della pagina” a pagina 162.)

Fireworks colloca il simbolo nella Libreria documento e una copia al centro della pagina.

Potete aggiungere nuovi stati al simbolo usando il dispositivo di scorrimento Stati nella finestra di ispezione 

Proprietà. Selezionate Finestra > Proprietà per aprire la finestra di ispezione Proprietà, qualora non fosse già aperta.

Convertire un oggetto in un simbolo di animazione

1 Selezionare l’oggetto.

2 Selezionare Elabora > Animazione > Anima selezione.

3 Modificare il simbolo impostando le proprietà dell’animazione. 

I controlli di animazione compaiono sul perimetro di delimitazione dell’oggetto e una copia viene aggiunta alla 

libreria.

Modificare i simboli di animazione

È possibile modificare diverse proprietà dei simboli, quali animazione, opacità e rotazione. È possibile applicare a un 

simbolo effetti di rotazione, accelerazione, dissolvenza oppure creare una combinazione di tali proprietà.

http://www.adobe.com/go/learn_fw_pagestatelay_it
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Una proprietà chiave è il numero di stati. Quando si imposta questa proprietà, Fireworks aggiunge automaticamente 

al documento il numero di stati necessari per completare l’azione. Se il simbolo richiede un numero di stati superiore 

a quello presente nell’animazione, un messaggio chiede se aggiungerne altri.

Potete modificare le proprietà dell’animazione utilizzando la finestra di dialogo Anima o la finestra di ispezione 

Proprietà.

Per regolare la velocità di animazione, vedete “Impostare la durata dello stato” a pagina 220. Per modificare il testo, 

gli elementi grafici, i tratti, i riempimenti o gli effetti, consultare “Modificare un simbolo e tutte le relative istanze” a 

pagina 162 e “Modificare specifiche istanze dei simboli” a pagina 163.

Proprietà dei simboli di animazione
Stati Numero di stati nell’animazione. È possibile specificarne fino a 250 con il dispositivo di scorrimento oppure 

inserire un numero nella casella di testo Stati. L’impostazione predefinita è 5.

Spostamento (Solo finestra di dialogo Anima) Distanza, in pixel, percorsa dall’oggetto. L’impostazione predefinita è 

72; tuttavia, non esistono limiti. Lo spostamento è lineare e non ci sono stati chiave (a differenza di Flash e Adobe 

Director).

Direzione (Solo finestra di dialogo Anima) Direzione, in gradi da 0 a 360º, in cui si sposta l’oggetto. È inoltre possibile 

modificare i valori Spostamento e Direzione trascinando le maniglie di animazione dell’oggetto.

Scala Modifica delle dimensioni del simbolo, in percentuale, dall’inizio alla fine. L’impostazione predefinita è 100%; 

tuttavia, non esistono limiti. Per scalare un oggetto da 0 a 100%, è necessario che le dimensioni dell’oggetto originale 

siano ridotte. È consigliabile utilizzare questa funzione solo per gli oggetti vettoriali.

Opacità Grado di dissolvenza dall’inizio alla fine. I valori possibili sono compresi tra 0 e 100 e quello predefinito è 

100%. La creazione di un effetto di comparsa/scomparsa richiede due istanze dello stesso simbolo: una per la 

riproduzione della comparsa, l’altra per la scomparsa.

Rotazione Grado di rotazione dall’inizio alla fine. I valori sono compresi tra 0 e 360°. È possibile digitare valori più 

elevati per più di una rotazione. L’impostazione predefinita è 0°.

Oraria e Antioraria Direzione di rotazione dell’oggetto, in senso orario o antiorario.

Modificare le proprietà del simbolo di animazione

1 Selezionare un simbolo di animazione.

2 Selezionare File > Animazione > Impostazioni per aprire la relativa finestra di dialogo. Selezionate Finestra > 

Proprietà per aprire la finestra di ispezione Proprietà, qualora non fosse già aperta.

3 Modificare le proprietà.

4 Se si sta utilizzando la finestra di dialogo Anima, fare clic su OK per accettare le modifiche alle proprietà.

Rimuovere le animazioni

È possibile rimuovere le animazioni eliminando il simbolo dell’animazione dalla libreria oppure rimuovendo 

l’animazione dal simbolo.

Rimuovere l’animazione da un simbolo di animazione selezionato

❖ Selezionare Elabora > Animazione > Rimuovi animazione.

Il simbolo diventa un simbolo grafico e non viene più animato. Se si riconverte in un secondo momento il simbolo in 

un simbolo di animazione, questo mantiene le impostazioni di animazione precedenti.
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Rimuovere un simbolo dalla libreria di un documento

1 Nel pannello Libreria documento, selezionare il simbolo di animazione.

2 Trascinare il simbolo sull’icona del cestino nell’angolo inferiore destro.

Modificare lo spostamento o la direzione di un simbolo

Un simbolo di animazione selezionato dispone di una casella di delimitazione univoca e di un tracciato di movimento 

che ne indica la direzione di spostamento. 

Il punto verde sul tracciato di movimento indica la posizione di partenza, mentre quello rosso indica il punto finale. I 

punti blu sul tracciato rappresentano gli stati. Ad esempio, un simbolo con cinque stati ha un punto verde, tre punti 

blu e un punto rosso sul tracciato. Se l’oggetto viene visualizzato al terzo punto, lo stato 3 è quello corrente.

È possibile modificare la direzione del movimento, variando l’angolazione del tracciato. 

❖ Trascinare una delle maniglie iniziali o finali di animazione dell’oggetto in una nuova posizione. Tenere premuto 

il tasto Maiusc durante il trascinamento per vincolare la direzione dello spostamento a incrementi di 45°.

Altri argomenti presenti nell’Aiuto 

“Impostare la durata dello stato” a pagina 220

Stati 

Per conoscere le tappe che hanno portato all’introduzione del concetto di pagina in Fireworks, vedete l’articolo di 

Sarthak www.adobe.com/go/learn_fw_simplifyingpagesstates_it. Nelle versioni di Fireworks precedenti alla CS4, gli 

stati venivano chiamati frame.  

È possibile realizzare animazioni creando stati il cui contenuto viene visualizzato nel pannello Stati. In tale pannello, è 

possibile denominare gli stati, riorganizzarli, impostare manualmente la tempistica dell’animazione e spostare gli 

oggetti da uno stato all’altro. 

Ciascuno stato ha anche alcune proprietà correlate. Per visualizzare un’anteprima dell’animazione durante la 

modifica, impostare il ritardo o nascondere uno stato.

I livelli di un’animazione possono essere utilizzati per organizzare gli oggetti che fanno parte dell’ambientazione o 

dello sfondo dell’animazione stessa. Se alcuni oggetti devono essere visibili durante l’intera animazione, inserirli in un 

livello e utilizzare il pannello Livelli per condividere il livello tra diversi stati. Gli oggetti all’interno di un livello 

condiviso tra gli stati sono visualizzabili in ogni stato. Per ulteriori informazioni, consultare “Condividere livelli” a 

pagina 139.

http://www.adobe.com/go/learn_fw_simplifyingpagesstates_it
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Stati e livelli

Le pagine contengono stati e gli stati contengono livelli. Una nuova pagina contiene un solo stato. Tutti i livelli creati 

e tutti gli oggetti su questi livelli contengono un solo stato. Per comprendere la relazione tra stati, pagine e livelli, vedete 

l'articolo di David Hogue www.adobe.com/go/learn_fw_usingpagesstates_it.

Quando create uno stato dal pannello Stati, il numero di livelli del nuovo stato è identico a quello dello stato 

precedente. Tuttavia, i livelli sono vuoti e non contengono oggetti dello stato precedente. Per duplicare oggetti tra gli 

stati, create uno stato duplicato anziché crearne un nuovo. Ogni istanza di un oggetto è indipendente tra gli stati 

quando questi vengono duplicati. 

Nota: l'eliminazione di un livello tra uno degli stati elimina il livello da tutti gli stati.

Per condividere gli oggetti di un livello tra stati, fate clic con il pulsante destro sul livello e selezionate Condividi livello 

tra stati. Gli oggetti nel livello sono condivisi tra stati e anche in nuovi stati quando vengono creati. Tutti gli oggetto 

sul livello corrispondente in altri stati vengono eliminati e sostituiti con oggetti del livello condiviso. Tutte le modiche 

agli oggetti nel livello condiviso si riflettono tra gli stati.

Stati e pagine master

Gli stati di una pagina master corrispondono direttamente agli stati di altre pagine del documento. Quando duplicate 

lo stato 1 su una pagina a normale, tutti gli oggetti vengono copiati da pagina a stato 1 in pagina a stato 2, e condivisa 

pagina master stato 2. Poiché la pagina master dispone di un solo stato, lo stato 2 su qualsiasi altra pagina è vuoto. 

Se duplicate lo stato 1 per creare lo stato 2 in una pagina master, anche il livello di sfondo sulla pagina master viene 

duplicato nello stato 2 della pagina master. Lo stato 2 della pagina master è condiviso con lo stato 2 di tutte le pagine 

del documento. 

Riepilogando, lo stato 1 della pagina master condivide lo stato 1 di tutte le pagine, lo stato 2 della pagina master 

condivide lo stato 2 di tutte le pagine e così via. Se il numero di stati di una pagina normale è maggiore di quello della 

pagina master, non esiste condivisione tra tali stati della pagina master fino a quando lo stato non viene creato sulla 

pagina master. 

Creazione di prototipi/pagine dimostrative con pulsanti e animazioni

I documenti Fireworks contenenti pulsanti e animazioni non vengono quasi mai visualizzati come desiderato. 

Fireworks presume che le animazioni siano l'intera pagina, mentre i pulsanti presumono che venga eseguito solo lo 

scambio di immagini sotto tale sezione. Quando l'animazione viene riprodotta, il contenuto di tutta la pagina cambia, 

compresi gli stati dei pulsanti. 

Le animazioni e i pulsanti devono essere creati ed esportati in maniera separata in una pagina web. I pulsanti di rollover 

utilizzano Javascript per visualizzare i diversi stati, ma le animazioni di Fireworks vengono esportate come file gif o 

swf, che sono indipendenti.

Impostare la durata dello stato 

Il ritardo dello stato consente di specificare la durata di visualizzazione dello stato corrente, in centesimi di secondo. 

Ad esempio, specificare 50 per visualizzare lo stato per mezzo secondo; specificare 300 per visualizzarlo per tre secondi.

1 Selezionare uno o più stati:

• Per selezionare un intervallo di stati contigui, tenere premuto il tasto Maiusc e selezionare il primo e l’ultimo 

stato.

• Per selezionare un intervallo di stati non contigui, tenere premuto Ctrl (Windows) o Comando (Mac OS) e fare 

clic sul nome di ciascuno stato.

http://www.adobe.com/go/learn_fw_usingpagesstates_it


221UTILIZZO DI FIREWORKS

Creazione di animazioni

Ultimo aggiornamento 4/5/2011

2 Effettuare una delle operazioni seguenti:

• Selezionare Proprietà dal menu Opzioni del pannello Stati.

• Fate doppio clic sulla colonna del ritardo degli stati.

3 Immettere un valore per il ritardo dello stato.

4 Premere Invio o fare clic fuori dal pannello.

Nascondere gli stati durante la riproduzione

Gli stati nascosti non vengono visualizzati durante la riproduzione e non vengono esportati. 

1 Effettuare una delle operazioni seguenti:

• Selezionare Proprietà dal menu Opzioni del pannello Stati.

• Fate doppio clic sulla colonna del ritardo degli stati.

2 Deselezionare Includi all’esportazione.

3 Premere Invio o fare clic fuori dal pannello.

Modificare i nomi degli stati

Quando si imposta l’animazione, Fireworks crea gli stati necessari e li visualizza nel pannello Stati come Stato 1, Stato 

2 e così via. Quando si sposta uno stato nel pannello, Fireworks ridefinisce il nome di tutti gli elementi in base al nuovo 

ordine. 

Per tenerne traccia, è utile assegnare agli stati nomi significativi. Quando si sposta uno stato rinominato, il suo nome 

resta inalterato.

1 Nel pannello Stati, fare doppio clic sul nome.

2 Digitare un nuovo nome e premere Invio.

Personalizzare i nomi degli stati

1 Selezionare File > Imposta HTML.

2 Nella finestra di dialogo Imposta HTML, selezionare la scheda Specifiche del documento.

3 Selezionare Personalizzato nel menu Nomi stati.

4 Nella finestra di dialogo, definire i nomi personalizzati da aggiungere agli stati.

Il nome personalizzato viene memorizzato per la durata della sessione. Poiché si tratta di un’impostazione delle 

specifiche del documento, selezionate “Personalizzato” come indicato nella prima immagine della schermata.

Manipolare gli stati

Nel pannello Stati è possibile aggiungere, copiare, eliminare e modificare l’ordine degli stati.

Aggiungere un nuovo stato

❖ Fare clic sul pulsante Stato nuovo/duplicato  in fondo al pannello Stati.
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Aggiungere stati a una sequenza

1 Selezionare Aggiungi stati dal menu Opzioni del pannello Stati.

2 Immettere il numero di stati da aggiungere.

3 Selezionare la posizione di inserimento degli stati e fare clic su OK.

Copiare uno stato

❖ Trascinare uno stato esistente sul pulsante Stato nuovo/duplicato in fondo al pannello Stati.

Copiare uno stato selezionato e inserirlo in una sequenza

La duplicazione di uno stato può essere utilizzata per far riapparire gli oggetti altrove nell’animazione.

1 Selezionare Duplica stato dal menu Opzioni del pannello Stati. 

2 Inserire il numero di duplicati da creare per lo stato selezionato, specificare la posizione degli stati duplicati e fare 

clic su OK.

Riordinare gli stati

❖ Trascinare i singoli stati in una nuova posizione all’interno dell’elenco.

Invertire l’ordine degli stati

Potete invertire l’ordine di tutti gli stati o di uno stato selezionato.

1 Selezionare Comandi > Documento > Inverti stati.

2 Effettuare una delle operazioni seguenti:

• Selezionare Tutti gli stati per invertire la sequenza degli stati dall’inizio alla fine.

• Selezionare Intervallo di stati e scegliere gli stati iniziale e finale di un intervallo di stati di cui invertire l’ordine.

3 Fare clic su OK.

Eliminare lo stato selezionato

❖ Effettuare una delle operazioni seguenti:

• Fare clic sul pulsante Elimina stato  nel pannello Stati.

• Trascinare lo stato sul pulsante Elimina stato.

• Selezionare elimina stato dal menu Opzioni del pannello Stati.

Spostare gli oggetti selezionati nel pannello stati

Per spostare oggetti in un altro stato, utilizzare il pannello Stati. Gli oggetti presenti in un solo stato scompaiono 

durante la riproduzione dell’animazione, ma è possibile disattivarne e attivarne la visualizzazione in diversi punti.

Nel pannello Stati, un piccolo cerchio a destra del tempo di ritardo indica lo stato dei relativi oggetti. 

1 Nell’area di lavoro, selezionare gli oggetti da visualizzare in un altro stato.

2 Nel pannello Stati, trascinare sul nuovo stato l’indicatore di selezione (il cerchio nero a destra del tempo di ritardo).
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Per copiare gli oggetti selezionati su altri stati, trascinarli tenendo premuto Alt (Windows) o Opzione (Mac OS).

Visualizzare gli oggetti in uno stato

❖ Selezionare lo stato dal menu a comparsa Stato in fondo al pannello Livelli.

Tutti gli oggetti nello stato selezionato sono elencati nel pannello Livelli e visualizzati nell’area di lavoro.

Informazioni sulla funzione Onion skin

Onion skin è una tecnica di visualizzazione dei contenuti degli stati prima e dopo lo stato selezionato. La tecnica Onion 

skin consente di animare in modo uniforme gli stati senza passare ripetutamente dall’uno all’altro. 

Quando Onion skin è attivato, gli oggetti negli stati precedenti e successivi vengono attenuati in modo da differenziarli 

dagli oggetti dello stato corrente. 

Per impostazione predefinita, l’opzione Modifica più stati è attivata: è quindi possibile selezionare e modificare gli 

oggetti attenuati degli altri stati, senza uscire dallo stato corrente. Utilizzare lo strumento Seleziona dietro per 

selezionare oggetti in stati in ordine sequenziale. 

Per regolare il numero di stati visibili prima e dopo quello corrente, fare clic sul pulsante Onion Skin e selezionare 

un’opzione di visualizzazione. L’opzione Personalizza consente di specificare il numero di stati e di controllare 

l’opacità. Utilizzare l’opzione Modifica più stati per selezionare e modificare tutti gli oggetti visibili. Deselezionare 

l’opzione per eseguire la modifica solo nella pagina corrente.

Intercalaggio

In Fireworks, l’intercalaggio è un processo manuale che fonde due o più istanze dello stesso simbolo, creando istanze 

intermedie con attributi interpolati. Utilizzare l’intercalaggio per applicare a un oggetto un movimento complesso 

all’interno dell’area di lavoro e per gli oggetti con diversi filtri attivi in ogni stato dell’animazione. Per esempio, è 

possibile intercalare un oggetto in modo che sembri muoversi lungo un tracciato lineare. 

Nota: nella maggior parte dei casi, l’uso di simboli di animazione è preferibile all’intercalaggio. Per ulteriori 

informazioni, vedete “I simboli di animazione” a pagina 216.
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Effettuare l’intercalaggio delle istanze

1 Selezionare due o più istanze dello stesso simbolo grafico dall’area di lavoro. Non selezionare istanze di simboli 

diversi.

2 Selezionare Elabora > Simbolo > Intercalaggio istanze.

3 Immettere il numero di passaggi di intercalaggio da inserire tra la coppia originale nella finestra di dialogo 

Intercalaggio istanze.

4 Per distribuire gli oggetti intercalati su stati separati, selezionare Distribuisci sugli stati e fare clic su OK.

È possibile eseguire questa operazione in un secondo momento selezionando tutte le istanze e facendo clic sul 

pulsante Distribuisci sugli stati  nel pannello Stati.

Anteprima di un’animazione

È possibile visualizzare in anteprima l’animazione su cui si sta lavorando per controllarne la progressione. Si può 

inoltre visualizzare in anteprima un’animazione dopo l’ottimizzazione per verificarne l’aspetto in un browser Web. 

l’esecuzione di anteprime in visualizzazione 2 per volta o 4 per volta è sconsigliata.

Nota: le animazioni aggiunte alle pagine master non vengono visualizzate. Aggiungete animazioni alle pagine secondarie 

e condividetele tra tutte le pagine.

Anteprima di un’animazione nello spazio di lavoro

❖ Utilizzare i comandi dello stato, in fondo alla finestra del documento.

Comandi degli stati

• Per impostare la durata di visualizzazione di ogni stato nella finestra del documento, immettere le impostazioni di 

ritardo stato nel pannello Stati.

• Gli stati nascosti esclusi dalla procedura di esportazione non vengono visualizzati durante l’anteprima. (Vedete 

“Nascondere gli stati durante la riproduzione” a pagina 221.)

• L’anteprima dell’animazione eseguita nella vista Originale consente di visualizzare le immagini sorgente a 

risoluzione piena, non l’anteprima ottimizzata utilizzata per il file esportato.

Anteprima di un’animazione nella vista Anteprima

1 Fare clic sul pulsante Anteprima, nell’angolo superiore sinistro della finestra del documento.

2 Utilizzare i comandi degli stati.

Anteprima di un’animazione all’interno di un browser Web

❖ Selezionare File > Anteprima nel browser e scegliere un browser nel sottomenu.

Nota: per visualizzare lo spostamento durante l’anteprima dell’animazione, selezionare GIF animata come formato del 

file di esportazione nel pannello Ottimizza, anche se si pianifica l’importazione dell’animazione in Flash come file SWF 

o Fireworks PNG.
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Ottimizzare un’animazione

Una volta impostati i simboli e gli stati dell’animazione, ottimizzarla per facilitarne il caricamento e la riproduzione. 

Una volta creata e ottimizzata, l’animazione è pronta per l’esportazione. Per ulteriori informazioni, consultare 

“Esportare un’animazione” a pagina 252.

Impostare la ripetizione continua di un’animazione

La ripetizione di un’animazione consente di ridurre il numero di stati necessari per realizzarla.

1 Selezionare Finestra > Stati per visualizzare il pannello Stati.

2  Fare clic sul pulsante Ripetizione continua animazione GIF  in fondo al pannello.

3 Selezionare il numero di ripetizioni dell’animazione dopo la prima riproduzione.

Se si seleziona 4, ad esempio, l’animazione viene riprodotta cinque volte in totale. L’opzione Sempre ripete 

l’animazione in modo continuo.

Selezionare le impostazioni dal pannello Ottimizza

L’ottimizzazione consente di comprimere un file in pacchetti più piccoli, riducendo i tempi di scaricamento dal Web. 

Per ulteriori informazioni sulle opzioni di ottimizzazione, consultare “Ottimizzare file GIF, PNG, TIFF, BMP e PICT” 

a pagina 241.

1 Selezionare Finestra > Ottimizza.

2 Selezionare un formato di file da esportare nel pannello Ottimizza.

3 Impostare le opzioni Tavolozza e Dithering. 

4 Selezionare Trasparenza indice o Trasparenza alfa dal menu a comparsa Trasparenza, nel pannello Ottimizza. 

5 Utilizzare gli strumenti di trasparenza del pannello Ottimizza per selezionare i colori di trasparenza.

6 Nel pannello Stati, impostare il ritardo degli stati. 

Operazioni con le animazioni esistenti

Per utilizzare una GIF animata esistente, importare il file GIF in un file Fireworks oppure aprirlo come file nuovo. 

Quando si importa una GIF animata, Fireworks la converte in un simbolo di animazione e la colloca nello stato 

selezionato. Se l’animazione ha più stati del filmato corrente, è possibile aggiungere automaticamente altri stati. 

Le GIF importate assumono le impostazioni di ritardo dello stato del documento corrente. Dato che il file importato 

è un simbolo di animazione, è possibile applicargli movimenti aggiuntivi. Ad esempio, importare un’animazione di 

una persona che cammina sul posto, quindi applicare proprietà di direzione e spostamento in modo da farla spostare 

attraverso lo schermo. 

Quando si apre una GIF animata, viene creato un nuovo file e ogni stato della GIF viene collocato in stati diversi di 

Fireworks. Sebbene la GIF non sia un simbolo di animazione, conserva tutte le impostazioni di ritardo stato del file 

originale.

le animazioni aggiunte alle pagine master non vengono visualizzate. Aggiungete l'animazione a una pagina secondaria 

e condividetela tra tutte le pagine.
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Una volta importato il file, occorre impostare il suo formato su GIF animata per esportare il movimento da Fireworks.

Importare una GIF animata

1 Scegliere File > Importa.

2 Individuare il file e fare clic su Apri.

3 Fare clic e trascinare per inserire il file nell’area di lavoro.

Aprire una GIF animata

❖ Scegliere File > Apri e individuare il file GIF.

Usare più file come una sola animazione

Fireworks consente di creare un’animazione a partire da un gruppo di file di immagini. Ad esempio, è possibile creare 

un banner pubblicitario basato su diversi elementi grafici esistenti.

1 Scegliere File > Apri.

2 Fare clic tenendo premuto il tasto Maiusc per selezionare più file.

3 Selezionare Apri come animazione e fare clic su OK.

Fireworks apre i file in un nuovo documento singolo, collocando ogni file in uno stato diverso in ordine di 

selezione.

Creare animazioni in distorsione e dissolvenza

Potete utilizzare il comando Distorci e dissolvi per creare diverse istanze di un oggetto che appare o scompare in 

dissolvenza seguendo una traiettoria elicoidale. Dopo aver creato il primo oggetto, le istanze successive vengono create 

automaticamente sulla base delle opzioni impostate nella finestra di dialogo Distorci e dissolvi. È inoltre possibile 

animare gli oggetti creati utilizzando l’opzione nella finestra di dialogo e salvare l’animazione come file GIF.

1 Creare o spostare un oggetto sull’area di lavoro. Ad esempio, disegnare un cerchio o spostare un’immagine sull’area 

di lavoro.

2 Selezionare Comandi > Creatività> Distorci e dissolvi.

3 Nella finestra di dialogo Distorci e dissolvi, configurare i parametri secondo le proprie esigenze. Modificare le 

diverse opzioni della finestra di dialogo per personalizzare l’effetto. Spostare la finestra di dialogo in modo da 

riuscire a vedere l’anteprima delle modifiche mentre vengono apportate.

Passaggi Indica il numero di istanze dell’oggetto creato.

Opacità Indica l’opacità degli oggetti creati.

Direzione Indica la direzione seguita dagli oggetti successivi rispetto al primo oggetto.

Passo indietro Ogni oggetto si muove dietro l’oggetto seguente nella serie.

Anima Selezionare questa opzione se si desidera animare l’insieme di oggetti creati.

Sfocatura Aumentando il valore di questo campo, l’effetto di sfocatura viene applicato man mano a partire 

dall’ultimo oggetto creato verso il primo oggetto.

Scostamento tonalità Modificare questo valore per cambiare i colori degli oggetti creati.
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Spaziatura Aumentare il valore per aumentare lo spazio tra gli oggetti creati.

Rotazione Indica fino a che punto gli oggetti successivi vengono ruotati.

Direzione Indica l’angolo di differenza tra gli oggetti successivi e il primo oggetto.

Scala Indica il ridimensionamento degli oggetti successivi rispetto al primo oggetto.

Opacità Indica l’opacità degli oggetti successivi rispetto al primo oggetto.

Ordine casuale Fare clic su questo pulsante se si desidera provare a inserire nelle impostazioni dei valori casuali 

scelti dal sistema.

Variazione Aggiunge delle variazioni all’opzione selezionata. Il valore impostato determina l’entità della 

variazione.

Preimpostazioni Consente di selezionare la preimpostazione che si adatta meglio alle proprie esigenze. È 

consigliabile cominciare con una preimpostazione e poi configurare le diverse opzioni in base alle proprie esigenze. 

È inoltre possibile selezionare Predefinito per utilizzare il set predefinito di preferenze oppure selezionare Ultimo 

utilizzo per usare il set di preferenze utilizzate l’ultima volta.

Anteprima Selezionare l’anteprima se si desidera visualizzare le modifiche all’oggetto man mano che vengono 

impostate le opzioni nella finestra di dialogo. 

Nota: se è stata selezionata l’opzione Anima, quando si fa clic sul pulsante OK, l’immagine scompare dall’area di 

lavoro.

4 Nella finestra di dialogo Proprietà, selezionate GIF Animato Websnap 128 dal menu delle opzioni di formato.

5 Per visualizzare l’anteprima della pagina in un browser, premere F12.

Nota: è possibile separare gli oggetti creati nello stesso modo in cui si separano gli altri oggetti. 
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Capitolo 16: Creazione di presentazioni

Creare e disporre una presentazione

Per creare presentazioni Adobe® Flash® o basate su HTML/SPRY, usare la finestra Crea presentazione per selezionare 

una cartella contenente immagini e aggiungere le opzioni desiderate. È possibile modificare le presentazioni esistenti 

aggiungendo o eliminando immagini, oppure aggiungendo più album a una singola presentazione.

I designer o gli sviluppatori Flash possono inoltre creare un riproduttore di album personalizzato in Flash per la 

visualizzazione dell’output XML di Creazione album di Adobe Fireworks®.

Creare una presentazione

1 Selezionare Comandi > Crea presentazione.

2 Fare clic sul pulsante Aggiungi un album (il segno più) accanto ad Album.

3 Scegliere i file di immagine da includere nella presentazione e fare clic su OK.

4 Immettere le informazioni necessarie nei riquadri Proprietà AlbumBook e alle Proprietà album.

5 Selezionare ognuno dei pannelli a destra per configurare le proprietà della presentazione.

6 Scegliere la posizione per la presentazione completata nel pannello Opzioni esportazione.

7 Dopo aver configurato tutte le impostazioni della presentazione, fare clic su Crea.

8 (Facoltativo) Per visualizzare le presentazioni nel browser, selezionare la casella di controllo Avvia presentazione 

in browser e fare clic su Fine.
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Aprire una presentazione esistente

1 Selezionare Comandi > Crea presentazione.

2 Nella finestra Crea presentazione, fare clic su Apri un AlbumBook esistente o fare clic sul pulsante Sfoglia (...) 

accanto ad Album.

3 Selezionare la cartella contenente il file XML della presentazione esistente e fare clic su Apri.

Eliminare un album

1 Aprire una presentazione esistente.

2 Selezionare un album dall’elenco Album, quindi fare clic sul pulsante Elimina album selezionato/i (il segno 

negativo) accanto ad Album.

Organizzare un album

1 Aprire una presentazione esistente.

2 Selezionare un album nell’elenco Album.

• Per aggiungere immagini, fare clic sul pulsante Aggiungi immagine/i (il segno più) accanto a Immagini. Quindi, 

fare clic sul pulsante Sfoglia (...) e selezionare una o più immagini. 

• Per modificare l’ordine delle immagini, selezionare un’immagine e fare clic sui pulsanti freccia sopra l’elenco 

delle immagini per spostarla.

Personalizzare una presentazione

Fare clic su ogni pannello delle proprietà nella parte destra della finestra Create Slideshow per visualizzarlo e 

personalizzare le proprietà.

Pannello Proprietà AlbumBook

Le proprietà AlbumBook sono applicate a un AlbumBook contenente più album.

Titolo Può contenere spazi vuoti, ad esempio “Il mio viaggio”. 

Descrizione Immettere una descrizione.

Lettore Selezionare il tipo.

Icona Informazioni (accanto a Lettore) Fare clic per visualizzare ulteriori informazioni sul lettore, incluse le proprietà 

album e AlbumBook supportate dal lettore selezionato.

Avvio automatico presentazione Avvia la presentazione all’apertura del lettore.

Consenti clic su immagini Consente di fare clic sull’immagine per aprirla in una nuova finestra del browser e salvarla, 

visualizzarla in una nuovo scheda o visualizzarla per intero.

Pannello Proprietà album

Le proprietà dell’album si riferiscono solo al singolo album selezionato.

Descrizione Immettere una descrizione per l’album.
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Miniatura Consente di selezionare un’immagine per l’anteprima di una miniatura nella presentazione.

Sfondo Consente di selezionare e scalare un’immagine di sfondo personalizzata per la presentazione. 

Pannello Didascalie

Consente di utilizzare le opzioni delle didascalie per personalizzare le didascalie delle immagini contenute nella 

presentazione.

Applica a tutti gli album Applica le opzioni per le didascalie a tutti gli album nell’AlbumBook.

Nessuna modifica Mantiene le didascalie esistenti.

Cancella tutte le didascalie Cancella dall’album tutte le didascalie.

Usa nome file Usa i nomi file delle immagini come didascalia. 

Includi estensione Se si sceglie di usare i nomi file come didascalie, include le estensioni dei nomi file.

Inserisci testo Consente di utilizzare il testo specificato come didascalia per ogni immagine.

Sostituisci didascalie Applica il testo inserito a tutte le immagini.

Pannello Filtri

I filtri possono essere applicati solo a un album nuovo. Per applicare i filtri selezionati a tutti gli album 

dell’AlbumBook, selezionare Applica a tutti gli album.

Pannello Proprietà presentazione

Le proprietà della presentazione vengono applicate alla presentazione corrente.

Applica a tutti gli album Applica le opzioni specificate per le didascalie a tutti gli album nell’AlbumBook.

Intervallo Numero di secondi tra un’immagine e l’altra.

Usa transizione Consente di selezionare un effetto di transizione tra un’immagine e l’altra.

Prima immagine Imposta la prima immagine dell’album. Si tratta del numero sequenziale dell’immagine nell’album.

Visualizza sequenza Consente di scegliere se visualizzare le immagini in ordine o casualmente.

Pannello Opzioni esportazione

Usare le opzioni seguenti per impostare l’esportazione delle immagini.

Esporta immagini Esporta le immagini intere e in miniatura con le impostazioni specificate. Deselezionare l’opzione 

per esportare solo il file XML.

Genera XML Genera un file .xml per le directory e immagini della presentazione. Deselezionare l’opzione per esportare 

solo le immagini.

Formato XML Seleziona il formato XML esportato come Crea presentazione o Adobe Media Gallery se si seleziona 

Genera XML.

Percorso esportazione Consente di specificare la posizione in cui esportare o generare la presentazione e i file 

associati.

Larghezza e Altezza Consente di specificare la larghezza e l’altezza delle immagini esportate. Le immagini 

ridimensionate in scala mantengono il rapporto originale.



231UTILIZZO DI FIREWORKS

Creazione di presentazioni

Ultimo aggiornamento 4/5/2011

Esporta miniature Esporta le miniature insieme alle immagini intere.

Larghezza e Altezza Consente di specificare la larghezza e l’altezza delle miniature esportate.

Qualità immagine Determina la qualità di output delle immagini intere e delle miniature esportate. L’impostazione 

100 indica la migliore qualità possibile.

Ingrandisci immagini per adattare Se necessario, ingrandisce l’immagine in modo che si adatti al formato di 

esportazione specificato.

Creare un lettore di album Fireworks personalizzato

È possibile creare un lettore personalizzato da utilizzare con il comando Crea presentazione. Inoltre, i file sorgente dei 

visualizzatori delle presentazioni predefiniti sono inclusi nel software e possono essere modificati. 

1 Pubblicare il file SWF e, se disponibile, il file HTML (con estensione .htm o .html). 

2 Cambiare l’estensione del file SWF in un’estensione che non sia .swf.

Nota: in Mac OS, rinominare il file SWF in Finder potrebbe non bastare (a meno che non si sia impostata l’opzione 

Mostra estensione file). Potrebbe essere necessario rinominare il file usando la finestra di dialogo delle proprietà del 

file, sotto Nome ed Estensione.

3 Nella stessa cartella del file SWF, creare un file XML con il seguente formato:

<?xml version="1.0"encoding="utf-8"?> 
<FWACPlayer> 

<Player name="Player - Black (Flash)"preview="player_black.jpg"launch="index.html"> 
<File src="player_black.fap"dst="player_black.swf"/> 
<File src="player_black.html"dst="index.html"/> 
<Info src="player_black.info"/> 

</Player> 
<Player name="Player - White (Flash)"preview="player_white.jpg"launch="index.html"> 

<File src="player_white.fap"dst="player_white.swf"/> 
<File src="player_white.html"dst="index.html"/> 
<Info src="player_white.info"/> 

</Player> 
</FWACPlayer>

Nota: se si possiedono più versioni dello stesso lettore base, è possibile elencarle nell’XML (come mostrato 

precedentemente).

4 Per ciascun nodo Lettore, elencare i nomi dei file sorgente e di destinazione all’interno del nodo File.

5 (Facoltativo) Per fornire ulteriori informazioni sul lettore, aggiungere il nodo Info, con l’attributo src contenente 

il nome del file. Il file di informazioni deve contenere un testo HTML. Se il file contiene testo semplice non HTML, 

i ritorni a capo e le tabulazioni vengono rimossi prima di visualizzare il testo.

6 Creare o modificare il file MXI in modo che i file SWF e HTML rinominati siano collocati in una cartella 

Configurations/Commands/Players.

Nota: affinché l’opzione Avvia presentazione in browser sia attiva alla fine della procedura, i file SWF e HTML 

devono avere lo stesso nome.

Il file XML creato possiede la struttura seguente:
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<AlbumBook... > 
<Album ... > 

<Slide ... /> 
<Slide ... /> 
<Slide ... /> 

</Album> 
<Album ... > 

<Slide ... /> 
<Slide ... /> 
<Slide ... /> 

</Album> 
</AlbumBook>

Definizioni nodo

Nodo AlbumBook

ver Versione del comando Create Slideshow che ha creato il file XML.

title Titolo principale della presentazione.

description Descrizione della presentazione.

firstAlbum Indice a base zero del primo album da visualizzare.

width Larghezza della presentazione.

height Altezza della presentazione.

showThumbnails Per mostrare o meno le miniature. Oppure, indica se le stesse sono state esportate.

thumbWidth Larghezza della miniatura.

thumbHeight Altezza della miniatura.

autoStart Avvia automaticamente la presentazione. 

allowClick Per consentire agli utenti di fare clic sulle immagini o meno.

clickAction Quale azione attivare al clic sull’immagine (aprirla in una nuova finestra, in una nuova scheda o far 

decidere al lettore).

Nodo Album

title Titolo dell’album in questione.

description Descrizione dell’album.

path Nome della cartella contenente le immagini per l’album selezionato. Le miniature vengono esportate nella 

relativa cartella all’interno del percorso.

hasThumb Ha una miniatura.

thumbSrc Immagine miniatura dell’album.

hasBg Ha un’immagine di sfondo.

bgSrc Immagine di sfondo dell’album.

bgScale Metodo di scala per lo sfondo dell’album.

interval Intervallo della presentazione in secondi per questo album.
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useTransition Usa la transizione nel passaggio da un’immagine all’altra.

transType Transizione della presentazione per questo album.

transTime Tempo di transizione.

firstImage Indice a base zero della prima immagine da visualizzare.

dispSequence Ordine in base al quale visualizzare le immagini (in sequenza o a caso).

Nodo diapositiva

src Nome del file di immagine per la diapositiva selezionata.

caption Didascalia associata alla diapositiva.

width Larghezza della diapositiva.

height Altezza della diapositiva.

thumbWidth Larghezza della miniatura della diapositiva.

thumbHeight Altezza della miniatura della diapositiva.
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Capitolo 17: Ottimizzazione ed 
esportazione

L’esportazione di elementi grafici da Adobe® Fireworks® avviene in due fasi. Prima di procedere con l’esportazione, è 

necessario ottimizzare gli elementi grafici: selezionare le opzioni che conferiscono a tali elementi l’aspetto ottimale, 

limitando le dimensioni del file in modo che vengano scaricati nel modo più rapido possibile.

Per ottenere supporto nel corso del processo di esportazione e ottimizzazione, utilizzare Autocomposizione esporta. 

Si tratta di una procedura guidata che suggerisce le impostazioni e visualizza un’Anteprima immagine da usare come 

riferimento visivo durante l’ottimizzazione. Anteprima immagine può essere utilizzata indipendentemente dalla 

procedura guidata di autocomposizione.

Per ottenere un maggiore controllo sul processo, utilizzare gli strumenti dello spazio di lavoro, ad esempio il pannello 

Ottimizza, i pulsanti di anteprima nella finestra del documento e la finestra di dialogo Esporta. 

In alcuni casi, è possibile salvare gli elementi grafici senza esportarli. Per ulteriori informazioni, consultare “Salvare i 

documenti in altri formati” a pagina 12.

Usare Autocomposizione Esporta

Autocomposizione Esporta guida l’utente attraverso il processo di ottimizzazione ed esportazione. 

1 Selezionare File > Autocomposizione Esporta.

2 Rispondere alle richieste visualizzate dal sistema e fare clic su Continua in ognuno dei pannelli.

Selezionare Dimensioni richieste file di esportazione nel primo pannello per ottimizzare il file in base alle 

dimensioni massime indicate.

3 Fare clic su Esci nella finestra Risultati analisi dell’autocomposizione. 

Viene visualizzata la finestra Anteprima esportazione con le opzioni di esportazione raccomandate. 

Usare Anteprima immagine 

È possibile aprire Anteprima immagine sia da Autocomposizione esporta sia dal menu File (File > Anteprima 

immagine).

L’area di anteprima visualizza il documento o l’elemento grafico esattamente come verranno esportati e valuta le 

dimensioni del file e i tempi di scaricamento in base alle impostazioni di esportazione correnti. 
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A. Gruppo di opzioni salvato per l’esportazione selezionata  B. Dimensioni del file e tempi di scaricamento stimati  C. Anteprima delle 
impostazioni di esportazione selezionate  D. Impostazioni di esportazione salvate nella vista attiva  

Per l’esportazione delle GIF animate o dei rollover JavaScript, le dimensioni stimate dei file corrispondono al totale di 

tutti gli stati.

Nota: deselezionare Anteprima per aumentare la velocità di ridisegno della finestra Anteprima esportazione. Per 

interrompere il ridisegno dell’area di anteprima durante la modifica delle impostazioni, premere Esc.

Modificare l’area di anteprima

Effettuare lo zoom dell’immagine

❖ Fare clic sul pulsante Zoom  quindi sull’anteprima per ingrandirla. Per ridurre l’anteprima, fare clic sul pulsante 

tenendo premuto il tasto Alt (Windows) o Opzione (Mac OS).

Spostare l’area visibile dell’immagine

❖ Effettuare una delle seguenti operazioni:

• Fare clic sul pulsante Puntatore  nella parte inferiore della finestra di dialogo e trascinare nell’anteprima.

• Tenere premuta la barra spaziatrice quando è attivo il puntatore Zoom e trascinare nell’anteprima.

Dividere l’area di anteprima per effettuare un confronto delle impostazioni

❖ Fare clic sul pulsante per la suddivisione delle vista , , . 

Ogni finestra può visualizzare un’anteprima dell’immagine con diverse impostazioni di esportazione.

Nota: quando si esegue un’operazione di ingrandimento/riduzione o panoramica mentre sono aperte più viste, tali 

operazioni vengono eseguite contemporaneamente in tutte le viste.

Impostare le opzioni di Anteprima immagine

Ottimizzare un’immagine in base alle dimensioni del file di destinazione

1 Fare clic sulla scheda Opzioni. 

A B C D



236UTILIZZO DI FIREWORKS

Ottimizzazione ed esportazione

Ultimo aggiornamento 4/5/2011

2 Fare clic sul pulsante Autocomposizione Ottimizza a dimensioni .

3 Immettere le dimensioni del file in kilobyte, poi fare clic su OK. 

L’autocomposizione Ottimizza a dimensioni cerca di adattare il file alle dimensioni richieste in uno dei seguenti modi:

• Regolazione della qualità JPEG

• Modifica dell’attenuazione JPEG

• Variazione del numero di colori nelle immagini a 8 bit

• Modifica delle impostazioni di dithering nelle immagini a 8 bit

• Attivazione o disattivazione delle impostazioni di ottimizzazione

Impostare le dimensioni dell’immagine esportata

1 Fare clic sulla scheda File.

2 Specificare una percentuale di scala o immettere la larghezza e l’altezza in pixel. Selezionare Vincola per scalare la 

larghezza e l’altezza in modo proporzionale.

Definire solo una parte dell’immagine da esportare

1 Fare clic sulla scheda File.

2 Selezionare Area di esportazione ed effettuare una delle seguenti operazioni:

• Trascinare il bordo punteggiato che compare attorno all’anteprima fino a racchiudere l’area di esportazione. Per 

far rientrare le aree nascoste nel campo visibile, trascinare all’interno dell’anteprima.

• Immettere le coordinate in pixel dei confini dell’area di esportazione.

Selezionare le impostazioni di animazione 

1 Fare clic sulla scheda Animazione.

• Per visualizzare un singolo stato, selezionarlo dall’elenco nella parte sinistra della finestra di dialogo. È inoltre 

possibile utilizzare i controlli per gli stati, in basso a destra della finestra di dialogo.

• Per riprodurre l’animazione, fare clic sul comando Esegui/Termina in basso a destra nella finestra di dialogo.

2 Per specificare il metodo di eliminazione dello stato, selezionare uno stato dall’elenco, fare clic sull’icona del cestino 

e selezionare una delle seguenti opzioni:

Non specificato Determina un metodo di eliminazione automatico per lo stato corrente, scartandolo se lo stato 

successivo contiene trasparenza di livello. Per la maggior parte delle animazioni, questa opzione automatica 

predefinita offre risultati visivi ottimali con dimensioni file notevolmente ridotte.

Nessuna Mantiene lo stato corrente quando quello successivo viene aggiunto alla visualizzazione. Lo stato corrente 

(e quelli precedenti) potrebbe essere visibile attraverso le aree trasparenti dello stato successivo. Utilizzare un 

browser per visualizzare un’anteprima accurata di un’animazione mediante questa opzione.
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Ripristina al precedente Scarta lo stato corrente e lo sostituisce momentaneamente con lo sfondo della pagina 

Web. Viene visualizzato solo uno stato per volta. Scegliere questa opzione se gli oggetti animati si spostano su uno 

sfondo trasparente.

Ripristina al precedente Scarta lo stato corrente e lo sostituisce temporaneamente con quello precedente. Scegliere 

questa opzione se gli oggetti animati si spostano su uno sfondo opaco.

3 Per impostare il ritardo, selezionare uno stato dall’elenco e immettere il valore del ritardo in centesimi di secondo 

nel campo Ritardo stato. 

4 Per impostare la riproduzione ripetuta dell’animazione, fare clic sul pulsante Ripetizione ciclica e scegliere il 

numero di ripetizioni dal menu a comparsa.

5 Per ritagliare ciascuno stato in modo da ottenere solo l’area dell’immagine che presenta differenze tra gli stati, 

selezionare Ritaglia ogni stato. Questa opzione consente di ridurre le dimensioni del file.

6 Per effettuare l’output dei soli pixel che cambiano da uno stato a un altro, selezionare Salva le differenze tra stati. 

Questa opzione consente di ridurre le dimensioni del file.

Esportare mediante Anteprima immagine

1 Selezionare File > Anteprima immagine.

2 Selezionare le opzioni di ciascuna scheda.

3 Fare clic su Esporta.

4 Nella finestra di dialogo Esporta, digitare un nome per il file, scegliere una destinazione, impostare eventuali altre 

opzioni, quindi fare clic su Salva.

Ottimizzare lo spazio di lavoro

Fireworks rende disponibili le funzioni di ottimizzazione ed esportazione direttamente nello spazio di lavoro per 

consentire di controllare la modalità di esportazione dei file. È possibile utilizzare opzioni di ottimizzazione 

preimpostate o personalizzarle selezionando opzioni specifiche, ad esempio il tipo di file e la tavolozza dei colori.

Il pannello Ottimizza contiene i controlli principali per l’ottimizzazione e (per i formati file a 8 bit) una tabella che 

visualizza i colori della tavolozza corrente dei colori per l’esportazione. Il pannello visualizza le impostazioni relative 

alla selezione attiva (una porzione o l’intero documento).

I pulsanti di anteprima della finestra del documento mostrano l’aspetto che assumerebbe l’elemento grafico una volta 

esportato con le opzioni di ottimizzazione correnti.

È possibile ottimizzare l’intero documento nello stesso modo, oppure selezionare singole porzioni o aree selezionate 

di un JPEG e assegnare diverse opzioni di ottimizzazione per ciascuna di esse.

Ottimizzare le singole porzioni

Quando è selezionata una porzione, la finestra di ispezione Proprietà presenta un menu a comparsa Impostazioni 

esportazione porzione da cui scegliere le impostazioni di ottimizzazione preimpostate (salvate).

1 Fare clic su una porzione per selezionarla. Fare clic tenendo contemporaneamente premuto il tasto Maiusc per 

selezionare più porzioni.

2 Selezionare le opzioni nel pannello Ottimizza.
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Visualizzare in anteprima e confrontare le impostazioni di ottimizzazione

I pulsanti di anteprima del documento consentono di visualizzare l’elemento grafico come apparirà in un browser 

Web, in base alle impostazioni di ottimizzazione. Oltre all’animazione, è possibile visualizzare in anteprima i 

comportamenti di rollover e navigazione. 

Il pulsante Originale e i pulsanti di anteprima del documento

L’anteprima presenta la dimensione totale, il tempo di download stimato e il formato di file del documento. Il tempo 

di download stimato viene calcolato come media del tempo richiesto per scaricare tutte le porzioni e gli stati 

dell’immagine con un modem a 56 K. Le anteprime 2 per volta e 4 per volta visualizzano informazioni addizionali che 

variano in base al tipo di file selezionato.

È possibile ottimizzare un intero documento o solo le porzioni selezionate durante la visualizzazione di un’anteprima. 

La sovrapposizione delle porzioni permette di differenziare dal resto del documento le porzioni attualmente in fase di 

ottimizzazione.

Quando si attiva la sovrapposizione della porzione, le porzioni non ottimizzate non sono attive.

Visualizzare l’anteprima di un’immagine in base alle impostazioni di ottimizzazione correnti

❖ Fare clic sul pulsante Anteprima nell’angolo superiore sinistro della finestra del documento.

Nota: nel pannello Strumenti, fare clic su Nascondi porzioni  per nascondere le porzioni e le guide porzioni durante 

l’anteprima.

Confrontare impostazioni di ottimizzazione diverse

1 Fare clic sul pulsante 2 per volta o 4 per volta nell’angolo superiore sinistro della finestra del documento.

2 Fare clic su una delle anteprime vista.

3 Immettere le impostazioni nel pannello Ottimizza.

4 Selezionare le altre anteprime e specificare impostazioni di ottimizzazione diverse per ciascuna di esse.
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Scegliendo l’anteprima 2 per volta o 4 per volta, la prima vista mostra il documento originale Fireworks PNG per 

poterlo confrontare con le versioni ottimizzate. È possibile passare da questa vista alla visualizzazione di un’altra 

versione ottimizzata.

Passare da una vista ottimizzata alla visualizzazione dell’originale nell’anteprima 2 per 
volta o 4 per volta

1 Selezionare una vista ottimizzata.

2 Nel menu a comparsa Anteprima nella parte inferiore della finestra di anteprima, selezionare Originale (Nessuna 

anteprima).

Passare dalla visualizzazione dell’originale a una vista ottimizzata nella modalità 2 per volta 
o 4 per volta

1 Selezionare la vista contenente l’originale.

2 Nella finestra a comparsa Anteprima, selezionare Anteprima immagine.

Nascondere o mostrare la sovrapposizione porzione

❖ Selezionare Visualizza > Sovrapposizione porzioni.

Ottimizzare mediante un’opzione preimpostata

Scegliere Finestra > Ottimizza per aprire il pannello Ottimizza. Quando si sceglie un’opzione preimpostata, le restanti 

opzioni del pannello Ottimizza vengono impostate automaticamente. 

❖ Scegliere un’opzione preimpostata dal menu a comparsa Impostazioni nella finestra di ispezione Proprietà o nel 

pannello Ottimizza.

GIF Web 216 Forza tutti i colori come colori WebSafe. La tavolozza colori contiene fino a 216 colori.

GIF WebSnap 256 Converte i colori nel relativo colore WebSafe più simile. Questa tavolozza colori può contenere 

fino a 256 colori.

GIF WebSnap 128 Converte i colori nel relativo colore WebSafe più simile. La tavolozza colori contiene fino a 128 

colori.

GIF Adaptive 256 Contiene solo i colori utilizzati nell’elemento grafico. Questa tavolozza colori può contenere fino 

a 256 colori.

JPEG - Qualità migliore Imposta la qualità su 80 e l’attenuazione su 0, per file di qualità e dimensioni maggiori.

JPEG - File più piccoli Imposta la qualità su 60 e l’attenuazione su 2; le immagini risultanti hanno dimensioni più 

che dimezzate rispetto a JPEG - Qualità migliore, ma sono anche di qualità inferiore.

GIF Animato WebSnap 128 Imposta il formato su GIF animata e converte i colori nei colori WebSafe più simili. La 

tavolozza colori contiene fino a 128 colori.

Scegliere un tipo di file

È possibile personalizzare l’ottimizzazione selezionando uno specifico tipo di file dal menu a comparsa Formato file 

esportato, quindi impostando le opzioni specifiche per il formato, ad esempio la qualità, il dithering e la profondità di 

un colore. Le impostazioni possono essere salvate come nuove preimpostazioni.

GIF Il formato GIF (Graphics Interchange Format) è un formato grafico per il Web molto diffuso, ideale per le 

immagini di tipo cartone animato, i logo, le immagine con aree trasparenti e le animazioni. Le immagini con aree di 
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colore uniforme vengono compresse al meglio se esportate come file GIF. I file GIF contengono un massimo di 256 

colori.

JPEG Sviluppato dal Joint Photographic Experts Group specificamente per le immagini fotografiche o contenenti un 

elevato numero di colori. Questo formato supporta milioni di colori (24 bit) ed è la scelta ottimale per le fotografie 

digitalizzate, le immagini che utilizzano texture, le immagini con transizioni di colori gradiente o qualsiasi immagine 

che richieda più di 256 colori.

PNG PNG (Portable Network Graphic) è un formato grafico versatile pensato per il Web, che supporta colori fino a 

32 bit, può contenere la trasparenza o un canale alfa ed essere progressivo. Tuttavia, non tutti i browser Web possono 

visualizzare le immagini PNG. Sebbene PNG sia il formato file nativo di Fireworks, i file PNG di Fireworks contengono 

informazioni aggiuntive specifiche per l’applicazione che non vengono memorizzate in un file PNG esportato o nei file 

creati con altre applicazioni. 

WBMP WBMP (Wireless Bitmap) è un formato grafico creato per i dispositivi portatili, come telefoni cellulari e 

palmari; è utilizzato specificamente nella pagine Wireless Application Protocol (WAP). Dal momento che WBMP è 

un formato a 1 bit, sono visualizzati solo due colori: bianco e nero.

TIFF TIFF (Tagged Image File Format) è un formato grafico utilizzato per la memorizzazione delle immagini bitmap. 

I file TIFF trovano ampio impiego nella stampa per l’editoria. Inoltre, molte applicazioni multimediali accettano i file 

TIFF importati.

BMP Il formato grafico di Microsoft Windows. Molte applicazioni possono importare le immagini in formato BMP.

PICT Sviluppato da Apple Computer, utilizzato prevalentemente nei sistemi operativi Mac OS. La maggior parte delle 

applicazioni Mac sono in grado di importare le immagini PICT.

Altri argomenti presenti nell’Aiuto 

“Ottimizzare file GIF, PNG, TIFF, BMP e PICT” a pagina 241

“Ottimizzare file JPEG” a pagina 248

Salvare e riutilizzare le impostazioni di ottimizzazione

Fireworks ricorda le ultime impostazioni di ottimizzazione utilizzate per l’esecuzione delle seguenti azioni:

• File > Salva

• File > Salva con nome

• File > Esporta

Queste impostazioni vengono in seguito applicate ai nuovi documenti.

Nota: le nuove porzioni ereditano le impostazioni di ottimizzazione predefinite dal documento principale.

Le impostazioni di ottimizzazione personalizzate si possono memorizzare per riutilizzarle in futuro in altre 

operazioni di ottimizzazione o elaborazione batch. I seguenti dati vengono salvati nelle preimpostazioni di 

ottimizzazione personalizzate:

• Impostazioni e tavola colori nel pannello Ottimizza

• Impostazioni di ritardo stato definite nel pannello Stati (valide solo per le animazioni)
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Salvare le impostazioni di ottimizzazione come preimpostazioni

Le impostazioni di ottimizzazione salvate vengono visualizzate in fondo al menu a comparsa Impostazioni nel 

pannello Ottimizza e nella finestra di ispezione Proprietà. Il file di preimpostazioni viene salvato nella cartella 

Impostazioni esportazione all’interno della cartella di configurazione di Fireworks dell’utente. Per informazioni sulla 

posizione in cui è ubicata questa cartella, consultare “File di configurazione utente” a pagina 310.

1 Nel menu del pannello Ottimizza, selezionare Salva impostazioni.

2 Digitare il nome prescelto per la preimpostazione di ottimizzazione e fare clic su OK.

Condividere con un altro utente di Fireworks le impostazioni di ottimizzazione salvate 

❖ Copiare il file delle preimpostazioni di ottimizzazione della cartella Export Settings nella cartella con lo stesso nome 

su un altro computer.

Nota: la posizione di questa cartella varia a seconda del sistema operativo. 

Eliminare una preimpostazione di ottimizzazione personalizzata

Non è consentito eliminare le ottimizzazioni preimpostate fornite con Fireworks.

1 Nel menu a comparsa Impostazioni salvate del pannello Ottimizza, selezionare un’impostazione di ottimizzazione.

2 Nel menu del pannello Ottimizza, selezionare Elimina impostazioni.

Ottimizzare file GIF, PNG, TIFF, BMP e PICT

Ogni formato grafico in Fireworks dispone di un gruppo esclusivo di opzioni. I tipi di file a 8 bit quali GIF, PNG 8, 

TIFF 8, BMP 8 e PICT 8, garantiscono il massimo controllo sull’ottimizzazione.

Per gli elementi grafici Web a tono continuo, ad esempio le foto, utilizzare un formato a 24 bit quale JPEG. Consultare 

“Ottimizzare file JPEG” a pagina 248.

Le impostazioni di ottimizzazione di Fireworks sono simili per tutti i formati file grafici a 8 bit. Per i formati file per il 

Web quali GIF e PNG, è possibile specificare la quantità di compressione.

Utilizzare le anteprime 2 per volta e 4 per volta per verificare e confrontare l’aspetto e le dimensioni stimate di un file 

grafico con diverse impostazioni di ottimizzazione. 

Scelta di una tavolozza di colori

Tutte le immagini a 8 bit contengono una tavolozza di colore composta da un massimo di 256 colori. L’immagine 

utilizza solo questi colori, ma non necessariamente tutti.

❖ Nel pannello Ottimizza, selezionare una delle seguenti opzioni dal menu a comparsa Tavolozza indicizzata:

Adattata Tavolozza personalizzata derivata dai colori effettivamente presenti nel documento. Il più delle volte offre 

immagini di qualità elevata.

Adattata WebSnap Tavolozza adattata in cui i colori vengono convertiti nel colore WebSafe più simile. I colori 

WebSafe sono quelli contenuti nella tavolozza Web 216.

Web 216 Tavolozza costituita dai 216 colori comuni ai sistemi Windows e Mac OS. Questa tavolozza viene spesso 

definita WebSafe (idonea per il Web) o browser-safe, perché produce risultati uniformi su piattaforme e browser 

diversi quando è visualizzata su monitor a 8 bit. 
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Esatta Contiene esattamente i colori utilizzati nell’immagine. Solo le immagini create con un numero di colori 

inferiore o uguale a 256 possono utilizzare questo tipo di tavolozza. In caso contrario, la tavolozza diventa Adattata.

Windows e Mac OS Ognuna di queste tavolozze contiene i 256 colori definiti dagli standard della rispettiva 

piattaforma.

Scala di grigi Tavolozza composta da un massimo di 256 sfumature di grigio. Questa tavolozza converte 

l’immagine in scala di grigi.

Bianco e nero Tavolozza a due colori, composta solo dal bianco e dal nero.

Uniforme Tavolozza matematica basata sui valori pixel RGB.

Personalizzata Tavolozza modificata o caricata da una tavolozza esterna (file ACT) o da un file GIF.

È possibile ottimizzare e personalizzare le tavolozze di colori con la tavola colori del pannello Ottimizza. 

Importare una tavolozza personalizzata

1 Effettuare una delle seguenti operazioni:

• Selezionare Carica tavolozza dal menu delle opzioni del pannello Ottimizza.

• Selezionare Personalizzata dal menu a comparsa Tavolozza indicizzata del pannello Ottimizza.

2 Portarsi su un file di tavolozza ACT o GIF e fare clic su Apri.

I colori contenuti nel file ACT o GIF vengono aggiunti alla tavola colori nel pannello Ottimizza.

Nota: per visualizzare i file con estensione .gif nella finestra di dialogo Apri, gli utenti di Windows devono selezionare 

File GIF dal menu a comparsa Tipo file.

Selezionare una profondità di colore per un’immagine a 8 bit

 La profondità del colore corrisponde al numero di colori utilizzati nell’immagine. La riduzione della profondità del 

colore riduce le dimensioni del file, ma può comportare anche la riduzione della qualità dell’immagine. Quando si 

riduce la profondità del colore, alcuni colori dell’immagine vengono scartati, a partire da quelli utilizzati meno di 

frequente. I pixel contenenti i colori scartati vengono convertiti nel colore più vicino rimasto nella tavolozza.

❖ Effettuare una delle seguenti operazioni:

• Nel pannello Ottimizza, selezionare un’opzione dal menu a comparsa Colori.

• Digitare un valore (compreso tra 2 e 256) nella casella di testo.

Nota: il valore riportato in fondo alla tavola colori indica il numero effettivo di colori visibile nell’immagine. Se 

non viene visualizzato alcun numero, fare clic sul pulsante Ricostruisci.

Rimuovere i colori inutilizzati in un’immagine a 8 bit

La rimozione dei colori inutilizzati riduce le dimensioni del file. 

❖ Nel menu del pannello Ottimizza, selezionare Rimuovi colori inutilizzati.

Includere tutte le tavolozze dei colori, incluse quelle non presenti nell’immagine salvata

❖ Deselezionare Rimuovi colori inutilizzati.
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Visualizzare e modificare i colori di una tavolozza

La tavola colori del pannello Ottimizza visualizza i colori nell’anteprima corrente dell’immagine quando si lavora in 

modalità a 8 bit o inferiore. È inoltre possibile modificare la tavolozza di un’immagine. La tavola colori viene 

aggiornata automaticamente quando si è in modalità Anteprima. Appare vuota se si sta ottimizzando più di una 

porzione alla volta o se non si tratta di un formato a 8 bit.

Su alcuni campioni colore compaiono piccoli simboli che indicano determinate caratteristiche dei singoli colori, come 

segue:

Rigenerare la tavola colori in modo che rifletta tutte le modifiche del documento

Quando è necessario rigenerare la tavola, il pulsante Ricostruisci viene visualizzato nella parte inferiore del pannello 

Ottimizza.

❖ Fare clic sul pulsante Ricostruisci.

Selezionare i colori di una tavolozza

• Per selezionare un colore singolo, fare clic sul colore nella tavola colori del pannello Ottimizza. 

• Per selezionare più colori, tenere premuto il tasto Ctrl (Windows) o Comando (Mac OS) e fare clic sui colori.

• Per selezionare un intervallo di colori, fare clic su un colore, quindi tenere premuto il tasto Maiusc e fare clic 

sull’ultimo colore dell’intervallo.

Effettuare un’anteprima di tutti i pixel del documento contenente un colore specifico

1 Fare clic sul pulsante Anteprima, nell’angolo superiore sinistro della finestra del documento.

2 Fare clic e tenere premuto il pulsante del mouse su un campione colore nella tavola colori del pannello Ottimizza.

I pixel che contengono il campione colore selezionato vengono modificati temporaneamente in un colore di 

evidenziazione fino al rilascio del pulsante del mouse.

Nota: quando si effettua l’anteprima dei pixel nel documento con la vista 2 per volta o 4 per volta, selezionare una 

vista diversa da quella Originale.

Simbolo Significato

Il colore è stato modificato e la variazione incide solo sul documento esportato. Quando si modifica un colore, questo non 

viene modificato nel documento sorgente.

Il colore è bloccato.

Il colore è trasparente. 

Il colore è WebSafe (idoneo per il Web).

Il colore dispone di più attribuiti. In questo caso, il colore è WebSafe, è bloccato ed è stato modificato.
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Bloccare o sbloccare i colori di una tavolozza

È possibile bloccare i singoli colori in modo da impedirne la rimozione o la modifica quando si modificano le tavolozze 

o si riduce il numero dei colori relativi. Qualora si passi a un’altra tavolozza una volta bloccati i colori, questi ultimi 

vengono aggiunti alla nuova tavolozza.

• Per attivare il blocco per un campione colore selezionato, fare clic sul pulsante Blocca  nella parte inferiore del 

pannello Ottimizza o fare clic con il pulsante destro del mouse (Windows) o tenendo premuto il tasto Ctrl (Mac 

OS) sul campione di colore, quindi selezionare Blocca colore.

• Per sbloccare tutti i colori, selezionare Sblocca tutti i colori dal menu del pannello Ottimizza.

Modificare i colori di una tavolozza 

La modifica di un colore sostituisce tutte le istanze di tale colore nelle immagini che vengono esportate o salvate come 

bitmap. A eccezione delle bitmap, la modifica non sostituisce il color nell’immagine originale. Quando si lavora con 

una bitmap, salvare una copia dell’immagine come file PNG in modo da conservare una versione modificabile 

dell’immagine originale.

1 Aprire il selettore colore di sistema procedendo in uno dei modi seguenti:

• Selezionare un colore e fare clic sul pulsante Modifica colore  nella parte inferiore del pannello Ottimizza.

• Fare doppio clic su un colore nella tavola colori.

2 Modificare il colore.

Nota: per visualizzare le opzioni di modifica, fare clic con il pulsante destro del mouse (Windows) o tenendo premuto 

il tasto Ctrl (Mac OS) su un colore della tavolozza.

Usare colori WebSafe 

 I colori WebSafe (idonei per il Web) sono colori comuni alle piattaforme Mac OS e Windows. A questi colori non viene 

applicato il dithering quando vengono visualizzati in un browser Web sui monitor impostati per visualizzare 256 

colori. Per un file Fireworks PNG, la modifica dei colori in WebSafe nel pannello Ottimizza viene applicata solo alla 

versione esportata dell’immagine, non all’immagine stessa.

• Per imporre l’uso dei colori WebSafe, selezionare Web 216 dal menu a comparsa Tavolozza indicizzata nel pannello 

Ottimizza.

• Per creare una tavolozza adattata che favorisca l’uso dei colori WebSafe, selezionare Adattata a Web dal menu a 

comparsa Tavolozza indicizzata nel pannello Ottimizza.

• Per imporre l’uso del colore WebSafe più simile al colore selezionato, selezionare un colore nella tavola colori del 

pannello Ottimizza, quindi fare clic sul pulsante Adatta a WebSafe .

Usare il dithering per approssimare i colori mancanti nella tavolozza

Il dithering consente di approssimare i colori non contenuti nella tavolozza corrente alternando pixel di colori simili. 

Da una certa distanza, i colori si fondono per assumere l’aspetto del colore mancante. Il dithering risulta 

particolarmente efficace per l’esportazione di fusioni o gradienti complessi o se si esportano immagini fotografiche in 

un formato a 8 bit, quale il GIF.

❖ Immettere un valore percentuale nel campo di testo Dithering del pannello Ottimizza.

Nota: il dithering può aumentare notevolmente le dimensioni dei file.
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Salvare le tavolozze di colori

È possibile salvare le tavolozze dei colori come file di tavolozza esterni utilizzabili con altri documenti di Fireworks o 

in altre applicazioni che supportano file di tavolozza esterni come Adobe Flash® e Adobe Photoshop®.  I file di tavolozza 

salvati hanno l’estensione .act.

1 Nel menu del pannello Ottimizza, selezionare Salva tavolozza.

2 Digitare un nome e scegliere la cartella di destinazione.

3 Fare clic su Salva.

Il file della tavolozza memorizzata potrà essere caricato nel pannello Campioni colore o nel pannello Ottimizza e 

utilizzato per l’esportazione di altri documenti.

Regolare la compressione

I file GIF possono essere compressi modificandone le impostazioni di perdita. A impostazioni di perdita maggiori 

corrispondono file di dimensioni minori ma anche una minore qualità delle immagini. Generalmente, l’impostazione 

ottimale è compresa tra 5 e 15.

GIF originale (a sinistra); perdita impostata su 30 (al centro); perdita impostata su 100 (a destra)

❖ Nel pannello Ottimizza, immettere un’impostazione per Perdita.

Rendere trasparenti le aree

Le aree trasparenti nei file GIF e PNG a 8 bit consentono la visualizzazione dello sfondo di una pagina Web attraverso 

le aree stesse. In Fireworks, una scacchiera grigia e bianca nella finestra del documento identifica le aree trasparenti.

Anteprima immagini ottimizzate in Fireworks (a sinistra); immagine esportata con trasparenza e inserita in una pagina Web con sfondo 
colorato (a destra)

Nota: sebbene i file PNG a 32 bit contengano trasparenza, il pannello Ottimizza non ha un’opzione di trasparenza 

applicabile ad essi.

Per le immagini GIF, utilizzare la trasparenza indice, che attiva o disattiva i pixel con valori di colore specifici.

Per impostazione predefinita, le immagini GIF sono esportate senza trasparenza. Anche se l’area di lavoro dietro 

un’immagine o oggetto appare trasparente nella vista Originale di Fireworks, lo sfondo dell’immagine potrebbe non 

essere trasparente a meno che non si selezioni Trasparenza indice prima dell’esportazione.
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Per i file PNG, è possibile utilizzare la trasparenza alfa, spesso utilizzata negli elementi grafici esportati contenenti 

trasparenza a gradiente e pixel semiopachi. Sebbene la trasparenza non sia molto utile per esportare nel Web (in 

quanto la maggior parte dei browser Web non supporta il formato PNG), è utile per l’esportazione in Flash o Adobe 

Director, applicazioni che supportano questo tipo di trasparenza.

Nota: l’impostazione dei colori come trasparenti non incide sull’immagine effettiva, ma solo sulla versione esportata di 

quest’ultima. L’aspetto definitivo dell’immagine esportata è visibile nell’anteprima. 

Altri argomenti presenti nell’Aiuto 

“Esportare dallo spazio di lavoro” a pagina 249

Rendere trasparente lo sfondo di un’immagine

1 Fare clic sul pulsante Anteprima, 2 per volta o 4 per volta, nell’angolo superiore sinistro della finestra del 

documento. In 2 per volta o 4 per volta, fare clic su una vista diversa dall’originale.

2 Nel pannello Ottimizza (Finestra > Ottimizza), selezionare il formato file GIF o PNG 8. Quindi selezionare 

Trasparenza indice dal menu a comparsa Sceglie il tipo di trasparenza.

Il colore dell’area di lavoro viene reso trasparente nell’anteprima e l’elemento grafico è pronto per l’esportazione.

Selezionare un colore per la trasparenza

1 Fare clic sul pulsante Anteprima, 2 per volta o 4 per volta, nell’angolo superiore sinistro della finestra del 

documento. In 2 per volta o 4 per volta, fare clic su una vista diversa dall’originale.

2 Nel pannello Ottimizza (Finestra > Ottimizza), selezionare il formato file GIF o PNG 8. Quindi selezionare 

Trasparenza indice dal menu a comparsa Sceglie il tipo di trasparenza.

3 Per scegliere un colore diverso, fare clic sul pulsante Imposta trasparenza .

4 Fare clic su un campione di colore nella tavola colore del pannello Ottimizza o su un colore del documento.

Aggiungere o rimuovere i colori trasparenti

1 Fare clic sul pulsante Anteprima, 2 per volta o 4 per volta, nell’angolo superiore sinistro della finestra del 

documento. In 2 per volta o 4 per volta, fare clic su una vista diversa dall’originale.

Nota: è possibile aggiungere o rimuovere colori trasparenti nella vista Originale, ma i risultati non saranno disponibili 

fino a quando non viene visualizzata un’anteprima.

2 Nel pannello Ottimizza (Finestra > Ottimizza), selezionare il formato file GIF o PNG 8. Quindi selezionare 

Trasparenza indice dal menu a comparsa Sceglie il tipo di trasparenza.

3 Nella parte inferiore del pannello, fare clic sul pulsante Aggiunge colore alla trasparenza  o Rimuove colore 

dalla trasparenza .

4 Fare clic su un campione nella tavola colore o su un colore del documento.

Interlacciare le immagini per il download graduale

In un browser Web, le immagini interlacciate vengono visualizzate inizialmente con una risoluzione inferiore e quindi, 

al termine del download, con la risoluzione completa.

Nota: questa opzione è disponibile solo per i formati GIF e PNG. È possibile ottenere risultati simili con il formato JPEG 

rendendolo progressivo.

❖ Nel menu del pannello Ottimizza, selezionare Interlacciato.
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Abbinare il colore allo sfondo di destinazione

L’antialiasing conferisce a un oggetto un aspetto più attenuato fondendone i colori sullo sfondo. Ad esempio, se 

l’oggetto è nero e la pagina su cui si trova è bianca, l’antialiasing aggiunge diverse sfumature di grigio ai pixel intorno 

al bordo dell’oggetto per creare una transizione più graduale tra il nero e il bianco.

❖ Nel pannello Ottimizza, selezionare un colore dall’elemento a comparsa Effetto mat. Farlo corrispondere meglio 

possibile al colore dello sfondo della pagina in cui verrà inserito l’elemento grafico.

Nota: l’antialiasing viene applicato solo agli oggetti dai bordi morbidi posizionati direttamente sull’area di lavoro.

Rimuovere gli aloni

Se si rende trasparente il colore dell’area di lavoro per un’immagine alla quale è stato precedentemente applicato 

l’antialiasing, i pixel dell’antialiasing vengono mantenuti. Quando poi si esporta o si salva l’immagine e la si inserisce 

in una pagina Web con uno sfondo di colore diverso, i pixel intorno all’oggetto a cui è stato applicato l’antialiasing 

possono risultare come aloni, particolarmente visibili su uno sfondo scuro.

Impedire la formazione di aloni nei file PNG di Fireworks e nei file di Photoshop importati

❖ Effettuare una delle seguenti operazioni:

• Impostare il colore dell’area di lavoro nella finestra di ispezione Proprietà o il colore dell’effetto mat nel pannello 

Ottimizza sul colore dello sfondo della pagina Web di destinazione.

• Con l’oggetto da esportare selezionato, selezionare Rigido dal menu a comparsa Bordo nella finestra di ispezione 

Proprietà.

Rimuovere un alone manualmente da un file GIF o da un altro file grafico

1 Con il file aperto in Fireworks, fare clic sul pulsante Anteprima, 2 per volta o 4 per volta nell’angolo superiore 

sinistro della finestra del documento. In 2 per volta o 4 per volta, fare clic su una vista diversa dall’originale.

2 Selezionare Trasparenza indice dal menu a comparsa Trasparenza del pannello Ottimizza.

3 Fare clic sul pulsante Aggiunge colore alla trasparenza , quindi su un pixel nell’alone.

Tutti i pixel dello stesso colore vengono rimossi nell’anteprima.

4 Se l’alone è ancora presente, ripetere il passaggio 3 finché non scompare.
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Ottimizzare file JPEG

Il pannello Ottimizza consente di ottimizzare i file JPEG impostando le opzioni di compressione e attenuazione.

I file JPEG vengono sempre salvati ed esportati con profondità di colore a 24 bit, quindi non è possibile ottimizzarli 

modificandone la tavolozza colori. Quando si seleziona un’immagine JPEG, la tavola colori è vuota.

Utilizzare i pulsanti 2 per volta e 4 per volta per verificare e confrontare l’aspetto e le dimensioni stimate di un file JPEG 

con diverse impostazioni di ottimizzazione. 

Nota: i file JPEG possono essere salvati direttamente dalla finestra di dialogo “Salva con nome”. 

Regolare la qualità JPEG

Il JPEG è un formato con perdita: durante la compressione vengono infatti scartati alcuni dati dell’immagine, a scapito 

della qualità del file finale. 

Immagine originale; impostazione di qualità di 50; impostazione di qualità di 20

❖ Regolare la qualità con il dispositivo di scorrimento del menu a comparsa Qualità nel pannello Ottimizza.

Un’impostazione percentuale maggiore consente di mantenere la qualità dell’immagine ma genera file di dimensioni 

superiori. 

Un’impostazione inferiore genera file di dimensioni ridotte, ma riduce anche la qualità dell’immagine.

Comprimere in modo selettivo le aree di un file JPEG 

Per ridurre le dimensioni complessive dell’immagine conservando la qualità delle aree più importanti, comprimere le 

aree più significative a un livello qualitativo superiore e quelle meno significative, come gli sfondi, a un livello 

qualitativo inferiore. 

L’area selezionata nell’immagine viene compressa a un livello di qualità di 90, mentre l’area non selezionata viene compressa al valore 50.

1 Nella vista Originale, con uno strumento Perimetro di selezione, selezionare l’area da comprimere dell’elemento 

grafico.

2 Selezionare Elabora > JPEG selettivo > Salva selezione come maschera JPEG.
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3 Nel pannello Ottimizza, selezionare JPEG dal menu a comparsa Formato file esportato.

4 Fare clic sul pulsante Modifica opzioni Qualità selettiva nel pannello Ottimizza. 

5 Selezionare Attiva Qualità selettiva e immettere un valore nella casella di testo.

Un valore basso comprime l’area selezionata in misura maggiore rispetto al resto dell’immagine; un valore elevato 

la comprime in misura minore rispetto al resto dell’immagine.

6 (Facoltativo) Modificare il colore di sovrapposizione per l’area JPEG selettiva. Questa operazione non incide 

sull’output.

7 Per esportare tutti gli elementi del testo su un livello superiore indipendentemente dal valore selezionato per la 

qualità selettiva, selezionare Conserva qualità testo. 

8 Per esportare i simboli dei pulsanti con un livello di qualità migliore, selezionare Conserva qualità pulsante.

Modificare l’area di compressione JPEG selettiva

1 Selezionare Modifica > JPEG selettivo > Ripristina maschera JPEG come selezione.

2 Con lo strumento Perimetro di selezione o un altro strumento di selezione, modificare le dimensioni dell’area. 

3 Selezionare Elabora > JPEG selettivo > Salva selezione come maschera JPEG.

4 (Facoltativo) Modificare le impostazioni per la qualità selettiva nel pannello Ottimizza.

Nota: per annullare una selezione, selezionare Elabora > JPEG selettivo > Rimuovi maschera JPEG.

Sfocare o aumentare la nitidezza di un dettaglio JPEG

La sfocatura attenua i bordi netti, che solitamente non vengono compressi in modo ottimale nei file JPEG. A valori più 

elevati corrisponde una maggiore sfocatura nel file JPEG esportato o salvato e in genere file di dimensioni minori. 

Un’impostazione di attenuazione pari a 3 riduce la dimensione del file, mantenendo al contempo livelli di qualità 

accettabili. 

Inoltre, scegliendo Precisione bordi JPEG quando si esportano o si salvano file JPEG contenenti testo o piccoli 

particolari, è possibile mantenere la nitidezza di tali elementi. Questa impostazione aumenta la dimensione del file.

Effettuare una delle seguenti operazioni:

• Per sfocare un dettaglio, impostare Attenuazione nel pannello Ottimizza.

• Per aumentare la nitidezza di un dettaglio, selezionare Precisione bordi JPEG dal menu a comparsa Opzioni del 

pannello Ottimizza.

Creare un’immagine JPEG progressiva

I file JPEG progressivi, come i file PNG e i file GIF interlacciati, vengono inizialmente visualizzati a una risoluzione 

inferiore, con un miglioramento della qualità mano a mano che prosegue lo scaricamento.

❖ Nel menu del pannello Ottimizza, selezionare JPEG progressivo.

Nota: le applicazioni di modifica immagini bitmap più datate non consentono di aprire i file JPEG progressivi.

Esportare dallo spazio di lavoro

Dopo averlo ottimizzato, è possibile esportare l’elemento grafico o il documento, oppure salvarlo, a seconda del tipo 

di file originale. 
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È possibile esportare o, in alcuni casi, salvare i documenti come immagine singola in formato GIF, JPEG o in un altro 

formato grafico. È inoltre possibile esportare l’intero documento come file HTML e relativi file immagine associati, 

solo le porzioni selezionate o un’area specificata. Inoltre, si possono esportare gli stati e i livelli di Fireworks come file 

di immagini separati.

La posizione predefinita in cui Fireworks esporta i file viene stabilita in base ai seguenti elementi, nell’ordine:

1 La preferenza di esportazione corrente del documento, che è impostata se in passato il documento è stato esportato 

e poi salvato nel formato PNG

2 La posizione di esportazione o salvataggio corrente, che viene impostata ogni volta che ci si sposta dalla posizione 

predefinita offerta nelle finestre di dialogo Salva, Salva con nome o Esporta

3 La posizione del file corrente

4 La posizione predefinita in cui vengono salvati i nuovi documenti o le nuove immagini nel sistema operativo in uso

La posizione predefinita in cui Fireworks salva i documenti viene invece stabilita con criteri diversi. Per ulteriori 

informazioni, consultare “Salvataggio dei file di Fireworks” a pagina 11. 

Esportare pagine come file di immagine

1 Selezionare File > Esporta.

2 Scegliere la posizione per i file da esportare.

3 Effettuare una delle seguenti operazioni:

• Nel menu a comparsa Esporta, selezionare Solo immagini, quindi selezionare o deselezionare la casella di 

controllo Solo pagina corrente. Le pagine vengono esportate con il formato immagine impostato nel pannello 

Ottimizza.

• Nel menu a comparsa Esporta, selezionare Pagine in file, quindi selezionare Immagini dal menu a comparsa 

Esporta come. Le pagine vengono esportate con il formato immagine impostato nel pannello Ottimizza.

• Selezionare Pagine in file dal menu a comparsa Esporta e selezionare PNG Fireworks dal menu a comparsa 

Esporta come. Ogni pagina viene esportata come file PNG separato, compatibile con Fireworks 8.

Nota: se si desidera esportare tutte le pagine nel formato selezionato, selezionare tutte le pagine e ottimizzare le 

impostazioni.

Esportare un’immagine singola

Se si lavora con un’immagine esistente aperta in Fireworks, è possibile salvarla invece che esportarla. Per ulteriori 

informazioni, consultare “Salvare i documenti in altri formati” a pagina 12. 

Nota: per esportare solo immagini specifiche da un documento, occorre prima suddividerlo in porzioni e poi esportare 

solo le porzioni desiderate. 

1 Nel pannello Ottimizza, selezionare un formato file e impostare le opzioni specifiche per il formato.

2 Selezionare File > Esporta.

3 Scegliere la posizione di esportazione del file.

Per gli elementi grafici per il Web, la migliore posizione è una cartella nel proprio sito Web.

4 Immettere un nome file privo di estensione. L’estensione viene aggiunta durante l’esportazione in base al tipo di file.

5 Nel menu a comparsa Esporta, selezionare Solo immagini. 

6 Fare clic su Salva.
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Esportare un documento suddiviso in porzioni

Per impostazione predefinita, quando si esporta un documento di Fireworks suddiviso in porzioni, questo viene 

esportato come file HTML con le immagini associate. Il file HTML esportato può essere visualizzato in un browser o 

importato in altre applicazioni per ulteriori modifiche.

Prima dell’esportazione, accertarsi di avere selezionato lo stile HTML appropriato nella finestra di dialogo 

Impostazioni HTML. Consultare “Impostare le opzioni di esportazione HTML” a pagina 258.

Esportare tutte le porzioni

1 Selezionare File > Esporta.

2 Accedere alla cartella sul disco rigido in cui si desidera effettuare l’esportazione.

3 Nel menu a comparsa Esporta, selezionare HTML e immagini.

4 Digitare un nome file nella casella Nome file (Windows) o Salva con nome (Mac OS).

5 Nel menu a comparsa HTML, selezionare Esporta file HTML.

6 Nel menu a comparsa Porzioni, selezionare Esporta porzioni.

7 (Facoltativo) Selezionare Inserisci immagine nella sottocartella.

8 Fare clic su Salva.

Esportare le porzioni selezionate

1 Fare clic tenendo contemporaneamente premuto il tasto Maiusc per selezionare più porzioni.

2 Selezionare File > Esporta.

3 Selezionare la posizione in cui memorizzare i file esportati, ad esempio una cartella nel proprio sito Web.

4 Nel menu a comparsa Esporta, selezionare HTML e immagini.

5 Immettere un nome file privo di estensione. L’estensione viene aggiunta durante l’esportazione in base al tipo di file.

Se si esportano più porzioni, Fireworks usa il nome immesso come nome principale per tutte le immagini esportate, 

escluse quelle alle quali sono stati assegnati nomi personalizzati utilizzando il pannello Livelli o la finestra di 

ispezione Proprietà.

6 Nel menu a comparsa Porzioni, selezionare Esporta porzioni.

7 Per esportare solo le porzioni selezionate prima dell’esportazione, scegliere Solo porzioni selezionate e accertarsi 

che non sia selezionata l’opzione Includi aree senza porzioni.

8 Fare clic su Salva.

Aggiornare una porzione

Se è stato già esportato un documento suddiviso in porzioni e successivamente sono state apportate modifiche al 

documento originale di Fireworks, è possibile aggiornare solo l’immagine o porzione modificata. Per semplificare 

l’individuazione della porzione di ricambio, assegnare alle porzioni nomi personalizzati. 

1 Nascondere la porzione e modificare l’area sottostante.

2 Visualizzare di nuovo la porzione.

3 Fare clic con il pulsante destro del mouse (Windows) o tenendo premuto il tasto Ctrl (Mac OS) e scegliere Esporta 

porzione selezionata.

4 Selezionare la stessa cartella della porzione originale con lo stesso nome di base e fare clic su Salva.
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5 Fare clic su OK quando il sistema richiede se sostituire il file esistente.

Nota: evitare di ridimensionare la porzione oltre le sue dimensioni di esportazione originali in Fireworks, altrimenti 

si potrebbero produrre risultati imprevisti nel documento HTML una volta aggiornata la porzione.

Esportare un’animazione

Una volta creata e ottimizzata, l’animazione è pronta per l’esportazione. Un’animazione può essere esportata in uno 

dei seguenti formati:

GIF animate Offrono i migliori risultati per le clipart e le immagini di qualità affini ai cartoni animati. 

Flash SWF o Fireworks PNG (non è necessaria l’esportazione) Esporta un’animazione come file SWF da importare in 

Flash. In alternativa, salta la procedura di esportazione importando un file sorgente PNG di Fireworks direttamente in 

Flash. Questo metodo diretto consente di importare tutti i livelli e gli stati dell’animazione per poi apportarvi ulteriori 

modifiche in Flash. Consultare “Operazioni con Flash” a pagina 272.

File multipli L’esportazione di livelli o stati di animazione come file multipli risulta utile quando si hanno più simboli 

su diversi livelli per lo stesso oggetto. Ad esempio, si può esportare un banner pubblicitario su più file se ogni lettera 

del nome di una società viene animata in un singolo elemento grafico. Consultare “Esportare gli stati o i livelli come 

file multipli” a pagina 252.

Se il documento contiene più di un’animazione, è possibile inserire le porzioni su ogni animazione per esportare 

ognuna con impostazioni di animazione diverse, come ripetizione continua e ritardo stati. 

Esportare un’immagine GIF animata

1 Scegliere Seleziona > Deseleziona per deselezionare tutte le porzioni e gli oggetti, quindi selezionare GIF animata 

come formato nel pannello Ottimizza.

2 Selezionare File > Esporta.

3 Immettere un nome per il file e selezionare la destinazione.

4 Fare clic su Salva.

Esportare più immagini GIF animate con diverse impostazioni di animazione

1 Fare clic tenendo contemporaneamente premuto il tasto Maiusc sulle animazioni per selezionarle tutte.

2 Selezionare Modifica > Inserisci > Porzione rettangolare o Porzione poligonale. 

3 Nella finestra del messaggio, fare clic su Multipli.

4 Selezionare ogni porzione singolarmente e utilizzare il pannello Stati per definire impostazioni di animazione 

diverse per ciascuna.

5 Selezionare tutte le porzioni da animare e selezionare GIF animata come formato nel pannello Ottimizza.

6 Per esportare le singole porzioni separatamente, fare clic su ogni porzione con il pulsante destro del mouse 

(Windows) o tenendo premuto il tasto Ctrl (Mac OS) e scegliere Esporta porzione selezionata. Nella finestra di 

dialogo Esporta, digitare un nome per il file, scegliere la destinazione e fare clic su Salva.

Esportare gli stati o i livelli come file multipli

Fireworks è in grado di esportare ogni livello o stato in un documento come file di immagine separato, utilizzando le 

impostazioni di ottimizzazione specificate nel pannello Ottimizza. È il nome del livello o dello stato a determinare il 

nome di ciascun file esportato. Questo metodo di esportazione viene talvolta utilizzato per esportare le animazioni.

1 Selezionare File > Esporta.
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2 Digitare un nome di file e scegliere la cartella di destinazione.

3 Nel menu a comparsa Esporta, scegliere un’opzione:

Stati su file Esporta gli stati come più file.

Livelli su file Esporta livelli come più file.

Nota: in questo modo tutti i livelli vengono esportati sullo stato corrente.

4 Per ritagliare automaticamente ogni immagine esportata in modo che includa solo gli oggetti di ciascuno stato, 

selezionare Ritaglia immagini. Per includere l’intera area di lavoro (incluse le aree vuote oltre gli oggetti), 

deselezionare questa opzione.

5 Fare clic su Salva.

Esportare un’area da un documento

1 Nel pannello Strumenti, selezionare lo strumento Area di esportazione .

2 Trascinare un perimetro di selezione che definisca la parte del documento da esportare.

Nota: è possibile regolare la posizione del perimetro di selezione durante il trascinamento. Tenendo premuto il 

pulsante del mouse, tenere premuta la barra spaziatrice, quindi trascinare il perimetro di selezione in un altro punto 

dell’area di lavoro. Rilasciare la barra spaziatrice per continuare a disegnare il perimetro di selezione.

Quando si rilascia il pulsante del mouse, l’area di esportazione rimane selezionata.

3 Ridimensionare l’area di esportazione come richiesto: 

• Per ridimensionare il perimetro dell’area di esportazione in modo proporzionale, trascinare una maniglia 

tenendo premuto il tasto Maiusc.

• Per ridimensionare il perimetro dal centro, trascinare una maniglia tenendo premuto il tasto Alt (Windows) o 

Opzione (Mac OS).

• Per vincolare le proporzioni e ridimensionare dal centro, trascinare una maniglia tenendo premuto il tasto Alt-

Maiusc (Windows) o Opzione-Maiusc (Mac OS).

4 Per passare ad Anteprima immagine, fare doppio clic all’interno del perimetro dell’area di esportazione.

5 Regolare le impostazioni in Anteprima immagine, quindi fare clic su Esporta.

6 Digitare un nome di file e scegliere la cartella di destinazione.

7 Dal menu a comparsa Esporta, selezionare Solo immagini.

8 Fare clic su Salva.

Nota: per annullare l’operazione senza esportare, fare doppio clic al di fuori del perimetro di selezione dell’area di 

esportazione, premere Esc o scegliere un altro strumento. 

Esportazione del codice HTML

Se non specificato altrimenti, quando si esporta un documento di Fireworks suddiviso in porzioni si esporta un file 

HTML con le relative immagini. Per definire le modalità di esportazione del codice HTML di Fireworks, utilizzare la 

finestra di dialogo Impostazioni HTML. 

Fireworks genera codice HTML puro, leggibile dalla maggior parte dei browser e degli editor HTML. Per impostazione 

predefinita, l’esportazione specifica la crittografia UTF-8.
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Sono disponibili diversi metodi di esportazione HTML da Fireworks:

• Esportare un file HTML, apribile in un secondo momento per la modifica in un editor HTML.

• Esportare ogni pagina in un file di Fireworks come file HTML separato.

• Copiare il codice HTML negli Appunti da Fireworks, poi incollarlo direttamente in un documento HTML 

preesistente.

• Esportare un file HTML, aprirlo in un editor HTML, copiare manualmente sezioni del codice dal file, quindi 

incollare tale codice in un altro documento HTML.

• Esportare l’HTML sotto forma di livelli CSS (Cascading Style Sheet) e XHTML.

• Utilizzare il comando Aggiorna HTML per apportare modifiche ai file HTML creati in precedenza.

Fireworks consente di esportare il codice HTML in formato Generico, Dreamweaver, Microsoft® FrontPage® e 

Adobe GoLive®.

Nota: Adobe Dreamweaver è strettamente integrato con Fireworks. Fireworks gestisce l’esportazione di HTML per 

Dreamweaver in modo diverso dall’esportazione per altri editor HTML. Se si esporta HTML di Fireworks per 

Dreamweaver, consultare “Operazioni con Dreamweaver” a pagina 262.

Il metodo di esportazione per trasferire il codice HTML di Fireworks in altre applicazioni rappresenta la soluzione 

ideale per i gruppi di lavoro. Questo metodo segmenta il flusso di lavoro, consentendo a un utente di eseguire 

un’operazione in un’applicazione che verrà poi ripresa in un secondo momento da un altro utente in un’altra 

applicazione.

Includere i commenti nel codice HTML esportato

I commenti HTML di Fireworks iniziano con <!-- e terminano con -->. Tutto ciò che è compreso tra questi due 

marcatori non viene interpretato come codice HTML o JavaScript.

❖ Prima dell’esportazione, selezionare l’opzione Includi commenti HTML nella scheda Generali della finestra di 

dialogo Impostazioni HTML.

Risultati dell’esportazione

Durante l’esportazione o la copia di HTML da Fireworks, vengono generati i seguenti elementi:

• Il codice HTML necessario a riassemblare le immagini suddivise in porzioni e il codice JavaScript, se il documento 

contiene elementi interattivi. Il codice HTML generato da Fireworks contiene collegamenti alle immagini esportate 

e imposta il colore di sfondo della pagina Web sul colore dell’area di lavoro.

• Uno o più file di immagini a seconda del numero di porzioni presenti nel documento e degli stati inclusi nei 

pulsanti.

• Un file denominato spacer.gif, se necessario. Questo è un file GIF trasparente da 1 pixel per 1 pixel che Fireworks 

utilizza per correggere problemi di spaziatura quando le immagini suddivise in porzioni vengono riassemblate in 

una tabella HTML. È possibile indicare se tale elemento deve essere esportato o meno.

• Nel caso di esportazione di menu a comparsa, vengono esportati i seguenti file: mm_css_menu.js e un file .css 

contenente il codice del menu a comparsa CSS. Se i menu a comparsa contengono sottomenu, viene esportato 

anche il file arrows.gif.

• Se si esporta o si copia il codice HTML in Dreamweaver, vengono creati file di note che facilitano l’integrazione tra 

Fireworks e Dreamweaver. Questi file hanno l’estensione .mno.

Esportare HTML di Fireworks

1 Selezionare File > Esporta. 
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2 Accedere alla cartella sul disco rigido in cui si desidera effettuare l’esportazione.

3 Nel menu a comparsa Esporta, selezionare HTML e immagini.

4 Fare clic sul pulsante Opzioni e selezionare l’editor HTML dal menu a comparsa Stile HTML nella scheda Generali 

della finestra di dialogo Impostazioni HTML. Se l’editor HTML in uso non è elencato, selezionare Generico.

Nota: è importante selezionare l’editor HTML in uso come stile HTML, in modo che gli elementi interattivi come i 

pulsanti e i rollover funzionino correttamente una volta importati nell’editor HTML.

5 Fare clic su OK.

6 Nel menu a comparsa HTML, selezionare Esporta file HTML. 

7 Se il documento contiene porzioni, selezionare Esporta porzioni dal menu a comparsa Porzioni.

8 Per memorizzare le immagini in una cartella separata, selezionare Inserisci immagine nella sottocartella. È possibile 

selezionare una cartella specifica o utilizzare la cartella predefinita delle immagini di Fireworks.

9 Se si esporta un documento Fireworks composto da più pagine, deselezionare la casella di controllo Solo pagina 

corrente per esportare tutte le pagine in documenti HTML separati.

10 Fare clic su Salva.

Dopo l’esportazione, i file esportati di Fireworks compaiono sul disco rigido. Le immagini e il file HTML sono 

generati nella posizione specificata nella finestra di dialogo Esporta.

Copiare il codice HTML negli Appunti

Il codice HTML di Fireworks può essere copiato in due modi. Si può usare il comando Copia codice HTML, oppure 

scegliere l’opzione Copia negli Appunti nella finestra di dialogo Esporta. Si potrà poi incollare questo codice HTML 

nel documento utilizzando l’editor HTML preferito.

Quando si stabilisce la modalità di inserimento dell’HTML di Fireworks in altre applicazioni, è necessario prendere in 

considerazione i seguenti svantaggi derivanti dalla copia del codice HTML negli Appunti:

• Non è possibile salvare le immagini in una sottocartella. Le immagini devono trovarsi nella stessa cartella del file in 

cui è stato incollato l’HTML copiato. Il codice HTML copiato in Dreamweaver costituisce un’eccezione.

• Tutti i collegamenti o i percorsi utilizzati nei menu a comparsa di Fireworks vengono mappati sul disco rigido. Il 

codice HTML copiato in Dreamweaver costituisce un’eccezione.

• Se si utilizza un editor HTML diverso da Dreamweaver o Microsoft FrontPage, il codice JavaScript associato a 

pulsanti, comportamenti e immagini rollover viene copiato, ma potrebbe non funzionare correttamente.

Se queste condizioni rappresentano un problema, si consiglia di utilizzare l’opzione Esporta HTML anziché copiare 

il codice HTML negli Appunti.

Nota: prima di copiare il codice HTML, accertarsi di avere selezionato lo stile HTML appropriato e l’opzione Includi 

commenti HTML nella scheda Generali della finestra di dialogo Impostazioni HTML.

Copiare HTML di Fireworks mediante l’opzione Copia codice HTML

1 Selezionare Modifica > Copia codice HTML.

2 Seguire la procedura guidata di autocomposizione. Quando richiesto, specificare la cartella di destinazione per le 

immagini esportate; deve trattarsi della posizione in cui risiederà il file HTML.

Nota: se si prevede di incollare il codice HTML in Dreamweaver, non è importante dove vengono esportate le 

immagini, purché risiedano nello stesso sito Dreamweaver del file HTML in cui si incollerà il codice.
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Copiare il codice HTML generato da Fireworks utilizzando la finestra di dialogo Esporta

1 Selezionare File > Esporta.

2 Nella finestra di dialogo Esporta, specificare una cartella come destinazione per le immagini esportate; deve trattarsi 

della stessa posizione in cui risiederà il file HTML.

Nota: se si prevede di incollare il codice HTML in Dreamweaver, non è importante dove vengono esportate le 

immagini, purché risiedano nello stesso sito Dreamweaver del file HTML in cui si incollerà il codice.

3 Nel menu a comparsa Esporta, selezionare HTML e immagini.

4 Nel menu a comparsa HTML, selezionare Copia negli Appunti.

5 Se il documento contiene porzioni, selezionare Esporta porzioni dal menu a comparsa Porzioni.

6 Fare clic sul pulsante Opzioni, selezionare l’editor HTML nella finestra di dialogo Impostazioni HTML e fare clic 

su OK.

7 Fare clic su Salva.

Incollare il codice HTML copiato da Fireworks in un documento HTML

1 Nell’editor HTML scelto, aprire un documento HTML esistente oppure crearne uno nuovo. Salvare il documento 

nella stessa posizione in cui si sono esportate le immagini.

Nota: se si utilizza Dreamweaver, non è necessario salvare il file HTML nella stessa posizione delle immagini 

esportate. Inoltre, se si esportano le immagini da Fireworks a un sito Dreamweaver e si salva il file HTML in una 

posizione al suo interno, Dreamweaver risolve i percorsi delle immagini associate.

2 Visualizzare il codice HTML e collocare il punto di inserimento tra i tag <BODY>.

Nota: il codice HTML copiato da Fireworks non include i tag di apertura e chiusura <HTML> e <BODY>.

3 Incollare il codice HTML. 

Se possibile, quando si esegue la copia negli Appunti, esportare le immagini nella posizione dove risiederanno nel 

sito Web. Fireworks usa gli URL relativi, quindi se si spostano l’HTML o le immagini, i collegamenti URL vengono 

interrotti.

Copiare il codice da un file di Fireworks esportato e incollarlo in un altro documento HTML

1 Aprire il codice HTML di Fireworks esportato in un editor HTML.

2 Evidenziare il codice necessario e copiarlo negli Appunti.

3 Aprire un documento HTML esistente oppure crearne uno nuovo.

4 Incollare il codice nel nuovo file HTML. Non è necessario copiare i tag <HTML> e <BODY>, in quanto dovrebbero 

essere già presenti nel documento HTML di destinazione. 

Se è stata selezionata l’opzione Includi commenti HTML nella finestra di dialogo Impostazioni HTML di 

Fireworks, seguire le istruzioni nei commenti per copiare e incollare il codice nella corretta posizione.

5 Se il documento di Fireworks contiene elementi interattivi, copiare il codice JavaScript. 

Il codice JavaScript è delimitato da tag <SCRIPT> e si trova nella sezione <HEAD> del documento. Copiare e incollare 

l’intera sezione <SCRIPT>, a meno che il documento di destinazione non contenga già una sezione <SCRIPT>. In 

questo caso, copiare e incollare solo il contenuto della sezione <SCRIPT> nella sezione <SCRIPT> esistente, facendo 

attenzione a non sovrascrivere il contenuto della sezione esistente. Inoltre verificare che, una volta incollato il 

codice, la sezione <SCRIPT> non contenga funzioni JavaScript duplicate.
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Aggiornare HTML esportati 

L’aggiornamento consente di apportare modifiche a un documento di Fireworks HTML precedentemente esportato 

ed è utile se si desidera aggiornare solo una sezione del documento. 

Nota: il comando Aggiorna HTML funziona in modo diverso nei documenti di Dreamweaver rispetto ad altri documenti 

HTML. Per ulteriori informazioni, consultare “Operazioni con Dreamweaver” a pagina 262.

Durante l’aggiornamento, si può scegliere se sostituire solo le immagini modificate oppure sovrascrivere codice e 

immagini. Se si decide di sostituire solo le immagini cambiate, le modifiche apportate al file HTML fuori da Fireworks 

vengono conservate.

Nota: in caso di modifiche di notevole entità al layout del documento, apportare le modifiche in Fireworks, quindi 

riesportare il file HTML.

1 Selezionare File > Aggiorna HTML. 

2 Selezionare il file da aggiornare. 

3 Fare clic su Apri.

4 Effettuare una delle seguenti operazioni:

• Se non si reperisce nessun HTML generato da Fireworks, fare clic su OK per inserire il nuovo HTML al termine 

del documento.

• Se invece viene reperito un file generato da Fireworks, scegliere una delle opzioni seguenti e fare clic su OK:

Sostituzione immagini e del loro HTML Sostituisce il codice HTML precedente di Fireworks.

Aggiorna le sole immagini Sovrascrive solo le immagini.

5 Se compare la finestra di dialogo Seleziona cartella immagini, scegliere una cartella e fare clic su Apri.

Esportare livelli CSS

I livelli CSS possono essere sovrapposti l’uno sull’altro. In Fireworks, il normale output HTML non supporta la 

sovrapposizione.

1 Selezionare File > Esporta.

2 Digitare un nome di file e scegliere la cartella di destinazione. 

3 Nel menu a comparsa Esporta, selezionare CSS e immagini.

• Per esportare solo lo stato corrente, selezionare Solo stato corrente.

• Per esportare solo la pagina corrente, selezionare Solo pagina corrente.

• Per scegliere una cartella per le immagini, selezionare Inserisci immagine nella sottocartella.

4 Fare clic su Opzioni per impostare le proprietà di pagina HTML.

5 Fare clic su Sfoglia per specificare un’immagine di sfondo e impostarne le opzioni di ripetizione:

• Selezionare Non ripetere per visualizzare l’immagine una sola volta.

• Selezionare Ripeti per ripetere (affiancare) l’immagine in orizzontale e in verticale.

• Selezionare Ripeti-x per affiancare l’immagine in orizzontale.

• Selezionare Ripeti-y per affiancare l’immagine in verticale.

6 Selezionare l’allineamento della pagina nel browser (a sinistra, al centro, a destra).

7 Fare clic su OK, quindi su Salva.
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Esportare XHTML

XHTML è una combinazione di HTML (l’attuale standard di formattazione e visualizzazione delle pagine Web) e XML 

(eXtensible Markup Language). XHTML è compatibile con le versioni precedenti, può essere quindi visualizzato con 

la maggior parte dei browser Web esistenti; inoltre può essere letto da tutti i dispositivi che visualizzano il contenuto 

XML, come palmari, telefoni cellulari e altri dispositivi portatili. 

Fireworks permette anche di importare il codice XHTML. Consultare “Creare file PNG di Fireworks da file HTML” a 

pagina 8. 

Per ulteriori informazioni su XHTML, consultare la specifica del World Wide Web Consortium (W3C) all’indirizzo 

www.w3.org.

1 Selezionare File > Imposta HTML, scegliere uno stile XHTML dal menu a comparsa Stile HTML della scheda 

Generale e fare clic su OK.

2 Esportare il documento utilizzando i metodi disponibili per l’esportazione o la copia HTML. Consultare 

“Esportazione del codice HTML” a pagina 253.

Nota: per l’esportazione in XHTML, Fireworks utilizza la codifica UTF-8.

Esportare file con e senza codifica UTF-8

 Il metodo di codifica del testo  UTF-8  (Universal Character Set Transformation Format-8) consente ai browser di 

visualizzare set di caratteri diversi nella stessa pagina HTML (ad esempio, testo il lingua cinese e in lingua inglese). La 

codifica UTF-8 è attivata per impostazione predefinita.

Fireworks permette anche di importare i documenti che utilizzano tale codifica. Consultare “Creare file PNG di 

Fireworks da file HTML” a pagina 8. 

Esportare i documenti senza codifica UTF-8

1 Selezionare File > Imposta HTML.

2 Nella scheda Specifiche del documento, deselezionare la casella UTF-8 e fare clic su OK.

3 Esportare il documento utilizzando i metodi disponibili per l’esportazione o la copia HTML.

Impostare le opzioni di esportazione HTML 

La finestra di dialogo Impostazioni HTML consente di definire le modalità di esportazione del codice HTML di 

Fireworks. Le modifiche apportate nella scheda Specifiche del documento vengono applicate solo al documento 

corrente. Le impostazioni delle schede Generali e Tabella sono preferenze globali e hanno effetto su tutti i nuovi 

documenti.

1 Effettuare una delle seguenti operazioni:

• Selezionare File > Imposta HTML.

• Fare clic sul pulsante Opzioni nella finestra di dialogo Esporta.

2 Nella scheda Generale, selezionare le opzioni desiderate.

Stile HTML  Seleziona lo stile per l’HTML esportato.

Il formato HTML generico funziona in qualsiasi editor HTML. Tuttavia, se il documento contiene comportamenti 

o altro contenuto interattivo, si consiglia di scegliere l’editor specifico, se presente nell’elenco. 

Per esportare il documento utilizzando lo standard XHTML, scegliere lo stile XHTML appropriato dal menu a 

comparsa.

Estensione  Scegliere un’estensione per il file dal menu a comparsa o immetterne una nuova.

http://www.w3.org
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Includi commenti HTML  Consente di includere commenti su dove copiare e incollare il codice HTML. Si consiglia 

di selezionare questa opzione se il documento contiene elementi interattivi quali pulsanti, comportamenti o 

immagini rollover. 

Nome file in minuscole  Consente di esportare il file HTML e i file immagine associati con nomi file in lettere 

minuscole.

Nota: questa opzione non applica le lettere minuscole all’estensione del file HTML se nel menu Estensione è stata 

selezionata l’estensione in lettere maiuscole.

Usa CSS per i menu a comparsa  Consente di utilizzare CSS anziché JavaScript per il codice del menu a comparsa. 

Per indicizzare il menu o per aggiornare i collegamenti con il codice, è possibile utilizzare Dreamweaver.

Scrivi CSS su un file esterno  Consente di scrivere il codice CSS su un file .css esterno esportato nella stessa 

posizione del file HTML. Il nome del file .css corrisponde a quello del file HTML, tranne per l’estensione. 

Scegliendo questa opzione, nella stessa posizione del file HTML viene anche esportato un file denominato 

mm_css_menu.js.

Nota: questa opzione è disponibile solo se è stata selezionata l’opzione Usa CSS per i menu a comparsa.

Creatore file (Mac OS)  Consente di scegliere un’applicazione associata dal menu a comparsa. Quando si farà 

doppio clic sul file HTML esportato sul disco rigido, questo si aprirà automaticamente nell’applicazione 

selezionata.

3 Nella scheda Tabella, scegliere le impostazioni per le tabelle HTML. Per informazioni, consultare “Definire le 

modalità di esportazione delle tabelle HTML” a pagina 186.

4 Nella scheda Specifiche del documento, scegliere una delle opzioni seguenti: 

Nomi file porzioni Consente di scegliere una formula per l’assegnazione automatica del nome alle porzioni nei 

menu a comparsa. Si possono utilizzare le impostazioni predefinite oppure scegliere le proprie opzioni.

Importante: se si sceglie Nessuno per i primi tre menu, Fireworks esporta i file delle porzioni che si sovrascrivono 

reciprocamente, producendo un singolo elemento grafico esportato e una tabella che visualizza tale elemento in ogni 

cella.

Etichetta ALT predefinita  Consente di immettere il testo da visualizzare al posto di tutte le immagini durante il 

download dal Web e come sostitutivo di quelle non scaricabili. In alcuni browser, al passaggio del mouse 

sull’immagine, può comparire anche sotto forma di descrizione comandi. Questa soluzione viene utilizzata anche 

per gli utenti Web ipovedenti.

Esporta più file HTML barra di navigazione (da utilizzare senza serie di fotogrammi) Selezionare questa opzione 

quando si esporta una barra di navigazione che collega più pagine. Fireworks esporta pagine aggiuntive per ciascun 

pulsante della barra di navigazione.

Includi aree senza porzioni Selezionare questa opzione per includere le parti dell’area di lavoro che non rientrano 

in alcuna porzione.

Codifica UTF-8  Per impostazione predefinita, questa opzione è attivata. Consente la visualizzazione di caratteri 

appartenenti a più set nel documento esportato. Per disattivare questa opzione, deselezionare la casella di controllo. 

5 Per salvare le impostazioni come predefinite, fare clic su Imposta predefiniti. 

Esportare file Adobe PDF

Per stampare un lavoro creato con Fireworks o distribuirlo per la revisione, effettuare l’esportazione in Adobe PDF. I 

revisori possono aggiungere commenti e rispondere ai commenti degli altri in Adobe Reader® o Acrobat®. Per 

informazioni sull’impostazione delle revisioni di un file PDF, consultare la Guida di Acrobat.
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I file PDF esportati mantengono tutte le pagine e i collegamenti ipertestuali; la navigazione funziona quindi 

esattamente come in una pagina Web. Tuttavia, a differenza dei prototipi HTML, Adobe PDF offre impostazioni di 

protezione con cui è possibile impedire la modifica o la copia dei lavori. 

1 Scegliere File > Esporta.

2 Dal menu a comparsa Esporta, selezionare Adobe PDF. 

3 Scegliere le pagine da esportare, quindi selezionare Visualizza PDF dopo l’esportazione per aprire automaticamente 

il PDF in Adobe Reader o Acrobat.

4 Per personalizzare il PDF, fare clic su Opzioni, quindi regolare le seguenti impostazioni:

Compatibilità Consente di stabilire con quali applicazioni Adobe PDF sarà possibile aprire il file esportato.

Compressione Consente di stabilire il tipo di compressione per l’immagine, riducendo le dimensioni del file. In 

generale, la compressione in formato JPEG e JPEG2000 offre risultati migliori su immagini come fotografie con la 

trasmissione graduale da colore a colore. ZIP è la scelta migliore per le illustrazioni contenenti aree estese di colori 

uniformi.

Qualità Per la compressione JPEG o JPEG2000, sono disponibili opzioni per la qualità delle immagini. Alta qualità 

genera file di dimensioni elevate ma con immagini di buona qualità.

Converti in scala di grigi Consente di convertire tutte le immagini in scala di grigi, riducendo la dimensione del file.

Abilita selezione testo Consente ai revisori di copiare il testo dal file esportato. Deselezionare questa opzione per 

ridurre notevolmente la dimensione dei file.

Valore pagina al vivo Determina la larghezza dei pixel del bordo vuoto che circonda l’immagine su ciascuna 

pagina. Ad esempio, un valore pari a 20 circonda ogni immagine con un bordo di 20 pixel.

Password per aprire il documento Per aprire il file esportato è necessario usare Password per apertura.

Password per limitare le attività È necessario usare Password per protezione per eseguire queste funzioni 

selezionate: Stampa, Modifica, Copia e Inserimento commenti.

5 Per chiudere la finestra di dialogo Opzioni, fare clic su OK.

6 Specificare un nome di file e una posizione, quindi fare clic su Salva.

Nota: durante l’esportazione in PDF, se alcune pagine del documento Fireworks hanno l’area di lavoro trasparente, 

gli oggetti con eventuale trasparenza perdono le rispettive caratteristiche trasparenti. Per evitare questo 

inconveniente, impostare l’area di lavoro come sfondo non trasparente prima dell’esportazione in PDF.

Visualizzare file PDF esportati (consigliato)

Quando visualizzate file PDF esportati in Adobe Acrobat o Adobe Reader, utilizzate le impostazioni seguenti:

1 In Adobe Acrobat o Adobe Reader, selezionate Modifica > Preferenze.

2 Selezionate Visualizzazione pagina nel pannello sinistro.

3 Impostate Risoluzione personalizzata su 72 pixel per pollice.

4 Impostate il valore di zoom su 100%.

Esportazione di file FXG

FXG è un formato di file supportato da Flash Catalyst, Fireworks, Illustrator e Photoshop. Quando si esporta un file 

contenente immagini vettoriali e bitmap utilizzando l’esportazione con export FXG, viene creata una cartella distinta 

nominata <filename.assets>. La cartella contiene le immagini bitmap associate al file. 
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Se uno dei file associati viene eliminato da questa cartella, l’operazione di importazione non riesce.

Nota: gli elementi, i filtri, i metodi di fusione, i gradienti e le maschere per i quali non esistono tag di mapping 

corrispondenti nel formato FXG vengono esportati come grafica bitmap.

1 Selezionare File > Esporta e aprire il percorso nel quale si desidera salvare i file. 

2 Inserite un nome per il file FXG.

3 Nella finestra di dialogo Esporta, selezionare FXG e immagini dal menu Esporta.

4 Fare clic su Salva.

Nota: gli oggetti che si estendono oltre l'area di lavoro in Fireworks vengono visualizzati completamente quando il file 

FXG esportato viene aperto in Flash Catalyst.

Inviare un documento Fireworks allegato a un 
messaggio e-mail

È possibile inviare un file Fireworks PNG, un file JPEG compresso o un documento con gli altri formati file e 

impostazioni di ottimizzazione disponibili nel pannello Ottimizza.

1 Selezionare File > Invia a e-mail.

2 Selezionare una delle seguenti opzioni:

Fireworks PNG Allega il documento PNG attivo a un nuovo messaggio e-mail.

JPG Compresso Allega il documento attivo a un nuovo messaggio e-mail usando l’impostazione di ottimizzazione 

JPEG - Qualità migliore.

Usa impostazioni di esportazione Allega il documento corrente a un messaggio e-mail usando le impostazioni 

definite nel pannello Ottimizza.

Nota: Mozilla, Netscape 6 e Nisus Emailer non sono supportati nei sistemi Mac OS.
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Capitolo 18: Utilizzo di Fireworks con altre 
applicazioni

Adobe® Fireworks® è un componente essenziale per lo sviluppo di contenuti multimediali o destinati al Web. L’ampia 

gamma di funzioni di integrazione di Fireworks consente di snellire la procedura di progettazione e di ottimizzarne 

l’uso con altre applicazioni.

Fireworks si integra in modo semplice e ottimale con gli altri prodotti Adobe quali Adobe Photoshop® e Adobe 

GoLive®. Ad esempio, è molto facile importare ed esportare elementi grafici di Photoshop come file completamente 

modificabili oppure creare e modificare HTML utilizzando Fireworks e GoLive.

Il tutorial di Dan Carr in Adobe Dev Center fornisce una panoramica sulla 

http://www.adobe.com/go/learn_fw_interactivecontent_it.

Operazioni con Dreamweaver

Adobe Dreamweaver® e Fireworks riconoscono e condividono molte delle stesse funzioni di modifica dei file, come le 

modifiche ai collegamenti, alle mappe immagine e alle porzioni di tabelle. Inoltre, Dreamweaver e Fireworks offrono 

insieme un flusso di lavoro ottimizzato per modificare, ottimizzare e collocare file di grafica per il Web nelle pagine HTML.

Collocare immagini di Fireworks nei file di Dreamweaver

Quando inserite file JPEG Fireworks in Dreamweaver, la qualità del file viene automaticamente calcolata. Il valore può 

essere 79 per alcuni file.

Nota: prima di utilizzare le procedure descritte, accertarsi che Dreamweaver sia selezionato come tipo HTML nella 

finestra di dialogo Impostazioni HTML.

Inserire immagini di Fireworks in Dreamweaver con il pannello File

1 Esportare l’immagine da Fireworks nella cartella del sito locale come specificato in Dreamweaver.

2 Aprire il documento di Dreamweaver accertandosi che sia attiva la vista Progettazione.

3 Trascinare l’immagine dal pannello File al documento di Dreamweaver.

Inserire immagini di Fireworks in Dreamweaver con il menu Inserisci

1 Posizionare il punto di inserimento dove si intende inserire l’immagine nella finestra del documento di 

Dreamweaver.

2 Effettuare una delle seguenti operazioni:

• Selezionare Inserisci > Immagine.

• Fare clic sul pulsante Immagine nella categoria Comune della barra Inserisci.

3 Passare all’immagine esportata da Fireworks, quindi fare clic su OK.

http://www.adobe.com/go/learn_fw_interactivecontent_it


263UTILIZZO DI FIREWORKS

Utilizzo di Fireworks con altre applicazioni

Ultimo aggiornamento 4/5/2011

Creare nuovi file di Fireworks da segnaposto di Dreamweaver

Mediante i segnaposto immagine è possibile provare diversi layout di pagina Web prima di creare il lavoro di grafica 

finale per la pagina. I segnaposto immagine consentono di specificare le dimensioni e la posizione delle immagini di 

Fireworks che verranno inserite in Dreamweaver in un secondo momento.

Quando si crea un’immagine Fireworks da un segnaposto immagine Dreamweaver, viene creato un nuovo documento 

Fireworks con un’area di lavoro delle stesse dimensioni del segnaposto selezionato.

Nota: tutti i comportamenti applicati all’interno di Fireworks sono conservati al ritorno a Dreamweaver. Allo stesso 

modo, la maggior parte dei comportamenti di Dreamweaver applicati ai segnaposto immagine sono anch’essi conservati 

durante l’avvio e la modifica con Fireworks. Tuttavia, c’è un’eccezione: i rollover disgiunti applicati ai segnaposto 

immagine in Dreamweaver non vengono conservati quando si apre e si modifica l’immagine in Fireworks.

Una volta terminata la sessione di Fireworks e ritornati a Dreamweaver, il nuovo elemento grafico di Fireworks creato 

prende il posto del segnaposto immagine originariamente selezionato.

1 In Dreamweaver, salvare il documento HTML desiderato in una posizione all’interno della cartella sito di 

Dreamweaver.

2 Posizionare il punto di inserimento nella posizione desiderata del documento ed effettuare una delle seguenti 

operazioni:

• Selezionare Inserisci > Oggetti immagine > Segnaposto immagine.

• Fare clic sul menu a comparsa Immagine nella categoria Comune della barra Inserisci e scegliere Segnaposto 

immagine.

3 Immettere il nome, le dimensioni, il colore e il testo alternativo per il segnaposto immagine.

Nel documento di Dreamweaver viene inserito un segnaposto immagine.

4 Effettuare una delle seguenti operazioni:

• Selezionare il segnaposto immagine e fare clic su Crea nella finestra di ispezione Proprietà.

• Fare doppio clic tenendo premuto il tasto Ctrl (Windows) o Comando (Mac OS) sul segnaposto immagine.

• Fare clic con il pulsante destro del mouse (Windows) o tenendo premuto il tasto Ctrl (Mac OS) e scegliere Crea 

immagine in Fireworks.

Fireworks si apre con uno spazio vuoto delle stesse dimensioni dell’immagine segnaposto. Nella parte superiore 

della finestra del documento è indicato che si sta modificando un’immagine da Dreamweaver.

5 Creare un’immagine in Fireworks e fare clic su Fine.

6 Specificare un nome e la posizione per il file PNG sorgente.

7 Specificare un nome per i file immagine esportati.
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Questi sono i file immagine visualizzati in Dreamweaver.

8 Specificare una posizione nella cartella del sito di Dreamweaver per i file o i file immagine esportati, quindi fare clic 

su Salva.

Quando si ritorna a Dreamweaver, il segnaposto immagine originariamente selezionato viene sostituito con la 

nuova immagine o tabella di Fireworks.

Inserire il codice HTML di Fireworks in Dreamweaver

L’esportazione di file da Fireworks a Dreamweaver è composta da due fasi. In Fireworks, esportare i file direttamente 

in una cartella sito di Dreamweaver. In questo modo viene creato un file HTML e i file immagine associati nella 

posizione specificata. Quindi, inserire il codice HTML in Dreamweaver con la funzione Inserisci HTML di Fireworks.

1 Esportare il documento HTML di Fireworks in formato HTML.

2 In Dreamweaver, salvare il documento in un sito definito.

3 Posizionare il punto di inserimento nel documento dove si desidera che inizi il codice HTML.

4 Effettuare una delle seguenti operazioni:

• Selezionare Inserisci > Oggetti immagine > HTML di Fireworks.

• Fare clic sul menu a comparsa Immagine nella categoria Comune della barra Inserisci e scegliere HTML di 

Fireworks.

5 Nella finestra di dialogo che viene visualizzata, fare clic su Sfoglia per scegliere il file HTML di Fireworks.

6 (Facoltativo) Per spostare il file HTML nel Cestino (Windows) o per eliminarlo definitivamente (Mac OS) al 

termine dell’operazione, selezionare Cancella il file dopo l’inserimento.

Questa opzione non ha effetto sul file PNG sorgente associato al file HTML.

7 Fare clic su OK per inserire nel documento di Dreamweaver il codice HTML assieme alle immagini, alle porzioni 

e al codice JavaScript associati.

Copiare il codice HTML di Fireworks da utilizzare in Dreamweaver

Quando il codice HTML di Fireworks viene copiato negli appunti, tutto il codice HTML e JavaScript associato al 

documento Fireworks viene copiato nel documento Dreamweaver, le immagini vengono esportate in una posizione 

specificata dall’utente e Dreamweaver aggiorna l’HTML con collegamenti relativi al documento.

Nota: questo metodo funziona solo con Dreamweaver, ma non con altri strumenti di editing HTML.

❖ Copiare l’HTML negli appunti di Fireworks, quindi incollarlo in un documento di Dreamweaver.

È possibile aprire in Dreamweaver un file HTML di Fireworks esportato, quindi copiare e incollare le sezioni 

desiderate in un altro documento di Dreamweaver.
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Aggiornare l’HTML di Fireworks esportato in Dreamweaver

La funzione Roundtrip HTML offre diversi vantaggi quando si utilizzano file HTML esportati in Dreamweaver. 

Consultare “La funzione Roundtrip HTML” a pagina 266.

1 Apportare modifiche al documento PNG in Fireworks.

2 Selezionare File > Aggiorna HTML.

3 Individuare il file di Dreamweaver contenente il codice HTML da aggiornare, quindi fare clic su Apri.

4 Individuare la cartella in cui si desidera collocare i file delle immagini aggiornati, quindi fare clic su Apri.

Fireworks aggiorna il codice HTML e JavaScript nel documento di Dreamweaver. Inoltre, Fireworks esporta le 

immagini associate al codice HTML e le colloca nella cartella di destinazione specificata.

Nota: qualora Fireworks non riesca a reperire il codice HTML corrispondente da aggiornare, offre comunque la 

possibilità di inserire il nuovo codice HTML nel documento di Dreamweaver. Fireworks colloca la sezione JavaScript 

del nuovo codice all’inizio del documento, mentre la tabella HTML o il collegamento all’immagine vengono inseriti 

alla fine del file.

Esportare i file di Fireworks in librerie di Dreamweaver

Una voce di libreria, o elemento libreria, è una parte del file HTML che si trova in una cartella denominata Library 

(Libreria) nella cartella principale del sito. Gli elementi libreria appaiono come categorie nel pannello Risorse di 

Dreamweaver. In Dreamweaver, gli elementi libreria semplificano la modifica e l’aggiornamento dei componenti dei 

siti Web usati più di frequente. È possibile trascinare un elemento libreria (file con estensione .lbi) dal pannello Risorse 

a una pagina qualsiasi del sito Web.

Non è possibile modificare un elemento libreria direttamente nel documento di Dreamweaver. Dal documento si può 

modificare solo l’elemento libreria principale. Successivamente, Dreamweaver può aggiornare ogni copia di 

quell’elemento presente nell’intero sito Web. Gli elementi libreria di Dreamweaver sono del tutto simili ai simboli di 

Fireworks; le modifiche al documento libreria principale (LBI) si riflettono in tutte le istanze della libreria del sito.

Nota: gli elementi libreria non supportano i menu a comparsa.

1 Selezionare File > Esporta.

2 Selezionare Libreria Dreamweaver dal menu a comparsa Esporta.

Nel sito di Dreamweaver, selezionare o creare una cartella denominata Library in cui posizionare i file. Il nome fa 

distinzione tra maiuscole e minuscole.

Nota: Dreamweaver non riconosce il file esportato come elemento di libreria a meno che non sia salvato nella cartella 

Libreria.

3 Digitare un nome di file.

4 (Facoltativo) Se l’immagine contiene delle porzioni, scegliere le relative opzioni.

5 Selezionare Inserisci immagine nella sottocartella per scegliere una cartella separata in cui salvare le immagini.

6 Fare clic su Salva.

Modificare i file di Fireworks da Dreamweaver

La funzione Roundtrip HTML offre una perfetta integrazione di Fireworks e Dreamweaver. Questa caratteristica 

consente di apportare modifiche in un’applicazione e fare in modo che queste variazioni si riflettano direttamente 

anche nell’altra.
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La funzione Roundtrip HTML

Fireworks riconosce e conserva la maggior parte dei tipi di modifiche apportate a un documento di Dreamweaver, 

inclusi le variazioni dei collegamenti, le mappe immagine modificate, il testo e il codice HTML modificato nelle 

porzioni HTML, nonché i comportamenti condivisi tra Fireworks e Dreamweaver. La finestra di ispezione Proprietà 

di Dreamweaver consente di identificare le immagini, le porzioni in tabelle e le tabelle generate da Fireworks e presenti 

nel documento.

Fireworks supporta la maggior parte dei tipi di modifiche apportate con Dreamweaver. Tuttavia, modifiche sostanziali 

apportate alla struttura di una tabella in Dreamweaver possono creare differenze non riconciliabili tra le due 

applicazioni. Se si intende apportare modifiche considerevoli a un layout di tabella, utilizzare la funzionalità di avvio 

e modifica di Dreamweaver all’interno di Fireworks.

Nota: grazie alla tecnologia di Fireworks, Dreamweaver offre funzioni di base di modifica delle immagini che consentono 

di modificare le immagini senza ricorrere a un’applicazione esterna. Le funzioni di Dreamweaver per la modifica delle 

immagini si applicano solo ai formati di file immagine JPEG e GIF.

Modificare un’immagine di Fireworks inserita in Dreamweaver

Nota: prima di modificare gli elementi grafici di Fireworks da Dreamweaver, è necessario eseguire alcune operazioni 

preliminari. Per ulteriori informazioni, consultare “Impostare le opzioni di avvio e modifica” a pagina 268.

1 In Dreamweaver, scegliere Finestra > Proprietà per aprire la finestra di ispezione Proprietà.

2 Effettuare una delle seguenti operazioni:

• Selezionare l’immagine desiderata. La finestra di ispezione Proprietà identifica la selezione come immagine di 

Fireworks e visualizza il nome del file PNG sorgente noto per l’immagine. Successivamente, fare clic su Modifica 

nella finestra di ispezione Proprietà.

• Fare doppio clic tenendo premuto il tasto Ctrl (Windows) o Comando (Mac OS) sull’immagine da modificare.

• Fare clic con il pulsante destro del mouse (Windows) o tenendo premuto il tasto Ctrl (Mac OS) sull’immagine 

desiderata e scegliere Modifica con Fireworks dal menu di scelta rapida.

3 Se richiesto, specificare se individuare un file sorgente di Fireworks per l’immagine inserita.

4 Modificare l’immagine in Fireworks.

Le modifiche apportate vengono mantenute in Dreamweaver.

5 Fare clic su Fine per esportare l’immagine utilizzando le impostazioni di ottimizzazione correnti, aggiornare il file 

GIF o JPEG utilizzato da Dreamweaver e salvare il file sorgente PNG, qualora sia stato selezionato un file sorgente.

Nota: quando si apre un’immagine dal pannello Sito di Dreamweaver, l’editor predefinito per quel tipo di immagine, 

impostato nelle Preferenze di Dreamweaver, apre il file. Quando le immagini vengono aperte da questa posizione, 

Fireworks non apre il file PNG originale. Per poter utilizzare le funzioni di integrazione di Fireworks, è necessario 

aprire le immagini dall’interno della finestra del documento di Dreamweaver.

Modificare una tabella di Fireworks inserita in Dreamweaver

Nota: prima di modificare le tabelle di Fireworks da Dreamweaver, è necessario eseguire alcune operazioni di avvio e 

modifica preliminari. Per ulteriori informazioni, consultare “Impostare le opzioni di avvio e modifica” a pagina 268.

1 In Dreamweaver, scegliere Finestra > Proprietà per aprire la finestra di ispezione Proprietà. 

2 Per aprire il file sorgente PNG nella finestra del documento, effettuare una delle seguenti operazioni: 

• Fare clic all’interno della tabella, quindi sul tag TABLE nella barra di stato per selezionare l’intera tabella. La 

finestra di ispezione Proprietà identifica la selezione come tabella di Fireworks e visualizza il nome del file PNG 

sorgente noto per la tabella. Successivamente, fare clic su Modifica nella finestra di ispezione Proprietà. 
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• Selezionare un’immagine nella tabella, quindi fare clic su Modifica nella finestra di ispezione Proprietà.

• Fare clic con il pulsante destro del mouse (Windows) o tenendo premuto il tasto Ctrl (Mac OS) sull’immagine, 

quindi scegliere Modifica con Fireworks dal menu di scelta rapida.

3 In Fireworks, apportare le modifiche necessarie.

Dreamweaver riconosce e mantiene tutte le modifiche applicate a una tabella in Fireworks.

4 Dopo avere apportato le modifiche alla tabella, fare clic su Fine nella finestra del documento.

Il codice HTML e i file delle porzioni immagine vengono esportati utilizzando le impostazioni di ottimizzazione 

correnti. La tabella inserita in Dreamweaver viene aggiornata e il file PNG sorgente viene salvato.

Nota: se si crea una tabella nidificata all’interno di una tabella generata da Fireworks e si tenta di modificarla 

mediante la funzionalità roundtrip in Dreamweaver, si può verificare un errore di Dreamweaver. Per ulteriori 

informazioni, consultare la nota tecnica 19231, nel sito Web di Adobe.

I comportamenti supportati e non supportati di Dreamweaver

Se un singolo elemento grafico non suddiviso in porzioni di Fireworks viene inserito in un documento di 

Dreamweaver e gli viene applicato un comportamento di Dreamweaver, al momento dell’apertura e della modifica in 

Fireworks all’elemento grafico viene sovrapposta una porzione. La porzione non è inizialmente visibile, dato che le 

porzioni sono automaticamente disattivate quando si aprono e modificano elementi grafici singoli e non suddivisi ai 

quali siano stati applicati comportamenti di Dreamweaver. La porzione può essere visualizzata attivandone la visibilità 

dal Livello Web del pannello Livelli.

Quando si visualizzano le proprietà di una porzione di Fireworks dotata di un comportamento di Dreamweaver, la 

casella di testo del collegamento nella finestra di ispezione Proprietà potrebbe visualizzare javascript:;. 

L’eliminazione di questo testo non ha alcuna conseguenza negativa. Anche sovrapponendovi un URL, il 

comportamento rimarrà comunque intatto alla riapertura del file in Dreamweaver.

Quando si opera con Roundtrip HTML da Dreamweaver, Fireworks supporta i formati lato server quali CFM e PHP.

Dreamweaver supporta tutti i comportamenti applicati a Fireworks, inclusi quelli richiesti per i rollover e i pulsanti.

Nota: gli elementi della libreria non supportano i menu a comparsa.

Fireworks supporta i seguenti comportamenti di Dreamweaver durante una sessione di avvio e modifica:

• Rollover semplice

• Scambia immagine

• Ripristino di immagini scambiate

• Impostazione del testo della barra di stato

• Impostare l’immagine della barra di navigazione

• Menu a comparsa

Nota: Fireworks non supporta comportamenti non nativi, inclusi i comportamenti lato server.
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Ottimizzare immagini e animazioni di Fireworks aggiunte a Dreamweaver

Modificare le impostazioni di ottimizzazione per un’immagine di Fireworks inserita in 
Dreamweaver

1 In Dreamweaver, selezionare l’immagine ed effettuare una delle seguenti operazioni:

• Selezionare Comandi > Ottimizza immagine.

• Fare clic sul pulsante Ottimizza nella finestra di ispezione Proprietà.

• Fare clic con il pulsante destro del mouse (Windows) o tenendo premuto il tasto Ctrl (Mac OS) e scegliere 

Ottimizza in Fireworks dal menu a comparsa.

2 Qualora richiesto, specificare se aprire un file sorgente di Fireworks per l’immagine inserita.

3 Apportare le modifiche necessarie nella finestra di dialogo Anteprima esportazione:

• Per modificare le impostazioni di ottimizzazione, fare clic sulla scheda Opzioni.

• Per modificare le dimensioni e l’area dell’immagine esportata, fare clic sulla scheda File. Se si modificano le 

dimensioni dell’immagine in Fireworks, è necessario reimpostare le dimensioni dell’immagine nella finestra di 

ispezione Proprietà quando si ritorna a Dreamweaver.

• Per modificare le impostazioni di animazione per l’immagine, fare clic sulla scheda Animazione.

4 Dopo aver modificato l’immagine, fare clic su OK per esportarla, aggiornarla in Dreamweaver, quindi salvare il file PNG.

Se è stato modificato il formato dell’immagine, la funzione Controllo collegamenti di Dreamweaver richiede di 

aggiornare i riferimenti all’immagine.

Modificare le impostazioni di animazione

Se si sta aprendo e ottimizzando un file GIF animato, è possibile anche modificare le impostazioni delle animazioni. 

Le opzioni di animazione disponibili nella finestra di dialogo Anteprima esportazione sono simili a quelle disponibili 

nel pannello Stati di Fireworks.

Nota: per modificare i singoli elementi grafici di un’animazione di Fireworks, è necessario aprire e modificare 

l’animazione stessa. 

Impostare le opzioni di avvio e modifica

Per utilizzare la funzionalità Roundtrip HTML in modo ottimale, è necessario eseguire alcune operazioni preliminari, 

quali la definizione di Fireworks come editor di immagini principale in Dreamweaver e la specifica delle preferenze di 

avvio e modifica per Fireworks, nonché la definizione di un sito locale in Dreamweaver.

Impostare Fireworks come principale editor esterno di immagini per Dreamweaver

In Dreamweaver sono disponibili una serie di preferenze per avviare automaticamente applicazioni specifiche per la 

modifica di determinati tipi di file. Per utilizzare la funzionalità di avvio e modifica di Fireworks, assicurarsi che questo 

sia impostato come editor principale per i file GIF, JPEG e PNG all’interno di Dreamweaver.

Nota: l’impostazione di questa preferenza è necessaria solo se si riscontrano problemi con l’avvio di Fireworks dall’interno 

di Dreamweaver.

1 In Dreamweaver, scegliere Modifica > Preferenze, quindi scegliere Tipi di file/Editor.

2 Nell’elenco Estensioni, selezionare un’estensione per il file Web (.gif, .jpg o .png).
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3 Nell’elenco degli editor, selezionare Fireworks. Se Fireworks non si trova nell’elenco, fare clic sul pulsante Più (+), 

individuare l’applicazione Fireworks sul disco rigido, quindi fare clic su Apri.

4 Fare clic su Rendi principale.

5 Ripetere i passaggi da 2 a 4 per impostare Fireworks come editor principale per gli altri tipi di file immagine Web.

Specificare le preferenze di avvio e modifica per i file sorgente di Fireworks

Le preferenze di avvio e modifica di Fireworks permettono di specificare le modalità di gestione dei file PNG 

all’apertura dei file di Fireworks da un’altra applicazione.

Dreamweaver riconosce le preferenze di avvio e modifica di Fireworks solo quando si apre e ottimizza un’immagine 

che non appartiene a una tabella di Fireworks e che non contiene un percorso di Design Note corretto verso il file 

sorgente PNG. In tutti gli altri casi, compresi tutti i casi di avvio e modifica delle immagini di Fireworks, Dreamweaver 

apre automaticamente il file PNG sorgente, richiedendo di individuare il file sorgente, qualora non riesca a reperirlo.

1 In Fireworks, scegliere Modifica > Preferenze (Windows) o Fireworks > Preferenze (Mac OS).

2 Fare clic sulla categoria Avvio e modifica, quindi impostare le opzioni desiderate. 

Per ulteriori informazioni, consultare “Preferenze Avvio e modifica” a pagina 308.

Design Notes e i file sorgente

Ogni volta che si esporta un file di Fireworks da un file PNG sorgente salvato in un sito di Dreamweaver, Fireworks 

scrive una nota di progettazione (Design Note) contenente informazioni sul file PNG. Quando si apre e si modifica da 

Dreamweaver un’immagine creata con Fireworks, Dreamweaver utilizza la Design Note per individuare il PNG 

sorgente per il file dell’immagine. Per garantire risultati ottimali, salvare sempre il file PNG sorgente di Fireworks e i 

file esportati in un sito di Dreamweaver. In questo modo è sicuro che qualsiasi utente che condivide il sito è in grado 

di individuare il PNG sorgente quando avvia Fireworks da Dreamweaver.
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Trasferimento dei file del sito mediante il pulsante Gestione file

Il pulsante Gestione file , nella parte superiore della finestra del documento, consente di accedere facilmente a vari 

comandi di trasferimento dei file. È possibile utilizzare questo pulsante se il documento risiede in una cartella del sito 

di Dreamweaver e se il sito ha accesso a un server remoto. Affinché Fireworks riconosca la cartella come sito, utilizzare 

la finestra di dialogo Gestisci siti di Dreamweaver per definire la cartella di destinazione (o una cartella contenente 

degli elementi) come cartella principale locale del sito.

Nota: prima di utilizzare le opzioni di deposito e ritiro di Fireworks, selezionare l’opzione Abilita deposito e ritiro file per 

il sito di Dreamweaver in cui risiede il documento.

Scarica Consente di copiare la versione remota del file nel sito locale, sovrascrivendo il file locale con la copia remota.

Ritira Consente di ritirare il file, sovrascrivendo il file locale con la copia remota.

Carica Consente di copiare la versione locale del file sul sito remoto, sovrascrivendo il file remoto con la copia locale.

Deposita Consente di depositare il file locale, sovrascrivendo il file remoto con la copia locale.

Annulla ritiro Annulla il ritiro del file locale e lo deposita, sovrascrivendo il file locale con la copia remota.

Nota: i comandi di Gestione file sono disponibili in Fireworks solo se il documento risiede in una cartella sito di 

Dreamweaver per cui è definito un server remoto. I comandi di Gestione file possono essere utilizzati per file che risiedono 

in siti che usano metodi di trasporto Locale/rete e FTP. I file in siti che usano SFTP o metodi di trasporto di terze parti, 

come SourceSafe, WebDAV e RDS, non possono essere trasferiti al o dal server remoto dall’interno di Fireworks.

Utilizzo di HomeSite, GoLive e altri editor HTML

Fireworks e Adobe HomeSite® condividono una potente integrazione che consente di avviare Fireworks da HomeSite 

per modificare gli elementi grafici Web. Quando si esce da Fireworks, gli aggiornamenti effettuati vengono applicati 

automaticamente all’immagine inserita in HomeSite. Se combinate, le due applicazioni garantiscono un flusso di 

lavoro ottimizzato per la modifica degli elementi grafici Web nelle pagine HTML.

Inserire immagini di Fireworks in HomeSite

Dopo aver esportato immagini GIF o JPEG da Fireworks, è possibile inserirle in un documento HomeSite.

1 In HomeSite, salvare il documento (necessario per la creazione di percorsi relativi alle immagini). 

2 Nella finestra Risorse, individuare e selezionare l’immagine di Fireworks esportata.

3 Effettuare una delle seguenti operazioni per inserire l’immagine di Fireworks nel documento di HomeSite:

• Trascinare il file dalla finestra Risorse alla posizione desiderata all’interno del codice HTML sulla scheda 

Modifica della finestra Documento.

• Nella scheda Modifica della finestra Documento, collocare il punto di inserimento dove si intende inserire 

l’immagine di Fireworks, quindi fare clic con il pulsante destro del mouse sul file nella finestra Risorse e scegliere 

Inserisci come collegamento.

Nel codice HTML viene creato un collegamento all’immagine di Fireworks. Fare clic sulla scheda Sfoglia per 

visualizzare l’anteprima dell’immagine nel documento di HomeSite.
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Inserire l’HTML di Fireworks in HomeSite

Nota: prima di esportare, copiare o aggiornare il codice HTML di Fireworks per l’uso in HomeSite, impostare il tipo di 

HTML su Generico nella finestra di dialogo Impostazioni HTML. 

Per ulteriori informazioni, consultare la Guida in linea di Fireworks.

Esportare l’HTML di Fireworks in HomeSite

L’esportazione di HTML da Fireworks genera un file HTML e i file immagine associati nella posizione specificata. 

Quindi si può aprire il file HTML in HomeSite per ulteriori modifiche.

❖ Esportare il documento in HTML di Fireworks, quindi aprire il file esportato in HomeSite scegliendo File > Apri. 

Copiare l’HTML di Fireworks negli Appunti per l’uso in HomeSite

Copiare l’HTML creato con Fireworks negli Appunti di Fireworks, quindi incollarlo direttamente in un nuovo 

documento di HomeSite. Tutte le immagini necessarie vengono esportate nella posizione specificata.

❖ Copiare l’HTML negli Appunti di Fireworks, quindi incollarlo in un nuovo documento di HomeSite. 

Copiare l’HTML da un file di Fireworks esportato e incollarlo in HomeSite

❖ Esportare un file HTML di Fireworks, quindi copiare e incollare il codice desiderato in un documento esistente di 

HomeSite. 

Aggiornare l’HTML di Fireworks esportato in HomeSite

❖ Utilizzare il comando Aggiorna HTML in Fireworks. 

Modificare le immagini di Fireworks in HomeSite

1 In HomeSite, salvare il documento.

2 Effettuare una delle seguenti operazioni:

• Fare clic con il pulsante destro del mouse sul file immagine in una delle schede File della finestra Risorse.

• Fare clic con il pulsante destro del mouse sull’immagine nella scheda Miniature della finestra Risultati.

• Fare clic con il pulsante destro del mouse sul tag img nel codice HTML della scheda Modifica nella finestra del 

documento.

3 Selezionare Modifica con Fireworks dal menu a comparsa.

HomeSite avvia Fireworks, qualora quest’ultimo non sia già aperto.

4 Qualora richiesto, specificare se individuare un file sorgente di Fireworks per l’immagine inserita. Per ulteriori 

informazioni sui file PNG sorgente di Fireworks, consultare la Guida in linea di Fireworks.

5 Modificare l’immagine in Fireworks. 

La finestra del documento indica che si sta modificando un’immagine di Fireworks da un’altra applicazione.

6 Al termine delle modifiche, fare clic su Fine nella finestra del documento. 

L’immagine aggiornata viene riesportata in HomeSite e, se selezionato, viene salvato anche il file sorgente PNG.
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Utilizzo di GoLive e altri editor HTML

Fireworks genera HTML puri che possono essere letti da tutti gli editor HTML; è inoltre in grado di importare 

contenuti HTML. Questa funzione consente di aprire e modificare quasi tutti i documenti HTML all’interno di 

Fireworks.

È possibile esportare e copiare codice HTML di Fireworks in GoLive in modo analogo alla maggior parte degli editor 

HTML. La sola eccezione è che occorre scegliere GoLive HTML come stile HTML prima di esportare o copiare 

l’HTML da Fireworks. 

Nota: lo stile dell’HTML di GoLive non supporta il codice dei menu a comparsa. Se il documento di Fireworks contiene 

menu a comparsa, prima dell’esportazione scegliere HTML generico come stile HTML.

Operazioni con Flash

• È possibile importare, copiare e incollare o esportare facilmente grafica vettoriale e immagini bitmap, animazioni 

e pulsanti a più stati da utilizzare in Adobe Flash®.

• il testo TLF di Flash viene copiato come immagine bitmap vuota in Fireworks in esecuzione su Windows. 

Convertite il testo TLF in ASCII e importatelo in Fireworks.

• Inoltre, la funzionalità di avvio e modifica semplifica la modifica degli elementi grafici di Fireworks dall’interno di 

Flash. Quando si utilizza Flash, le preferenze di avvio e modifica impostate in Fireworks vengono sempre applicate.

• Lo stile dell’HTML di Flash non supporta il codice dei menu a comparsa. I comportamenti dei pulsanti di Fireworks 

e altri tipi di interattività non vengono importati in Flash.

Inserire elementi grafici di Fireworks in Flash

L’importazione o la copia di un file PNG di Fireworks forniscono il massimo controllo sulle modalità di importazione 

di elementi grafici e animazioni in Flash. È inoltre possibile importare file JPEG, GIF, PNG e SWF esportati da 

Fireworks.

Nota: quando gli elementi grafici di Fireworks vengono importati o copiati e incollati in Flash, alcuni attributi vanno 

persi, quali ad esempio i filtri attivi e le texture. Non è possibile importare o copiare e incollare l’effetto gradiente contorni 

da Fireworks in un documento Flash. Inoltre, Flash supporta solo i riempimenti uniformi, i riempimenti a gradiente e i 

tratti base.

Importare file PNG di Fireworks in Flash

I file PNG sorgente di Fireworks possono essere importati direttamente in Flash, senza doverli esportare ad alcun altro 

formato grafico. Tutti gli elementi grafici vettoriali, bitmap, delle animazioni e dei pulsanti multistato di Fireworks 

possono essere importati in Flash.

Nota: i comportamenti dei pulsanti di Fireworks e altri tipi di interattività non vengono importati in Flash poiché i 

comportamenti di Fireworks vengono abilitati da JavaScript, esterno al formato file. Flash utilizza codice ActionScript 

interno.

1 Salvare il documento in Fireworks.

2 Passare a un documento aperto di Flash.

3 (Facoltativo) Fare clic sullo stato chiave e sul livello nel quale importare il contenuto di Fireworks.

4 Scegliere File > Importa.
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5 Individuare il file PNG e selezionarlo.

6 Nella finestra di dialogo Importa documento Fireworks, effettuare una delle seguenti operazioni:

• Selezionare l’opzione Importa come singolo bitmap appiattito.

• Selezionare un’opzione di importazione dai due menu a comparsa.

7 Selezionare la modalità di importazione del testo.

8 Fare clic su OK.

Nota: le selezioni effettuate nella finestra di dialogo Importa documento Fireworks vengono salvate e utilizzate come 

impostazioni predefinite.

Opzioni per l’importazione di testo, oggetti vettoriali ed elementi grafici di Fireworks

Opzioni per l’importazione di elementi grafici

Importa come singolo bitmap appiattito Consente di importare una singola immagine non modificabile.

Importa tutte le pagine come clip filmato in stati nuovi Importa tutte le pagine nel file PNG in un nuovo livello di 

Flash che prenderà lo stesso nome del file PNG. Nel nuovo livello si crea uno stato chiave nella posizione attuale dello 

stato; la prima pagina del file PNG viene inserita in tale stato come clip filmato e tutte le altre pagine vengono quindi 

inserite negli stati seguenti come clip filmato. Vengono mantenuti sia la gerarchia dei livelli che gli stati all’interno del 

file PNG.

Importa Pagina 1 nello stato corrente come clip filmato Il contenuto della pagina selezionata viene importato come 

clip filmato, il quale viene inserito nello stato e nel livello attivi del file di Flash. Vengono mantenuti sia la gerarchia 

dei livelli che gli stati all’interno del file PNG.

Importa tutte le pagine come clip filmato in scene nuove Importa tutte le pagine dal file PNG e le applica tutte in una 

nuova scena come clip filmato. Vengono mantenuti tutti i livelli e gli stati all’interno del file PNG. Nel caso in cui nel 

file di Flash esistano già delle scene, il processo di importazione aggiunge le scene nuove di seguito a quelle già esistenti.

Importa Pagina 1 in un livello nuovo La pagina selezionata viene importata come livello nuovo. Gli stati vengono 

importati nella sequenza cronologica come stati separati.

Opzioni per l’importazione degli oggetti vettoriali

Importa come bitmap per mantenere aspetto Conserva la modificabilità degli oggetti vettoriali, a meno che siano 

disponibili riempimenti, tratti o effetti speciali non supportati da Flash. Per conservare l’aspetto di tali oggetti, Flash li 

converte in immagini bitmap non modificabili.

Importa come tracciati modificabili Conserva la modificabilità di tutti gli oggetti vettoriali. Se gli oggetti presentano 

riempimenti, tratti o effetti speciali non supportati da Flash, le proprietà potrebbero sembrare diverse dopo 

l’importazione.

Opzioni per l’importazione di testo

Importa come bitmap per mantenere aspetto Conserva la modificabilità del testo, a meno che siano presenti 

riempimenti, tratti o effetti speciali non supportati da Flash. Per conservare l’aspetto di tale testo, Flash lo converte in 

un’immagine bitmap non modificabile.

Nota: Il testo TLF di Flash viene copiato come immagine bitmap vuota in Fireworks. 

Mantieni modificabile tutto il testo Conserva la modificabilità di tutto il testo. Se gli oggetti di testo presentano 

riempimenti, tratti o effetti speciali non supportati da Flash, potrebbero sembrare diversi dopo l’importazione.
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Copiare o trascinare gli elementi grafici di Fireworks in Flash

Per copiare elementi grafici in versioni di Flash precedenti a Flash 8, scegliere Modifica > Copia contorni tracciati.

Nota: potrebbe essere necessario separare gli oggetti (Modifica > Separa) per renderli modificabili come oggetti vettoriali 

separati in Flash.

1 In Fireworks, selezionare l’oggetto o gli oggetti da copiare.

2 Selezionare Modifica > Copia e scegliere Copia dal menu a comparsa Flash.

3 In Flash, creare un nuovo documento e scegliere Modifica > Incolla o trascinare il file direttamente da Fireworks a 

Flash.

4 Nella finestra di dialogo Importa documento Fireworks, selezionare un’opzione:

Stato corrente come clip filmato Il contenuto da incollare viene importato come clip filmato, il quale viene inserito 

nello stato e nel livello attivi nel file di Flash. Vengono mantenuti sia la gerarchia dei livelli che gli stati all’interno 

del file PNG.

Nuovo livello Il contenuto incollato viene importato come nuovo livello. Gli stati vengono importati nella 

sequenza cronologica come stati separati.

5 Selezionare la modalità di importazione degli oggetti vettoriali.

6 Selezionare la modalità di importazione del testo.

7 Fare clic su OK.

Nota: le selezioni effettuate nella finestra di dialogo Importa documento Fireworks vengono salvate e utilizzate come 

impostazioni predefinite.

La struttura della libreria di Flash

Gli oggetti di Fireworks sono importati in una Cartella oggetti Fireworks nella libreria di Flash. La struttura all’interno 

di questa cartella è la seguente:

Cartella File 1 // Con lo stesso nome del file di Fireworks

• Cartella Pagina 1 // Con lo stesso nome della pagina (se vi è più di una pagina)

— Pagina 1 // Con lo stesso nome della pagina

— — Cartella Stato 1 // Con lo stesso nome dello stato (se sono presenti più stati)

— — Stato 1 // Con lo stesso nome dello stato

— — — Simbolo 1 nello Stato 1 // Nome in base al nome del simbolo

— — — Simbolo 2 nello Stato 1

... 

— Cartella Livelli condivisi // Livelli condivisi tra gli stati nella Pagina 1

— — Cartella Livelli condivisi // Con lo stesso nome del livello condiviso

— — Simbolo del Livello condiviso

• Cartella Pagina 2 

— Pagina 2 

— Simbolo 1 nella Pagina 2 (per le pagine senza stati) 

... 
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• Cartella Pagina master 

— Pagina master 

— Simbolo 1 nella Pagina master 

... 

— Cartella Livelli condivisi // Livelli condivisi tra le pagine 

— — Cartella Livelli condivisi // Con lo stesso nome del livello condiviso 

— — Simbolo del Livello condiviso 

L’importazione dei simboli di Fireworks in Flash

Quando si importano simboli Fireworks in Flash, è necessario tenere presente quanto segue:

• Se un simbolo utilizza il ridimensionamento a 9 sezioni, le quattro guide sezione vengono importate e mantenute 

in Flash. Tuttavia, il ridimensionamento a 9 sezioni non viene mantenuto per le animazioni. I simboli importati 

vengono salvati come simboli nella libreria di Flash.

• Le piccole modifiche apportate ai simboli complessi vengono perse. Viene importata la copia master del simbolo.

• I simboli grafici complessi vengono immagazzinati come file PNG e JSF. Viene importato solo il file PNG. Se il 

simbolo è formato da diversi tracciati, questi vengono combinati in un simbolo unico.

• Per ottenere una piena funzionalità dei simboli complessi in Flash, sostituirli con la versione Flash del simbolo.

Conservazione degli attributi di visibilità e blocco

Gli oggetti e i livelli che nel file PNG sono nascosti, vengono importati e rimangono nascosti in Flash. Tuttavia, le parti 

non visibili di un simbolo grafico complesso non vengono importate (ad esempio, gli stati Sopra o Giù di un pulsante).

Se un livello è bloccato o nascosto, tutti gli oggetti e i sottolivelli al suo interno ereditano questa impostazione e la 

mantengono quando vengono importati in Flash.

Se si importa una singola pagina in un nuovo livello in Flash, viene creato un livello per l’intera pagina e vengono 

visualizzati tutti gli oggetti. Gli attributi di blocco e visibilità non vengono mantenuti.

Effetti livello Photoshop supportati

Effetti dal vivo Photoshop - Ombra esterna La mappatura è la seguente:

• La dimensione viene mappata su blurX, blurY.

• La distanza viene mappata su distanza.

• Il colore viene mappato sul colore.

• L’angolo viene mappato su 180 - (angolo dell’effetto Photoshop).

Effetti dal vivo Photoshop - Ombra interna La mappatura è la seguente:

• La dimensione viene mappata su blurX, blurY.

• La distanza viene mappata su distanza.

• Il colore viene mappato sul colore.

• L’angolo viene mappato su 180 - (angolo dell’effetto Photoshop).

Effetti dal vivo Photoshop - Bagliore esterno La mappatura è la seguente:

• L’opacità viene mappata sull’intensità.
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• Il colore viene mappato sul colore.

• La dimensione viene mappata su blurX, blurY.

Effetti dal vivo Photoshop - Bagliore interno La mappatura è la seguente:

• L’opacità viene mappata sull’intensità.

• Il colore viene mappato sul colore.

• La dimensione viene mappata su blurX, blurY.

• Gli oggetti con qualunque altro effetto livello Photoshop vengono rasterizzati.

Esportazione di elementi grafici di Fireworks in altri formati per Flash

È possibile esportare elementi grafici di Fireworks come file JPEG, GIF, PNG e Adobe Illustrator 8 (AI), quindi 

importarli in Flash.

Sebbene PNG sia il formato di file nativo di Fireworks, i file degli elementi grafici PNG esportati da Fireworks sono 

differenti dai file sorgente PNG salvati in Fireworks. Analogamente ai file GIF o JPEG, i file PNG esportati contengono 

solo dati dell’immagine, senza informazioni aggiuntive sulle porzioni, i livelli, l’interattività, i filtri attivi o altro 

contenuto modificabile.

Esportare elementi grafici e animazioni di Fireworks come file SWF

Elementi grafici e animazioni di Fireworks possono essere esportati come file SWF di Flash. Per conservare le 

dimensioni e la formattazione del colore del tratto, scegliere Mantieni aspetto nella finestra di dialogo delle opzioni di 

esportazione Flash SWF.

La seguente formattazione viene persa durante l’esportazione in formato SWF: modalità di fusione, livelli, maschere 

(applicate prima dell’esportazione), oggetti porzione, mappe immagine, comportamenti, riempimenti a motivo e 

gradienti contorni.

1 Selezionare File > Salva con nome.

2 Immettere un nome di file e scegliere la cartella di destinazione.

3 Per il formato, selezionare Adobe Flash SWF.

4 Fare clic su Opzioni. Quindi, selezionare un’opzione per Oggetti:

Mantieni tracciati Consente di mantenere la modificabilità dei tracciati. Gli effetti e la formattazione non vengono 

mantenuti.

Mantieni aspetto Consente di convertire gli oggetti vettoriali in oggetti bitmap in base alle necessità e conservare 

l’aspetto dei tratti e del riempimento applicato. La modificabilità andrà perduta.

5 Selezionare un’opzione per Testo:

Mantieni modificabilità Consente di mantenere la modificabilità del testo. Gli effetti e la formattazione non 

vengono mantenuti.

Converti in tracciati Consente di convertire il testo in tracciati e conservare le opzioni di spaziatura e crenatura 

personalizzate definite in Fireworks. La possibilità di modificarlo come testo va perduta.

6 Impostare la qualità delle immagini utilizzando il dispositivo di scorrimento a comparsa Qualità JPEG.

7 Selezionare gli stati da esportare e la frequenza stati in secondi.

8 Fare clic su OK, quindi su Salva nella finestra di dialogo Esporta.
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Esportare file PNG a 8 bit con trasparenza

Per esportare file PNG a 32 bit con trasparenza, è sufficiente importare file sorgente PNG di Fireworks direttamente 

in Flash. Per esportare file PNG a 8 bit con trasparenza, completare la procedura descritta di seguito:

1 In Fireworks, scegliere Finestra > Ottimizza per aprire il pannello Ottimizza.

2 Selezionare PNG 8 come formato di file di esportazione e Trasparenza alfa dal menu a comparsa Trasparenza.

3 Selezionare File > Esporta.

4 Selezionare Solo immagini dal menu a comparsa Esporta.

5 Salvare il file con nome.

Importare in Flash immagini e animazioni esportate da Fireworks

1 Creare un nuovo documento in Flash.

Nota: se si sta importando un elemento grafico di Fireworks in un file di Flash esistente, creare un nuovo livello in 

Flash.

2 Selezionare File > Importa e individuare l’elemento grafico o il file animazione.

3 Fare clic su Apri per importare il file.

Utilizzare Fireworks per modificare gli elementi grafici di Flash

Mediante l’integrazione di avvio e modifica, è possibile utilizzare Fireworks per apportare modifiche agli elementi 

grafici precedentemente importati in Flash, anche se non sono stati esportati da Fireworks.

Nota: i file PNG Fireworks nativi importati in Flash costituiscono un’eccezione; è necessario che il file PNG sia stato 

importato come immagine bitmap appiattita.

Se l’immagine è stata esportata da Fireworks e il file originale PNG era stato salvato, è possibile modificare il file PNG 

in Fireworks direttamente da Flash. Quando si ritorna a Flash, vengono aggiornati sia il file PNG che il file grafico di 

Flash.

1 In Flash, fare clic con il pulsante destro del mouse (Windows) o tenere premuto il tasto Ctrl e fare clic (Mac OS) su 

un elemento grafico selezionato nel pannello Libreria documento.

2 Selezionare Modifica con Fireworks dal menu a comparsa.

Nota: se Modifica con Fireworks non compare nel menu a comparsa, scegliere Modifica con e individuare 

l’applicazione Fireworks.

3 Fare clic su Sì nella casella Trova sorgente per individuare il file PNG originale per l’elemento grafico Fireworks, 

quindi fare clic su Apri.

4 Apportare le modifiche necessarie, quindi fare clic su Fine.

Un nuovo file viene esportato in Flash e il file PNG originale viene salvato.

Altri argomenti presenti nell’Aiuto 

“Preferenze Avvio e modifica” a pagina 308
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Utilizzo di Illustrator

La grafica vettoriale può essere condivisa in modo semplice tra Fireworks e Adobe Illustrator®.  Tuttavia, l’aspetto degli 

oggetti può variare da applicazione a applicazione, in quanto Fireworks non condivide tutte le stesse funzioni di tutte 

le applicazioni di grafica vettoriale.

Utilizzo di Illustrator

Fireworks fornisce supporto per l’importazione dei file nativi di Illustrator (AI) CS2 e versioni successive, grazie a 

opzioni che consentono di mantenere molte proprietà dei file importati, tra cui livelli e motivi. Le immagini collegate, 

tuttavia, non vengono importate. 

È possibile importare immagini di Illustrator in Fireworks per ulteriori modifiche e per ottimizzarle per il Web.  È 

inoltre possibile esportare file di Illustrator da Fireworks.

Quando si importano file di Illustrator, Fireworks mantiene le seguenti funzioni:

Punti di Bezier  Il numero e la posizione dei punti di Bezier verranno mantenuti.

Colori All’importazione di contenuto AI in Fireworks, i colori vengono mantenuti con la maggiore precisione 

possibile. Fireworks supporta soltanto lo schema RGB. Gli schemi di colori diversi da RGB vengono automaticamente 

convertiti in RGB a 8 bit prima di essere importati in Fireworks.

Attributi del testo: è possibile copiare il testo senza problemi da Illustrator a Fireworks senza alcun cambiamento 

nell’aspetto del testo. 

Quando si importa del testo, Illustrator conserva i seguenti attributi:

• Carattere 

• Dimensioni 

• Colore 

• Grassetto

• Corsivo 

• Allineamento (a sinistra, a destra, centrato e giustificato) 

• Orientamento (orizzontale, verticale da sinistra a destra, verticale da destra a sinistra) 

• Spaziatura tra lettere 

• Posizione dei caratteri (normale, apice, pedice) 

• Crenatura automatica 

• Coppie di crenatura 

Per importare in modo rapido testo specifico in un file di Illustrator, copiarlo direttamente in Fireworks. Il testo 

copiato mantiene tutti gli attributi di testo.

Riempimenti sfumatura I gradienti vengono importati come gradienti nativi di Fireworks. Tutte i punti di sfumatura 

del gradiente vengono conservati. Anche i valori di opacità associati ai riempimenti del gradiente vengono conservati 

durante l’importazione.

Immagini I file AI di Illustrator possono contenere file dei seguenti tipi: PDF, BMP, EPS, GIF, JPEG, JPEG2000, PICT, 

PCX, PCD, PSD, PXR, PNG, TGA e TIFF.  Le immagini incorporate vengono inserite in Fireworks come immagini 

rasterizzate. Tuttavia, Fireworks non è in grado di aprire i file Al di Illustrator contenenti immagini collegate di tipo 

EPS e Al. 
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Maschere di ritaglio Fireworks supporta l’importazione di maschere di ritaglio con tracciati e tracciati composti a 

livello base.

Tracce con riempimento Le tracce con riempimento vengono importate come un singolo oggetto di disegno.

Riempimenti uniformi I tracciati con riempimento vengono importati come un singolo oggetto di disegno.

Tracciati composti I tracciati composti vengono importati come un singolo oggetto di disegno.

Gruppi Il gruppo viene mantenuto e i singoli oggetti raggruppati vengono inseriti come oggetti di disegno.

Grafici I grafici vengono importati come gruppi e perdono la loro particolare modificabilità come grafici.

Oggetti primitivi Gli oggetti primitivi di Illustrator sono in realtà tracciati, quindi non vengono importati come 

primitivi di Fireworks. 

Pattern I pattern vengono importati come singole tessere. Esse vengono importate come motivo nativo in Fireworks, 

che viene assegnato all’oggetto di disegno.

Tratti di pennello I tratti di pennello vengono importati come gruppi multipli (uno per tracciato chiuso).

Simboli I simboli vengono importati come un normale gruppo di oggetti.

Trasparenza Fireworks importa correttamente l’opacità degli oggetti, mantenendone le impostazioni di trasparenza 

in base ai valori originali di Illustrator. 

Livelli secondari Fireworks importa tutti i sottolivelli come sottolivelli di Fireworks nativi.

Importare file Illustrator contenenti più tavole di disegno

È possibile aprire un file Illustrator contenente diverse tavole di disegno, effettuando una delle seguenti operazioni:

Importazione del file Illustrator in Fireworks  Se desiderate importare dei file Adobe Illustrator contenenti diverse 

tavole di disegno e quindi importare le tavole di disegno singolarmente, utilizzate l’opzione File > Importa. 

Quando importate un file Adobe Illustrator contenente diverse tavole di disegno, il menu Pagina della finestra di 

dialogo Opzioni file vettoriali è attivo. All’interno del menu Pagina, selezionare la tavola di disegno che si desidera 

importare. Ogni tavola di disegno di Illustrator viene mappata su una pagina di Fireworks. Ad esempio, le tavole di 

disegno 1, 2 e 3 nel file Adobe Illustrator vengono visualizzate come 1, 2 e 3 nel menu Pagina.

Apertura di file Illustrator in Fireworks Per aprire tutte le tavole di disegno di un file Illustrator, selezionare File > Apri 

e aprire il file Illustrator contenente le tavole di disegno. Poiché tutte le tavole di disegno vengono importate come 

singole pagine, nella finestra di dialogo Opzioni file vettoriali le opzioni di conversione del file sono disabilitate. 

Nota: le opzioni di conversione del file vengono disabilitate anche quando si importano file Illustrator di versioni 

precedenti alla CS3 e per i file Illustrator con una sola tavola di disegno.

Operazioni con Photoshop

Fireworks importa file di Photoshop (PSD) nativi e mantiene molte funzioni di Photoshop. È inoltre possibile 

esportare elementi grafici di Fireworks in Photoshop per la modifica dettagliata dell’immagine.
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Inserire immagini di Photoshop in Fireworks

Le immagini di Photoshop possono essere inserite in Fireworks mediante i comandi File > Importa e File > Apri o 

trascinando i file nell’area di lavoro. Il comando Importa consente di accedere a opzioni individuali per i livelli di 

sfondo e le cartelle dei livelli. Al contrario, il comando Apri e il metodo di trascinamento del file consentono di 

accedere alle opzioni per le guide e gli stati.

Altri argomenti presenti nell’Aiuto 

“Preferenze di importazione e apertura da Photoshop” a pagina 307

Funzioni di Photoshop convertite e non supportate in Fireworks

Quando si apre o si importa un file Photoshop, in Fireworks l’immagine viene convertita in formato PNG secondo le 

preferenze di importazione specificate. Vedere “Preferenze di importazione e apertura da Photoshop” a pagina 307.

• Le singole maschere livelli vengono convertite in maschere di Fireworks. Le maschere di gruppo non sono 

supportate.

• Le maschere di ritaglio vengono convertite in maschere oggetto, con leggere modifiche nell’aspetto. Per mantenere 

l’aspetto perdendo però la possibilità di modifica, selezionare la preferenza Maschere di ritaglio.

• I metodi di fusione dei livelli vengono convertiti in modalità di fusione per oggetti di Fireworks, se esistono le 

modalità corrispondenti.

• Per impostazione predefinita, vengono mantenuti gli effetti livello. Se si preferisce convertire questi effetti in filtri 

attivi corrispondenti, selezionare la preferenza Effetti di livello. Tuttavia, effetti e filtri simili potrebbero produrre 

risultati leggermente diversi.

• Il primo canale alfa della tavolozza Canali viene convertito in aree trasparenti nell’immagine di Fireworks. 

Fireworks non supporta ulteriori canali alfa di Photoshop.

• Tutte le profondità e i metodi di colore di Photoshop vengono convertiti in RGB a 8 bit.

Trascinare, aprire o importare immagini di Photoshop in Fireworks

Ciascuna immagine trascinata, aperta o importata diventa un nuovo oggetto bitmap.

Nota: in Windows, i nomi dei file devono includere l’estensione PSD affinché Fireworks possa riconoscere il tipo di file. 

1 Effettuare una delle seguenti operazioni:

• Trascinare un’immagine o file di Photoshop in un documento di Fireworks aperto.

• Selezionare File > Apri o File > Importa e individuare un file di Photoshop (PSD). 

2 Fare clic su Apri. 

3 Nella finestra di dialogo visualizzata, impostare le opzioni per l’immagine e fare clic su OK.

4 Se è stato utilizzato il comando File > Importa, viene visualizzato un cursore che ha la forma di una L invertita. 

Nell’area di lavoro, fare clic sul punto in cui si desidera collocare l’angolo superiore sinistro dell’immagine.

Altri argomenti presenti nell’Aiuto 

“Preferenze di importazione e apertura da Photoshop” a pagina 307
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Opzioni di importazione per i file di Photoshop

Quando si importa o apre un file di Photoshop in Fireworks, viene visualizzata una finestra di dialogo che consente di 

specificare come importare l’immagine. Le opzioni scelte determinano l’aspetto e la modificabilità del testo importato.

1 Specificare le dimensioni dell’immagine in pixel o percentuale e specificare la risoluzione dei pixel. Per mantenere 

il rapporto larghezza/altezza corrente, selezionare Vincola proporzioni.

2 Se il file di Photoshop contiene composizioni di livelli, selezionare quale versione dell’immagine importare. 

Selezionare Mostra anteprima per visualizzare un’anteprima della composizione selezionata. La casella di testo 

Commenti visualizza i commenti presenti nel file di Photoshop. 

3 Dal menu a comparsa inferiore, scegliere come aprire l’immagine Photoshop in Fireworks:

Mantieni modificabilità del livello rispetto all’aspetto Mantiene quanto possibile la struttura del livello e la 

modificabilità del testo senza sacrificare l’aspetto dell’immagine stessa. Se il file include funzioni non supportate da 

Fireworks, l’applicazione mantiene l’aspetto del documento unendo e rasterizzando i livelli. Di seguito sono 

riportati alcuni esempi:

• I livelli CMYK, i livelli di regolazione e i livelli che utilizzano un’opzione di foratura vengono uniti con i livelli 

sottostanti.

• I livelli che utilizzano effetti non supportati possono essere uniti, in base al metodo di fusione del livello e alla 

presenza di pixel trasparenti.

Mantieni aspetto del livello Photoshop Appiattisce tutti gli oggetti di ciascun livello di Photoshop e converte 

ciascun livello di Photoshop in un oggetto bitmap. Questa opzione non consente di modificare i livelli di Photoshop 

in Fireworks. Tuttavia, i gruppi di livelli vengono mantenuti.

Impostazioni personali da preferenze Importa il file utilizzando le impostazioni di conversione file personalizzate 

specificate nella finestra di dialogo Preferenze. Vedere “Preferenze di importazione e apertura da Photoshop” a 

pagina 307.

Riduci livelli Photoshop in immagine singola Importa il file di Photoshop come immagine appiattita priva di livelli. 

Il file convertito non ha più singoli oggetti, ma è un’unica immagine bitmap. L’opacità viene mantenuta, ma non è 

modificabile.

4 Se è stato utilizzato il comando File > Importa, è possibile selezionare le seguenti opzioni:

Includi livelli di sfondo Importa gli oggetti dal livello di sfondo dell’immagine.

Importa in nuova cartella Importa l’immagine in una nuova cartella di livelli denominata Importazione 

Photoshop. 

5 Se è stato utilizzato il comando File > Apri o il file di Photoshop è stato trascinato in Fireworks, è possibile 

selezionare le seguenti opzioni:

Includi guide Mantiene le guide di Photoshop nelle posizioni originali.

Converti livelli in stati Colloca ciascun gruppo di livelli di Photoshop in un proprio stato.

L’importazione di testo da Photoshop

Per importare in modo rapido testo specifico in un file di Photoshop, copiarlo direttamente in Fireworks. Il testo 

copiato mantiene tutti gli attributi di testo.

Quando si importano file di Photoshop contenenti del testo, Fireworks controlla i tipi di carattere necessari nel 

sistema. Se i caratteri non sono installati, Fireworks richiede di sostituirli o di mantenerne l’aspetto. 
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Se al testo del file di Photoshop sono stati applicati effetti supportati da Fireworks, questi vengono applicati anche a 

Fireworks. Tuttavia, dal momento che Fireworks e Photoshop applicano gli effetti in modo diverso, questi possono 

avere un aspetto differente in ciascuna applicazione.

Quando i file di Photoshop 6 o 7 che contengono testo vengono aperti o importati in Fireworks, con l’opzione 

Mantieni aspetto selezionata, viene visualizzata un’immagine in cache del testo in modo che il suo aspetto rimanga 

identico a quello che aveva in Photoshop. Una volta modificato il testo, l’immagine memorizzata nella cache viene 

sostituita con il testo effettivo. L’aspetto del testo potrebbe essere leggermente diverso rispetto a quello del testo 

originale. Tuttavia, i dati dei tipi di carattere originali sono memorizzati nel file PNG, quindi è possibile utilizzare i 

caratteri originali memorizzati nel sistema anziché quelli installati.

Nota: Fireworks non può esportare il testo in formato Photoshop 6 o 7. Se si modifica un documento che contiene testo 

in questo formato e lo si riesporta in Photoshop, il file viene esportato in formato Photoshop 5.5. Se invece non si 

effettuano modifiche al testo, il file viene esportato in formato Photoshop 6. 

Altri argomenti presenti nell’Aiuto 

“Preferenze di importazione e apertura da Photoshop” a pagina 307

Importare ed esportare gradienti da Photoshop

La qualità del gradiente dopo l’importazione e l’esportazione dipende dal tipo di gradiente. Si potrebbe verificare una 

leggera variazione nel colore e nell’opacità dei gradienti.

Gradiente Qualità di importazione

Lineare Quasi perfetta.

Radiale Quasi perfetta.

Riflesso Quasi perfetta.

Rombo Corrispondenza approssimativa (mappata alla rettangolare)

Angolo Corrispondenza approssimativa (mappata alla conica)

Gradiente Qualità di esportazione

Lineare Quasi perfetta.

Radiale Quasi perfetta.

Righe Quasi perfetta.

Rettangolare Corrispondenza approssimativa (mappata al rombo)

Conica Corrispondenza approssimativa (mappata all’angolo)

Ellisse Corrispondenza approssimativa (mappata alla radiale)

Increspature Corrispondenza approssimativa (mappata alla radiale)

Starburst Corrispondenza imperfetta (mappato a shapeburst)

Contorno, seta, onde Corrispondenza imperfetta (mappato a lineare)
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Mantenere l’aspetto del livello di regolazione dopo l’importazione

Quando si importa un file PSD contenente un livello di regolazione, l’aspetto dei singoli livelli viene mantenuto dopo 

l’importazione.

1 Nella finestra delle preferenze, selezionare Importazione/Apertura Photoshop.

2 Selezionare Mantieni aspetto dei livelli regolati.

Mantieni aspetto dei livelli regolati

 Quando si importa un file PSD contenente un livello di regolazione, l’aspetto dei singoli livelli viene mantenuto dopo 

l’importazione. Assicurarsi di aver selezionato Impostazioni personali da preferenze all’interno della finestra di 

dialogo.

Utilizzare filtri e plug-in di Photoshop

È possibile utilizzare diversi filtri e plug-in di Photoshop e di terzi parti, sia nella finestra dei filtri attivi sia nel menu 

Filtri.

Nota: i plug-in e i filtri per Photoshop 5.5 e versioni precedenti sono supportati. Per ulteriori informazioni, vedete 

http://www.fireworkszone.com/g-2-536. I plug-in e filtri di Photoshop 6 e versioni successive non sono compatibili con 

Fireworks.

Attivare i plug-in di Photoshop mediante la finestra di dialogo Preferenze

1 Scegliere Modifica > Preferenze (Windows) o Fireworks > Preferenze (Mac OS).

2 Fare clic sulla categoria dei plug-in.

3 Selezionare Plug-in Photoshop.

Viene visualizzata la finestra di dialogo Seleziona una cartella (Windows) o Scegli una cartella (Mac OS).

Nota: se la finestra di dialogo non si apre, fare clic su Sfoglia.

4 Individuare la cartella nella quale sono installati i filtri e i plug-in di Photoshop o altri programmi, quindi fare clic 

su Seleziona (Windows) o Scegli (Mac OS).

5 Fare clic su OK per chiudere la finestra di dialogo Preferenze.

6 Riavviare Fireworks. 

Altri argomenti presenti nell’Aiuto 

“Preferenze Plug-in” a pagina 308

Attivare i plug-in di Photoshop mediante la finestra di dialogo dei filtri attivi

1 Selezionare un oggetto vettoriale, un oggetto bitmap o un blocco di testo nell’area di lavoro e fare clic sul pulsante 

più (+) accanto all’etichetta Filtri nella finestra di ispezione Proprietà.

2 Selezionare Opzioni > Individua plug-in dal menu a comparsa.

3 Individuare la cartella nella quale sono installati i filtri e i plug-in di Photoshop o altri programmi, quindi fare clic 

su Seleziona (Windows) o Scegli (Mac OS). Se compare un messaggio che richiede di riavviare Fireworks, fare clic 

su OK.

4 Riavviare Fireworks per caricare i filtri e i plug-in.

Nota: in alternativa, è possibile installare i plug-in direttamente nella corrispondente cartella di Fireworks.

http://www.fireworkszone.com/g-2-536
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Inserire gli elementi grafici di Fireworks in Photoshop

Fireworks garantisce un supporto esteso per l’esportazione dei file in formato Photoshop (PSD). Le immagini di 

Fireworks esportate in Photoshop mantengono le stesse caratteristiche di modificabilità una volta riaperte in 

Fireworks, così come gli altri elementi grafici di Photoshop. Gli utenti di Photoshop possono intervenire sulle 

immagini in Fireworks e quindi proseguire la fase di modifica in Photoshop.

È possibile utilizzare l’estensione Salva PSD per esportare rapidamente le pagine e gli stati del documento Fireworks 

come file separati PSD. Questa estensione è disponibile alla pagina 

http://www.adobe.com/go/learn_fw_psdsave_it

Esportare un file in formato Photoshop

1 Selezionare File > Salva con nome.

2 Assegnare un nome al file e scegliere Photoshop PSD dal menu Salva con nome.

3 Per specificare le impostazioni di esportazione preimpostate per oggetti, effetti e testo, fare clic su Opzioni. Quindi, 

scegliere una preimpostazione dal menu Impostazioni.

Mantieni modificabilità rispetto all’aspetto Converte gli oggetti in livelli, conserva la modificabilità degli effetti e 

converte il testo in livelli di testo modificabili di Photoshop. Selezionare questa opzione se si prevedono interventi 

importanti sulle immagini di Photoshop e non è quindi necessario conservare l’aspetto preciso dell’immagine di 

Fireworks.

Mantieni aspetto Fireworks Converte ogni oggetto in un singolo livello di Photoshop, gli effetti e il testo in 

immagini diventano quindi non modificabili. Selezionare questa opzione per mantenere il controllo sugli oggetti 

di Fireworks in Photoshop e conservare contemporaneamente l’aspetto originale dell’immagine di Fireworks.

File Photoshop ridotto Appiattisce ogni livello in un’immagine pienamente renderizzata. Selezionare questa 

opzione se si esporta un file contenente un numero elevato di oggetti Fireworks.

Personale Consente di specificare impostazioni specifiche per oggetti, effetti e testo.

4 Fare clic su Salva per esportare il file di Photoshop.

Nota: Photoshop 5.5 e versioni precedenti non possono aprire i file contenenti più di 100 livelli. È necessario eliminare 

o fondere gli oggetti se il documento di Fireworks che si sta esportando contiene più di 100 oggetti.

Personalizzare le impostazioni di esportazione di Photoshop

1 Nella finestra di dialogo Salva con nome, selezionare Photoshop PSD come tipo di file e fare clic su Opzioni.

2 Nel menu a comparsa Impostazioni, scegliere Personale.

3 Nel menu a comparsa Oggetti, scegliere una delle opzioni seguenti:

Converti in livelli Photoshop Converte oggetti singoli di Fireworks in livelli di Photoshop e le maschere di 

Fireworks in maschere livello di Photoshop.

Riduci a livello singolo ogni livello Fireworks Appiattisce tutti gli oggetti di ogni singolo livello di Fireworks e 

trasforma ogni livello di Fireworks in un livello in Photoshop. Quando si sceglie questa opzione, si perde la capacità 

di modificare gli oggetti di Fireworks in Photoshop. Andranno perse anche altre caratteristiche associate agli 

oggetti di Fireworks, come le modalità fusione.

4 Nel menu a comparsa Effetti, scegliere una delle opzioni seguenti:

Mantieni modificabilità Converte i filtri attivi di Fireworks nel loro equivalente Photoshop. Gli eventuali effetti 

privi di corrispondenti in Photoshop vengono scartati.

http://www.adobe.com/go/learn_fw_psdsave_it
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Rendering degli effetti Appiattisce gli effetti in oggetti. Quando si sceglie questa opzione, l’aspetto degli effetti 

viene mantenuto, ma non è possibile modificare gli effetti in Photoshop.

5 Nel menu a comparsa Testo, scegliere una delle opzioni seguenti:

Mantieni modificabilità Converte il testo in un livello modificabile di Photoshop. Le caratteristiche di 

formattazione del testo non supportate in Photoshop vanno perse. 

Rendering del testo Trasforma il testo in un oggetto immagine. Quando si sceglie questa opzione, l’aspetto del 

testo viene mantenuto, ma non è possibile modificare il testo.

Operazioni con Director

Fireworks consente di esportare elementi grafici e contenuti interattivi in Director®. Questa funzionalità consente agli 

utenti di Director di usufruire degli strumenti di progettazione grafica e di ottimizzazione di Fireworks senza 

compromettere la qualità.

• Il processo di esportazione mantiene i comportamenti e le porzioni presenti nell’immagine. 

• Le immagini suddivise in porzioni possono essere esportate con i rollover

Nota: lo stile HTML di Director non supporta il codice dei menu a comparsa.

Inserire file di Fireworks in Director

Director può importare immagini appiattite di Fireworks, quali JPEG e GIF. Le immagini PNG a 32 bit possono inoltre 

essere importate con trasparenza. Per il contenuto suddiviso in porzioni, interattivo e animato, Director può importare 

HTML di Fireworks.

Per informazioni sull’esportazione delle immagini appiattite di Fireworks quali JPEG e GIF, consultare la Guida in 

linea di Fireworks.

Esportare immagini PNG a 32 bit con trasparenza

1 In Fireworks, scegliere Finestra > Ottimizza, modificare il formato file di esportazione in PNG 32 e impostare Mat 

su trasparente.

2 Selezionare File > Esporta.

3 Selezionare Solo immagini dal menu a comparsa Salva con nome. 

4 Salvare il file con nome.

Esportare contenuto di Fireworks suddiviso in livelli e porzioni in Director

Con l’esportazione delle porzioni di Fireworks a Director, è possibile esportare contenuto suddiviso in porzioni e 

interattivo quali le immagini dei pulsanti e dei rollover. L’esportazione dei livelli in Director consente di esportare 

contenuto di Fireworks suddiviso in livelli quali, ad esempio, le animazioni.

1 In Fireworks, scegliere File > Esporta.

2 Nella finestra di dialogo Esporta, digitare un nome per il file e scegliere una cartella di destinazione.

3 Selezionare Director dal menu a comparsa Esporta.

4 Selezionare un’opzione di Sorgente:

Livelli di Fireworks Esporta tutti i livelli presenti nel documento. Selezionare questa opzione se si esporta contenuto 

suddiviso in livelli o un’animazione.
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Porzioni di Fireworks Esporta le porzioni del documento. Selezionare questa opzione se si esporta contenuto 

suddiviso in porzioni o interattivo quali le immagini dei rollover e i pulsanti.

5 Per ritagliare automaticamente le immagini esportate in modo che si adattino agli oggetti di ciascuno stato, 

selezionare Ritaglia immagini. 

6 Selezionare Inserisci immagine nella sottocartella per definire una cartella per le immagini.

Importare un’immagine appiattita di Fireworks in Director

1 In Director, scegliere File > Importa. 

2 Portarsi sul file desiderato, quindi fare clic su Importa.

3 (Facoltativo) Modificare le opzioni nella finestra di dialogo Opzioni immagine. Per informazioni su ciascuna 

opzione, consultare Utilizzo di Director.

4 Fare clic su OK per visualizzare l’elemento grafico importato nel cast come bitmap.

Importare contenuto di Fireworks interattivo, suddiviso in livelli o porzioni

1 In Director, scegliere Insert > Fireworks > Images from Fireworks HTML (Inserisci > Fireworks >Immagini da 

HTML di Fireworks).

Nota: nome e posizione di questo comando di menu possono essere differenti a seconda della versione di Director.

2 Individuare il file HTML di Fireworks esportato per l’uso in Director.

3 (Facoltativo) Modificare le opzioni nella finestra di dialogo Open Fireworks HTML (Apri HTML di Fireworks). 

Color (Colore) Specifica una profondità colore per gli elementi grafici importati. Se contengono la trasparenza, 

scegliere il colore a 32 bit.

Registration (Registro) Imposta il punto di registro per gli elementi grafici importati.

Import Rollover Behaviors as Lingo (Importa comportamenti rollover come Lingo) Converte i comportamenti di 

Fireworks in codice Lingo.

Import to Score (Importa in score) Inserisce i membri del cast nello score durante l’importazione.

4 Fare clic su Open (Apri).

Vengono importati gli elementi grafici e il codice del file HTML di Fireworks.

Nota: se si sta importando un’animazione di Fireworks, trascinare gli stati chiave in Director per ridefinire la 

programmazione di ogni livello importato secondo necessità.

Modificare i membri del cast di Director in Fireworks

Altri argomenti presenti nell’Aiuto 

“Preferenze Avvio e modifica” a pagina 308

Avviare Fireworks per modificare un membro del cast di Director

1 In Director, fare clic con il pulsante destro del mouse (Windows) o fare clic tenendo premuto il tasto Ctrl (Mac OS) 

su un elemento grafico selezionato nella finestra del Cast.

2 Selezionare Launch External Editor (Avvia editor esterno) dal menu a comparsa.

Nota: per impostare Fireworks come editor esterno per le immagini bitmap, in Director scegliere File > Preferences > 

Editors (File > Preferenze > Editor) e impostare Fireworks.
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Il file si apre in Fireworks e la parte superiore della finestra del documento indica che si sta modificando un file da 

Director.

3 Apportare le modifiche necessarie e fare clic su Done (Fine) al termine dell’operazione.

Fireworks esporta un nuovo file grafico a Director.

Usando l’integrazione di avvio e modifica, si possono apportare modifiche ai membri del cast di Director avviando 

Fireworks per modificarli dall’interno dell’applicazione. Inoltre, è possibile avviare Fireworks dall’interno di 

Director per ottimizzare i membri del cast.

Ottimizzare i membri del cast di Director

Avviare Fireworks da Director per visualizzare in anteprima le modifiche di ottimizzazione per i membri del cast 

selezionati.

1 In Director, selezionare il membro del cast nella finestra Cast e fare clic su Optimize in Fireworks (Ottimizza in 

Fireworks) nella scheda Bitmap della finestra di ispezione Proprietà.

2 In Fireworks, modificare le impostazioni di ottimizzazione. 

3 Al termine, fare clic su Aggiorna. Se viene visualizzata la finestra di dialogo MIX Editing, fare clic su Fine. 

Condividere metadati delle immagini con Adobe XMP 

Adobe XMP (eXtensible Metadata Platform) consente di aggiungere informazioni sui file ai file PNG, GIF, JPEG, 

Photoshop e TIFF salvati. XMP facilita lo scambio di metadati (autore, copyright e parole chiave) tra le applicazioni di 

Adobe.

1 Scegliere File > Informazioni file

2 Effettuare una delle seguenti operazioni:

• Per aggiungere metadati, consultare “Aggiungere metadati mediante la finestra di dialogo Informazioni file” a 

pagina 287.

• Per creare nuove categorie di metadati, consultare “Operazioni con i modelli di metadati” a pagina 288.

• Per importare metadati da un file XML esistente, consultare “Importare metadati in un documento” a 

pagina 290.

Aggiungere metadati mediante la finestra di dialogo Informazioni file

La finestra di dialogo Informazioni file presenta i dati della fotocamera, altre proprietà di file, la cronologia delle 

modifiche e informazioni sul copyright e sull’autore. Presenta inoltre pannelli per metadati personalizzati. I metadati 

possono essere aggiunti direttamente nella finestra di dialogo Informazioni file. Se sono selezionati più file, la finestra 

di dialogo indica se per un campo di testo sono presenti valori diversi. Le informazioni immesse in un campo di testo 

sovrascrivono eventuali metadati esistenti e vengono applicate a tutti i file selezionati.

Nota: è possibile visualizzare i metadati nel pannello Metadati, in alcune visualizzazioni del pannello Contenuto e 

quando si porta il puntatore su una miniatura nel pannello Contenuto.

1 Selezionare uno o più file.

2 Scegliere File > Informazioni file.

3 Nella parte superiore della finestra di dialogo, selezionare una delle seguenti schede:
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Scorrere le schede mediante le frecce destra e sinistra oppure fare clic sulla freccia rivolta verso il basso e scegliere 

una categoria dall’elenco.

Descrizione Consente di immettere informazioni sul file, quali il titolo del documento, l’autore, la descrizione e le 

parole chiave che possono essere utilizzate per la ricerca del documento. Per specificare le informazioni del 

copyright, selezionate Coperto da copyright dal menu a comparsa Stato copyright. Immettere quindi il proprietario 

e la nota di copyright nonché l’URL della persona o della società a cui appartiene il copyright.

IPTC Contiene quattro aree: in Contenuto IPTC viene descritto il contenuto visivo dell’immagine. In Contatto 

IPTC sono elencati i dati di contatto del fotografo. In Immagine IPTC sono elencati dati descrittivi sull’immagine. 

Stato IPTC elenca informazioni sul flusso di lavoro e copyright.

Dati fotocamera Contiene due aree: Dati fotocamera 1 presenta informazioni di sola lettura sulla fotocamera e le 

impostazioni con cui è stata ripresa la foto, ad esempio marca e modello della fotocamera, velocità otturatore e 

numero di apertura. Dati fotocamera 2 contiene informazioni di sola lettura sul file, tra cui dimensioni in pixel e 

risoluzione.

Dati video Elenca le informazioni relative al file video, comprese la larghezza e l’altezza dei fotogrammi video; 

consente inoltre di immettere informazioni quali il nome del nastro e della scena.

Dati audio Consente di immettere informazioni relative ai file audio, quali il titolo, il nome dell’artista, il bitrate e 

le impostazioni per la riproduzione a ciclo continuo.

SWF mobile Elenca informazioni sui file multimediali per dispositivi mobili, tra cui titolo, autore, descrizione e tipo 

di contenuto.

Categorie Permette di inserire informazioni basate sulle categorie Associated Press.

Origine Consente di immettere informazioni utili per la diffusione di notizie, quali data e luogo di creazione, 

informazioni per la trasmissione, istruzioni particolari e informazioni per il titolo.

DICOM Presenta informazioni sul paziente, sullo studio, sulla serie e sulle apparecchiature per immagini DICOM.

Storia Per le immagini salvate da Photoshop, presenta le informazioni provenienti dalla funzione Storia di Adobe 

Photoshop. L’opzione Storia è disponibile solo se è installato anche Adobe Photoshop.

Illustrator Consente di applicare un profilo documento per la stampa, il Web o output per dispositivi mobili.

Avanzati Elenca campi e strutture per la registrazione di metadati mediante nomi di spazi e proprietà, ad esempio 

formato file e proprietà XMP, Exif e PDF.

Dati Raw Presenta informazioni testuali XMP sul file.

4 Digitare le informazioni da aggiungere ai campi visualizzati.

5 Fare clic su OK per salvare le modifiche.

Operazioni con i modelli di metadati

È possibile creare nuovi modelli per metadati in Adobe Bridge mediante il comando Crea modello metadati. È inoltre 

possibile modificare i metadati nella finestra di dialogo Informazioni file e salvarli come file di testo con estensione 

.xmp. I file XMP possono essere condivisi con altri utenti o applicati ad altri file.

È possibile salvare i metadati in un modello da utilizzare per compilare i metadati dei documenti Adobe InDesign e di 

altri documenti creati con software abilitato per XMP.  I modelli creati vengono registrati in un percorso condiviso 

accessibile a tutti i software abilitati per XMP.

Per vedere i propri modelli XMP, aprire la finestra di dialogo Informazioni file, fare clic su Importa e scegliere Mostra 

cartella di modelli.
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Creare un modello di metadati

1 Effettuare una delle seguenti operazioni:

• Scegliere Strumenti > Crea modello metadati.

• Scegliere Crea modello metadati dal menu del pannello Metadati.

2 Immettere un nome nella casella di testo Nome modello.

3 Selezionare i metadati da includere nel modello dai campi disponibili nella finestra di dialogo Crea modello 

metadati e immettere i valori desiderati nelle relative caselle.

Nota: se si seleziona un’opzione di metadati e la relativa casella viene lasciata vuota, quando il modello viene 

applicato a un documento eventuali metadati corrispondenti presenti in quest’ultimo vengono eliminati da Adobe 

Bridge.

4 Fare clic su Salva.

Salvare i metadati come file XMP nella finestra di dialogo Informazioni file

1 Scegliere File > Informazioni file.

2 Scegliere Esporta dal menu a comparsa nella parte inferiore della finestra di dialogo.

3 Digitare un nome per il file, scegliere una posizione in cui salvarlo e fare clic su Salva.

Mostrare o eliminare i modelli di metadati

1 Per mostrare i modelli di metadati in Esplora risorse (Windows) o nel Finder (Mac OS), effettuare una delle 

seguenti operazioni:

• Scegliere Strumenti > Crea modello metadati. Fare clic sul menu a comparsa nell’angolo in alto a destra della 

finestra di dialogo risultante e scegliere Mostra cartella di modelli.

• Scegliere File > Informazioni. Fare clic sul menu a comparsa nella parte inferiore della finestra di dialogo 

risultante e scegliere Mostra cartella di modelli.

2 Selezionare il modello da eliminare e premere il tasto Canc, oppure trascinare il modello nel Cestino.

Applicare i modelli di metadati ai file in Adobe Bridge

1 Selezionare uno o più file.

2 Scegliere uno dei seguenti comandi dal menu del pannello Metadati o dal menu Strumenti:

• Aggiungi metadati, seguito dal nome del modello. Il modello di metadati viene applicato solo se nel file non è 

già presente un valore o una proprietà di metadati.

• Sostituisci metadati, seguito dal nome del modello. I metadati del modello sostituiscono completamente 

eventuali metadati già presenti nel file.

Modificare i modelli di metadati

1 Effettuare una delle seguenti operazioni:

• Scegliere Strumenti > Modifica modello metadati, seguito dal nome del modello.

• Scegliere Modifica modello metadati, seguito dal nome del modello, dal menu del pannello Metadati.

2 Immettere nuovi valori di metadati nelle caselle.

3 Fare clic su Salva.
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Importare metadati in un documento

1 Selezionare uno o più file.

2 Scegliere File > Informazioni file.

3 Scegliere Importa dal menu a comparsa nella parte inferiore della finestra di dialogo.

Nota: prima di poter importare i metadati, è necessario salvare un modello di metadati.

4 Specificare come importare i dati:

Cancella proprietà esistenti e sostituisci con proprietà modello Sostituisce tutti i metadati nel file con i metadati 

presenti nel file XMP file.

Mantieni metadati originali ma sostituisci proprietà corrispondenti dal modello Sostituisce solo i metadati che 

hanno proprietà differenti nel modello.

Mantieni metadati originali ma aggiungi proprietà corrispondenti dal modello (Impostazione predefinita) 

Applica i metadati del modello solo se nel file non è già presente un valore o una proprietà di metadati.

5 Fare clic su OK.

6 Individuare il file XMP e fare clic su Apri.

Anteprima dei documenti di Fireworks in emulatori di 
dispositivi mobili

I documenti Fireworks possono essere visualizzati in anteprima nei diversi emulatori di dispositivi mobili disponibili 

in Device Central. Device Central viene automaticamente installato insieme a Fireworks.

Anteprima documenti Fireworks in Device Central

1 Creare il documento che si desidera visualizzare in anteprima in Fireworks. È possibile creare anche un documento 

con diverse pagine e visualizzare l’anteprima delle singole pagine.

2 Selezionare File > Anteprima in Device Central.

3 In Device Central, visualizzare l’anteprima del documento nei diversi dispositivi elencati nel pannello Dispositivi 

di prova.

Il colore di sfondo della pagina viene utilizzato come colore di sfondo dell’anteprima. Se lo sfondo è trasparente, il 

colore di sfondo utilizzato per l’anteprima è bianco.

Per visualizzare l’anteprima del documento, utilizzare le diverse opzioni di Device Central. Per ulteriori informazioni, 

vedere l'Esercitazione video disponibile su Adobe TV.

Creare un documento Fireworks basato su un dispositivo mobile selezionato

Per creare un documento per uno specifico dispositivo mobile, utilizzare la seguente procedura. 

1 Selezionare File > Device Central.

2 Nel pannello Dispositivi di prova della finestra Device Central, selezionare il dispositivo per il quale si desidera 

creare il documento Fireworks.

Nota: se si desidera creare un documento Fireworks la cui dimensione è leggermente diversa da quella specificata nel 

pannello del dispositivo, selezionare Usa dimensione personalizzata. Modificare i valori secondo le esigenze.

http://tv.adobe.com/watch/learn-fireworks-cs5/using-the-new-integration-with-device-central
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3 Fare clic su Crea.

4 Fireworks apre un documento con le dimensioni selezionate.

Per ulteriori informazioni, vedere l'Esercitazione video disponibile su Adobe TV.

Creare un documento Fireworks basato su un dispositivo mobile selezionato

Quando si crea un documento per una serie di dispositivi mobili con le stesse dimensioni, utilizzare la seguente 

procedura. 

1 Selezionare File > Device Central.

2 Nel pannello Dispositivi di prova della finestra Device Central, selezionare i dispositivi per i quali si desidera creare 

il documento Fireworks.

Nota: se si selezionano dispositivi di dimensioni diverse, Device Central crea dei gruppi contenenti dispositivi di 

dimensioni simili. Questi gruppi vengono visualizzati nel pannello Preimpostazioni dimensioni corrispondenti.

3 Nel pannello Preimpostazioni dimensioni corrispondenti, selezionare il gruppo per il quale si desidera creare un 

documento Fireworks. 

4 Fare clic su Crea.

5 Fireworks apre un documento con le dimensioni selezionate.

Per ulteriori informazioni, vedere l'Esercitazione video disponibile su Adobe TV.

http://tv.adobe.com/watch/learn-fireworks-cs5/using-the-new-integration-with-device-central
http://tv.adobe.com/watch/learn-fireworks-cs5/using-the-new-integration-with-device-central
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Capitolo 19: Automatizzare le operazioni

Adobe® Fireworks® automatizza e semplifica molte attività di disegno, modifica e conversione di file che richiedono 

solitamente tempo e che sono necessarie per lo sviluppo Web.

Ricerca e sostituzione di elementi

• La funzione Trova e sostituisci aiuta a individuare e sostituire rapidamente diversi elementi, come testo, URL, 

caratteri e colori. Si possono eseguire ricerche e sostituzioni nel documento corrente o in più file.

• La funzione Trova e sostituisci funziona solo sui file PNG di Fireworks o sui file contenenti oggetti vettoriali, quali 

i file Adobe FreeHand® e Adobe Illustrator®.

Pannello Trova
A. Opzione Cerca  B. Opzione Trova  

Trovare e sostituire espressioni regolari

Negli esempi seguenti viene illustrato l'utilizzo della funzione Trova e sostituisci per le espressioni regolari.

Esempio 1

1 Digitate Type K2Editor nell'oggetto di testo.

2 Selezionate Modifica > Cerca e sostituisci.

3 Selezionate Espressioni regolari.

4 In Trova, immettete (\w+)Editor.

5 In Sostituisci, immettete $1Soft.

6 Fare clic su Sostituisci tutto.

La parola K2Editor cambia in K2Soft.

Esempio 2

1 Digitate IndyCar=3500:WRCar=2000 nell'oggetto di testo.

2 Nella finestra di dialogo Trova e sostituisci, ricercate (\w{4})(\w{3})=\d+:\w+\2=\d+\d

Viene eseguita la ricerca della stringa IndyCar=3500:WRCar=2000.

A
B



293UTILIZZO DI FIREWORKS

Automatizzare le operazioni

Ultimo aggiornamento 4/5/2011

Selezionare la sorgente per la ricerca

1 Aprire il documento.

2 Eseguire una delle procedure seguenti per aprire il pannello Trova:

• Selezionare Finestra > Trova.

• Selezionare Modifica > Cerca e sostituisci.

• Premere Ctrl+F (Windows) o Comando+F (Mac OS).

Nota: se i file selezionati sono bloccati o depositati da un sito Adobe Dreamweaver®, viene richiesto di sbloccarli o 

ritirarli prima di proseguire.

3 Selezionare una sorgente per la ricerca con il menu a comparsa Cerca.

4 Dal menu a comparsa Trova, selezionare l’attributo per il quale effettuare la ricerca. Impostare le opzioni per 

l’attributo selezionato in Trova.

5 Selezionare un’opzione di ricerca e sostituzione.

Nota: la sostituzione automatica degli oggetti in più file salva i file e non può essere annullata.

Impostare le opzioni di ricerca e sostituzione in più file

Quando si eseguono ricerche e sostituzioni su più file, specificare in che modo Fireworks deve gestire i file aperti dopo 

la ricerca.

1 Selezionare Opzioni di sostituzione dal menu del pannello Trova.

2 Selezionare Salva e chiudi file per salvare e chiudere ogni file dopo la ricerca e la sostituzione. 

Solo i documenti attivi originali rimarranno aperti.

Nota: se la funzione Salva e chiudi è disattivata e si stanno elaborando in batch molti file, potrebbero verificarsi 

problemi di memoria insufficiente, con interruzione dell’elaborazione batch.

3 Selezionare un’opzione Backup file originali:

Nessun backup Esegue la ricerca e la sostituzione senza creare copie di backup dei file originali. I file modificati 

sostituiscono quelli originali.

Sovrascrivi backup preesistenti Crea e memorizza una sola copia di backup di ogni file modificato durante 

un’operazione di ricerca e sostituzione. Se vengono eseguite ulteriori operazioni di ricerca e sostituzione, il file 

originale precedente sostituisce sempre la copia di backup. Le copie di backup vengono memorizzate in una 

sottocartella denominata Original Files (File originali).

Backup incrementali Salva tutte le copie di backup dei file modificati durante l’operazione di ricerca e sostituzione. 

I file originali vengono spostati nella sottocartella Original Files della cartella corrente, mentre in coda a ogni nome 

di file viene aggiunto un valore incrementale. Qualora vengano eseguite ulteriori operazioni di ricerca e 

sostituzione, il file originale viene copiato nella cartella dei file originali, mentre il numero successivo più alto viene 

aggiunto al nome del file. Ad esempio, per un file denominato Disegno.png, la prima volta che viene eseguita la 

ricerca e la sostituzione viene creato un file di backup denominato Disegno-1.png. Alla seconda sessione di ricerca 

e sostituzione, il file di backup verrà denominato Disegno-2.png e così via.

4 Fare clic su OK.
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Trovare e sostituire il testo

1 Nel pannello Trova, selezionare Trova testo dal secondo menu a comparsa.

2 Inserire il testo da cercare.

3 Inserire il testo di sostituzione.

4 (Facoltativo) Selezionare le opzioni per definire ulteriormente la ricerca.

Trovare e sostituire i caratteri

1 Nel pannello Trova, selezionare Trova carattere dal secondo menu a comparsa.

2 Selezionare il carattere e lo stile da trovare.

È possibile limitare la ricerca selezionando dimensioni minime e massime dei caratteri in punti.

3 Specificare il carattere, lo stile e la dimensione da utilizzare come sostituzione.

Trovare e sostituire i colori

1 Nel pannello Trova, selezionare Trova colore dal secondo menu a comparsa.

2 Scegliere un’opzione dal menu a comparsa Applica a per stabilire come verranno applicati i colori trovati:

Riempimenti e tratti Trova e sostituisce sia i colori dei riempimenti che quelli dei tratti.

Tutte le proprietà Trova e sostituisce i colori di tratti, riempimenti ed effetti.

Riempimenti Trova e sostituisce un colore di riempimento, ad eccezione dei riempimenti a motivo.

Tratti Trova e sostituisce solo i colori dei tratti.

Effetti Trova e sostituisce solo i colori degli effetti.

Trovare e sostituire gli URL

1 Nel pannello Trova, selezionare Trova URL dal secondo menu a comparsa.

2 Inserire l’URL da cercare.

3 Inserire l’URL di sostituzione.

4 (Facoltativo) Selezionare le opzioni per definire ulteriormente la ricerca:

Espressioni regolari Trova parti di parole o numeri in base alle condizioni specificate per la ricerca.

Trovare e sostituire i colori non sicuri per il Web

Per ulteriori informazioni, consultare “Ottimizzare file GIF, PNG, TIFF, BMP e PICT” a pagina 241.
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Un colore è detto WebSafe se il suo aspetto appare costante su entrambe le piattaforme Macintosh e Windows. I colori 

non WebSafe sono quelli non inclusi nella tavolozza di colori Web216.

❖ Selezionare Trova diverso da Web216 dal menu a comparsa Trova del pannello Trova.

Trova diverso da Web216 non consente di trovare o sostituire i pixel all’interno degli oggetti immagine.

Elaborazione batch 

L’elaborazione batch costituisce una soluzione di grande comodità per convertire interi gruppi di file grafici. Utilizzare 

una delle opzioni di elaborazione batch:

• Convertire una selezione di file in un altro formato.

• Convertire una selezione di file nello stesso formato ma con impostazioni di ottimizzazione diverse.

• Scalare i file esportati.

• Trovare e sostituire testo, colori, URL, caratteri e colori diversi dai colori Web216.

• Rinominare i gruppi di file mediante qualsiasi combinazione delle seguenti operazioni: aggiunta di un prefisso, 

aggiunta di un suffisso, sostituzione di una sottostringa e sostituzione degli spazi vuoti.

• Eseguire comandi specifici su una selezione di file.

Per ulteriori informazioni, consultare “Specificare la posizione di salvataggio per i file di backup” a pagina 299.

Flusso di lavoro per elaborazione batch

1 Selezionare File > Elaborazione batch e selezionare i file da elaborare.

• I file possono provenire da diverse cartelle.

• I documenti aperti possono essere inclusi nel batch.

• È possibile salvare lo script dell’elaborazione batch e utilizzarlo in un secondo momento senza aggiungere file.

Nota: se i file selezionati sono bloccati o depositati da un sito Dreamweaver, verrà richiesto di sbloccarli o ritirarli 

prima di proseguire.

2 Selezionare il file da aggiungere o rimuovere facendo clic nella finestra di dialogo Batch (Windows) o Elaborazione 

batch (Mac OS):

Aggiungi Aggiunge all’elenco dei file da elaborare in batch i file e le cartelle selezionati. Se si seleziona una cartella, 

vengono aggiunti all’elaborazione batch tutti i file leggibili e validi contenuti al suo interno.

Nota: i file validi sono tutti quelli creati, nominati e salvati. Se l’ultima versione del file non è stata salvata, il sistema 

richiede se salvarla e proseguire l’elaborazione batch. Se il file non viene salvato, viene interrotta l’intera procedura di 

elaborazione batch.

Aggiungi tutto Aggiunge all’elenco dei file da elaborare in batch tutti i file validi contenuti nella cartella selezionata.

Rimuovi Rimuove i file selezionati dall’elenco dei file da elaborare in batch.

3 Per aggiungere tutti i file aperti, selezionare Includi file aperti correnti. 

Questi file non compaiono nell’elenco dei file da elaborare in batch, ma vengono inclusi nell’operazione.
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4 Fare clic su Avanti, quindi effettuare una delle seguenti procedure:

• Per aggiungere un’attività al batch, selezionarlo nell’elenco Opzioni batch e fare clic su Aggiungi.

• Per riordinare l’elenco, selezionare l’attività dall’elenco Includi nel batch e fare clic sui pulsanti freccia su e giù.

Nota: le operazioni Esporta e Rinomina vengono eseguite sempre per ultime. Le altre attività vengono eseguite 

nell’ordine in cui vengono visualizzate.

5 Per visualizzare ulteriori opzioni per un’attività, selezionarla nell’elenco Includi nel batch.

6 Selezionare le impostazioni per ogni opzione aggiuntiva. Per rimuovere un’attività dall’elenco, fare clic su Rimuovi.

7 Fare clic su Avanti.

8 Selezionare le opzioni di salvataggio dei file elaborati:

Backup  Selezionare le opzioni di backup per i file originali.

Salva script  Salva le impostazioni di elaborazione batch per uso futuro.

Output batch Esegue l’elaborazione batch.

Al termine dell’elaborazione batch, compare un messaggio qualora non sia stato possibile elaborare alcuni dei file 

specificati.

Nota: durante l’elaborazione batch viene compilato il file di registro FireworksBatchLog.txt. Il file di registro si trova in:

• \Documents and Settings\<nome utente>\Dati applicazione\Adobe\Fireworks CS5\FireworksBatchLog.txt 

(Windows XP)

• \Utenti\<nome utente>\AppData\Roaming\Adobe\Fireworks CS5\ FireworksBatchLog.txt (Windows Vista)

• /Utenti/<nome utente>/Libreria/Application Support/Adobe/Fireworks CS5/FireworksBatchLog.txt (Mac OS)
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Modificare le impostazioni di ottimizzazione durante l’elaborazione batch

1 Selezionare Esporta dall’elenco Opzioni batch e fare clic su Aggiungi.

2 Dal menu a comparsa Impostazioni, scegliere tra le opzioni seguenti e fare clic su OK:

• Selezionare Usa impostazioni da ogni file per conservare le impostazioni di esportazione precedenti di ogni file 

durante l’elaborazione batch. Ad esempio, se si elabora in batch una cartella di file GIF e JPEG, i file risultanti 

saranno ancora GIF e JPEG. Per l’esportazione di ogni file Fireworks utilizza la tavolozza e le impostazioni di 

compressione originali.

• Selezionare Personalizza oppure fare clic su Modifica per cambiare le impostazioni nella finestra di dialogo 

Anteprima immagine.

• Selezionare un’impostazione di esportazione preimpostata, quali GIF Web 216 o JPEG - Qualità migliore. Tutti 

i file verranno convertiti a questa impostazione.

Modificare i nomi file durante l’elaborazione batch

1 Selezionare Rinomina dall’elenco Opzioni batch e fare clic su Aggiungi.

2 Specificare le opzioni Rinomina nella parte inferiore della finestra di dialogo Elaborazione batch:

Sostituisci con Consente di sostituire i caratteri di ogni nome file con caratteri diversi oppure di eliminare alcuni 

caratteri. Ad esempio, nei nomi file Temp_123.jpg, Temp_124.jpg e Temp_125.jpg, è possibile sostituire 

“Temp_12” con “Compleanno”, in modo da ottenere Compleanno3.jpg, Compleanno4.jpg e Compleanno5.jpg.

Sostituisci spazi con Consente di sostituire gli spazi presenti nel nome del file con uno o più caratteri specificati 

oppure di eliminare tutti gli spazi da ogni nome di file. Ad esempio, un file che si chiama Pic nic.jpg può essere 

modificato in Picnic.jpg oppure Pic-nic.jpg.

Aggiungi prefisso Consente di inserire un prefisso da aggiungere all’inizio del nome di ogni file. Ad esempio, se si 

inserisce “notte_”, durante l’elaborazione batch il file Alba.gif viene rinominato notte_Alba.gif.

Aggiungi suffisso Consente di inserire un suffisso da aggiungere alla fine del nome dei file, prima dell’estensione. 

Ad esempio, se si inserisce “_giorno”, durante l’elaborazione batch il file Alba.gif viene rinominato Alba_giorno.gif.

Nota: per ogni nome file modificato, è possibile effettuare una combinazione qualsiasi delle operazioni Sostituisci, 

Sostituisci spazi, Aggiungi prefisso e Aggiungi suffisso. Ad esempio, è possibile sostituire “Temp” con “Festa”, 

rimuovere tutti gli spazi e aggiungere un prefisso e un suffisso contemporaneamente.

3 Fare clic su Avanti per proseguire l’elaborazione batch.



298UTILIZZO DI FIREWORKS

Automatizzare le operazioni

Ultimo aggiornamento 4/5/2011

Scalare gli elementi grafici durante l’elaborazione batch

1 Selezionare Scala dall’elenco Opzioni batch e fare clic su Aggiungi.

2 Scegliere un’opzione di scalatura nel menu a comparsa Scala:

Nessuna scala Esporta i file invariati.

Scala alle dimensioni Scala le immagini in base ai valori di larghezza e altezza specificati.

Scala per contenere area Adatta le immagini in modo proporzionale entro i valori massimi specificati per 

larghezza e altezza.

Scegliere Scala per contenere area per convertire un gruppo di immagini in miniature di dimensioni uniformi.

Scala alla percentuale Scala le immagini in base a una percentuale.

3 (Facoltativo) Se si seleziona Scala per contenere area, selezionare anche l’opzione Scala solo i documenti più grandi 

delle dimensioni di destinazione.

Effettuare operazioni di ricerca e sostituzione durante l’elaborazione batch

Sostituisci batch influisce solo sui seguenti formati file: Fireworks PNG, Illustrator e FreeHand. Non ha alcun effetto 

sui file GIF e JPEG.

1 Selezionare Trova e sostituisci dall’elenco Opzioni batch e fare clic su Aggiungi.

2 Fare clic su Modifica.

3 Selezionare il tipo di attributo da ricercare e sostituire.

4 Immettere o selezionare lo specifico elemento da trovare nella casella di testo Trova.

5 Immettere o selezionare lo specifico elemento da sostituire nella casella di testo Sostituisci con.

6 Fare clic su OK per memorizzare le impostazioni di ricerca e sostituzione.

7 Fare clic su Avanti per proseguire l’elaborazione batch.
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Utilizzo dei comandi per l’elaborazione batch

Nota: la posizione esatta della cartella Commands varia da sistema a sistema. Dipende inoltre dalla disponibilità del 

pannello solamente per il proprio profilo utente o per tutti gli utenti. Le cartelle dei pannelli comandi si trovano nella 

cartella Configuration all’interno della cartella dell’applicazione Fireworks e nella cartella di configurazione di Fireworks 

specifica dell’utente.

Eseguire comandi JavaScript durante l’elaborazione batch

Nota: i comandi non possono essere modificati.

1 Per visualizzare i comandi disponibili, fare clic sul pulsante con il segno più (+) (Windows) o sul triangolo (Mac 

OS) accanto all’opzione Comandi nell’elenco Opzioni batch.

2 Per aggiungere un comando all’elenco Includi nel batch, selezionarlo e fare clic su Aggiungi.

Nota: alcuni comandi non funzionano durante l’elaborazione batch. Selezionare i comandi che funzionano 

all’interno del documento senza richiedere la selezione di alcun oggetto.

Specificare la posizione di salvataggio per i file di backup

Le copie di backup vengono collocate nella sottocartella File originali, all’interno di ogni cartella di origine.

1 Selezionare una posizione per l’output del batch.

2 Selezionare Backup per impostare le opzioni di backup.

3 Selezionare le modalità di esecuzione dei file di backup:

Sovrascrivi backup preesistenti Sovrascrive il file di backup precedente.

Backup incrementali Conserva copie di tutti i file di backup precedenti. All’esecuzione di una nuova elaborazione 

batch, in fondo al nome di ogni nuova copia di backup viene aggiunto un numero.

Nota: se l’opzione Backup non è selezionata, l’elaborazione batch, se interessa lo stesso formato, sovrascrive il file 

originale qualora i nomi coincidano. Se invece l’elaborazione batch ha per oggetto un formato file diverso, si viene a 

creare un nuovo file senza alcuno spostamento o modifica del file originale.
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Elaborazioni batch come script

Quando si salva uno script nella cartella Commands del disco rigido, lo script viene aggiunto al menu Comandi di 

Fireworks.

Creare uno script di elaborazione batch

1 Per creare uno script di batch, fare clic su Salva script.

2 Immettere un nome e una destinazione per lo script.

Nota: la posizione esatta di questa cartella varia. Le cartelle dei comandi si trovano nella cartella Configuration 

all’interno della cartella dell’applicazione Fireworks e nella cartella di configurazione di Fireworks specifica 

dell’utente.

3 Fare clic su Salva.

Eseguire uno script batch

1 Effettuare una delle seguenti operazioni:

• In Fireworks, selezionare Comandi > Esegui script.

• All’esterno di Fireworks, fare doppio clic sul nome del file di script nel disco rigido.

2 Selezionare uno script e fare clic su Apri.

Trascinare gli script più usati

1 Salvare uno script.

2 Effettuare una delle seguenti operazioni:

• Trascinare l’icona del file script sull’icona di Fireworks sul desktop.

• Trascinare l’icona del file script su un documento aperto di Fireworks.

Nota: se si trascinano più file di script e più file grafici sull’applicazione Fireworks, i file grafici vengono elaborati 

più volte, una per ogni script.

Estensione di Fireworks

Un’estensione è uno script di comando, un pannello di comando, una libreria, un filtro, un motivo, una texture o una 

forma automatica che estende le funzionalità di Fireworks. Fireworks viene distribuito con Adobe Extension Manager, 

un programma che consente di semplificare le operazioni di installazione, gestione ed eliminazione delle estensioni. 

Una raccolta di estensioni predefinite viene visualizzata nel menu Comandi.

Se si è esperti in JavaScript, è possibile creare le proprie estensioni Fireworks. Inoltre, è possibile utilizzare l’architettura 

di comunicazione tra più prodotti di Fireworks per consentire ad applicazioni ActionScript™ e C++ di controllare 

Fireworks. Per ulteriori informazioni, consultare la documentazione Extending Fireworks.

Durante l’installazione o la creazione di estensioni, tenere presente la seguente condizione:

• Quando si installa un’estensione o si crea un comando personalizzato, questo viene inserito nel menu Comandi di 

Fireworks.
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• Le estensioni di terze parti vengono memorizzate in sottocartelle della cartella Configuration, nella cartella 

dell’applicazione Fireworks.

• I comandi archiviati come file SWF nella cartella Command Panels sono disponibili come pannelli nel menu 

Finestra.

• I comandi creati e salvati tramite il pannello Cronologia vengono memorizzati nella cartella Commands dell’utente.

• Per ulteriori informazioni sull'estensione di Fireworks, vedete la guida di Extension Manager e visitate Fireworks 

Exchange all'indirizzo www.adobe.com/go/learn_fw_exchange_it.

Aprire Extension Manager da Fireworks

❖ Effettuare una delle seguenti operazioni:

• Selezionare Comandi > Gestisci estensioni.

• Selezionare ? > Gestisci estensioni.

Creazione di un file MXP per le risorse

1 Create un file MXI. Potete usare una copia del file MXI nella cartella Adobe Extension Manager CS5 come modello. 

Per file MXI di esempio, vedete i file MXI nella cartella Configuration nel percorso di installazione di Adobe 

Fireworks CS5.

2 Nel tag <files>, effettuate le seguenti operazioni: 

a Nell'attributo <nome file>, specificate il nome dei file presenti localmente e che devono essere inclusi nel 

pacchetto del file MXP. 

b Nell'attributo <destinazione>, specificate il percorso sulla macchina dell'utente in cui installare i file.

3 Selezionate Comandi > Gestisci estensioni.

4 In the Adobe Extension Manager, selezionate File > Package MXP Extension.

5 Selezionate il file MXI.

6 Specificate un percorso per il file MXP.

7 Fate doppio clic sul file MXP creato nel percorso specificato. I file citati nel file MXI vengono aggiunti al percorso 

specificato nel file.

Ad esempio, se desiderate aggiungere un insieme di file STL a Fireworks, specificate il percorso dei file STL come 

$Fireworks\First Run\Styles nel file MXI. Quando eseguite un file MXP creato utilizzando il file MXI, i file STL 

vengono installati in questo percorso. L'accesso agli Stili è possibile utilizzando il pannello Stili in Fireworks dopo aver 

chiuso e riaperto l'applicazione.

Scripting

Creazione di script con il pannello Cronologia

Il pannello Cronologia registra un elenco di tutte le operazioni eseguite durante la sessione di lavoro in Fireworks. 

Ogni passaggio viene memorizzato su una riga separata del pannello Cronologia, a partire dal più recente. Per 

impostazione predefinita, nel pannello sono memorizzati 20 passaggi. È tuttavia possibile modificare questo valore in 

qualsiasi momento.

http://www.adobe.com/go/learn_fw_exchange_it
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È possibile salvare gruppi di operazioni nel pannello Cronologia sotto forma di comando riutilizzabile. Poiché i 

comandi salvati non sono specifici del documento, è possibile utilizzarli in qualsiasi documento Fireworks.

I comandi salvati vengono archiviati come file JSF nella cartella Commands all’interno della cartella di configurazione 

di Fireworks specifica dell’utente.

È possibile eseguire in qualsiasi momento i comandi registrati o una selezione delle azioni del pannello Cronologia.

Salvare i passaggi come comandi da riutilizzare

1 Selezionare i passaggi da salvare come comandi:

• Fare clic su un passaggio, quindi fare clic su un altro tenendo premuto il tasto Maiusc per selezionare l’intervallo 

di passaggi da salvare come comando.

• Per selezionare passaggi non contigui, tenere premuto il tasto Ctrl (Windows) o Comando (Mac OS) e fare clic.

2 Fare clic sul pulsante Salva passaggi come comando, nella parte inferiore del pannello Cronologia.

3 Immettere un nome per il comando e fare clic su OK.

Annullare o ripetere i passaggi

❖ Effettuare una delle seguenti operazioni:

• Trascinare il marcatore di annullamento verso l’alto fino a raggiungere l’ultima operazione da annullare o 

ripristinare.

• Fare clic lungo la traccia del marcatore di annullamento a sinistra del pannello Cronologia.

Nota: i passaggi annullati rimangono evidenziati in grigio nel pannello Cronologia.

Modificare il numero di passaggi memorizzati nel pannello Cronologia

1 Selezionare Modifica > Preferenze (Windows) o Fireworks > Preferenze (Mac OS).

2 Modificare il valore Livelli annullamento.

Nota: un numero maggiore di livelli di annullamento richiede una quantità maggiore di memoria del computer.

Annullare tutti i passaggi 

❖ Selezionare Cancella cronologia dal menu del pannello Cronologia.

L’eliminazione di passaggi consente di liberare memoria e spazio su disco. Non è possibile annullare le modifiche 

apportate dai passaggi eliminati.

Riprodurre un comando salvato

1 Se necessario, selezionare uno o più oggetti.

2 Selezionare il comando desiderato dal menu Comandi.

Riprodurre una selezione di passaggi registrati

1 Selezionare uno o più oggetti.

2 Selezionare i passaggi nel pannello Cronologia.

3 Fare clic sul pulsante Riproduci nella parte inferiore del pannello Cronologia.

I passaggi contrassegnati da una X non sono ripetibili e non possono essere riprodotti. Le linee di separazione 

indicano che è stato selezionato un oggetto diverso. I comandi creati a partire dai passaggi che attraversano la linea 

di separazione possono produrre risultati non prevedibili.



303UTILIZZO DI FIREWORKS

Automatizzare le operazioni

Ultimo aggiornamento 4/5/2011

Applicare i passaggi selezionati a oggetti contenuti in molti documenti

1 Selezionare un intervallo di passaggi.

2 Fare clic sul pulsante Copia passaggi negli Appunti.

3 Selezionare uno o più oggetti in qualsiasi documento di Fireworks.

4 Selezionare Modifica > Incolla.

Ripetere l’ultimo passaggio

❖ Selezionare Modifica > Ripeti Script comandi.

Informazioni sulla creazione di script con JavaScript

Per ridurre il numero di operazioni ripetitive, è possibile creare in un editor di testo JavaScript personalizzati da 

eseguire in Fireworks. Tramite JavaScript, è possibile controllare praticamente ogni singolo comando o impostazione 

di Fireworks. Poiché anche Dreamweaver utilizza JavaScript, è possibile scrivere script che controllano Fireworks da 

Dreamweaver.

Per la documentazione relativa all’API di JavaScript, consultare Estensione di Fireworks.

Creazione di comandi e pannelli con Flash

Per creare i propri comandi o pannelli Fireworks, utilizzare Adobe Flash® per creare filmati SWF che contengano 

codice JavaScript. Archiviare i filmati utilizzati come comandi nella cartella Commands sul disco rigido. Archiviare i 

filmati utilizzati come pannelli nella cartella Command Panels (ad esempio, il pannello Allinea).

Nota: la posizione esatta di queste cartelle varia. Le cartelle Commands e Command Panels si trovano nella cartella 

Configuration all’interno della cartella dell’applicazione Fireworks nonché nella cartella di configurazione di Fireworks 

specifica dell’utente.

Gestire i comandi

Nota: è possibile rinominare o eliminare qualsiasi comando creato dall’utente tramite l’opzione Gestisci comandi salvati 

di Fireworks. Per gli altri comandi ed estensioni installati con Fireworks o scaricati dal sito Web Adobe Exchange, 

utilizzare Extension Manager.

Ridenominare un comando personalizzato creato dall’utente

1 Selezionare Comandi > Gestisci comandi salvati e selezionare il comando.

2 Fare clic su Rinomina, immettere un nuovo nome e fare clic su OK.

Eliminare un comando personalizzato creato dall’utente

❖ Effettuare una delle seguenti operazioni:

• In Fireworks, selezionare Comandi > Gestisci comandi salvati. Quindi selezionare il comando e fare clic su 

Elimina.

• Sul disco rigido, eliminare il file JSF del comando dalla cartella Commands all’interno della cartella di 

configurazione di Fireworks dell’utente.
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Nota: per rinominare o eliminare un comando distribuito con Fireworks o scaricato da Adobe Exchange, aprire 

Extension Manager.

Modificare un comando tramite JavaScript

Gli script di comando vengono salvati come JavaScript e possono essere modificati con qualsiasi editor di testi.

1 Dal desktop, passare alla cartella Commands o Command Panels appropriata del disco rigido.

2 Aprire il file script in un editor di testo e modificare il codice JavaScript.

3 Salvare e chiudere lo script.

Modificare azioni selezionate dal pannello Cronologia tramite JavaScript

1 In Fireworks selezionare un intervallo di operazioni nel pannello Cronologia.

2 Fare clic sul pulsante Copia passaggi negli Appunti, in fondo al pannello Cronologia.

3 Creare un nuovo documento con un editor di testi.

4 Incollare i passaggi nel nuovo documento di testo e apportare le modifiche richieste.

5 Salvare e chiudere lo script.

6 Copiare lo script nella cartella Commands del disco rigido.

• I comandi salvati direttamente nella cartella Commands o nel pannello Cronologia vengono visualizzati 

immediatamente nel menu Comandi.

• I comandi salvati nella cartella Command Panels sono disponibili nel menu Finestra solo dopo il riavvio di 

Fireworks.



305

Ultimo aggiornamento 4/5/2011

Capitolo 20: Preferenze e scelte rapide da 
tastiera

Le impostazioni delle preferenze di Fireworks consentono di controllare l’aspetto generale dell’interfaccia utente e 

personalizzare i diversi aspetti della modifica e l’utilizzo delle cartelle. È inoltre possibile personalizzare le scelte rapide 

da tastiera.

Impostare le preferenze

1 Scegliere Modifica > Preferenze (Windows) o Fireworks > Preferenze (Mac OS).

2 Selezionare la categoria di preferenze che si desidera modificare.

3 Apportare le modifiche, quindi fare clic su OK.

Preferenze della scheda Generale
Opzioni documento Per aprire l’applicazione direttamente nello spazio di lavoro, deselezionare Mostra pagina 

iniziale. Per mantenere le dimensioni di tratti e riempimenti quando si ridimensionano gli oggetti, deselezionare Scala 

tratti ed effetti.

Salvataggio di file: Aggiungi icone anteprima (solo Mac OS) Consente di visualizzare o nascondere le miniature dei 

file PNG di Fireworks memorizzati sul disco rigido. Deselezionare questa opzione per visualizzare la tradizionale icona 

di Fireworks normalmente utilizzata per rappresentare i file PNG di Fireworks. Le modifiche vengono applicate dopo 

aver salvato il file.

Numero massimo di annullamenti Consente di impostare i livelli di annullamento/ripristino su un valore compreso 

tra 0 e 1009. Questa impostazione si applica sia al comando Modifica > Annulla sia al pannello Cronologia. Se si 

seleziona un numero elevato, potrebbe essere necessaria una quantità di memoria maggiore.

Interpolazione Consente di selezionare uno dei quattro metodi di scala utilizzati da Fireworks per interpolare i pixel 

quando vengono scalate le immagini:

• L’interpolazione bicubica, che rappresenta il metodo predefinito, assicura i migliori risultati in termini di nitidezza 

e qualità nella maggior parte dei casi.

• L’interpolazione bilineare garantisce risultati più nitidi rispetto all’interpolazione morbida, ma non così nitidi 

quanto quelli dell’interpolazione bicubica.

• L’interpolazione morbida, utilizzata già in Fireworks 1, fornisce una sfocatura morbida ed elimina ogni contorno 

netto. Questo metodo è utile quando gli altri metodi producono effetti indesiderati.

• L’interpolazione più vicina dà luogo a bordi frastagliati e contrasti netti senza alcuna sfocatura. L’effetto è simile 

all’ingrandimento o alla riduzione di un’immagine.

Preimpostazioni colore Consente di selezionare i colori predefiniti per tratti di pennello, riempimenti e tracciati 

evidenziati. Le opzioni Tratto e Riempimento non modificano automaticamente i colori nel pannello Strumenti. 

Modificano piuttosto i colori predefiniti nel pannello Strumenti.

Area di lavoro Per comprimere automaticamente i pannelli agganciati quando si fa clic lontano da essi, selezionare 

Riduzione automatica pannelli icone.
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Preferenze Modifica

Le preferenze di modifica controllano l’aspetto del puntatore e ogni altro ausilio visivo per gli oggetti bitmap.

Elimina oggetti durante ritaglio Elimina in modo permanente i pixel o gli oggetti che non rientrano nella casella di 

delimitazione della selezione quando si ritaglia un documento o ridimensiona l’area di lavoro. Questa opzione è valida 

solo per gli oggetti bitmap.

Elimina tracciati durante la conversione in perimetro di selezione Consente di eliminare definitivamente il tracciato 

dopo la sua conversione in un perimetro di selezione.

Cursori dimensioni pennello Permette di impostare la dimensione e la forma dei puntatori degli strumenti. Per alcuni 

pennelli di grandi dimensioni a più punte, viene utilizzato per impostazione predefinita il puntatore a croce. Quando 

questa opzione e l’opzione Cursori di precisione sono disattivate, vengono visualizzati i puntatori raffiguranti le icone 

degli strumenti.

Cursori di precisione Consente di sostituire i puntatori raffiguranti le icone degli strumenti con il puntatore a croce.

Disattiva “Nascondi bordi”  Consente di disattivare l’opzione Nascondi bordi quando cambia la selezione.

Mostra Anteprima penna Mostra un’anteprima del segmento del tracciato successivo che viene creato facendo clic con 

lo strumento Penna.

Mostra punti solidi Mostra i punti selezionati come attenuati e quelli deselezionati come solidi.

Mouse evidenziato Consente di evidenziare gli elementi selezionabili con un clic del mouse.

Anteprima trascinamento Mostra un’anteprima della nuova posizione dell’oggetto durante il trascinamento.

Mostra maniglie di riempimento Consente la modifica a video dei riempimenti.

Distanza selezione Consente di specificare la distanza del puntatore da un oggetto (da 1 a 10 pixel) prima che 

quest’ultimo possa essere selezionato.

Opzione Ridimensionamento a 9 sezioni Consente di separare automaticamente le forme automatiche quando si 

utilizza lo strumento Ridimensionamento a 9 sezioni, eliminando la finestra di dialogo che chiede se si desidera 

separare tali forme.

Preferenze Guide e griglie
Caselle colore Se si fa clic su queste caselle, viene visualizzata una finestra a comparsa che consente di selezionare un 

colore o immettere valori esadecimali.

Mostra Consente di visualizzare le guide o le griglie dell’area di lavoro.

Aggancia Consente di agganciare gli oggetti alle linee delle griglie o alle guide.

Blocca Consente di bloccare in posizione le guide precedentemente posizionate, impedendo che vengano spostate 

inavvertitamente quando si apportano modifiche agli oggetti.

Distanza agganciamento Consente di specificare la distanza alla quale si deve trovare l’oggetto che si sta spostando (da 

1 a 10 pixel) prima che tale oggetto possa agganciarsi a una griglia o a una linea delle guide. Questa opzione funziona 

se è attiva la funzione Aggancia alla griglia o Aggancia alle guide.

Impostazioni griglia Consente di modificare le dimensioni, in pixel, delle celle della griglia. Immettere i valori nelle 

caselle di spaziatura orizzontali e verticali.
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Preferenze Testo
Interlinea, Spostamento linea di base Consente di modificare il valore di incremento per le scelte rapide da tastiera 

correlate. 

Per creare un elenco completo delle scelte rapide relative al testo, consultare “Creare un foglio di riferimento per la 

serie di scelte rapide attuale” a pagina 310.

Mostra i nomi dei caratteri in inglese Sostituisce i caratteri asiatici nel menu dei caratteri.

Nota: questa modifica diventa effettiva al riavvio di Fireworks.

Dimensione anteprima carattere Specifica le dimensioni degli esempi dei caratteri nei menu.

Numero di caratteri recenti Determina il numero massimo di tipi di caratteri utilizzati di recente elencati sopra 

l’elemento di divisione nei menu dei caratteri.

Nota: questa modifica diventa effettiva al riavvio di Fireworks.

Carattere predefinito Specifica il tipo di carattere che sostituirà qualsiasi tipo di carattere del documento mancante 

nel sistema.

Preferenze di importazione e apertura da Photoshop

Queste preferenze determinano il modo in cui Fireworks si comporterà quando si importano o aprono i file di 

Photoshop. Per ulteriori informazioni, consultare “Operazioni con Photoshop” a pagina 279.

Mostra finestra di dialogo di importazione Visualizza le opzioni quando si importano i file PSD mediante il comando 

File > Importa.

Mostra finestra di dialogo di apertura Visualizza le opzioni quando si trascinano file PSD in Fireworks o si utilizza il 

comando File > Apri.

Condividi livelli tra stati Aggiunge ogni livello importato a tutti gli stati dei file di Fireworks. Se questa opzione è 

deselezionata, ogni livello viene aggiunto a uno stato diverso. Questo risulta utile per importare file da usare come 

animazioni.

Immagini bitmap con effetti modificabili Permette di modificare gli effetti delle immagini bitmap durante 

l’importazione. Le immagini bitmap non possono essere modificate.

Immagini bitmap appiattite Importa le immagini bitmap e relativi effetti come immagini appiattite non modificabili.

Testo modificabile Importa i livelli di testo come testo modificabile. In Fireworks non è possibile modificare la 

formattazione del testo (come barrato, apice, pedice e sillabazione automatica). Inoltre, non è possibile separare le 

legature presenti nel testo sorgente.

Immagini bitmap appiattite Importa i livelli di testo come immagini appiattite non modificabili.

Tracciati ed effetti modificabili Permette di modificare i livelli forma e relativi effetti.

Immagini bitmap appiattite Importa i livelli forma come immagini appiattite non modificabili.

Immagini bitmap appiattite con effetti modificabili Importa i livelli forma come immagini appiattite ma permette di 

modificarne i relativi effetti.

Effetti di livello Sostituisce gli effetti dinamici di Photoshop con filtri di Fireworks simili.

Maschere di tracciati di ritaglio Consente di rasterizzare e rimuovere le maschere di ritaglio, mantenendone l’aspetto. 

Deselezionare questa opzione se si desidera modificare le maschere in Fireworks. Tuttavia, l’aspetto potrà risultare 

diverso rispetto a Photoshop.
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Preferenze Avvio e modifica

Le preferenze di avvio e modifica controllano la modalità di avvio e modifica degli elementi grafici di Fireworks da 

parte di applicazioni esterne.

1 Sono disponibili i seguenti menu a comparsa:

Alla modifica da un’applicazione esterna Determina se il file PNG originale di Fireworks si apre o meno quando si 

utilizza Fireworks per modificare le immagini in altre applicazioni.

All’ottimizzazione da un’applicazione esterna Determina se il file PNG originale di Fireworks si apre o meno 

quando si ottimizza un’immagine. Questa impostazione non si applica a Director, che si apre sempre 

automaticamente e ottimizza l’elemento grafico senza richiedere un file PNG sorgente, anche se è stata scelta 

un’impostazione diversa per questa preferenza in Fireworks.

2 Specificare le modalità di modifica delle immagini di Fireworks situate nelle applicazioni esterne:

Usa sempre sorgente PNG Apre automaticamente il file PNG di Fireworks definito nella Design Note come 

sorgente per l’immagine inserita. In questo caso vengono aggiornati sia il PNG sorgente che l’immagine inserita 

corrispondente.

Non usare mai sorgente PNG Apre automaticamente l’immagine inserita di Fireworks, indipendentemente dal 

fatto che esista un file PNG sorgente o meno. In questo caso viene aggiornata solo l’immagine inserita.

Chiedi all’avvio Consente di specificare ogni volta se aprire o meno il file PNG sorgente. Quando si modifica o 

ottimizza un’immagine inserita, Fireworks richiede di effettuare una scelta relativa all’avvio e la modifica. Inoltre è 

possibile specificare preferenze globali di lancio e modifica da questo prompt.

Preferenze Plug-in

Queste preferenze consentono di accedere a file aggiuntivi di pattern (o motivi), texture e plug-in di Adobe Photoshop. 

Le cartelle di destinazione possono trovarsi sul disco rigido, un CD-ROM, un’unità disco rigido esterna o un volume 

di rete.

I plug-in di Photoshop appaiono nel menu Filtri di Fireworks e nel menu Aggiungi effetti della finestra di ispezione 

Proprietà. Le texture o i motivi memorizzati come file PNG, JPEG e GIF compaiono come opzioni nei menu a 

comparsa Motivo e Texture della finestra di ispezione Proprietà.

Per ulteriori informazioni su texture e motivi, consultare “Aggiungere texture a un tratto o riempimento” a pagina 127.

Ripristinare le preferenze predefinite

Nota: Il ripristino delle preferenze predefinite determina la rimozione di tutte le impostazioni personalizzate e il 

ripristino della configurazione originale di Fireworks.

1 Uscire da Fireworks.

2 Individuare il file delle preferenze di Fireworks sul disco rigido ed eliminarlo.

La posizione esatta del file varia da sistema a sistema. Vedere “Posizione del file delle preferenze di Fireworks” a 

pagina 311

3 Riavviare Fireworks.

Al successivo avvio di Fireworks, viene creato un nuovo file di preferenze.



309UTILIZZO DI FIREWORKS

Preferenze e scelte rapide da tastiera

Ultimo aggiornamento 4/5/2011

Selezionare e personalizzare le scelte rapide della 
tastiera

Fireworks consente di utilizzare le scelte rapide da tastiera per selezionare comandi di menu, scegliere strumenti dal 

pannello Strumenti ed eseguire rapidamente operazioni varie che non esistono come comandi di menu. Se si ha 

familiarità con l’uso delle scelte rapide di altre applicazioni come Adobe FreeHand, Adobe Illustrator, Photoshop o 

prodotti che utilizzano un diverso standard, è possibile passare alla serie di scelte rapide preferita.

Selezionare una serie di scelte rapide 

1 Selezionare Modifica > Scelte rapide da tastiera (Windows) o Fireworks > Scelte rapide da tastiera (Mac OS).

2 Selezionare la serie dal menu a comparsa Serie corrente, quindi fare clic su OK.

Creare scelte rapide personalizzate e secondarie

È possibile creare scelte rapide da tastiera personalizzate da una serie preinstallata, nonché scelte rapide secondarie che 

includano diversi modi per effettuare un’azione.

Le scelte rapide da tastiera (eccetto quelle per comandi di menu) non possono includere tasti di modifica: Control, 

Maiusc e Alt (Windows) o Comando, Maiusc, Opzione e Ctrl (Mac OS). Devono essere composte da una singola 

lettera o tasto numerico.

1 Selezionare Modifica > Scelte rapide da tastiera (Windows) o Fireworks > Scelte rapide da tastiera (Mac OS).

2 Fare clic sul pulsante Duplica serie.

3 Immettere un nome per la serie personalizzata e fare clic su OK. 

4 Selezionare la categoria di scelte rapide appropriata dall’elenco Comandi.

Comandi di menu Tutti i comandi ai quali è possibile accedere dalla barra dei menu

Strumenti Gli strumenti situati nel pannello Strumenti

Varie Diverse azioni predefinite

5 Dall’elenco Comandi, selezionare il comando di cui si desidera modificare la scelta rapida.

6 Fare clic nella casella di testo Premi tasto e premere sulla tastiera i tasti desiderati per la nuova scelta rapida.

7 Per aggiungere una scelta rapida secondaria all’elenco, fare clic sul pulsante Aggiungi una nuova scelta rapida (+). 

In caso contrario, fare clic su Cambia per sostituire la scelta rapida selezionata.

Eliminare scelte rapide personalizzate e serie di scelte rapide

Eliminare una serie di scelte rapide personalizzate

1 Selezionare Modifica > Scelte rapide da tastiera (Windows) o Fireworks > Scelte rapide da tastiera (Mac OS).

2 Fare clic sul pulsante Elimina gruppo (l’icona raffigurante un cestino).

3 Selezionare una serie di scelte rapide.

4 Fare clic sul pulsante Elimina.

Eliminare una scelta rapida personalizzata

1 Selezionare il comando nell’elenco Comandi.
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2 Selezionare la scelta rapida personalizzata dall’elenco Scelte rapide.

3 Fare clic sul pulsante Elimina la scelta rapida selezionata (-).

Creare un foglio di riferimento per la serie di scelte rapide attuale 

Un foglio di riferimento è la serie di scelte rapide corrente memorizzata in formato tabella HTML. Il foglio di 

riferimento può essere visualizzato da un browser Web oppure stampato.

Nota: i fogli di riferimento esportati da Fireworks hanno codifica UTF-8.

1 Selezionare Modifica > Scelte rapide da tastiera (Windows) o Fireworks > Scelte rapide da tastiera (Mac OS).

2 Fare clic sul pulsante Esporta gruppo come HTML accanto alla casella di testo Serie corrente.

3 Immettere il nome del foglio di riferimento, quindi selezionare la posizione del file.

4 Fare clic su Salva.

Utilizzare i file di configurazione

I file di configurazione specifici per gli utenti consentono di personalizzare funzioni di Fireworks quali gli stili, le scelte 

rapide da tastiera e i comandi, senza incidere sulla configurazione di Fireworks per gli altri utenti.

Fireworks consente inoltre di installare file di configurazione master.

Nota: per visualizzare i file di configurazione, accertarsi che le opzioni di visualizzazione delle cartelle siano impostate 

per visualizzare tutti i file e le cartelle. In alcuni sistemi, potrebbe essere necessario fare clic sull’opzione che consente di 

mostrare i file su una cartella per visualizzarne il contenuto. Per informazioni sulla visualizzazione di tutti i file e cartelle, 

consultare la Guida in linea di Windows.

File di configurazione utente

Fireworks crea un gruppo diverso di file di configurazione per ogni utente. I file sono memorizzati nella cartella 

Adobe/Fireworks CS5 all’interno della cartella personale dell’utente Dati applicazioni (Windows) o della cartella 

Application Support (Mac OS). La posizione di questa cartella varia seconda del sistema operativo utilizzato e del tipo 

di sistema, che può essere multiutente o monoutente. Per informazioni su come individuare questa cartella, consultare 

la documentazione fornita con il sistema operativo.

Nota: i nomi di alcune cartelle di sistema potrebbe variare sulle versioni localizzate o personalizzate del sistema.

File di configurazione master che interessano tutti gli utenti

I file di configurazione master contengono le impostazioni predefinite di Fireworks che interessano tutti gli utenti. Si 

trovano nella cartella delle applicazioni di Fireworks, ovvero la posizione sul disco rigido in cui è stato installato 

Fireworks.

Nota: gli utenti Mac OS dovrebbero conoscere il concetto di pacchetto applicativo di Apple.

Durante il salvataggio della maggior parte delle impostazioni, Fireworks modifica i file di configurazione specifici 

dell’utente e non i file di configurazione master, in quanto molti utenti non dispongono dell’accesso a tutti i file se 

lavorano su sistemi multiutente.

Gli utenti con accesso a livello amministratore possono personalizzare le caratteristiche di tutti gli utenti modificando 

i file di configurazione master.
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Salvare le impostazioni di configurazione master per tutti gli utenti

❖ Salvare o trascinare una copia del file nella posizione appropriata all’interno della cartella dell’applicazione 

Fireworks.

Posizione del file delle preferenze di Fireworks

Le preferenze di Fireworks sono memorizzate in un file denominato Fireworks CS5 Preferences.txt (Windows) o 

Fireworks CS5 Preferences (Mac OS). La posizione esatta del file varia a seconda del sistema operativo.

• In Windows, le preferenze di un utente si trovano nella cartella di configurazione di Fireworks specifica per l’utente. 

• In Mac OS, le preferenze si trovano nella cartella Libreria/Preferenze all’interno della cartella dell’utente. Per 

informazioni su come individuare la cartella dell’utente Mac OS, consultare l’Aiuto di Apple.

Nota: in Mac OS, la maggior parte dei file di configurazione specifici per l’utente di Fireworks sono memorizzati 

nell’apposita cartella Application Support. Il file delle preferenze di Fireworks CS5 fa eccezione.

Reinstallazione di Fireworks

Quando si disinstalla o si reinstalla Fireworks, i file di configurazione specifici per gli utenti rimangono inalterati sulla 

maggior parte dei sistemi. Se si desidera reinstallare Fireworks utilizzando le impostazioni predefinite, eliminare 

manualmente questi file di configurazione prima di avviare l’installazione.

Se si sceglie di rimuovere i file di configurazione delle preferenze e quelli specifici per l’utente durante il processo di 

disinstallazione, questi vengono rimossi per tutti gli utenti presenti nel sistema.

Visualizzare il contenuto del pacchetto (solo Mac OS)

In ambiente Mac OS, Fireworks viene installato nel formato indipendente, o pacchetto applicativo. Il pacchetto 

applicativo è il luogo di memorizzazione dei file dell’applicazione Fireworks e di tutti i file di configurazione predefiniti 

forniti con il software. Per impostazione predefinita, il contenuto del pacchetto è nascosto.

1 Accedere alla directory del disco rigido in cui è installato Fireworks.

2 Fate clic tenendo premuto il tasto Ctrl sull’icona di Fireworks CS5 e selezionate Mostra contenuti pacchetto.
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